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NOTICE

ROSEMOUNT (“SELLER”) SHALL NOT BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS IN THIS MANUAL OR OMISSIONS FROM THIS
MANUAL. SELLER MAKES NO WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THIS MANUAL AND, IN NO EVENT, SHALL SELLER BE LIABLE FOR ANY
SPECIAL OR CONSEQUENTIAL DAMAGES INCLUDING, BUT NOT LIMITED TO, LOSS OF PRODUCTION, LOSS OF PROFITS, ETC.

PRODUCT NAMES USED HEREIN ARE FOR MANUFACTURER OR SUPPLIER IDENTIFICATION ONLY AND MAY BE TRADEMARKS/
REGISTERED TRADEMARKS OF THESE COMPANIES.

THE CONTENTS OF THIS PUBLICATION ARE PRESENTED FOR INFORMATIONAL PURPOSES ONLY, AND WHILE EVERY EFFORT HAS
BEEN MADE TO ENSURE THEIR ACCURACY, THEY ARE NOT TO BE CONSTRUED AS WARRANTIES OR GUARANTEES, EXPRESSED OR
IMPLIED, REGARDING THE PRODUCTS OR SERVICES DESCRIBED HEREIN OR THEIR USE OR APPLICABILITY. WE RESERVE THE RIGHT
TO MODIFY OR IMPROVE THE DESIGNS OR SPECIFICATIONS OF SUCH PRODUCTS AT ANY TIME.

SELLER DOES NOT ASSUME RESPONSIBILITY FOR THE SELECTION, USE, OR MAINTENANCE OF ANY PRODUCT. RESPONSIBILITY FOR
PROPER SELECTION, USE, AND MAINTENANCE OF ANY SELLER PRODUCT REMAINS SOLELY WITH THE PURCHASER AND END-USER.

WARRANTY

1. LIMITED WARRANTY: Subject to the limitations contained in Section 2 herein and except as otherwise expressly provided
herein, Rosemount (“Seller”) warrants that the firmware will execute the programming instructions provided by Seller, and
that the Goods manufactured or Services provided by Seller will be free from defects in materials or workmanship under
normal use and care until the expiration of the applicable warranty period. Goods are warranted for twelve (12) months
from the date of initial installation or eighteen (18) months from the date of shipment by Seller, whichever period expires
first. Consumables and Services are warranted for a period of 90 days from the date of shipment or completion of the
Services. Products purchased by Seller from a third party for resale to Buyer (“Resale Products”) shall carry only the warranty
extended by the original manufacturer. Buyer agrees that Seller has no liability for Resale Products beyond making a
reasonable commercial effort to arrange for procurement and shipping of the Resale Products. If Buyer discovers any
warranty defects and notifies Seller thereof in writing during the applicable warranty period, Seller shall, at its option,
promptly correct any errors that are found by Seller in the firmware or Services, or repair or replace F.O.B. point of
manufacture that portion of the Goods or firmware found by Seller to be defective, or refund the purchase price of the
defective portion of the Goods/Services. All replacements or repairs necessitated by inadequate maintenance, normal wear
and usage, unsuitable power sources, unsuitable environmental conditions, accident, misuse, improper installation,
modification, repair, storage or handling, or any other cause not the fault of Seller are not covered by this limited warranty,
and shall be at Buyer's expense. Seller shall not be obligated to pay any costs or charges incurred by Buyer or any other party
except as may be agreed upon in writing in advance by an authorized Seller representative. All costs of dismantling,
reinstallation and freight, and the time and expenses of Seller's personnel for site travel and diagnosis under this warranty
clause shall be borne by Buyer unless accepted in writing by Seller. Goods repaired and parts replaced during the warranty
period shall be in warranty for the remainder of the original warranty period or ninety (90) days, whichever is longer. This
limited warranty is the only warranty made by Seller and can be amended only in a writing signed by an authorized
representative of Seller. Except as otherwise expressly provided in the Agreement, THERE ARE NO REPRESENTATIONS OR
WARRANTIES OF ANY KIND, EXPRESSED OR IMPLIED, AS TO MERCHANTABILITY, FITNESS FOR PARTICULAR PURPOSE, OR
ANY OTHER MATTER WITH RESPECT TO ANY OF THE GOODS OR SERVICES. It is understood that corrosion or erosion of
materials is not covered by our guarantee.

2. LIMITATION OF REMEDY AND LIABILITY: SELLER SHALL NOT BE LIABLE FOR DAMAGES CAUSED BY DELAY IN PERFORMANCE.
THE SOLE AND EXCLUSIVE REMEDY FOR BREACH OF WARRANTY HEREUNDER SHALL BE LIMITED TO REPAIR, CORRECTION,
REPLACEMENT, OR REFUND OF PURCHASE PRICE UNDER THE LIMITED WARRANTY CLAUSE IN SECTION 1 HEREIN. IN NO
EVENT, REGARDLESS OF THE FORM OF THE CLAIM OR CAUSE OF ACTION (WHETHER BASED IN CONTRACT, INFRINGEMENT,
NEGLIGENCE, STRICT LIABILITY, OTHER TORT, OR OTHERWISE), SHALL SELLER'S LIABILITY TO BUYER AND/OR ITS
CUSTOMERS EXCEED THE PRICE TO BUYER OF THE SPECIFIC GOODS MANUFACTURED OR SERVICES PROVIDED BY SELLER
GIVING RISE TO THE CLAIM OR CAUSE OF ACTION. BUYER AGREES THAT IN NO EVENT SHALL SELLER'S LIABILITY TO BUYER
AND/OR ITS CUSTOMERS EXTEND TO INCLUDE INCIDENTAL, CONSEQUENTIAL OR PUNITIVE DAMAGES. THE TERM
“CONSEQUENTIAL DAMAGES” SHALL INCLUDE, BUT NOT BE LIMITED TO, LOSS OF ANTICIPATED PROFITS, LOSS OF USE,
LOSS OF REVENUE, AND COST OF CAPITAL.
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1  Cybersecurity recommendations for
Rosemount XA gas chromatograph
(GC) and MON2020 users
Install XA GC in a secure environment with physical protection
• Install the XA GC in a secure environment with physical protection.
• Scan the USB shipped with the XA GC with anti-virus software before use.
• Store all the GC related files including application files, drawings, and documents, in a

secure network/drive with restricted access.
Install MON2020 on a secure personal computer (PC)
• Access to PC should be protected by adequate username/password.
• With restricted admin privileges on PC - operating system (OS) configuration, install

software, etc.
• Restrict network ports and connection of mass storage devices/removable media.
• Resides on a private local area network (LAN) with firewall and network access control

list configured for blocking illegitimate access.
• With anti-virus software kept current on PC.
• With Microsoft® Windows automatic updates enabled on PC.
• PC updated with Windows security patches.
• With physical access controls - locked room, key-card entry, etc.
Use XA GCs in secure network
This product is designed to be used in an industrial environment with appropriate defense-
in-depth security measures and compensating controls effective against cyber-attacks.
This product is not designed to be connected directly to the Internet or Internet facing
networks. Security measures should include, but are not limited to:
• Ethernet should be set up in a private LAN with firewall and network access control list

configured for blocking illegitimate access.
• Network devices stored with physical access controls - physical locks, ID verification, etc.
• Network devices updated with all available security patches.
• Anti-virus software kept current on all computers in the network.
• Other industry best practices for secure network.
Control access to XA GC using password of sufficient complexity
• The password length should be at least eight alphanumeric characters.
• All default users should be removed after XA GC commissioning or password upgrade

to comply with the password complexity guidelines.
• Password policy level should be set after GC commissioning by accessing Tools → Users 

→User Administration.
• Use a unique password for each user.

Manual Cybersecurity recommendations for Rosemount XA gas chromatograph (GC) and MON2020 users 
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• Avoid sharing passwords with other users.
Control access to user profile for XA GC using admin password of sufficient
complexity
• The admin password length should be at least 10 alphanumeric characters.
• The admin password should include at least one number, mix of upper/lower case

characters, and at least one special character (!@#$%^&*_-+=:?)
• The default admin password should be changed after GC commissioning by using the

password complexity guidelines.
• Avoid sharing the password with non-admin users.
Upload/download files of the approved types to/from XA GC
• Upload/download files of the approved types to/from XA GC.
• The approved files of type include .xls, .xlsx, .pdf, .tif/.tiff, .xrted (XA trend file), .xcgm (XA

chromatogram file), and .xcmp (XA comparison file).
• Scan the mass storage device with the latest anti-virus software before uploading any

files to GC.
Check integrity for distributed binaries
• A hash value will be provided for some software/firmware files distributed by Emerson

GC, so that the user can verify the integrity of the file.
• The hashing algorithm SHA-256 is used for calculating the hash value of the binary file.
• There are many programs for calculating the SHA-256 hash including Windows

Command Prompt, Windows PowerShell, and third-party software (such as Hash Tool).
The user can use a program of choice to calculate the SHA-256 hash value of the
downloaded file and compare it to the value specified on the download page.

• The following is an example of using Windows Command Prompt to calculate the
SHA-256 hash value:
— In a command line, run the command:

• certutil -hashfile [filename] SHA256
— For example:

Cybersecurity recommendations for Rosemount XA gas chromatograph (GC) and MON2020 users Manual 
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1 Rosemount™ 1500XA Gas
Chromatograph (GC) safety 

Your installation must comply with all certifications and safety instructions.

Rosemount™ 1500XA Gas Chromatograph System

Rosemount 1500XA Gas Chromatographs are designed to meet the specifications for
Class 1, Division 2, Groups B, C, and D area classification using a Z-purge system. An
optional Nationally Recognized Testing Laboratory (NRTL) 3rd party certification is
available when ordering. This option ensures that an NRTL organization has reviewed,
tested, and certified the Rosemount 1500XA Gas Chromatograph to the applicable
product safety test standards.

NOTICE

The Rosemount 1500XA is field or type certified product by an National Recognized Testing Lab 
for both US and Canadian standards. Internal components or related assemblies may contain 
their own individual product certifications.

WARNING!

HAZARDOUS AREAS
Do not open the enclosure unless the area is known to be non-hazardous or unless all devices
within the enclosure have been de-energized. Do not restore power after the enclosure has
been opened until the enclosure has been purged for 60 minutes at a pressure of 0.3 in. w.c.

WARNING!

HAZARDOUS AREAS
The safety of this equipment relies on the provision of proper purging and pressurizing when
used in hazardous locations. It must not be put into use without "special permission" from the
inspection authority having jurisdiction.

WARNING!

HOT INTERNAL PARTS

Rosemount
™
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WARNING!

HIGH TEMPERATURE INTERNAL PARTS
Do not open this enclosure unless the area atmosphere is known to be below the ignitable
concentration of combustible materials or unless all equipment within has been de-energized
for 5 minutes.

WARNING!

AIR PURGE ADJUST
This valve must remain open unless area is non-hazardous.

WARNING!

SUPPLY MAINS
The unit is intended to be connected to supply mains by qualified personnel in accordance with
national (e.g., NFPA 70, CEC 22.1, etc) and local codes.

WARNING!

MAINS POWER
A suitable "approved" switch and fuse or a circuit breaker shall be provided to facilitate the
disconnection of the mains power.

WARNING!

All safety related precautions and warnings must be followed before dispensing and disposing
of gas.

WARNING!

HAZARDOUS AREAS
Do not disconnect equipment unless power has been switched off or the area is known to be 
non-hazardous.

WARNING!

Substitution of components may impair suitability for Class I, Division 1 and 2.

Rosemount
™
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WARNING!

SAFE ATMOSPHERE
Service connections can only be used when the atmosphere is known to be safe.

WARNING!

ELECTRIC SHOCK
Keep cover tight while circuits are alive. Do not open when energized. Conduits runs must have
a sealing fitting adjacent to enclosure.

WARNING!

BURN HAZARD
Many parts of the analyzer may be heated to 120 °C (248 °F).

To prevent burns, do not touch any of the hot parts. Many parts of an analyzer are always hot
unless it has been switched off and allowed to cool down.

• Before fitting, removing, or performing any maintenance on the analyzer, make sure
that it has been switched off and allowed to cool for at least two hours.

• When handling the analyzer, always use suitable protective gloves.

• If burned, seek medical treatment immediately.

Rosemount
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Schedule of limitations
1. The 1500XA and 4500XA backplanes are certified as components to be installed in the 1500XA 

or 4500XA Gas Chromatograph manufactured by Rosemount, Inc.
2. The 1500XA or 4500XA backplanes do not show a maximum surface temperature exceeding 

+185 °F (+85 °C) considering a maximum temperature of +131 °F (+55 °C) with 5K safety factor 
applied.

3. The 1500XA and 4500XA intrinsically safe (IS) backplanes are located in a Z or X purged 
electronics enclosure of the 1500XA and 4500XA Gas Chromatographs that provide IP54 
ingress protection per IEC 60079-0.

4. Installation shall be per control drawing 9A00052G01 for 1500XA backplane and 9R00026 for 
4500XA backplane.

5. A minimum clearance of 0.1 in. (3.0 mm) between live parts and earthed metal shall be 
maintained.

6. If other electrical circuits are fitted into the enclosure, then they shall be suitably approved for 
the hazardous area of installation and all live parts shall be protected to a minimum of IP30 
when the enclosure is opened.

7. The 4500XA backplane shall only be used in an area of at least pollution degree 2, as defined in 
IEC 60664-1.

8. The 4500XA backplane shall be installed in a suitable enclosure that provides a minimum 
ingress protection of IP54 in accordance with IEC 60079-0, unless it is afforded an equivalent 
degree of protection by location.

9. Transient protection shall be provided that is set at a level not exceeding 140 percent of the 
peak rated voltage value 24 V of the supply terminals to the 4500XA backplane.

10. The unit shall be powered off before any maintenance is performed on it.
11. The 4500XA shall only be powered by an IEC/EN 60950-1 power source with an output not 

exceeding Um 24 V.



• Appendix B: description of and instructions for using the local operator interface
(LOI)

• Appendix: instructions for installing and maintaining the carrier gas

• Appendix D: tables of Modbus map files

• Appendix E: a list of boards, valves, and other components suggested as spare parts.

• Appendix F: instructions for shipping and long-term storage recommendations.

• Appendix G: displays engineering drawings.

• Appendix H: provides a list of terms and abbreviations used in this manual.
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• Chapter 1: certification and safety information for the Rosemount 1500XA Gas
Chromatograph.

• Chapter 2: a general description of the Rosemount 1500XA gas chromatograph (GC)
system and its components, their configurations, and functions. Also, Chapter 2 gives
guidelines for sampling system and gas connections, descriptions of the analyzer
subsystems and components, and descriptions of the controller subsystems and
components.

• Chapter 3: a description of site selection and necessary tools for installation.

• Chapter 4: instructions for installing the GC hardware.

• Chapter 5: instructions for regular maintenance and care of the GC hardware as well as
instructions for troubleshooting, repairing, and servicing the GC.

• Appendix A: explanation of how the Rosemount 1500XA operates.

This manual provides the following information:



2 About Rosemount™ 1500XA Gas
Chromatographs

2.1 Description
The Rosemount™ 1500XA is a high-speed gas chromatograph (GC) that is factory
engineered to meet specific field application requirements based on stream composition
and the anticipated concentration of the components of interest.

This GC was fully inspected and tested before it left the factory. Program parameters were
installed and documented in the GC Config Report furnished with the USB stick shipped in
your gas chromatograph documentation package.

Components

The GC typically consists of two major components, the analyzer assembly and the sample
conditioning system (SCS).

See Figure 2-1 for analyzer details.

Analyzer assembly (XA series)

The assembly includes:

• Columns

• Detectors

• Preamplifier

• Valves

• Solenoids

• Analyzer, which includes:

- Electronics and ports for signal processing

- Instrument control

- Data storage

- Personal computer (PC) interface

- Telecommunications

Sample conditioning system (SCS)

The SCS is located between the process stream and the analyzer sample inlet, usually
mounted on the lower portion of the analyzer stand. Optionally, the SCS can be configured
with Genie® bypass filters, liquid shut-off valves, and optional solenoids for stream
switching, all of which can be enclosed in an electric (heat tape design) oven.

The standard configuration SCS includes:

• Mounting plate

About Rosemount
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• Block (or shutoff) valves

• Filters

In its standard configuration, the Rosemount 1500XA can handle multiple streams.

Operation

Although the Rosemount 1500XA GC can be operated from the local operator interface
(LOI) (see Appendix B), it is designed to be run primarily from a personal computer (PC)
running MON2020 software (see Section 2.2). The PC provides you with the greatest
capability, ease of use, and flexibility. One PC running MON2020 can connect with multiple
gas chromatographs over a local area network. The GC’s Ethernet capability makes it
possible to interact with the GC even if it is located in a hazardous area. The PC can be used
to display chromatograms and reports, which can then be stored as files on the PC’s hard
drive.

About Rosemount
™
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Typical installation

System OverviewFigure 2-1:   

A. 1/4 in. connector carrier in
B. 1/4 in. connector valve actuation gas
C. Electronics enclosure
D. Air-bath oven
E. 1/4 in. air regulator in
F. 3/4 in. customer connection
G. LOI display
H. 1/4 in. air regulator
I. Z-Purge pressure regulator
J. 3/4 in. customer connection
K. 3/4 in. customer connection
L. Mechanical pressure regulator panel
M. Cyclops Z-Purge indicator

Documentation

The Rosemount 1500XA Gas Chromatograph Operations Manual (P/N 2-3-9000-762) is
intended as a user's guide to accompany the Rosemount 1500XA gas chromatograph
system.

About Rosemount
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For software operation instructions, see the MON2020 Software for Gas Chromatographs
User Manual (P/N 2-3-9000-745). The operations and software manuals are included on the
MON2020 software USB stick that ships with the gas chromatograph or can be
downloaded from: Gas Chromatograph Software - MON2020 Download.

2.2 MON2020
MON2020 provides operator control of the Rosemount 1500XA, monitors analysis results,
and inspects and edits various parameters that affect Rosemount 1500XA operation. It
also controls display and printout of the chromatograms and reports, and it stops and
starts automatic analysis cycling or calibration runs.

After the equipment/software has been installed and the operation stabilized, automatic
operation takes place over an Ethernet network.

MON2020 is a Windows™-based program that allows you to maintain, operate, and
troubleshoot a gas chromatograph. Individual GC functions that can be initiated or
controlled by MON2020 include, but are not limited to, the following:

• Valve activations

• Timing adjustments

• Stream sequences

• Calibrations

• Baseline runs

• Analyses

• Halt operation

• Stream/detector/heater assignments

• Stream/component table assignments

• Stream/calculation assignments

• Diagnostics

• Alarm and event processing

• Event sequence changes

• Component table adjustments

• Calculation adjustments

• Alarm parameters adjustments

• Analog scale adjustments

• LOI variable assignments (optional)

Reports and logs that can be produced, depending upon the GC application in use,
include, but are not limited to, the following:

• Configuration report

• Parameter list

• Analysis chromatogram
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• Chromatogram comparison

• Alarm log (unacknowledged and active alarms)

• Event log

• Various analysis reports

For a complete list of the GC functions, reports, and logs available through MON2020,
consult the software manual (P/N 2-3-9000-745) available for download from: 
Gas Chromatograph Software - MON2020 Download.

2.3 Software description
The GC uses two distinct types of software. This enables total flexibility in defining the
calculation sequence, report content, format, type and amount of data for viewing,
control, and/or transmission to another computer or controller assembly. The two types
are:

• Embedded GC firmware

• MON2020 software

The RTOS firmware and the application configuration software are installed when the
Rosemount 1500XA is shipped.

The application configuration is tailored to the customer’s process and shipped on a USB
stick. The hardware and software are tested together as a unit before the equipment
leaves the factory.

2.4 Embedded GC firmware
The GC’s embedded firmware supervises operation of the Rosemount 1500XA through its
internal microprocessor-based controller. All direct hardware interface is via this control
software. It consists of a multi-tasking program that controls separate tasks in system
operation, as well as hardware self-testing, user application downloading, startup, and
communications. Once configured, the Rosemount 1500XA can operate as a stand alone
unit.

2.5 Equipment description and specifications
The Rosemount 1500XA Gas Chromatograph combines the proven analytical components
of the Rosemount 700XA Gas Chromatograph with the larger oven capacity and flexibility
of a traditional air-bath oven design.

This section describes the various subsystems and components that make up the
Rosemount 1500XA Gas Chromatograph. It also details the GC’s equipment specifications.
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2.5.1 Electronics enclosure
The Rosemount 1500XA electronics enclosure contains:

• Card cage assembly

• Local operator interface

• Backplane

• AC/DC power supply

• Circuit breaker

• Solenoid valves

• Methanator (optional)

• Oven heater

• Z-purge controller

Local operator interface

The local operator interface (LOI) gives you in-depth control over the GC’s functions. It has
a high resolution color display that is touch key activated and allows you to operate the GC
without a laptop or a PC.

Local operator interfaceFigure 2-2:   
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The LOI includes the following features:

• Color LCD display with VGA (640 x 480 pixels) resolution

• ASCII text and graphics modes

• Adjustable auto-backlighting

• 8 infrared-activated touch screen keys that eliminate the requirement for a
magnetic pen

• Complete GC status, control, and diagnostics, including full chromatogram display

See Appendix B for more information about operating the LOI.
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Electronics assembly

Electronics Assembly ComponentsFigure 2-3:   

A. CPU board
B. Detector preamp board
C. Heater solenoid driver board
D. Card cage
E. ROC module slots
F. Base I/O board
G. Power supply
H. Circuit breaker
I. Backplane
J. Air bath heater

The electronics assembly contains the following components:

• Card cage can support the following:

- CPU board (1)

- Base I/O board (1)

- Heater/solenoid driver board (2)

- Detector preamp board (3)

- ROC Module slots (4)
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™

 1500XA Gas Chromatographs

12 Rosemount™ 1500XA Gas Chromatograph



• Backplane/field termination board (1)

• AC/DC power supply converter (1)

• Flame detector slots (2)

Note
Quantities referenced above are the maximum number of cards the Rosemount 1500XA can hold.
Your GC may not include some of the electronics shown.

Pressure switch

The pressure switch activates when the carrier pressure falls below a predetermined
setpoint. When activated, the switch triggers a general alarm that displays on the LOI and
in MON2020.

Mechanical pressure regulators

The mechanical pressure regulators and gauges are used to set and monitor the pressure
of the carrier gas flow through the GC's columns, as well as the pressure of the FID air and
fuel (H2), if installed.

The regulators and gauges are typically located on the top or side of the electronics
enclosure.

Regulators and GaugesFigure 2-4:   

2.5.2 Air-bath oven
The air-bath oven uses a conventional instrument air heater design for maximum analytical
flexibility. The oven has capacity for up to eight chromatograph valves and four detectors.
There is also the capacity to install liquid sample valves for heavier samples. The oven can
operate at temperatures up to 120 °C (248 °F) as the application dictates.

The air-bath oven contains the valves, the columns, the detectors, and the stream
switching system.
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Note
The analyzer can have a maximum of two flame detectors and/or four TCDs.

A more detailed component list for the oven compartment includes the following:

Air-bath compartment componentsTable 2-1:   

Component Description

Valves A Rosemount 1500XA can have up to eight XA pneumatically actuated valves.

Column module Columns are either capillary or micro-packed.

Thermal conductivity detector (TCD) The Rosemount 1500XA supports a maximum of four TCDs.

Temperature switch Switch for the heating element. The switch turns off its heating element if the
heating element reaches 160 °C (257 °F).

Flame ionization detector (FID) The optional flame ionization detector can be used in place of a TCD to detect
trace levels of compounds.

2.5.3 Sample system
A well designed, properly adjusted sampling system is essential to optimum performance
of any gas chromatograph. If a good sample is not obtained for analysis, the system is
compromised.

The purpose of the sample handling system is to transfer a conditioned fluid sample that is
compatible with gas chromatography requirements.

The sample conditioning system (SCS) is located between the process stream and the
analyzer, and is usually mounted beneath the air-bath oven. It serves these purposes:

• Extracts final sample from the fast loop.

• Performs final filtration.

• Performs stream switching for a multi-stream analyzer.

• Adjusts the final pressure, temperature, and flow on the selected sample flowing to
the sample valve.

The following points should be considered in selecting and installing a sampling system:

• Sample point

• Sample volume and flow rate

• Sample conditioning

• Contamination precautions

• Valving

• Calibration gas
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2.5.4 Equipment specifications 
Table 2-2: Utility specifications 

Type Specification 

Dimensions (without sampling system) H x W x D: 50 x 40 x 24 in. (127 x 102 x 61 cm) 

Weight (without sampling system) Approximately 150 lb (68 kg) 

Mounting Base mount (standard) 
Secure the bottom of the base mount to the ground using the ⅜-in. diameter 
holes.  

Power • 120 Vac ±10 % (type approval) 
• 220 Vac ±10 % (field certification) 
• 50/60 Hz 400 watts running 
• 1100 watts start-up 

Instrument air • 4 SCFM at 40 psig of oil-free instrument air for purge and oven heat 

Valve actuation • 100 - 110 psig for valve actuation 

Environment • -18 to 55 °C (0 to 130 °F) for 1500XA type-approved unit 

• -18 to 55 °C (0 to 130 °F) for TCD and FID 

Area classification options (hardware de- 
pendent) 

Optional certification (type approval only available for FID, TCD, and 
methanator configuration) 
• Class I, Division 2, Groups B, C, and D 

Rosemount 1500XA Gas Chromatograph intrinsically safe backplane
• Class I, Division 2, Groups B, C, and D 
• Associated equipment for: Class I, Division 1, Groups B, C, and D 
• Ex nA [ic IIB + H2 Gc] IIB + H2 Gc 
• Zone 2 AEx nA [ic IIB + H2 Gc] IIB + H2 Gc 

Rosemount 1500XA Gas Chromatograph explosionproof flame 
ionization detector (FID) 
• Class I, Division 1, Groups B, C, and D 
• Ex db IIB + H2 Gb 
• Class I, Zone 1, AEx db IIB + H2 Gb 

Equipment ratings • Pollution degree: 2
• Installation category: II
• Altitude: 2000 m (6562.7 ft.) 
• Humidity: 0-90% relative humidity non-condensing 
• Electrical supply: Mains supply voltage fluctuations are not to exceed

±10% of the nominal supply voltage.



About Rosemount™ 1500XA Gas Chromatographs 

Rosemount™ 1500XA Gas Chromatograph 16 

Electronics hardware 
Use the following table to determine the electronic hardware specifications: 

Table 2-3:  Communications and hardware specifications 

Type Specifications 

Communications (standard) • Analog inputs: 
- Two standard 4-20 mA inputs filtered with transient protection

• Analog outputs: 
- Six isolated outputs, 4–20 mA 

• Serial communication ports: 
- Three termination blocks
- Configurable as RS-232, RS-422, or RS-485 
- One D-sub (9-pin) port for PC connection

• Digital inputs: 
- Five inputs, user assignable
- Optically isolated, rated to 30 Vdc at 0.5 A 

• Digital outputs: 
- Five inputs, user assignable
- Form C and electro-mechanically isolated, 24 Vdc 

Communications (Options) Four expansion slots available for additional communications. Each slot has 
the capacity to add one of the following: 
• Four analog inputs (isolated) card 
• Four analog outputs (isolated) card 
• Eight digital inputs (isolated) card 
• Five digital outputs (isolated) card 
• One RS-232, RS-422, or RS-485 serial connection card 

(up to two maximum) 

Ethernet Two available connections 
• one RJ45 port 
• one four-wire termination – with 10/100 Mbps 
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Oven components 
The following table lists the specifications for the components that are housed in the air 
bath oven. 

Table 2-4: Oven components 

Type Specification 

Valves • 6-port or 10-port valves (8 maximum) 
- Piston-operated diaphragms with pneumatic actuation

• Liquid injection valves (4 maximum) 

Columns Supports packed, micro-packed and capillary columns. 

Solenoid actuation • 24 Vdc 
• 80 - 120 psi 

Wetted parts 316 stainless steel and diaphragm 

Temperature Maximum oven operating temperature of 120 °C (248 °F). 

Software 
The following table lists the specifications for the GC’s software. 

Table 2-5: Software specifications 

Type Specification 

Software Windows™-based MON2020 

Firmware Embedded firmware 

Methods Four timed event tables and four component data tables 

Peak Integration • Fixed time or auto slope and peak identification.
• Update retention time upon calibration or during analysis.
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Corrosion protection 
The following table lists the specifications for corrosion protection. 

 

Table 2-6: Corrosion protection 
 

Type Specification 

Enclosure Material Copper-free and aluminum-coated with industrial grade powder coat suita- 
ble for high humidity and salt-laden environments. 

Process Wetted Materials Stainless steel; if the function of an item excludes the use of stainless steel, 
such as the glass rotameter tubes, materials that are resistant to corrosion 
are used. 

Electronics All electronic circuit boards are tropicalized with a clear conformal coating. 

 
 

Archived data storage capabilities 
The archived data storage capabilities of the Rosemount 1500XA GC are shown in 
Table 2-7. 

 

Table 2-7: Archived Data Storage 
 

Type Maximum number of records 

Analysis results 31,744 (88 days with 4-minute cycle time) 

Final calibration results 370 

Calibration results 100 (per row in Analysis Configuration table) 

Final validation results 370 (per row in Analysis Configuration table) 

Validation results 100 (per row in Analysis Configuration table) 

Analysis chromatograms 3,406 (approximately nine days assuming 4-minute cycle time and single 
entry in analysis) 

Final calibration chromatograms 370 (per row in Analysis Configuration table) 

Final validation chromatograms 370 (per row in Analysis Configuration table) 

Protected chromatograms 100 

Hourly averages 

(up to 256** variables) 

2,400 

Daily averages 

(up to 256** variables) 

365 



Archived Data Storage (continued)Table 2-7:   

Type Maximum number of records

Weekly averages

(up to 256** variables)

58

Monthly averages

(up to 256** variables)

12

Variable averages

(up to 256** variables)

2,360

Every run

(up to 256** variables)

2,360

Alarm logs 1,000

Event logs 1,000

* The GC can store final calibration or final validation chromatograms for up to one year, provided that no more than
one calibration or validation is run per day, and the cycle time is less than 15 minutes. If the cycle time exceeds 15 mi-
nutes, the oldest final calibration or validation chromatograms will be deleted to make room for newer ones.

** A total of 256 averages, including hourly, daily, weekly, monthly, variable, and every run averages are archived.
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3 Getting started

3.1 Site selection
The site selected for the gas chromatograph is important for measurement accuracy.

Install the GC as close as possible to the sample system but allow for adequate access
space for maintenance tasks and adjustments. Allow a minimum of 3 ft (0.9 m) in front of
the GC for operator access.

Ensure that exposure to radio frequency (RF) interference is minimal.

WARNING!

HAZARDOUS AREA EXPLOSION HAZARD
Do not use a PC or a printer in a hazardous area. Serial and Ethernet communications links are
provided to connect the analyzer to the PC and to connect to other computers and printers in a
safe area.

Failure to follow this warning may result in injury or death to personnel

WARNING!

VENTILATION
If you plan to place the GC in a sealed shelter, always vent the GC to atmosphere with ¼-in.
tubing or larger. This will prevent the build up of gases.

Getting started
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3.2 Unpacking the unit
Unpack and inspect the Rosemount™ 1500XA gas chromatograph upon receipt.

Procedure

1. Unpack the equipment.

• Remove the Rosemount 1500XA from the shipping crate.

• Remove the memory stick containing the software, quick start guide, and
manuals.

Note
The MON2020 version number is located on the back of the USB card.

2. Retain the shipping information.

3. Inspect all parts and assemblies for possible shipping damage.

4. If any parts or assemblies appear to have been damaged in shipment, first file a
claim with the carrier.

5. Next, complete a full report describing the nature and extent of the damage and
forward this report immediately to your Emerson Customer Care representative.

6. Include the GC's model number in the report.

Disposition instructions will be provided as soon as possible.

If you have any questions regarding the claim process, contact your Emerson
Customer Care representative for assistance.

Installation and startup should proceed only if all required materials are on hand and
free from obvious defects.

Getting started
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3.3 Necessary tools and components
Observe the following list of tools and components that you will need for installing the
analyzer:

• Chromatographic grade carrier gas: 99.995% pure with less than 5 ppm water and
0.5 ppm hydrocarbons. Possible carriers gases (application dependent) include:

- Helium

- Nitrogen

- Argon

- Hydrogen

• High pressure dual-stage regulator for the carrier gas cylinder, high side up to 3,000
pounds per square in., gauge (psig), low side capable of controlling pressure up to
150 psig.

• Calibration standard gas with correct number of components and concentrations.

• Dual-stage regulator for the calibration gas cylinder, low pressure side capable of
controlling pressure up to 30 psig.

• Sample probe (fixture for procuring the stream, or sample gas for chromatographic
analysis).

• Stainless steel tubing:

- 1/8-in. for connecting calibration standard to analyzer

- 1/8-in. for connecting stream gas to the analyzer

- 1/4-in. for connecting carrier to the analyzer

• Sulfur-inert coated , stainless steel tubing for H2S applications

• Miscellaneous Swagelok tube fittings, tubing benders and tubing cutter.

• 14 AWG (18 MWG) or larger electrical wiring and conduit to provide
115 or 220 volts AC, single phase, 50 to 60 Hertz (Hz), from an appropriate circuit
breaker and power disconnect switch. See guidelines in Section 4.2.1.

• Digital volt-ohm meter with probe-type leads.

• A flow measuring device.

3.4 Optional tools and components

WARNING!

EXPLOSION HAZARD
Do not use a PC in a hazardous area. Electrostatic discharges may cause an explosion.

Serial port and Ethernet are provided to connect the unit to the PC and to connect to other
computers and printers in a safe area.

Failure to follow this warning may result in injury or death to personnel.
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Supporting tools and components include:

• A Windows™-based PC and either a direct or remote communications connection to
interface with the Rosemount 1500XA. See the MON2020 user manual for more
information on specific PC requirements.

• The Rosemount 1500XA has a factory-wired Ethernet port on the backplane. Refer
to Section 4.3.7 for more information.

• Modbus communications are optional

Getting started

22 Rosemount™ 1500XA Gas Chromatograph



4 Installation and startup

This section provides instructions for installing and setting up the Rosemount™ 1500XA.

Note
Because the Rosemount 1500XA is available in different configurations, it is possible that not all of
the instructions in this section apply to your particular GC. In most cases, however, to install and set
up a Rosemount 1500XA, Emerson recommends that you follow the instructions in the same order
as they are presented in this manual.

4.1 Installing a gas chromatograph in hazardous
environments
Follow these precautions if installing or operating the GC in a hazardous area:

Procedure

1. Do not operate a personal computer in a hazardous area. To interface with a GC in a
hazardous area, use a PC that is remotely connected to the GC and that is located in
a nonhazardous area.

2. Ensure that field connections to the analyzer and the GC are appropriately certified
and made through purged conduit or flameproof glands.

WARNING!
Observe all applicable regulations when installing purged GC units.

Failure to observe all regulations when installing purged GC units may result in
noncompliance, equipment damage, or personal injury.

The purged analyzer housing is designed for use in locations where fire and
explosion hazards may exist, specifically areas that are classified by the National Fire
Protection Association (NFPA) as Class I, Division 2, Group B, C, and D. However,
other regulations do apply. Consult the authority having jurisdiction or appropriate
site policies and procedures regarding wiring and installation practices.
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4.2 Gas chromatograph wiring

4.2.1 Installing power source wiring
Follow these precautions when installing power source wiring:

• All wiring, as well as circuit breaker or power disconnect switch locations, must
conform to the CEC or NEC; all local, state, or other jurisdictions; and company
standards and practices.

• Provide single-phase, three-wire power at 115 or 220 Vac, 50-60 Hertz.

NOTICE
If you do not have a single phase, three-wire AC power source, you must purchase an
isolation transformer.

• Locate a power shut-off or disconnect switch in a safe area.

• Provide the GC and any optionally installed devices with one 20-amp circuit breaker
for protection.

CAUTION!
POWER

15 amps is the maximum current for 14 AWG (wire).

• Use multi-stranded copper conductor wire according to the following
recommendations:

- For power feed distances up to 250 ft (76 m), use 14 AWG (American Wire
Gauge) (18 Metric Wire Gauge), stranded.

- For power feed distances 250 to 500 ft (76 to 152 m), use 12 AWG (25 Metric
Wire Gauge), stranded.

- For power feed distances 500 to 1000 ft (152 to 305 m), use 10 AWG (30 Metric
Wire Gauge), stranded.

4.2.2 Signal wiring
Follow these general precautions for field wiring digital and analog input/output (I/O)
lines:

• Metal conduit or cable (according to local code) used for process signal wiring must
be grounded at conduit support points, because intermittent grounding helps
prevent the induction of magnetic loops between the conduit and cable shielding.

• All process signal wiring should be of a single, continuous length between field
devices and the GC. If, however, the length of the conduit runs require that multiple
wiring pulls be made, the individual conductors must be interconnected with
suitable terminal blocks.

• Use suitable lubrication for wire pulls in conduit to prevent wire stress.
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• Use separate conduits for AC voltage and DC voltage circuits.

• Do not place digital or analog I/O lines in the same conduit as AC power circuits.

• Use only shielded cable for digital I/O line connections.

- Ground the shield at only one end.

- Shield-drain wires must not be more than two AWG sizes smaller than the
conductors for the cable.

• When inductive loads (relay coils) are driven by digital output lines, the inductive
transients must be diode-clamped directly at the coil.

• Any auxiliary equipment wired to the GC must have its signal common isolated from
earth/chassis ground.

CAUTION!

SIGNAL INTERFERENCE

Any loop of extra cable left for service purposes inside the GC purged housing must not be
placed near the conduit entry for AC power. This applies to all digital and analog I/O lines
connecting to the GC. If the above precaution is not followed, the data and control signals to
and from the GC can be adversely affected.

4.2.3 Installing electrical and signal line grounds
Follow these general precautions for grounding electrical and signal lines:

• For shielded signal conducting cables, shield-drain wires must not be more than two
AWG sizes smaller than the conductors for the cable. Shielding is grounded at only
one end.

• Metal conduit used for process signal wiring must be grounded at conduit support
points (intermittent grounding of conduit helps prevent induction of magnetic
loops between the conduit and cable shielding).

• A dedicated ground lug is located inside the GC's electronics enclosure on the side
wall and the enclosure door. Chassis ground conductors (color code green) inside
the electronics enclosure should be stranded, insulated copper wire. These device
chassis ground conductors should all be connected to the dedicated ground lug.
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Internal Ground LugsFigure 4-1:   

A. Upper electronics enclosure door - internal ground lug
B. Upper electronics enclosure wall - internal ground lug

• A dedicated ground lug is located on the outside of the GC's electronics enclosure.
This ground point should be connected to a copper ground rod as described in the
next bulleted item.

Installation and startup
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External Ground LugFigure 4-2:   

A. External earth ground

• A single-point ground must be connected to a copper-clad, 10-foot long, 3/4-in.
diameter steel rod, which is buried, full-length, vertically into the soil as close to the
equipment as is practical.

Note
The grounding rod is not furnished.

• Resistance between the copper-clad steel ground rod and the earth ground must
not exceed 25 Ohms.

• The equipment-grounding conductors used between the GC and the copper-clad
steel ground rod must be sized according to your local regulations.
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Length Wire

15 ft. (4.6 m) or less 8 AWG, stranded, insulated copper

15 to 30 ft. (4.6 to 9.1 m) 6 AWG, stranded, insulated copper

30 to 100 ft. (9.1 to 30.5 m) 4 AWG, stranded, insulated copper

• All interior enclosure equipment-grounding conductors must be protected by metal
conduit.

• External equipment that is connected to the GC should be powered via isolation
transformers to minimize the ground loops caused by the internally shared safety
and chassis grounds.

4.2.4 Installing electrical conduit
Follow these general precautions for conduit installation:

• Conduit cutoffs must be cut at a 90-degree angle. Cutoffs must be made by a cold
cutting tool, hacksaw, or by some other approved means that does not deform the
conduit ends or leave sharp edges.

• All conduit fitting-threads, including factory-cut threads, must be coated with a
metal-bearing conducting grease prior to assembly.

• Temporarily cap the ends of all conduit runs immediately after installation to
prevent accumulation of water, dirt, or other contaminants. If necessary, swab out
conduits prior to installing the conductors.

• Install drain fittings at the lowest point in the conduit run; install seals at the point of
entry to the GC to prevent vapor passage and accumulation of moisture.

• Use liquid-tight conduit fittings for conduits exposed to moisture.

When a conduit is installed in hazardous areas, follow these general precautions for
conduit installation:

• All conduit runs must have a fitting, which contains explosion-proof sealing
(potting) located within three inches from the conduit entrance to the explosion-
proof housing. The seal should have a minimum IP rating of IP54 or equivalent
NEMA/Type rating on the conduit sealing devices.

• The conduit installation must be vapor tight, with threaded hub fittings, sealed
conduit joints and gaskets on covers, or other approved vapor-tight conduit fittings.

WARNING!

Observe all precautionary signs posted on the certified explosion-proof equipment. Consult
your company's policies and procedures and other applicable documents to determine wiring
and installation practices that are appropriate for hazardous areas.

Failure to do so may result in serious injury or death to personnel.
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4.2.5 Sample system requirements
Observe the following guidelines for installing GC sample systems:

Line length If possible, avoid long sample lines. In case of a long sample line, flow veloci-
ty can be increased by decreasing downstream pressure and using by-pass
flow via a fast loop.

CAUTION!

Stream switching requires a sample pressure of 20 psig.

Sample line tubing
material

• Use sulfur-inert tubing for H2S streams; for all other applications, use
stainless steel tubing.

• Ensure tubing is clean and free of grease.

Dryers and filters Use small sizes to minimize time lag and prevent back diffusion.
• Install a minimum of one filter to remove solid particles. Most applica-

tions require fine-element filters upstream of the GC. The GC includes a
2-micron filter.

• Use ceramic or porous metallic type filters. Do not use cork or felt filters.

NOTICE

Install the probe/regulator first, immediately followed by the coalesc-
ing filter and then the membrane filter. See Appendix C for a recommen-
ded natural gas installation.

Pressure regulators
and flow controllers

• Use stainless steel wetted materials.
• Parts should be rated for sample pressure and temperature.

Pipe threads and
dressings

Use PTFE tape. Do not use pipe thread compounds or pipe dope.

Valving • Install a block valve downstream of sample takeoff point for mainte-
nance and shutdown.

• The block valve should be a needle valve or cock valve type, of proper
material and packing, and rated for process line pressure.
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4.3 Installing the analyzer

WARNING!

EXPLOSION HAZARD
Do not open the enclosure unless the area is known to be non-hazardous or unless all devices
within the enclosure have been de-energized. Power must not be restored after enclosure has
been opened until enclosure has been purged for 60 minutes at a pressure of 0.3 in. w.c.

Failure to de-energize the analyzer may cause an explosion and severely injure personnel.

4.3.1 Connecting power to the GC
Connect power to the gas chromatograph.

WARNING!

ELECTRIC SHOCK
Do not connect AC power leads without first ensuring that AC power source is switched off.

Failure to observe all safety precautions could result in serious injury or death.

Circuit BreakerFigure 4-3:   

A. Electronics enclosure
B. Circuit breaker

To connect power to the GC, follow these steps:
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Procedure

1. Locate the three leads for connecting power to the GC. The leads are colored as
follows:

GC power wiring Color

Hot Black

Neutral White

Ground Green

2. Connect the leads to the AC power source (i.e., with circuit breaker and power
disconnect switch).

Make power line splices and conduit seals that comply with applicable electrical
code and hazardous area wiring requirements.

WARNING!
ELECTRIC SHOCK
Do not apply power to the GC until all power, interconnection, and external signal
connections have been verified, and proper grounds have been made.

Failure to properly connect the GC unit may result in serious personal injury.

3. If necessary, connect the analyzer's chassis ground to an external copper ground rod
(at remote locations).

See Section 4.2.3 for more information.

4. Close the electronics enclosure door and apply power to the GC.

4.3.2 Connecting the sample and other gas lines
To install GC sample and gas lines, do the following:

Procedure

1. Remove the plug from the 1/16 in. sample vent tubing marked SV1 that is located
on the flow panel assembly.
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Sample Vent and Measure Vent LinesFigure 4-4:   

A. Sample and gas line vents

• If desired, connect the sample vent lines to an external, ambient pressure vent. If
the vent line is terminated in an area exposed to wind, protect the exposed vent
with a metal shield.

• Use 1/4 in. or 3/8 in. tubing for vent lines longer than 10 feet.

At this stage in the installation, the GC measure vent (MV) lines (labeled on the side
of the GC) should remain plugged until the GC has been checked for leaks. For
regular operation, however, the MV lines must be unplugged.

Note
Do not discard the vent line plugs. They are useful when leak-checking the GC and its sample
or gas line connections.

2. Connect the carrier gas to the GC. The carrier gas inlet is labeled Carrier In and is a
1/4 in. T-fitting.

Installation and startup

32 Rosemount™ 1500XA Gas Chromatograph



WARNING!
EXPLOSION HAZARD
Do not turn on sample gas until you have completely checked the carrier lines for leaks.

Failure to follow this warning may result in injury or death to personnel.

• Use stainless steel tubing to convey carrier gas.

• Use a dual-stage regulator with high-side capacity of 3,000 psig and low-side
capacity of 150 psig.

• Carrier gas is fed from two bottles (see Appendix C) for carrier gas plumbing.

3. Connect calibration standard gas to the GC.

When installing the calibration standard gas line, ensure that the correct tubing
connection is made.

• Use 1/8-in. stainless steel tubing to connect calibration standard gas unless the
application requires treated tubing.

• Use a dual-stage regulator with low-side capacity of up to 30 psig.

4. Connect sample gas stream(s) to the GC.

• Use 1/8 in. stainless steel tubing, as appropriate, to connect sample gas.

• Unless stated otherwise in the product documentation, ensure that the pressure
of the calibration and sample line is regulated at 15 psig to 20 psig.

5. After all lines have been installed, proceed with leak-checking the carrier and sample
lines. See Section 4.4.
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4.3.4 Maximum effective distance by communication
protocol type
The table below lists the maximum distance at which the indicated protocol can transmit
data without losing effectiveness. If longer runs are required, the use of a repeater or other
type of extender will be necessary to maintain the protocol's efficiency.

Communication protocol Maximum distance

RS-232 50 ft (15.24 m)

RS-422/RS-485 4,000 ft (1,219.2 m)

Ethernet (CAT5) 300 ft (91.44 m)

4.3.5 RS-485 serial port terminating resistors
To ensure correct communication with all hosts, place a 120-ohm terminating resistor
across the GC serial port terminals on the RS-485 link. On a multi-dropped link, install the
terminating resistor on the last controller link only.

4.3.6 Configuring GC Communications
The Rosemount 1500XA has four serial communications ports: Port 0, Port 1, Port 2, and
Port 3, which is a dedicated PC-to-GC port. The mode for each of the first three ports can
be set to RS-232, RS-422, or RS-485. These port configurations are normally specified by
the customer at the time of order and then set at the factory, but they can be changed at
any time with MON2020.
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RS-232, RS-485 and RS-422 Port ConfigurationsFigure 4-5:   

Optional RS-232 serial ports

It is possible to install an optional RS-232 board in one or both of the expansion I/O slots
provided on the GC’s card cage in the electronics enclosure.

This extra port can be used for Modbus ASCII/RTU communications or to connect directly
to a computer installed with MON2020.
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RS-232 ConnectionsFigure 4-6:   

Terminal Label Definition

1 RX Receive

2 TX Transmit

3 RTS Request to send

4 DTR Data termininal ready

5 GND Ground

To install an optional RS-232 board, do the following:

Procedure

1. Start MON2020 and connect to the GC.

2. Select the Tools → I/O Cards... menu.

3. Identify the appropriate card slot under the Label column and then select
Communications module - RS232 from the appropriate Card Type drop-down list.

4. Click OK.

5. Turn off the GC.

Installation and startup

36 Rosemount™ 1500XA Gas Chromatograph



6. Install the RS-232 board into the appropriate I/O card slot in the GC’s card cage.

7. Close and secure the electronics enclosure door.

8. Apply power to start the GC.

Optional RS-485/RS-422 serial ports

It is possible to install an optional RS-485 board in one or both of the expansion I/O slots
provided on the GC’s card cage in the electronics enclosure. This card can be configured in
RS-422 (4-wire) or RS-485 (2-wire) mode. RS-485 mode is the default setting; to configure
the card for RS-422 mode, see 
Configuring the optional RS-485 serial port to function as an RS-422 serial port. Also see
ROC800-Series Discrete Input Module at ROC 800-Series web site at 
Emerson.com/ROC800-Series

This extra port can be used for Modbus ASCII/RTU communications or to connect directly
to a computer installed with MON2020.

Installing an optional RS-485/RS-422 serial port card

To install an optional RS-485/RS-422 serial port card, do the following:

Procedure

1. Start MON2020 and connect to the GC.

2. Select I/O Cards... from the Tools menu. The I/O Cards window displays.

3. Identify the appropriate card slot under the Label column and then select
Communications module - RS422/485 from the appropriate Card Type drop-down
list.

4. Click OK.

5. Turn off the GC.

6. Install the RS-485/RS-422 serial port card into the appropriate expansion slot in the
GC’s card cage.

7. Close the electronics enclosure door.

8. Start the GC.

Configuring the optional RS-485 serial port to function as an RS-422 serial port

See Figure 4-7 and Table 4-1 for the correct jumper settings to configure the optional
RS-485 serial port to function as an RS-422 serial port:
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RS-485/RS-422 Jumper Settings on Serial BoardFigure 4-7:   

A. J3 (RS-485 2-wire) (RS-422 4-wire)
B. J4 (Termination OUT, IN)
C. J5 (RS-485 2-wire) (RS-422 4-wire)
D. J6 (Termination OUT, IN)

Configuring the Serial Connections for RS-485/RS-422 Serial
Communications
Table 4-1:   

Jumpers RS-485 (half duplex/2-wire) RS-422 (full duplex/4-wire)

J3 Half Full

J5 Half Full

Termination IN Termination OUT

J4 In Out

J6 In Out

TB1 Wire Terminals

RS-485 (Half Duplex/2-Wire) RS-422 (Full Duplex/4-Wire)

A RxTx+ Rx+

B RxTx- Rx-

Y NC Tx+

Z NC Tx-
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4.3.7 Connecting directly to a PC using the GC’s Ethernet1
port
The GC’s DHCP server feature and its Ethernet1 port on the backplane at J22 allows you to
connect directly to the GC. This is a useful feature for GCs that are not connected to a local
area network; all that is needed is a PC, typically a notebook computer, and a CAT5
Ethernet cable.

Note
The PC must have an Ethernet network interface card (NIC) that supports the automatic medium-
dependent interface crossover (Auto-MDIX) technology and either an Ethernet cable of at least CAT5
or an Ethernet Crossover Cable of at least CAT5.

Note
The backplane has two switches located at SW1. The first switch is used for starting the DHCP server.
See Section 4.3.8 for more information. The second switch is reserved for future use.

Note
The GC can be connected (or remain connected) to the local network on Ethernet2 (TB11) on the
backplane while the DHCP feature on Ethernete1 is being used.

The backplane has two Ethernet ports:

Ethernet Connections on the BackplaneTable 4-2:   

Name Location Connector Type

ETHERNET1 J22 RJ45 (DHCP-enabled)

ETHERNET2 TB11 4-wire terminal block

Ethernet Ports on the BackplaneFigure 4-8:   

A. Ethernet1 (RJ45) port
B. Ethernet2 (4-wire) port
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Procedure

1. Plug one end of the Ethernet cable into the PC’s Ethernet port and the other end into
the GC’s RJ45 socket on J22 on the backplane.

2. Locate switch at SW1, directly between Ethernet1 and Ethernet2 ports on the
backplane. Place SW1 in the ON position. This starts the GC’s DHCP server feature.
The server typically takes approximately 20 seconds to initialize and start up.

SW1 Switch on the BackplaneFigure 4-9:   

A. Backplane SW1

Note
The GC can be connected (or remain connected) to the local network on Ethernet2 (TB11) on
the backplane while the DHCP feature on Ethernet1 is being used.

3. Wait for 20 seconds and then do the following to ensure that the server has
provided an IP address to the PC:

a. From the PC, go to Start → Control Panel → Network Connections....

b. The Network Connections window lists all dial-up and LAN / high-speed Internet
connections installed on the PC. In the list of LAN / high speed Internet
connections, find the icon that corresponds to the PC-to-GC connection and
check the status that displays beneath the Local Area Connection. It
should show the status as Connected. The PC is now capable of connecting to
the GC. See Using MON2020 to connect to the GC.
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c. If the status is Disconnected, it may be that the PC is not configured to accept
IP addresses; therefore, do the following:

4. Right-click the Properties icon. The Local Area Connection Properties window
displays.

5. Scroll to the bottom of the Connection list box and select Internet Protocol (TCP/
IP).

6. To configure the PC to accept IP addresses issued from the GC, select the Obtain an
IP address automatically and Obtain DNS server address automatically check boxes.

7. Click OK to save the changes and to close the Internet Protocol (TCP/IP) Properties
window.

8. Click OK to close the Local Area Connection Properties window.

9. Return to the Network Connections window and confirm that the appropriate icon’s
status reads Connected. If the icon still reads Disconnected refer to 
Section 5.6.4.

NOTICE
If you power cycle the GC, then you will lose connectivity. After the GC initializes
completely, refer to Section 5.6.4 to learn how to repair the connection.

10. Click Properties. The Internet Protocol (TCP/IP) Properties window displays.

Using MON2020 to connect to the GC

To connect to the GC using the RJ45 Ethernet1 connection, do the following:

Procedure

1. Start MON2020. After starting, the Connect to GC window displays.

2. Locate the default Direct-DHCP under the GC Name column. This GC directory is
created automatically when MON2020 is installed. The GC can be renamed, but the
IP address that it references, 192.168.135.100, should not be changed.

3. Click the associated Ethernet button. MON2020 prompts you to enter a user name
and password, after which you will be connected to the GC.

4.3.8 Connecting directly to a PC using the GC’s wired
Ethernet2 terminal
Connecting to a PC from the GC's wired Ethernet terminal.

The Rosemount 1500XA has a wired Ethernet2 terminal at TB11 on the backplane that you
can connect to with a static IP address. All that is needed is a PC, typically a notebook
computer, and a 2-wire, twisted pair, CAT5 Ethernet cable with one of its plugs removed to
expose the wires.
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Crimped CAT5 CableFigure 4-10:   

Note
The GC can be connected (or remain connected) to the local network on Ethernet2 (TB11) on the
backplane while the DHCP feature is being used.

Wired Ethernet2 Terminal Block on the BackplaneFigure 4-11:   

A. TB11 four-wire Ethernet2 connector
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Use the following schematics as a guide to wiring the GC via its four wire connector at
TB11. Figure 4-12 shows the traditional wiring scheme. Figure 4-13 shows how to wire a
CAT5 cable without the RJ45 plug.

Field Wiring to TB11Figure 4-12:   

CAT5 Wiring to TB11Figure 4-13:   

Once you have wired the cable to the Ethernet terminal, plug the other end into a PC or a
wall jack. See Section 4.3.10 to continue configuring the GC.

4.3.9 Connecting directly to a PC using the GC’s serial port
Connecting to a PC from the GC's serial port.

The GC’s serial port at J23 on the backplane allows a PC with the same type of port to
connect directly to the GC. This is a useful feature for a GC that is located in an area
without Internet access; all that is needed is a PC running Microsoft® Windows™, a
notebook computer, and a straight-through serial cable.
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J23 Serial Port on the BackplaneFigure 4-14:   

A. Backplane RS-232 serial port

To set up the PC for the direct connection, do the following:

Procedure

1. Do the following to install the communications cable between two computers:

a. Navigate to Start → Control Panel and select the Phones and Modem Options
icon.

The Phones and Modem Options dialog displays.

b. Select the Modem tab and click Add….

The Add Hardware Wizard displays.

c. Select the Don’t detect my modem; I will select it from a list check box and then
click Next.

d. Click Have Disk.

The Install from Disk dialog appears.

e. Click Browse.

Installation and startup

44 Rosemount™ 1500XA Gas Chromatograph



The Browse dialog displays.

f. Navigate to the MON2020 install directory (typically C:\Program Files
(x86)\Emerson Process Management\MON2020) and select Emerson Direct 
Connection.inf.

g. Click Open.

You will be returned to the Install from Disk dialog.

h. Click OK.

You will be returned to the Add Hardware Wizard.

i. Click Next.

j. Select an available serial port and click Next.

The Hardware Installation dialog displays.

k. Click Continue Anyway.

After the driver is installed, you will be returned to the Add Hardware Wizard.

l. Click Finish.

You will be returned to the Phones and Modems dialog. The Emerson Direct 

Connect modem should be listed in the Modem column.

2. Start MON2020 and do the following to create a GC connection for the Emerson 
Direct Connection modem:

a. Select GC Directory from the File menu.

The GC Directory window displays.

b. Select Add from the GC Directory window’s File menu.

A New GC row will be added to the bottom of the table.

c. Select the New GC text and type a new name for the GC connection.

d. Select the new GC’s Direct check box.

e. Click the Direct button located at the bottom of the GC Directory window.

The Direct Connection Properties window displays.

f. Select Communications cable between two computers (COM n) from the Port drop-down 
list.

Note
The letter n stands for the COM port number.

g. Select 57600 from the Baud Rate drop-down list.
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h. Click OK to save the settings.

You will be returned to the GC Directory window.

i. Click OK to save the new GC connection and to close the GC Directory window.

3. Connect one end of the direct connect cable to the GC’s serial port at J23 on the
backplane.

4. Connect the other end of the direct connect cable to the PC’s corresponding serial
port.

5. Select Connect… from the Chromatograph menu.

The Connect to GC window displays.

6. Click Direct to connect to the GC using the serial cable connection.
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4.3.10 Assigning a static IP address to the GC
To configure the GC with a static IP address, do the following:

Procedure

1. Start MON2020 and log on to GC using a direct Ethernet connection. For more
information, refer to Section 4.3.7.

2. Select Application → Ethernet ports....

The Ethernet Ports window displays.

3. Depending upon the Ethernet port to which you want to assign a static IP address,
do the following:

a. The Ethernet port at TB11: Enter the appropriate values in the Ethernet2 IP
Address, the Ethernet 2 Subnet, and the Default Gateway fields.

b. The RJ45 Ethernet port at J22: Enter the appropriate values in the Ethernet1 IP
Address, the Ethernet1 Subnet, and the Default Gateway fields.

Note
IP, Subnet, and Gateway addresses can usually be obtained from a member of your IT
staff.

Important
To configure a Ethernet IP address using the LOI, refer to Figure B-44 .

4. Click OK.

5. Log off the GC.

6. Access the backplane, which is located in the GC’s upper enclosure.
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Port Locations on the BackplaneFigure 4-15:   

A. J22 Ethernet 1
B. Switch SW1
C. TB11 Ethernet2

7. If you are setting up a static IP address for the Ethernet1 port at J22, and you also
intend to connect to your company’s local area network, do the following:

a. Locate the switch, at SW1 on the backplane.

SW1 is located between the Ethernet port at J22 and TB11, four-wire connector.
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SW1 on the BackplaneFigure 4-16:   

A. Switch SW1 on the backplane

b. Use a Phoenix screwdriver and move the dip switch to the OFF position.

This disables the DHCP server.

8. To connect to the GC, do the following:

a. Start MON2020 and select File → GC Directory....

The GC Directory window displays.

b. Select Add, and a new GC profile will be added to the end of table.

Note
You can name the GC’s profile as well as add a short description.

c. Select the new profile and click Ethernet... Enter the GC’s static IP address in the
IP address field.

d. Click OK.
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The Ethernet Connection Properties for New GC window closes.

9. Click Save to save the new profile.

10. Click OK to close the GC Directory window.

11.
Select Chromatograph → Connect... to connect to the GC or click .

The Connect to GC window displays. The newly created GC profile should be listed in
the table.

12. Locate the new GC profile and click the Ethernet button that is associated with it.

The Login window displays.

13. Enter a User Name and User Pin and click OK.

4.3.11 Wiring the discrete digital inputs and outputs
The GC’s backplane has five discrete outputs and five discrete inputs.

If more than five digital outputs are required, see Typical field wiring of a ROC800 DO module
to add the ROC800 Digital Output Module.

Wiring the discrete digital inputs

DANGER!

ELECTRIC SHOCK

The equipment operates using mains voltage that is dangerous to life. Make sure that the
circuit breakers are set to OFF, and tagged-off, before opening the electronics enclosure.

Failure to observe this precaution will cause serious personal injury or death.

WARNING!

EXPLOSION HAZARD
Do not open the enclosure unless the area is known to be non-hazardous or unless all devices
within the enclosure have been de-energized. Power must not be restored after enclosure has
been opened until enclosure has been purged for 60 minutes at a pressure of 0.3 in. w.c.

Failure to de-energize the analyzer may cause an explosion and severely injure personnel.

To connect digital signal input lines to the GC, See Appendix G drawing 9R00004, Sheet 2
and do the following:
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Procedure

1. Disconnect power to the analyzer and allow the components to cool for at least five
minutes.

2. Open the electronics enclosure door and access the backplane.

3. Make the digital input wiring connections on the backplane at TB7.

Digital inputs - TB7 on the BackplaneFigure 4-17:   

A. TB7 connector

Note
The discrete digital input terminals on the backplane are self-powered. Devices connected to
the digital input will be powered by the GC's dedicated isolated 24 V power supply.

Note
The discrete digital input terminals are optically isolated from the GC's other circuitry.

Installation and startup

Operations Manual 51



4. Route digital I/O lines away from the sensitive detector lines (on the left side of the
backplane) and away from the analog inputs and outputs.

There are connections for five digital inputs on the backplane at TB7, as indicated in
the following table.

Discrete Digital Inputs TB7Table 4-3:   

TB7 Function

Pin 1 DI1

Pin 2 DI-RTN

Pin 3 DI2

Pin 4 DI-RTN

Pin 5 DI3

Pin 6 DI-RTN

Pin 7 DI4

Pin 8 DI-RTN

Pin 9 F_DIG_IN5

Pin 10 DI5

Wiring the discrete digital outputs

The discrete outputs are located on TB3, which is a 15-pin connector, and have five Form-C
relays on the back plane. All contact outputs have a rating of 1A at 30 Vdc. Refer to
drawing P/N 9R00004 in Section G.1.
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Digital outputs - TB3 on the BackplaneFigure 4-18:   

A. TB3 Discrete digital output termination block

Table 4-4 lists the discrete digital output function for each pin on the TB3 connector.

Discrete Digital Outputs - TB3Table 4-4:   

TB3 Function

Pin 1 NC1

DIG_OUT NC1

Pin 2 ARM1

DIG_OUT ARM1

Pin 3 NO1

DIG_OUT NO1

Pin 4 NC2

DIG_OUT NC2
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Discrete Digital Outputs - TB3 (continued)Table 4-4:   

TB3 Function

Pin 5 ARM 2

DIG_OUT ARM2

Pin 6 NO2

DIG_OUT NO2

Pin 7 NC3

DIG_OUT NC3

Pin 8 ARM3

DIG_OUT ARM3

Pin 9 NO3

DIG_OUT NO3

Pin 10 NC4

DIG_OUT NC4

Pin 11 ARM4

DIG_OUT ARM4

Pin 12 NO4

DIG_OUT NO4

Pin 13 NC5

DIG_OUT NC5

Pin 14 ARM5

DIG_OUT ARM5

Pin 15 NO5

DIG_OUT NO5

Note
Form-C relays are single-pole double-throw (SPDT) relays that have three positions: normally closed
(NC); an intermediate position, also called the make-before-break position (ARM); and normally open
(NO).

4.3.12 Wiring the analog inputs
All Rosemount 1500XAs have at least two analog inputs. An additional four analog inputs
are available with a ROC800 AI-16 card (see Typical field wiring of a ROC800 DO module) that
can be installed into one of the optional slots in the card cage.

Analog inputs on the backplane

There are two analog input connections on the backplane at TB10.
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Analog inputs - TB10 on the BackplaneFigure 4-19:   

A. TB10

Analog Inputs TB10Table 4-5:   

TB10 Function

Pin 1 +AI_1

Pin 2 -AI_1

Pin 3 +AI_2

Pin 4 -AI_2

Analog inputs settings

Figure 4-20 shows how to wire two analog inputs (TB10).

These analog inputs are set to accept a current (4-20 mA) source.
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Customer Wiring for Analog InputsFigure 4-20:   
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Selecting the input type for an analog input

An analog input can be set to either voltage (0-10 V) or current (4-20 mA) accessed from
the MON2020 Hardware|Analog Inputs menu.

Procedure

1. Start MON2020 and connect to the GC.

2. Select Hardware → Analog Inputs.... The Analog Inputs window displays.

3. Click Save to save the changes and keep the window open, or click OK to save the
changes and close the window.

Typical wiring for line-powered transmitters

The following drawing shows the most common wiring plan for supplying power to two
4-20 mA transmitters, such as pressure sensor transmitters.

Typical Wiring for Line-Powered TransmittersFigure 4-21:   
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4.3.13 Analog output wiring
The Rosemount 1500XA has at least six analog outputs. An additional four analog inputs
are available with an ROC800 AO card that can be installed into one of the optional slots in
the card cage.

Analog outputs on the backplane

There are six analog output connections on the backplane at TB4 and TB30.
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Analog Outputs TB4 and TB30Figure 4-22:   

A. TB4
B. TB30
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Analog Outputs - Backplane TB4 24 V External PowerTable 4-6:   

TB4 Function

Pin1 EXT_PWR_1

Pin2 4-20mA_1+

Pin3 GND

Pin4 EXT_PWR_2

Pin5 4-20mA_2+

Pin6 GND

Pin7 EXT_PWR_3

Pin8 4-20mA_3+

Pin9 GND

Analog Outputs - Backplane TB30 24 V External PowerTable 4-7:   

TB30 Function

Pin1 EXT_PWR_4

Pin2 4-20mA_4+

Pin3 GND

Pin4 EXT_PWR_5

Pin5 4-20mA_5+

Pin6 GND

Pin7 EXT_PWR_6

Pin8 4-20mA_6+

Pin9 GND

Factory settings for analog outputs

This drawing shows how to wire up to six devices to the analog outputs that are located on
the backplane.
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Wiring for Six Analog Outputs (Powered Internally)Figure 4-23:   

Wiring for customer externally-powered analog outputs

It is possible to furnish power to each analog output while maintaining isolation between
channels.

Consult the following diagrams before wiring a customer-powered device:

Procedure

1. Use this drawing to provide power wiring to each analog output while maintaining
isolation between channels.
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TB4 Wiring for Customer-Powered Analog OutputsFigure 4-24:   

2. Figure 4-24 shows the settings for the analog outputs connections, located on the
backplane, that are necessary to provide power to each analog output while
maintaining isolation between channels.

Refer to Table 4-8 and Table 4-9 for External 24 V loop power.

Analog Outputs - Backplane TB4 24 V External PowerTable 4-8:   

TB4 Function

Pin1 EXT_PWR_1

Pin2 4-20mA_1+

Pin3 GND

Pin4 EXT_PWR_2

Pin5 4-20mA_2+

Pin6 GND

Pin7 EXT_PWR_3

Pin8 4-20mA_3+

Pin9 GND
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Analog Outputs - Backplane TB30 24 V External PowerTable 4-9:   

TB30 Function

Pin1 EXT_PWR_4

Pin2 4-20mA_4+

Pin3 GND

Pin4 EXT_PWR_5

Pin5 4-20mA_5+

Pin6 GND

Pin7 EXT_PWR_6

Pin8 4-20mA_6+

Pin9 GND

4.3.14 Optional digital and analog inputs and outputs

Optional discrete digital inputs

When plugged into one of the optional card slots in the card cage, the Emerson ROC800 DI
card provides eight additional discrete digital inputs. The discrete digital inputs can
monitor the status of relays, open-collector or open-drain type solid-state switches, and
other two-state devices. For more information, see ROC800-Series Discrete Input Module at
Emerson’s ROC 800-Series web site at Emerson.com/ROC800-Series
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Optional Digital I/O ModulesFigure 4-25:   

Typical field wiring of a ROC800 DI module

To connect the ROC800 DI module to a field device, do the following:

Procedure

1. Expose the end of the wire to a maximum length of ¼ in. (6.3 mm).

Note
Twisted-pair cables are recommended for I/O signal wiring. The module’s terminal blocks
accept wire sizes between 12 and 22 AWG. Allow some slack when making connections to
prevent strain.

CAUTION!
ELECTRICAL HAZARD

Allow only a minimum exposure of bare wires to prevent short circuits.

Failure to do so may cause a short circuit and damage equipment.

2. Insert the exposed end into the clamp beneath the termination screw.

3. Tighten the screw.
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Typical WiringFigure 4-26:   

ROC800 Discrete digital wiringTable 4-10:   

Terminal Label Definition

1 1 CH 1 Positive

2 2 CH 2 Positive

3 3 CH 3 Positive

4 4 CH 4 Positive

5 5 CH 5 Positive

6 6 CH 6 Positive

7 7 CH 7 Positive

8 8 CH 8 Positive

9 COM Common

10 COM Common
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Typical field wiring of a ROC800 DO module

ROC800 Discrete Digital Output WiringFigure 4-27:   

CONTROL

DO

1+

2+

3+

4+

5+

COM

COM

COM

COM

COM

5 CHAN

DISCRETE DEVICE 

EXTERNALLY POWERED

Terminal Label Definition

1 1+ Positive discrete output

2 COM Discrete output return

3 2+ Positive discrete output

4 COM Discrete output return

5 3+ Positive discrete output

6 COM Discrete output return

7 4+ Positive discrete output

8 COM Discrete output return

9 5+ Positive discrete output

10 COM Discrete output return

To connect the ROC800 DO module to a field device, do the following:

Procedure

1. Expose the end of the wire to a maximum length of ¼ in. (6.3 mm).
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Note
Twisted-pair cables are recommended for I/O signal wiring. The module’s terminal blocks
accept wire sizes between 12 and 22 AWG. Allow some slack when making connections to
prevent strain.

CAUTION!
ELECTRICAL HAZARD

Allow only a minimum exposure of bare wires to prevent short circuits.

Failure to do so may cause a short circuit and damage equipment .

2. Insert the exposed end into the clamp beneath the termination screw.

3. Tighten the screw.

Optional analog inputs

When plugged into one of the optional card slots on the card cage, the ROC800 AI-16 card
provides four additional analog inputs. The AI channels are scalable, but are typically used
to measure either a 4-20 mA analog signal or a 1-5 V dc signal. If required, the low end of
the AI module’s analog signal can be calibrated to zero. For more information, see Analog
Input Modules (ROC800-Series) at Emerson’s ROC 800-Series website.
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Optional Analog Expansion Card SlotsFigure 4-28:   

A. Optional I/O expansion card slots

Typical field wiring of a ROC800 AI-16 module

CAUTION!

ELECTROSTATIC DISCHARGE (ESD) HAZARD

Operators and technicians must wear an electrostatic wrist strap when handling printed circuit
cards to prevent shorting the boards through static electricity.
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Typical ROC800 WiringFigure 4-29:   

To connect the ROC800 AI-16 module to a device, do the following:

Procedure

1. Expose the end of the wire to a maximum length of ¼ in. (6.3 mm).

Note
Twisted-pair cables are recommended for I/O signal wiring. The module’s terminal blocks
accept wire sizes between 12 and 22 AWG. Allow some slack when making connections to
prevent strain.

CAUTION!
ELECTRICAL HAZARD

Allow only a minimum exposure of bare wires to prevent short circuits.

Failure to do so may cause a short circuit and damage equipment.

2. Insert the exposed end into the clamp beneath the termination screw.

3. Tighten the screw.

There are two dip switches on the terminal block side of the module that can be
used to set a 250 Ω resistor in or out of circuit for each analog input.

To put an analog input’s resistor in circuit, flip the appropriate dip switch to I; to put
an analog input’s resistor out of circuit, flip the appropriate dip switch to V.
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Calibrating a ROC800 AI-16 module

To calibrate the ROC800 AI-16 module you must have a PC with the ROCLINK™ 800
Configuration software installed and open.

See Emerson’s ROC 800-Series for details, downloads and manuals.

Procedure

1. Select the Configure → I/O → RTD Points → Calibration tab.

2. Select an analog input.

3. Click Update to request one value update from the input.

4. Click Freeze to stop the values of the input from being updated during calibration.

Note
If you are calibrating a temperature input, disconnect the RTD sensor and connect a decade
box or comparable equipment to the RTD terminals of the ROC card.

5. Click Calibrate.

6. Enter a value for Set Zero after stabilization.

7. Enter a value for Set Span after stabilization.

8. Enter values for up to three Midpoints one at a time or click Done if you are not
configuring midpoints.

9. Click OK to close the main calibration window and unfreeze the associated inputs.
To calibrate the inputs for another analog input, return to Step 1.

Optional analog outputs

When plugged into one of the optional card slots on the card cage, the ROC800 AO card
provides four additional analog outputs. Each channel provides a 4 to 20 mA current signal
for controlling analog current loop devices. For more information, see 
Emerson’s ROC 800-Series at Emerson Process Management’s ROC 800-Series website.

Typical field wiring of a ROC800 AO module

Procedure

1. Expose the end of the wire to a maximum length of ¼ in. (6.3 mm).

Note
Twisted-pair cables are recommended for I/O signal wiring. The module’s terminal blocks
accept wire sizes between 12 and 22 AWG. A minimum of bare wire should be exposed to
prevent short circuits. Allow some slack when making connections to prevent strain.

2. Insert the exposed end into the clamp beneath the termination screw.

3. Tighten the screw.

4. Close the electronics enclosure door and apply power to the GC.
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5. Run MON2020 and connect to the GC.

4.4 Leak checking and purging for first calibration

CAUTION!

EQUIPMENT DAMAGE

Make sure all tubing is clean and dry internally. Prior to installation, blow the tubing free of
internal moisture, dust, or other contaminants.

Failure to clean and dry the tubing may compromise the integrity of the analyzer/or warranty.

Verify that all electrical connections are correct and safe and then turn the unit on.

4.4.1 Checking the GC for leaks
Leak checking carrier and calibration gas lines requires power and a PC connected to the
GC.

Note
Refer to the analyzer's drawing documentation package that shipped with the GC for leak checking
and identifying vents.

The GC and fittings were factory tested for leaks prior to shipment.

To perform a leak check, do the following:

Procedure

1. Plug the measure vent (labeled MV) vent line if it is open.

Leave the SV or sample vent line open or unplugged).

2. Slowly pressurize each line in turn; then block-in the line, making sure the pressure
holds.

For example, the carrier gas line should be slowly brought up to 110 psig (± 2%) with
the dual-stage regulator at the carrier gas cylinder.

3. After two minutes, shut the carrier gas bottle valve and observe the high side
regulator gauge on the carrier gas bottle.

a. The gauge should not bleed down more than 115 psig in ten minutes.

b. If helium is lost at a faster rate, leaks are usually found between the carrier gas
bottle and the analyzer. Check and tighten all connections, as well as the dual-
stage regulator.

4. When the leak check is complete, reopen the helium bottle valve. Remove the plug
from the MV line.

5. Shut the metering valve below the rotameter on the front of the flow panel.
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The metering valve is left shut for now, but will be reopened later during initial
purging and the analyzer's first calibration.

6. Repeat the procedure with sample gas and stream gas.

Note
Do not use a liquid leak detector such as Snoop® on the valves or components in the oven.

Note
Refer to the Flow Configuration schematic in the documentation packet that shipped with the 
GC for detailed instructions to plug the FID vents.

4.4.2 Purging carrier gas lines
Use this procedure to purge the carrier gas lines.

Purging carrier and calibration gas lines requires power and a PC connected to the GC.

To purge the carrier gas lines, do the following:

Procedure

1. Ensure that the vent line plugs have been removed, and the vent lines are open.

2. Ensure that the carrier gas bottle valve is open.

3. Set the GC side of the carrier gas to 115 psig.

4. Turn on the GC and the PC.

5. Start MON2020 and connect to the GC.

NOTICE
Consult the MON2020 Software for Gas Chromatograph manual for information about
connecting to a GC.

6. Select the Hardware → Heaters... menu. The Heaters window displays.
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Heaters WindowFigure 4-30:   

7. Allow the GC system temperature to stabilize and the carrier gas lines to become
fully purged with carrier gas, which usually takes at least an hour.

The temperature values for the heaters should indicate that the unit is warming up.

The Status column displays OK.

8. Select Control → Auto Sequence....

For more information about this function, refer to the MON2020 Software for Gas
Chromatographs manual.

Note
Step 6 through Step 8 may be performed using the LOI.

Important
A continuous operation without sample gas for a period of four to eight hours (or overnight) is
recommended, during which no changes should be made to the settings described in Step 1
through 7.

4.4.3 Purging calibration gas lines
Use this procedure to purge the calibration gas lines.

Purging carrier and calibration gas lines requires power and a PC connected to the GC.

To purge the calibration gas lines, do the following:

Procedure

1. Ensure that the carrier gas lines have been fully purged and that the sample vent
plugs have been removed.

2. Close the calibration gas bottle valve.
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3. Fully open the block valve associated with the calibration gas feed. Refer to the
MON2020 Software for Gas Chromatographs manual for instructions on selecting
streams.

4. Open the calibration gas bottle valve.

5. Increase the outlet pressure to 15 psig, plus or minus 5 percent, at the calibration
gas bottle regulator.

6. Close the calibration gas bottle valve.

7. Let both gauges on the calibration gas bottle valve bleed down to 0 psig.

8. Repeat Step 4 through Step 7, five times.

9. Open the calibration gas bottle valve.

Note
This applies to vapor calibration standard.

WARNING!
Observe all safety precautions defined in the calibration gas Safety Data Sheet (SDS).,
especially for hazardous locations.

Failure to follow the safety instructions may cause injury to personnel.

4.5 System startup
Use this procedure to perform a system startup.

1. For system startup, run a Single-Stream analysis of the calibration gas.

a. Verify the calibration stream is set to Auto.

a. Use MON2020 to run a single stream analysis on the calibration stream. Once
proper operation of the GC is verified, halt the analysis by selecting Control →
Halt....

Note
Example - use the MON2020 → Control → Single Stream → Calibrate menu path and select
the associated analysis stream.

Unless stated otherwise in the product documentation, ensure that the pressure of the
calibration and sample line is regulated at 10 to 30 psig (15 psig is recommended).

b. Validate calibration gas and retention times and run a manual calibration.

c. Use MON2020 → Application → Component Data... menu path and select the
associated stream. Check the Component Data table for calibration gas
validation information and retention times.

d. Use MON2020 → Control → Calibration... menu path and select the analysis
stream to run a manual calibration. Select the Purge stream for 60 seconds checkbox
and Normal calibration type radio button; then click OK.
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Refer to the MON2020 Software for Gas Chromatographs manual for more
information.

2. Select Control → Auto Sequence... to start auto sequencing of the line gas stream(s).

Refer to the MON2020 Software for Gas Chromatographs manual for more
information.

The GC will begin the auto sequence analysis.

4.5.1 FID configuration
When connected to the GC via MON2020, select Hardware → Detectors menu to access
the Detectors dialog. Refer to the MON2020 Software User Manual for additional
configuration details.

MON2020 - Detectors WindowFigure 4-31:   

Halt the analysis: Control → Halt (F3).

Configure the following fields from the Detectors dialog:

• FID Ignition - Manual or Automatic
• Ignition Attempts

• Wait Time Bet (between) Tries

• Igniter On duration

• Flame On Sense Temp

• Flame Out Sense Temp

• Electrometer Voltage
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Note
If the FID does not appear in the Detectors window your GC may not be fitted with an FID.
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5 Maintaining and troubleshooting the
gas chromatograph

5.1 Maintenance and repairs in hazardous
environments

DANGER!

SAFETY PRECAUTIONS

Observe all precautionary signs posted on the Rosemount™ 1500XA. Failure to do so can result
in injury or death to personnel.

Observe and follow all safety precautions and warnings before performing maintenance or
equipment repairs.

The Rosemount 1500XA enclosure is rated for a general purpose area and is certified by
CSA for Class I Division 2 Groups B, C, and D locations with a Type Z purge controller.

WARNING!

EXPLOSION HAZARD
Do not open the enclosure unless the area is known to be non-hazardous or unless all devices
within the enclosure have been de-energized. Power must not be restored after enclosure has
been opened until enclosure has been purged for 60 minutes at a pressure of 0.3 in. w.c.

Failure to de-energize the analyzer may cause an explosion and severely injure personnel.

Before opening the GC, reduce the risk of igniting hazardous atmospheres by
disconnecting the equipment from all power sources. Keep the assembly closed tightly
when in operation to reduce the risk of igniting hazardous atmospheres.

Incoming inlet wiring must meet local standards (i.e. in conduit with seal fitting within 18
in. or via cable glands). Seal all unused entries with blanks.

Please direct all health, safety, and certification related questions to your Emerson
Customer Care representative.
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5.2 Troubleshooting and repair concept
The most efficient method for maintaining and repairing the Rosemount 1500XA is a
component-replacement concept that allows you to return the system to operation as
quickly as possible. Sources of trouble, such as printed-circuit assemblies, valves, etc., are
identified during troubleshooting test procedures and should be replaced with units in
known good working order.

5.3 Routine maintenance
The Rosemount 1500XA will perform accurately for long periods with very little attention
(except for maintaining the carrier gas cylinders). A bi-monthly record of certain
parameters will greatly assist in assuring that the Rosemount 1500XA is operating to
specifications. The maintenance checklist should be filled out bi-monthly, dated, and kept
on file for access by maintenance technicians as necessary. This gives a historical record of
the operation of the Rosemount 1500XA, enables a maintenance technician to schedule
replacement of gas cylinders at a convenient time, and allows quick troubleshooting and
repair when necessary.

A diagnostic file, which contains calibration and analysis chromatograms, alarm and event
logs, analysis reports, and the complete configuration file, should also be made and filed
with the checklist, furnishing a positive dated record of the Rosemount 1500XA. The
chromatograms and reports can also be compared to the chromatograms and reports run
during the troubleshooting process.

Before contacting Customer Care, connect to your GC and save the diagnostics data file.
From the MON2020 → Tools → Save Diagnostic Data... menu, save the diagnostic data file.

MON2020 prompts you to send an email to Customer Care (at gc.csc@emerson.com) with
the diagnostic data file.

5.3.1 Maintenance checklist
Print the sample maintenance checklist on the following page as necessary for your files. If
you have a problem, please complete the checklist first and have the results available, as
well as the sales order number, when calling your Emerson Customer Care representative
for technical assistance. The sales order number can be found on the nameplate located on
the front of the Rosemount 1500XA. The chromatograms and reports archived when your
GC left the factory are filed by this number.

Note
To find the default measurements for the parameters on the checklist, use MON2020 to view the
GC’s Parameter List.
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5.3.2 Routine maintenance procedures
At least bi-monthly, create and save a diagnostic data file and check carrier and calibration
gas supplies.

Diagnostic data file

The diagnostic data file is a small data file that contains the last chromatogram from each
stream, the final calibration chromatogram, calibration reports, validation reports,
protected chromatograms, the maintenance log, and the event log. To create the
diagnostic data file in MON2020, go to Tools → Save Diagnostic Data... and save the file to
your computer.

5.3.3 Service programs
Rosemount Lifecycle Services offers maintenance service programs that are tailored to fit
specific requirements. Contracts for service and repair can be arranged by contacting
Lifecycle Services at the address or telephone number on the back of this manual or
visiting the website at: Lifecycle Services

5.4 Access to GC components
Review Section 2.5 to familiarize yourself with the locations and placement of the GC’s core
components.

5.5 Precautions for handling PC assemblies
Printed circuit assemblies contain CMOS integrated circuits, which can be damaged if the
assemblies are not properly handled.

CAUTION!

ELECTROSTATIC DISCHARGE (ESD) HAZARD

Operators and technicians must wear an electrostatic wrist strap when handling printed circuit
cards to prevent shorting the boards through static electricity.

The following precautions must be observed when working with the assemblies:

• Do not install or remove the printed circuit assemblies while power is applied to the
units.

• Keep electrical components and assemblies in their protective (conductive) carriers
or wrapping until ready for use.

• Use the protective carrier as a glove when installing or removing printed circuit
assemblies.
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• Wear an ESD wrist strap to prevent static discharge when installing or removing
printed circuit assemblies.

SW7 on the CPU boardFigure 5-1:   

A. SW7 switch (ON is towards the dot.)

5.6 General troubleshooting
This section contains general troubleshooting information for the Rosemount 1500XA.
The information is arranged either by major subsystems or by major functions of the
instrument. Refer to Section 5.6.1 for frequent causes of hardware alarms.

Note
Correct ALL alarms before re-calibration.

5.6.1 Hardware alarms
Use the following table to identify the alarm and possible cause and solution for the
problem.
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Alarm name Possible causes/solution

LTLOI Failure Recommended actions:
1. Power the GC down completely.
2. Check that the LOI board ribbon cable is correctly terminated at J6

on the backplane board at one end and on the LOI board at the
other end.

3. Power up the GC.
4. If message appears again, replace the LOI board.

Maintenance Mode A technician has put the GC into Maintenance mode for servicing.

To disable Maintenance mode, deselect the Maintenance Mode check box
in the System dialog.

Power Failure The GC has experienced a restart, caused by power failure, since
alarms were last cleared. The GC automatically starts in Warm Start
mode.

During Warm Start mode, the GC does the following:
1. Waits for the heaters to stabilize.
2. Purges the sample loop.
3. Actuates the valves for two cycles.

After completing these actions, the GC switches to auto-sequence
mode.

User Calculation Failure One or more errors were detected while parsing a user-defined calcu-
lation. This usually happens when a user-defined calculation attempts
to use a system variable that does not exist.

Recommended action: Fix the calculation that is referring to the unde-
fined system variable.

Low Battery Voltage A low battery voltage has been detected on the CPU board. Replace
the CPU board immediately to avoid losing GC configuration data.

Recommended actions:
1. Save the diagnostic data file (on MON2020, go to Tools → Save Di-

agnostic Data... ).
2. Power down the GC.
3. Check SW7 on the CPU board is in the ON position.
4. Replace the CPU Board.
5. Restore Configuration back to the GC. In MON2020, go to File →

Restore Configuration to GC... .

Preamp Board 1 Comm Failure(1) Preamp board not detected.

Recommended actions:
1. Power the GC down completely.
2. Check that the board is properly seated in the correct slot (Pre-

amp1) on the backplane.
3. Power up the GC.
4. If message appears again, replace the preamp board.
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Alarm name Possible causes/solution

Preamp Board 2 Comm Failure Preamp board not detected.

Recommended actions:
1. Power the GC down completely.
2. Check that the board is properly seated in the correct slot (Pre-

amp2) on the backplane.
3. Power up the GC.
4. If message appears again, replace the preamp board.

Preamp Board 3 Comm Failure Preamp board not detected.

Recommended actions:
1. Power the GC down completely.
2. Check that the board is properly seated in the correct slot (Pre-

amp3) on the backplane.
3. Power up the GC.
4. If message appears again, replace the heater/solenoid board.

Heater Solenoid Board 1 Comm Failure Heater/Solenoid board not detected.

Recommended actions:
1. Power the GC down completely.
2. Check that the board is properly seated in the correct slot (Heater

Solenoid 1) on the backplane.
3. Power up the GC.
4. If message appears again, replace the heater/solenoid board.

Heater Solenoid Board 2 Comm Failure Heater/Solenoid board not detected.

Recommended actions:
1. Power the GC down completely.
2. Check that the board is properly seated in the correct slot (Heater

Solenoid 2) on the backplane.
3. Power up the GC.
4. If message appears again, replace the heater/solenoid board.

BaseIO Board Comm Failure Base I/O (Multifunction I/O) board not detected.

Recommended actions:
1. Power the GC down completely.
2. Check that the board is properly seated in the correct slot on the

backplane.
3. Power up the GC.
4. If message appears again, replace the Base IO board.

Stream Skipped

• <Analysis 1 Label> Stream Skipped
• <Analysis 2 Label> Stream Skipped
• <Analysis 3 Label> Stream Skipped
• <Analysis 4 Label> Stream Skipped

One or more streams in the stream sequence cannot be analyzed be-
cause their Usage option is set to Unused. <Analysis n Label> added for
concurrent analysis configurations.

Recommended actions:

1. Use MON2020 to do one of the following:
2. Remove the unused stream(s) from the stream sequence.
3. Change the Usage option of the stream(s) in the Streams dialog to

something other than Unused.
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Alarm name Possible causes/solution

GC Idle

• <Analysis 1 Label> GC Idle
• <Analysis 2 Label> GC Idle
• <Analysis 3 Label> GC Idle
• <Analysis 4 Label> GC Idle

The GC has been placed in Idle mode and is not running an analysis.
<Analysis n Label> added for concurrent analysis configurations.

Warm Start Failed

• <Analysis 1 Label> Warm Start Failed
• <Analysis 2 Label> Warm Start Failed
• <Analysis 3 Label> Warm Start Failed
• <Analysis 4 Label> Warm Start Failed

The GC failed to achieve desired operating condition after power up.
Unable to regulate heater zone temperature(s). <Analysis n Label>
added for Concurrent Analysis configurations.

Recommended actions:
1. Check heater settings in MON2020 or the LOI.
2. Check that the carrier gas cylinder pressure is 10 psi (or greater)

above the mechanical regulator set point.
3. Confirm that carrier cylinder has flow to the GC.
4. Check for leaks in the carrier gas sample path.
5. Confirm that RTDs are not open.
6. If necessary, replace RTD(s), heater(s) and/or regulator(s).

Heater 1 Out Of Range

Heater 2 Out Of Range

Heater 3 Out Of Range

Heater 4 Out Of Range

Heater 5 Out Of Range

Heater 6 Out Of Range

Heater 7 Out Of Range

Heater 8 Out Of Range

The GC failed to regulate heater zone temperatures for the indicated
heater to within preset limits.

Recommended actions:
1. Check temperatures within the GC, using MON2020 or the LOI. Be

aware that the GC may generate this alarm during start up or if the
set point has been changed.

2. Check wiring, looking for splits or loose connections at the termi-
nation board (for both the heaters and the RTDs).

3. If necessary, replace the defective heater and/or RTD.
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Alarm name Possible causes/solution

Flame Out

• Detector 1 Flameout
• Detector 2 Flameout

The FID  flame will not light or has extinguished. If the FID is out, follow 
the steps below.

Recommended actions:
1. Use the LOI or MON2020 to ignite the FID.
2. If unable to sustain the flame, confirm that both fuel and air cylin-
ders are connected and contain sufficient pressure.
3. Confirm that fuel and air set points are set to achieve factory-de-
sired mixture.
4. Confirm that there is no blockage at the FID exhaust outlet - such 
as a cap or ice.
5. Check that the wiring connections are secure for the FID, both on 
the FID cap and at the termination board.
6. If necessary, replace the FID module.
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Alarm name Possible causes/solution

Flame Over Temperature

• Detector 1 Flame Over Temperature
• Detector 2 Flame Over Temperature

The FID flame temperature is above safe limits set at the factory, and
the FID flame has been extinguished, the fuel supply valve closed, and
automatic analyses halted.

Recommended actions:
1. Confirm that both fuel and air cylinders are connected and contain

sufficient pressure.
2. Confirm that fuel and air set points are set to achieve desired mix-

ture.
3. Use the LOI or MON2020 to ignite the FID.

Detector 1 Scaling Factor Failure

Detector 2 Scaling Factor Failure

Detector 3 Scaling Factor Failure

Detector 4 Scaling Factor Failure

Detector 5 Scaling Factor Failure

Detector 6 Scaling Factor Failure

The GC detected an excess scaling factor deviation for Detector #n.

Recommended action: Replace the preamp board:

1. Detectors 1 and 2 are preamp boards located in Preamp1.
2. Detectors 3 and 4 are preamp boards located in Preamp2.
3. Detectors 5 and 6 are preamp boards located in Preamp3

No sample flow 1

No sample flow 2

(Applies to the optional sample flow switch)

The corresponding flow switch indicates that there is no sample flow in
the GC.

Recommended actions:

1. Check sample gas rotameter in the sample conditioning system for
flow and do one of the following:

2. If no gas flow or no rotameter is present, do the following:
a. Confirm that there is gas flow at the sample point location.
b. Check that the sample valves in the sample conditioning sys-

tem are open.
c. Check that the bypass return vent path is free of obstruction.
d. Confirm that the sample line is connected from the sample

point to the GC’s sample conditioning system and is free of ob-
structions.

e. Close the valve at the sample tap, remove pressure from the
line and check the filters at the probe or the sample condition-
ing system or both. If they are filled with liquids or particulates,
replace the filtering elements.

3. If automatic stream selection valves are present, confirm that they
are operating properly.

4. If a slight sample gas flow is present at the rotameter in the sample
conditioning system, drain or replace all filters.

5. If flow is observed in the rotameter, replace the sample flow
switch.
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Alarm name Possible causes/solution

Loss of Purge There is a failure in the purge operation.

Recommended actions:
1. Check that there is inert purge gas flowing into the electronic en-

closure of the gas chromatograph. If not, check the plant instru-
ment air is connected or repair the source of purge gas.

2. Confirm that the door to the electronic enclosure is shut and that
there is positive pressure (above setpoint) present in the enclo-
sure. If there is no positive pressure, and purge gas is flowing into
the enclosure, look for damage to the door gasket and/or bulk-
heads and sealing materials. Repair as needed.

3. Look for loose or disconnected terminations on the purge control-
ler assembly. Note that the purge controller assembly is mounted
on the exterior of the GC but its terminations can be accessed from
the interior of the electronics enclosure. Repair as required.

4. Replace purge controller assembly.

Low Carrier Pressure 1

Low Carrier Pressure 2

Low Carrier Pressure 3

Low Carrier Pressure 4

Input carrier pressure for detector is below the
preset limit.

Input carrier pressure for the named detector is below the preset limit.

Recommended action:

1. Check that the carrier cylinder pressure is 10 psi (or greater) above
the mechanical regulator set point.

2. If input carrier pressure is low, check the carrier cylinder pressure.
3. Replace carrier gas cylinder if required.

Analog Input 1 High Signal

Analog Input 2 High Signal

Analog Input 3 High Signal

Analog Input 4 High Signal

Analog Input 5 High Signal

Analog Input 6 High Signal

Analog Input 7 High Signal

Analog Input 8 High Signal

Analog Input 9 High Signal

Analog Input 10 High Signal

Measured value for the indicated analog input is greater than the user-
defined full scale range.

Analog Input 1 Low Signal

Analog Input 2 Low Signal

Analog Input 3 Low Signal

Analog Input 4 Low Signal

Analog Input 5 Low Signal

Analog Input 6 Low Signal

Analog Input 7 Low Signal

Analog Input 8 Low Signal

Analog Input 9 Low Signal

Analog Input 10 Low Signal

Measured value for the indicated analog input is lower than the user-
defined full scale range.
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Alarm name Possible causes/solution

Analog Output 1 High Signal

Analog Output 2 High Signal

Analog Output 3 High Signal

Analog Output 4 High Signal

Analog Output 5 High Signal

Analog Output 6 High Signal

Analog Output 7 High Signal

Analog Output 8 High Signal

Analog Output 9 High Signal

Analog Output 10 High Signal

Analog Output 11 High Signal

Analog Output 12 High Signal

Analog Output 13 High Signal

Analog Output 14 High Signal

Measured value for the indicated analog output is greater than the
user-defined full scale range.

Analog Output 1 Low Signal

Analog Output 2 Low Signal

Analog Output 3 Low Signal

Analog Output 4 Low Signal

Analog Output 5 Low Signal

Analog Output 6 Low Signal

Analog Output 7 Low Signal

Analog Output 8 Low Signal

Analog Output 9 Low Signal

Analog Output 10 Low Signal

Analog Output 11 Low Signal

Analog Output 12 Low Signal

Analog Output 13 Low Signal

Analog Output 14 Low Signal

Measured value for the indicated analog output is lower than the user-
defined zero range.
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Alarm name Possible causes/solution

Stream 1 Validation Failure

Stream 2 Validation Failure

Stream 3 Validation Failure

Stream 4 Validation Failure

Stream 5 Validation Failure

Stream 6 Validation Failure

Stream 7 Validation Failure

Stream 8 Validation Failure

Stream 9 Validation Failure

Stream 10 Validation Failure

Stream 11 Validation Failure

Stream 12 Validation Failure

Stream 13 Validation Failure

Stream 14 Validation Failure

Stream 15 Validation Failure

Stream 16 Validation Failure

Stream 17 Validation Failure

Stream 18 Validation Failure

Stream 19 Validation Failure

Stream 20 Validation Failure

The most recent validation sequence for the indicated stream failed.

Recommended actions:
1. Check that the validation gas cylinder isolation valves are open.
2. Check that the validation gas regulators are set properly.
3. If the validation gas regulator pressure is below the set point, re-

place the gas bottle with a full one.
4. If the gas used for validation is the same as the gas that is used for

calibration, ensure that the cylinder gas composition value listed
on the cylinder's tag or on the certificate of analysis received from
the supplier matches the value displayed in MON2020's Compo-
nent Data table.

5. Re-run the validation sequence.
6. If still unsuccessful contact your Emerson representative.

Stream 1 RF Deviation

Stream 2 RF Deviation

Stream 3 RF Deviation

Stream 4 RF Deviation

Stream 5 RF Deviation

Stream 6 RF Deviation

Stream 7 RF Deviation

Stream 8 RF Deviation

Stream 9 RF Deviation

Stream 10 RF Deviation

Stream 11 RF Deviation

Stream 12 RF Deviation

Stream 13 RF Deviation

Stream 14 RF Deviation

Stream 15 RF Deviation

Stream 16 RF Deviation

Stream 17 RF Deviation

Stream 18 RF Deviation

Stream 19 RF Deviation

Stream 20 RF Deviation

The most recent calibration sequence failed.

Recommended actions:
1. Check that the calibration gas cylinder isolation valves are open.
2. Check that the calibration gas regulators' pressures are set proper-

ly and that the cylinder is not below the set point. If the cylinder is
below the set point, replace it with a full cylinder.

3. Verify that the calibration cylinder gas composition value listed on
the cylinder tag or on the certificate of analysis received from sup-
plier matches the calibration cylinder gas composition value dis-
played in MON2020's Component Data table. If there is a mis-
match, edit the Component Data table to reflect the correct value.
Re-run the calibration sequence.

4. If still unsuccessful contact your Emerson representative.
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Alarm name Possible causes/solution

Energy Value Invalid

<Analysis 1 Label> Energy Value Invalid

<Analysis 2 Label> Energy Value Invalid

For each configured Analysis (Analysis n Label added if a concurrent
analysis configuration) perform a check of the analyzed energy value
of calibration gas against known value as part of the warm start se-
quence.

The Energy Value Invalid alarm is raised to instruct the associated DCS
that the analyzer has failed and all data should be ignored until a suc-
cessful calibration run has been performed to verify the analysis of the
GC.

On completing warmup, the GC will perform a single analysis of the
calibration stream. Using results of this analysis, the GC will calculate
the energy value and compare it against the previously entered value
stored in the tables.

If the calculated energy value is within the allowable limits set up by
the user, the Energy Value Invalid alarm is cleared, and the GC returns
to normal operation; otherwise the Energy Value Invalid alarm remains
active and the GC returns to normal operation.

Recommended actions

1. Ensure that correct Calibration Gas Energy Value and limits have
been entered in Component Data Table - Edit Energy Value dialog.

2. Ensure calibration gas bottle is open and not low or empty.
3. Check analyzed concentration results for each individual compo-

nent versus calibration gas concentrations in the Component Data
table.

4. Adjust timed events if necessary.

Calibration Energy Check Fail

<Analysis 1 Label> Calibration Energy Check
Fail

<Analysis 2 Label> Calibration Energy Check
Fail

Upon completion of a calibration sequence, a Calibration Gas Energy
Value check is performed.

If the calculated energy value fails the check, the software automati-
cally runs the calibration again.

If the second calibration also fails this check, the calibration is failed
and a system aAlarm, Calibration Energy Value Check Fail, is raised.

Recommended action(s)
1. Ensure calibration gas bottle is open and not low or empty.
2. Check analyzed concentration results for each individual compo-

nent versus calibration gas concentrations in the component data
table.

3. Adjust timed events if necessary.
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Alarm name Possible causes/solution

Stored Data Integrity Failure Archived results, event logs and alarm logs are stored as records in the
instrument database along with a CRC16 checksum. When the data is
retrieved, the checksum is recomputed and the stored checksum is
checked against the calculated checksum. If they don’t match the in-
strument raises a Stored Data Integrity Failure alarm.

Recommended actions

1. Reset archives using dialog under MON2020 Log/Reports Menu .

Note
All archived data in the GC will be lost. If this problem recurs, the CPU
board should be replaced.

ROM Checksum Failure ROM Checksum Validation – The firmware checksum is recomputed at
periodic intervals. If the calculated checksum varies from original val-
ue, a ROM Checksum Failure Alarm is raised.

Recommended action(s)

1. Re-flash the GC controller firmware using MON2020 from the
Tools → Upgrade Firmware

Note
All archived data in the GC will be lost. If this problem recurs, the CPU
board should be replaced.

Sample Fluid Unavailable

• <Analysis 1 Label> Sample Fluid Unavaila-
ble

• <Analysis 2 Label> Sample Fluid Unavaila-
ble

• <Analysis 3 Label> Sample Fluid Unavaila-
ble

• <Analysis 4 Label> Sample Fluid Unavaila-
ble

Stream switching sequence defined in Custom Logic configuration
failed to successfully execute. <Analysis n Label> is added for Concur-
rent Analysis configurations.

Recommended action(s)

1. Confirm proper operation of all sample system components and
ability to provide adequate sample flow.

(1) In MON2020, select Hardware → Installed Hardware for hardware slot locations.

5.6.2 Voltage LEDs
A set of LEDs can be found on the backplane. These LEDs are a quick way to visually inspect
the voltage status of some of the GC’s electrical components.
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The following LEDs are associated with the following GC components:

Voltage LEDs and associated GC electrical componentTable 5-1:   

GC Component

• VIN - fuse open - Glows red when the fuse has blown or been removed; other-
wise, it is not lit.

• 1 RTN - 24 loop (Power) - Glows green when the power supply for the analog out-
puts is functioning properly; otherwise, it is not lit.

• 24V (Regulated) - GC Power - Glows green when the GC power is functioning
properly; otherwise, it is not lit.

• 17V - (Input for the preamp) - Glows green when the power supply for the Pre-
amp is functioning properly; otherwise, it is not lit.

• 12V - (Input for the I/O cards) - Glows green when the optional ROC expansion
card's power supply is functioning properly; otherwise, it is not lit.

• 5V1 - Glows green when the System chip's 5.1 V power supply is functioning
properly; otherwise, it is not lit.

• 3V4 - Glows green when the 3.4 V power supply for the System chips is function-
ing properly; otherwise, it is not lit.

Note
Some boards have a different shade of green for this LED.

• Power ON - Glows green when the GC is on; otherwise, it is not lit.
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5.6.3 Test points

Upper Enclosure Showing Test Points on the BackplaneFigure 5-2:   

A. Backplane test points
B. Test points - exploded view

The backplane has a set of test points that allow you to measure the voltage output of the
base I/O card. Each test point is labeled with a voltage value that, when measured with a
voltmeter, should give a measurement equal to what is displayed on the label. A reading
that does not match this label may indicate a faulty base I/O card. Try swapping out the
suspect card with a different one, and take another measurement. To get a measurement
for a test point, touch the voltmeter’s negative probe to the DGND test point, and touch
the voltmeter’s positive probe to the desired test point.

The test points are associated with the following GC components:

Backplane Test Points and Associated GC ComponentsTable 5-2:   

Test Point GC Component Tolerances

VIN Voltage in

I RTN Isolated return

I 24V (Regulated) Isolated voltage (loop power) 24 V (±2.4 V)
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Backplane Test Points and Associated GC Components (continued)Table 5-2:   

Test Point GC Component Tolerances

24V

(Regulated)

GC power 24 V (±2.4 V)

17V5 Preamp (input for the bridge circuit) 17.5 V ±0.5 V

12V Optional I/O cards 12 V ±0.6 V

5V1 System chips 5.1 V ±0.25 V

3V4 System chips 3.4 V ±0.15 V

FVIN Field voltage input ±0 V - 3 V

FVGND Field voltage ground 21 V - 30 V

The input voltage range for DC/DC power supply is between 21 and 30 volts. The input
range for AC/DC power supply is 90 - 264 volts (auto-ranging).
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5.6.4 Troubleshooting DHCP connectivity issues
Use the following tips to troubleshoot server connectivity issues:

1. Ensure that the GC is up and running. If equipped with a front panel, check the CPU
LED on the front panel; a green light means that the GC is operational. If equipped
with an LOI, ensure that the LOI is communicating with the GC.

2. Check that the SW1 switch is in the ON position.

3. Check the following connections:

a. If you are using a Ethernet straight-through cable, ensure that the PC has an
Ethernet network interface card with auto-MDIX.

b. If your Ethernet network interface card does not support auto-MDIX, ensure that
you are using an Ethernet crossover patch cable.

c. Check to see if the GC's CPU board link lights are on (see Figure 5-3. The three
Ethernet1 LEDs are located on the front bottom edge of the card. Three
Ethernet2 LEDs are just above the Ethernet1 LEDs. If link lights are off, then check
your connections. (see Figure 5-3).
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CPU Board Link LightsFigure 5-3:   

A. CPU board
B. Ethernet link lights

4. Do the following to ensure that your network adapter is enabled:

a. Go to Start → Control Panel → Network Connections....

b. Check the status of the Local Area Connection icon. If the status appears as
Disabled, right-click the icon and select Enable from the context menu.

5. Do the following to try to repair the network connection:

a. Go to Start → Control Panel → Network Connections....

b. Right-click the Local Area Connection icon and select Repair from the context
menu.
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5.6.5 Sample flow balance check
Ensure that the flow panel gauge is properly set. Flow should be as specified on the
Parameter List for the Rosemount 1500XA. To access the list, start MON2020, connect to
the GC and select Logs/Reports → Parameter List....

5.6.6 Carrier flow balance check
Check the flow at the measure vent using a portable electronic flow meter or a mechanical
flow meter.

If your reading is out of range as shown in the MON2020 Logs/Reports → Parameters List...,
do not adjust the pressure regulators; instead, consult with your local the Emerson
Customer Care representative.

5.6.7 Monitoring the detector(s) and columns temperature
Use MON2020 to monitor the temperature of the detector(s) and columns to determine if
the GC is thermally stable.

When connected to the GC via MON2020, select Hardware → Heaters... menu to access
this function.

When viewing the Heater window, the typical heater configuration is as follows:

The Temperature column on the Heaters window displays the current temperature; the
Current PWM column displays the percentage of power being used to run the heater.

The settings and values shown in the Heaters window and described below, are preset at
the factory and are based on the specific customer application. These values should not be
changed unless recommended by Application Engineering, Customer Service personnel,
or as part of a factory application requirement.

Hardware - Heaters ConfigurationFigure 5-4:   
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5.6.8 Replacing the CPU
Use the following procedure to replace a CPU.

1. Save the GC configuration file. In MON2020, go to File → Save Configuration (to
PC)....

2. Power down the GC.

3. Open the GC cover.

4. Remove the clear plastic cover that holds the boards in place.

5. Remove the CPU board.

6. On the new CPU board, set up switches as shown in the following image:
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CPU Switch SettingsFigure 5-5:   

7. Install the new CPU board back in the card cage.

Ensure the board is seated firmly in place.

8. Place the clear plastic cover back over the boards.

9. Close the GC cover.

10. Power up the GC and connect to it through MON2020.

See Using MON2020 to connect to the GC for more information.

11. In MON2020, go to Chromatograph → View/Set Date_Time.... Set the date and time
for the GC.
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See the MON2020 reference manual for more information.

12. In MON2020, go to Tools → Cold Boot.... Cold boot the GC.

The GC reboots automatically and disconnects from MON2020.

13. Wait for the GC to reboot.

14. Reconnect to the GC using MON2020.

15. In MON2020, go to File → Restore Configuration (to GC).... Use the configuration file
you saved in step 1 or use the last known good configuration.

16. Wait for the heaters to stabilize.

17. Go to Control → Auto Sequence... to auto sequence the GC.

5.6.9 Recover the CPU
Follow this procedure if you have accidentally installed a CPU board with the switch in the
Off position or if unusual things are happening to the analyzer and you suspect a corrupt
CPU.

Important
Do not use a config file saved from a suspect CPU.

Procedure

1. Power down the GC.

2. Open the GC cover.

3. Remove the cover from the card cage.

4. Remove the CPU board from the card cage.

5. Ensure the switches on the CPU board are as shown below:

6. Set the CPU board aside for ten minutes to bleed the contents of the battery backed
RAM.

7. On the CPU board, set up the switches as shown below:
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8. Install the CPU board.

Ensure that the board is firmly seated in the card cage.

9. Install the cover on the card cage.

10. Close the GC cover.

11. Power up the GC

12. Connect to the GC using MON2020.

See Using MON2020 to connect to the GC for more information.

13. Go to Chromatograph → View/Set Date Time....

14. Set the date and time for the GC. Save your changes.

15. Go to Tools → Cold Boot.... Cold boot the GC.
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The GC reboots automatically and disconnects from MON2020.

16. Wait for the GC to boot.

17. Connect to the GC using MON2020.

18. Go to File → Restore Configuration (to GC)... and restore configuration to the GC.

19. Wait for the heaters to stabilize.

20. In MON2020, go to Control → Auto Sequence... to return the GC to normal
operation.

5.7 Checking the GC for leaks
Leak checking is a standard component of any maintenance protocol. See Section 4.4.1.

5.7.1 Plugged lines, columns, and valves
If the lines, columns, or valves are plugged, check the gas flow at valve ports. For a
reference, use the flow diagram in the drawing package that shipped with your GC, and
remember these points about flow diagrams:

• Port-to-port flow paths are indicated by solid or dashed lines on the valve symbol in
the drawing.

• A dashed line indicates flow direction when the valve is ON, that is, energized.

• A solid line indicates flow direction when the valve is OFF, i.e., not energized.

5.8 Repairing and maintaining the valves
Only minimal valve repair and maintenance is required (e.g., replacing the diaphragms).

5.8.1 Required tools for valve maintenance
The tools required for performing repair and general maintenance on the XA Series valve
assemblies are:

• Torque wrench, scaled in foot-pounds

• 1/2-in. socket for 10-port valves

• 7/16-in. socket for 6-port valves

• 1/4-in. open-ended wrench

• 5/16-in. open-ended wrench

• 5/32-in. Allen wrench
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5.8.2 Valve replacement parts
Replacement parts required for each XA Series valves consist of the following parts:

• Diaphragm kit 6-port XA valve (P/N 2-4-0710-248)

• Diaphragm kit 10-port XA valve (P/N 2-4-0710-171)

XA Series ValvesFigure 5-6:   

5.8.3 Valve overhaul

Note
Rosemount valves have a lifetime warranty. Replacement factory-built XA Series valves are available.
Call your local Emerson Customer Care representative for more information.

Use the following procedure to overhaul a valve:

Procedure

1. If you are overhauling a 6-port valve, refer to drawing #CE-22260; If you are
overhauling a 10-port valve, refer to drawing #CE-22300. Both drawings are
available in Appendix G.

2. Shut off the carrier and sample gas streams entering the unit.

WARNING!
HOT SURFACES
Power down the GC and allow to cool for at least five minutes.

Failure to allow the analyzer to cool may cause burns from hot surfaces in the enclosure.

3. Open the door to the lower enclosure to access the valves.

4. Disconnect tubing and fittings that attach to the valve from other locations.
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5. Loosen the attaching bolt on the valve to be replaced or serviced.

6. Loosen the valve’s torque bolt.

ValveFigure 5-7:   

A. Torque bolt

7. Holding the lower piston plate, pull the valve straight off the block. The alignment
pins may stick slightly.

8. Remove and discard the old valve diaphragms and gaskets.

9. Clean the sealing surface as required using a non-lint-forming cloth and isopropyl
alcohol. Blow the sealing surface with clean, dry instrument air or carrier gas. Dirt,
including dust and lint, can cause troublesome leakage.

Note
Do not use an oil-based cleaner on the valve.

10. Replace the old diaphragms and gaskets, in the same order, with the new ones
supplied.

11. Reassemble the valve using the following steps:

a. Align the pins with holes in the block and push the valve assembly into place.

b. Tighten the valve’s torque bolt. The 6-port valve requires 20 ft/lb of torque; the
10-port valve requires 30 ft/lb of torque.

c. Reinstall the valve using the two mounting screws and reconnect all fittings and
tubing.

5.8.4 Valve cleaning
Use isopropyl alcohol to clean a valve.
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Note
Do not use an oil-based cleaner on valves.

5.9 Repairing and maintaining the detectors
When a TCD fails to perform normally it should be replaced. Signs that a TCD may be faulty
include, but are not limited to, the following:

• A chromatogram with a wandering or drifting baseline

• A chromatogram with a noisy baseline

• A chromatogram with a no peaks

• No chromatogram

A test for a faulty TCD involves measuring the resistance of each filament using a
multimeter. A pair of thermistors should give the same resistance reading; therefore, if a
thermistor reading is significantly different from the reading of its mate, the pair should be
replaced. Otherwise, the TCD bridge will be unbalanced, noisy, and drifty.

5.9.1 Required tools for TCD maintenance
A flat-head screwdriver is required for removing and replacing TCDs. Use a multimeter to
test the thermistor pair.

5.9.2 TCD replacement parts
Consult the parameter list that was provided with the GC for the thermistor kit required to
replace one TCD. A new thermistor seal (2-3-0500-391) is also required.

TCDFigure 5-8:   
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5.9.3 Replacing a TCD
Use the following procedure to remove a TCD assembly from the GC for repair or
replacement.

WARNING!

EXPLOSION HAZARD
Do not open the enclosure unless the area is known to be non-hazardous or unless all devices
within the enclosure have been de-energized. Power must not be restored after enclosure has
been opened until enclosure has been purged for 60 minutes at a pressure of 0.3 in. w.c.

Failure to de-energize the analyzer may cause an explosion and severely injure personnel.

WARNING!

EXPLOSION HAZARD
Disconnect all electrical power to the unit and ensure the area is free of explosive gases. Failure
to follow this warning may result in injury or death to personnel or cause damage to the
equipment.

Procedure

1. Disconnect all power to the unit and allow the unit to cool.

2. Open the door of the lower enclosure to gain access to the TCD housing(s).

TCD HousingFigure 5-9:   

3. Unscrew the four TCD cover screws and remove the cover to the housing .
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Components of a TCDFigure 5-10:   

A. TCD termination block
B. Gas tubing connectors
C. TCD block
D. TCD retainer nut
E. Thermistor leads
F. TCD housing grooves

4. The TCD thermistor is held within the TCD block by the retainer nut. To replace the
thermistor, do the following:

a. Unscrew and release the thermistor leads from the termination block.

b. Unscrew the retainer nut from the TCD block.

c. Remove the old PFTE™ seals, thermistor, and its wires from the retainer nut.

d. Remove the PFTE shields from the old thermistor wires and place on the new
thermistor wires.

e. Insert a new PFTE seal into the TCD block.

f. Thread the thermistor through the retainer nut.

g. Screw the retainer nut back into the TCD block. Ensure a tight fit (quarter turn
after finger tight); otherwise a potential leak path might open.

h. Reconnect the thermistor leads to the termination block, taking care to
reconnect the thermistor leads to the corresponding terminal block screws.

Note
The thermistors are a matched pair and must be replaced as such. Step 4 needs to be done for
each thermistor in a pair.
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5. Check the gas tubings in the TCD housing grooves. Make sure tubing is properly
seated and reattach the TCD housing cover with the four screws.

Note
Not properly setting the tubing into the grooves may cause the tubing to get pinched when
the cover is reattached.

6. Close the enclosure door and apply power to the analyzer.

5.9.4 Removing the flame ionization detector (FID)
The FID has no replaceable parts. Damage such as a broken RTD or igniter coil will require
that the unit be removed and replaced.

DANGER!

EXPLOSION HAZARD

Disconnect all electrical power to the unit and ensure the area is free of explosive gases.

Failure to follow this warning may result in injury or death to personnel.

Use the following procedure to remove an FID from the GC:

Procedure

1. Disconnect all power to the unit.

Allow at least 10 minutes for the components to cool-down.

2. Open the door of the air-bath oven (lower enclosure) to gain access to the FID
housing and allow components to cool down so that they can be handled.

3. Unscrew and remove the eight screws which secure the explosion-proof housing
cover to gain access to the FID.

4. Unscrew the tubing nut connecters (E and D) located at the base of the FID (keeping
them separate for installation later).
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FID ComponentsFigure 5-11:   

A. FID exhaust
B. FID cap
C. FID board
D. Shield
E. FID block screws
F. Tubing nut (sample in)
G. Signal
H. Polarization voltage

5. Loosen the tubing nut connector securing the FID exhaust tube (A).

6. Remove the screw from the top of the FID assembly.

CAUTION!
ELECTROSTATIC DISCHARGE (ESD) HAZARD

Operators and technicians must wear an electrostatic wrist strap when handling printed
circuit cards to prevent shorting the boards through static electricity.

7. Grasp the edges of the FID board and gently pull and wiggle to remove the six socket
tubes that extend into the pins in the cap.

8. Unscrew the two FID block bolts which secure the old FID base to the bracket and
remove the FID.
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5.9.5 Maintaining the FID
The FID cap (B in Figure 5-11) has no replaceable parts. Damage, like a broken RTD or
broken igniter coil, requires a replacement cap.

FIDFigure 5-12:   

A. Flame tip assembly

The flame tip assembly can be removed for cleaning.
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Prerequisites

Before cleaning the flame tip assembly, remove the FID (see Section 5.9.4).

Procedure

1. Loosen the flame tip isolator one turn.

2. Gently lift and remove the flame tip assembly. Use short needle nose pliers if it is
stubborn, taking care not to bend the tube.

Flame Tip AssemblyFigure 5-13:   

5.9.6 Reassembling the FID
Procedure

1. Insert the FID into the mounting bracket and secure with the two block screws.

2. Grasp the edges of the FID board and align with the six socket tubes that extend into
the pins in the cap. Replace the screw at the top of the FID assembly.

3. Tighten the tubing nut connector, securing the FID exhaust tube.

4. Screw in the tubing nut connectors located at the base of the FID.

5. Install the explosion-proof cover over the FID assembly and secure to the base with
eight bolts.

6. Close the air-bath oven enclosure door and apply power to restart the GC.

5.10 Replacing the methanator
Use this procedure to replace the methanator assembly and replace the RTD.

The optional methanator, which is a catalytic converter, converts CO2 and/or CO into
methane by adding hydrogen and heat to the sample. The methanator requires little
maintenance.

Maintaining and troubleshooting the gas chromatograph

Operations Manual 111



WARNING!

BURN HAZARD
Enclosure contains hot internal parts. This enclosure must not be opened unless the area
atmosphere is known to be below the ignitable concentration of combustible materials or
unless all equipment within has been de-energized for thirty-five minutes.

Failure to allow the components to cool down may cause thermal injuries to personnel.

Note
Be sure to insulate the methanator assembly to prevent heat loss.

See drawing 9R00004 in Section G.1 for wiring connections.

Procedure

1. Order the Rosemount MethanatorKit P/N 2-3-0710-265.

2. Inspect the packaging for damage. If damaged in shipping, contact your local
Customer Care representative.

3. Power down the GC and allow to cool thirty-five minutes before opening the
electronics enclosure door.

See the wiring diagram sent with your GC to determine where the wires are
connected.

4. Disconnect the RTD wires.

5. Disconnect the heater wires from TB25 on the backplane.

6. Loosen and remove the two flat head screws and nuts from the methanator bracket.

7. Remove the methanator assembly from the electronics enclosure.

8. Install the new methanator by attaching it to the methanator bracket using two flat
head screws and nuts.

9. Reconnect the RTD and heater wires.

10. Close the electronics enclosure door and apply power to the GC.

5.11 Measure vent flow
You will need an accurate flow meter for this measurement.
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Measure Flow VentsFigure 5-14:   

A. Measure and sample vents

Procedure

1. Consult the parameter list that was provided with the GC to learn the appropriate
flow rate.

2. Attach a flow meter to each measurement vent output on the side of the GC that is
labeled MVn, where n is for each vent.. The flow should match the value displayed in
the parameter list.
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5.12 Electrical components
The GC is designed to operate for long periods of time without the need for preventive or
regularly scheduled maintenance.

WARNING!

EXPLOSION HAZARD
Do not open the enclosure unless the area is known to be non-hazardous or unless all devices
within the enclosure have been de-energized. Power must not be restored after enclosure has
been opened until enclosure has been purged for 60 minutes at a pressure of 0.3 in. w.c.

Failure to de-energize the analyzer may cause an explosion and severely injure personnel.

Prior to opening the GC, use MON2020 to ensure that there are no configuration or
parameter errors.

To access the card cage, do the following:

Procedure

1. Ensure electrical power is disconnected from the unit and the environment is safe.

2. Allow the unit to cool.

3. Open the electronics enclosure door and access the card cage assembly holding the
circuit boards.
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Electronics ComponentsFigure 5-15:   

A. CPU board
B. Detector preamp board
C. Heater solenoid driver board
D. Card cage
E. ROC Module slots
F. Base I/O board
G. Power supply
H. Circuit breaker
I. Backplane
J. Air bath heater

4. Note the location and direction of any board removed. Release the catch(es) and
remove/replace the circuit board(s) as necessary.

5. Close and latch the electronics enclosure door.

6. Apply power to the GC.
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5.13 Analog inputs and outputs
The analog outputs can be calibrated or adjusted with MON2020. However, these outputs
should be measured with a calibrated digital meter upon initial installation at zero scale
and full scale. Then the span can be set with MON2020 so that it represents values from 0
to 100 percent of the user-defined units in use.

Nominally, calibration is made within a range of 4-20 milliamperes (mA) output from each
analog channel. To set a reference point to trigger an alarm condition, configure zero scale
calibration with a 0 mA output, and full scale calibration set up to 22.5 mA output.

If there is reason to suspect that the span on any particular channel might be off after a
period of time and heavy use, then the analog output for that channel should be
recalibrated.

5.13.1 Analog output adjustment
The initial analog output adjustments are set at the factory, before shipment, at standard
values (4-20 mA). It may be necessary to check and/or adjust these values depending on
output cabling/impedance. The adjustment may require two people if the units are some
distance apart. It requires a calibrated digital meter to check the zero and full scale values
at the receiving end. The scale or span value can then be adjusted with MON2020.

It is possible to calibrate the analog outputs using different engineering units, volts, and
percentages.

5.14 Upgrading the embedded software
The base GC firmware performs functions similar to operating systems such as DOS,
Windows™, or Linux®. The base GC firmware provides the basic resources and interfaces to
run the user's applications. There is no direct user-level interface to the firmware.

If a firmware upgrade is required for your system, refer to the MON2020 Gas
Chromatograph Software manual for additional information.

The GC’s applications use the tools provided by firmware to perform the desired gas
chromatograph applications for the user. There are different applications to facilitate
different gas chromatographic needs. To load a new application or to upgrade an existing
application, refer to the MON2020 Gas Chromatograph Software manual for details.
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Appendix A
Theory of operation

The following sections discuss the theory of operation for the GC, the engineering
principles and the concepts used.

Note
See Appendix H for definitions of the terminology used in this document.

A.1 Thermal conductivity detector (TCD)
One of the detectors available on the GC is a thermal conductivity detector (TCD) that
consists of a balanced bridge network with heat sensitive thermistors in each leg of the
bridge. Each thermistor is enclosed in a separate chamber of the detector block.

One thermistor is designated the reference element, and the other thermistor is
designated the measurement element. See Figure A-1 for a schematic diagram of the
thermal conductivity detector.

Analyzer Assembly with TCD BridgeFigure A-1:   
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In the quiescent condition, prior to injecting a sample, both legs of the bridge are exposed
to pure carrier gas. In this condition, the bridge is balanced, and the bridge output is
electrically nulled.

The analysis begins when the sample valve injects a fixed volume of sample into the
column. The continuous flow of carrier gas moves the sample through the column. As
successive components elute from the column, the temperature of the measurement
element changes.

The temperature change unbalances the bridge and produces an electrical output
proportional to the component concentration.

The differential signal developed between the two thermistors is amplified by the
preamplifier. Figure A-2 illustrates the change in detector electrical output during elution of
a component.

Detector output during component elutionFigure A-2:   

A. Detector bridge balanced.
B. Component begins to elute from column and is measured by thermistor.
C. Peak concentration of component.

In addition to amplifying the differential signal developed between the two thermistors,
the preamplifier supplies drive current to the detector bridge.

The signal is proportional to the concentration of a component detected in the gas
sample. The preamplifier provides twodifferent gain channels as well as compensation for
baseline drift.

The signals from the preamplifier are sent to the electronic assembly for component
concentration computation, recording, or viewing on a PC monitor with MON2020.
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A.2 Flame ionization detector (FID)
Another detector available for the Rosemount™ 1500XA is the flame ionization detector
(FID). The FID requires a polarization voltage, and its output is connected to the input to a
high impedance amplifier that is called an electrometer. The burner uses a mixture of
hydrogen and air to maintain the flame. The sample of gas to be measured is also injected
into the burner. See Figure A-3 for a schematic diagram of the FID.

Analyzer assembly with FID detector bridgeFigure A-3:   

A. Polarizing voltage
B. Electrometer
C. Signal out
D. Sample/H2

E. Air

A.3 Data acquisition
Every second, exactly 50 equally spaced data samples are taken (i.e., one data sample
every 20 milliseconds) for analysis by the controller assembly.

As a part of the data acquisition process, groups of incoming data samples are averaged
together before the result is stored for processing. Non-overlapping groups of N samples
are averaged and stored, and thus reduce the effective incoming data rate to 40/N
samples per second. For example, if N = 5, then a total of 40/5 or 8 (averaged) data
samples are stored every second.
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The value for the variable N is determined by the selection of a peak width parameter (PW).
The relationship is

N = PW

where PW is given in seconds. Allowable values of N are 1 to 63; this range corresponds to
PW values of 2 to 63 seconds.

The variable N is known as the integration factor. This term is used because N determines
how many points are averaged, or integrated, to form a single value. The integration of
data upon input, before storing, serves two purposes:

• The statistical noise on the input signal is reduced by the square root of N. In the
case of N = 4, a noise reduction of 2 would be realized.

• The integration factor controls the bandwidth of the chromatograph signal. It is
necessary to match the bandwidth of the input signal to that of the analysis
algorithms in the controller assembly. This prevents small, short-duration
perturbations from being recognized as true peaks by the program. It is therefore
important to choose a peak width that corresponds to the narrowest peak in the
group under consideration.

A.4 Peak detection
For normal area or peak height concentration evaluation, the determination of a peak's
start point and end point is automatic. The manual determination of start and end points is
used only for area calculations in the Forced Integration mode. Automatic determination of
peak onset or start is initiated whenever Integrate Inhibit is turned off. Analysis is started in a
region of signal quiescence and stability, such that the signal level and activity can be
considered as baseline values.

Note
The controller assembly software assumes that a region of signal quiescence and stability will exist.

Having initiated a peak search by turning Integrate Inhibit off, the controller assembly
performs a point by point examination of the signal slope. This is achieved by using a
digital slope detection filter, a combination low pass filter and differentiator. The output is
continually compared to a user-defined system constant called Slope Sensitivity. A default
value of 8 is assumed if no entry is made. Lower values make peak onset detection more
sensitive, and higher values make detection less sensitive. Higher values (20 to 100) would
be appropriate for noisy signals, (e.g., high amplifier gain).

Onset is defined where the detector output exceeds the baseline constant, but peak
termination is defined where the detector output is less than the same constant.

Sequences of fused peaks are also automatically handled. This is done by testing each
termination point to see if the region immediately following it satisfies the criteria of a
baseline. A baseline region must have a slope detector value less than the magnitude of
the baseline constant for a number of sequential points. When a baseline region is found,
this terminates a sequence of peaks.
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A zero reference line for peak height and area determination is established by extending a
line from the point of the onset of the peak sequence to the point of the termination. The
values of these two points are found by averaging the four integrated points just prior to
the onset point and just after the termination points, respectively.

The zero reference line will, in general, be non-horizontal, and thus compensates for any
linear drift in the system from the time the peak sequence starts until it ends.

In a single peak situation, peak area is the area of the component peak between the curve
and the zero reference line. The peak height is the distance from the zero reference line to
the maximum point on the component curve. The value and location of the maximum
point is determined from quadratic interpolation through the three highest points at the
peak of the discrete value curve stored in the controller assembly.

For fused peak sequences, this interpolation technique is used both for peaks, as well as
valleys (minimum points). In the latter case, lines are dropped from the interpolated valley
points to the zero reference line to partition the fused peak areas into individual peaks.

The use of quadratic interpolation improves both area and height calculation accuracy and
eliminates the effects of variations in the integration factor on these calculations.

For calibration, the controller assembly may average several analyses of the calibration
stream.

A.5 Basic analysis computations
Two basic analysis algorithms are included in the controller assembly:

• Area Analysis – calculates area under component peak

• Peak Height Analysis – measures height of component peak

Note
MON2020 can perform a variety of other calculations. For more information, see the MON2020 Gas
Chromatograph Software manual.

A.5.1 Concentration analysis - response factor
Concentration calculations require a unique response factor for each component in an
analysis. These response factors may be manually entered by an operator or determined
automatically by the system through calibration procedures (with a calibration gas mixture
that has known concentrations).

The response factor calculation, using the external standard, is:

where
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ARFn area response factor for component n in area per mole percent

Arean area associated with component n in calibration gas

Caln amount of component n in mole percent in calibration gas

Htn peak height associated with component n mole percent in calibration gas

HRFn peak height response factor for component n

Calculated response factors are stored by the controller assembly for use in the
concentration calculations, and are printed out in the configuration and calibration
reports.

Average response factor is calculated as follows:

where

RFAVGn area or height average response factor for component n

RFi area or height average response factor for component n from the calibration run

k number of calibration runs used to calculate the response factors

The percent deviation of new RF averages from old RF average is calculated in the following
manner:

where the absolute value of percent deviation has been previously entered by the
operator.
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A.5.2 Concentration calculation - mole percentage (without
normalization)
After response factors have been determined by the controller assembly or entered by the
operator, component concentrations are determined for each analysis by using the
following equations:

where

ARFn Area response factor for component n in area per mole percent

Arean Area associated with component n in unknown sample

CONCn Concentration of component n in mole percent

Htn Peak height associated with component n mole percent in unknown sample

HRFn Peak height response factor for component n

Component concentrations may also be input through analog inputs 1 to 4 or may be
fixed. If a fixed value is used, the calibration for that component is the mole percent that
will be used for all analyses.

A.5.3 Concentration calculation in mole percentage (with
normalization)
The normalized concentration calculation is:

where

CONCNn Normalized concentration of component n in percent of total gas concentration

CONCi Non-normalized concentration of component n in mole percent for each k compo-
nent

CONCn Non-normalized concentration of component n in mole percent

k Number of components to be included in the normalization
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Note
The average concentration of each component will also be calculated when data averaging is
requested.

A.6 Functional description
A sample of the gas to be analyzed is taken from the process stream by a sample probe
installed in the process line. The sample passes through a sample line to the SCS where it is
filtered or otherwise conditioned. After conditioning, the sample flows to the analyzer
assembly for separation and detection of the gas components.

Gas chromatography process modelFigure A-4:   

A. Process line
B. Probe
C. Sample system
D. Chromatograph oven
E. GC Controller
F. Sample return
G. Slip stream
H. Carrier gas
I. Reference vent
J. Detector vent
K. Analysis results

Separation and analysis

The chromatographic separation of the sample gas into its components is accomplished in
the following manner.
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1. A precise volume of sample gas is injected into one of the analytical columns. The
column contains a stationary phase (packing) that is either an active solid or an inert
solid support that is coated with a liquid phase (absorption partitioning).

2. The sample gas is moved through the column by means of a mobile phase (carrier
gas).

3. The selective retardation of the components takes place in the column, causing
each component to move through the column at a different rate. This separates the
sample into its constituent gases and vapors.

4. A detector located at the outlet of the analytical column senses the elution of
components from the column and produces electrical outputs proportional to the
concentration of each component.

Output from the electronic assembly is normally displayed on a remotely located PC or in a
Distributed Control system (or Flow computer).

Connection between the GC and the PC can be accomplished from a direct serial line, an
optional Ethernet cable, or via a Modbus-compatible communication interface.

Several chromatograms may be displayed via MON2020 with separate color schemes,
allowing you to compare present and past data.

In most cases, it is essential to use MON2020 to configure and troubleshoot the GC. The
PC may be remotely connected via Ethernet, telephone, radio or satellite communications.
Once installed and configured, the GC can operate independently for long periods of time.
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Appendix B
Local operator interface (LOI)

B.1 LOI for displaying and entering data
The LOI has multiple components that you can use to interact with the unit.

LOI ComponentsFigure B-1:   

A. LCD screen
B. Keypads
C. LED indicators

B.2 LOI components

B.2.1 Light emitting diode (LED) indicators
There are three LED status indicators on the LOI that show the overall status of the gas
chromatograph. These LEDs are positioned to the right of the display screen. Each LED,
when lit, indicates a specific condition.
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The GC is currently running an analysis.

The GC has at least one unacknowledged alarm.

The GC has an out-of-tolerance or alarm condition that requires an
operator action.

LCD display screen

The LCD display screen measures 4.4 by 3.3 in. (111.4 x 83.5 mm) and is capable of 640 by
480 VGA pixel resolution, supporting both text and full graphics. The backlighting, boost,
and brightness are all under software control. The boost and brightness levels are user-
adjustable.

Keypad

The keypad consists of eight infrared keys.

Command keys

The four keys located above the LCD display screen are command keys. See Section B.3.3
for more information.

Arrow keys

The four keys below the LCD display screen are arrow keys that allow you to navigate
within the screen by scrolling or moving the cursor from field to field. These keys function
in the same way as a computer keyboard’s arrow keys.

• Left

• Up
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• Down

• Right

Pressing a key

A key is pressed by placing a finger on the glass over the associated key hole and then
removing the finger. Holding a finger over the key hole will cause that key to repeat until
the finger is removed.

B.3 Using the LOI

B.3.1 Startup
Upon starting the GC, the LOI automatically runs in Status Display mode, in which it scrolls
through a predefined series of screens, displaying each screen for approximately 30
seconds.

Screen Description

Status Displays information about the operational state of the analyzer, including a
scrolling list of up to 25 user-selectable parameters that can be defined or
modified using the MON 2020 software.

Note
There is more than one Status screen if the GC is configured with more than
one analysis/cycle clock.

Live Chromatogram Displays the chromatogram for the current analysis in real time.

Note
There is more than one Live Chromatogram screen if the GC is configured with
more than one analysis/cycle clock.

Note
This screen does not display if the GC is not currently analyzing a sample.

Active Alarms Lists active alarms, if any.
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Screen Description

Heater Displays information about the PID temperature control loops.

Valves Displays the settings and states of the stream and analyzer valves.

In Status Display mode, you can manually scroll to the next screen using the RIGHT key, or
to the previous screen using the LEFT key. You can pause automatic scrolling at any time
by pressing the EXIT key, and you can resume automatic scrolling by pressing either the
LEFT or the RIGHT key. Automatic scrolling resumes after ten minutes of keypad inactivity.

Pressing F1 when MOVE is displayed in the green box below it takes the focus inside the
screen so that you can navigate through the controls of the screen using the LEFT, RIGHT,
UP and DOWN keys. Pressing EXIT returns the focus to the top level—that is, outside of the
screen. Pressing LEFT or RIGHT at the top level resumes automatic scrolling in addition to
moving to the previous or next screen.

At any time, while in Status Display mode, you can press ENTER or F2 to enter the Main
Menu. Use the EXIT key to leave the Main Menu and return the LOI to Status Display mode.
If you log onto the GC from the Main Menu to perform operations or edit data, when you
exit the menu you will automatically be logged off the LOI.

B.3.2 Navigating menus
At any time while in Status Display mode, you can press ENTER or F2 to enter the Main
Menu.

Use the UP or DOWN keys to navigate between fields or controls within each drop-down
menu. Pressing the DOWN key while focus is on the last field of a drop-down menu moves
the focus to the first field on a screen. Alternatively, pressing the UP key while focus is on
the first field of the drop down menu causes the focus to move to the last field.

Use the ENTER key from the Main Menu to activate submenus and individual menu items.

Press EXIT to leave the Main Menu and return the LOI to Status Display mode if no menu is
dropped down. If a menu is dropped down, then pressing EXIT closes that menu.

If you log onto the GC from the Main Menu to perform operations or edit data, when you
exit the menu you will automatically be logged off the LOI.

The Main Menu allows you access to all of the available LOI screens; however, you must be
logged on to make changes. If you are not logged on and you attempt to edit a field, the
Login screen will appear first.

After a period of fifteen minutes of inactivity, you will be automatically logged off.

B.3.3 Navigating the screen
LOI screens have several functions. They can display data for review; they can display data
for editing; and they can be used to initiate activities.
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Within any given screen, the function of the ENTER key depends upon the context. It can
be used to validate and save changes or to initiate an action.

If a validation error is found after pressing ENTER, an Invalid Entry message displays.
Press ENTER again to close the message and then re-enter your data.

Pressing EXIT closes the currently open screen. If you have made changes to the screen,
the LOI will display a confirmation message asking if you want to save your changes. Use
the arrow keys to select the appropriate button and press ENTER. If you select No, your
changes will be discarded and the Main Menu will display; if you select Cancel, the
message window will close and you will be returned to the current screen; if you select Yes,
your changes will be validated and saved and then you will be returned to the Main Menu.

The F1 and F2 keys are context dependent. A one-word description of the function of each
of these keys displays in a green prompt box directly under the key in the title bar of the
top-level full-sized screen.

In some cases, F1 acts as a toggle between scrolling either a line or a page at a time. When
this is true, the currently selected option (LN or PG) displays with a green background and
black text, while the non-selected option displays with a black background and green text.
The table below lists the possible functions of the F1 key:

Press F1 to move the cursor around within the boundary of the screen.

Press F1 to open the edit dialog for the field that contains the cursor. The type
of dialog that displays depends upon the type of field to be edited. See 
Section B.3.4 and Section B.3.5 for more information.

Press F1 to select the field to be edited.

Press F1 to delete the character to the left of the cursor.

Press F1 to scroll line by line within a screen.

Press F1 to scroll page by page within a screen.

Press F1 to click the button and execute the command

Note
Throughout this appendix, when referring to the F1 key, the key’s current valid function will be
indicated in parenthesis—for instance, F1 (MOVE) or F1 (SELECT).

The F2 key, when MAIN is displayed in the prompt box, closes all screens and goes back to
the Main Menu.
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There is a navigation icon in the upper right corner of the screen that indicates which
navigation keys are active for the currently displayed screen.

When you press a key, a green check will flash in the upper left corner if the key is valid; if
the key is not valid, a red cross (X) will flash in the upper left corner.

B.3.4 Editing numeric fields
When the focus is on an editable field, pressing F1 (EDIT) will display the Edit dialog
containing the field’s original text.

Use the LEFT or RIGHT keys to move through the individual characters within the field and
to select the character to be changed. Use the UP or DOWN keys to select the value of
each digit. The possible values are 1, 2, 3, 4, 5, 6, 7, 8, 9, 0, “-” (minus), “.” (period), and
E.

The “-” value is available for signed numbers.

The “.” and the E values are available for floating-point numbers, except for retention
times and timed event values.

The following rules apply when entering a floating-point value:

• More than one E is not allowed.

• More than one “.” is not allowed.

• If the previous position is an E, then a “.” and a 0 is not allowed.

• A “-” is allowed only after an E or at the first position only.

• If the previous position is “.”, then an E is not allowed.

• If the first character is a “-” and the current index is 1, then a “.” is not allowed.

• If the previous position is a “-”, then a 0 is not allowed.

• If the next character is an E, then a “.” is not allowed at the previous location.

The DOWN key moves backward in the list from the current value of the selected digit.

The UP key moves forward in the list from the current value of the selected digit.
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The F1 (BACKSP) key acts as a backspace and deletes the digit immediately to the left of
the current position.

The ENTER key validates and saves the entry and then closes the Edit dialog. The new entry
will display in the field.

The EXIT key cancels any changes that were entered and closes the Edit dialog, restoring
the previous value to the field.

B.3.5 Editing non-numeric fields
The function of the keys when editing non-numeric data is context-dependent.

Editing alphanumeric fields

Alphanumeric fields take numbers (0 - 9) and letters (a - z, A - Z).

Selecting check boxes

Press F1 (SELECT) to select or clear a checkbox.

Selecting a CheckboxFigure B-2:   

Clicking buttons

Press F1 (EXECUTE) to click the button and execute the command.
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Selecting radio buttons

Procedure

1. Press F1 (SELECT) to select a group of radio buttons.

2. Use the UP/ DOWN or LEFT/RIGHT keys to move through the various radio buttons
within the group.

3. Press ENTER to accept the current selection or press EXIT to abort any changes and
to restore the previous selection.

Selecting an item from a list box

Procedure

1. Press F1 (SELECT) while focused on the list box to switch it to Edit mode.

Selecting a List BoxFigure B-3:   

2. Use the UP and DOWN keys to move between the values within the list box.

3. Press ENTER to accept the current selection or press EXIT to abort the new selection,
and the list box will revert to the previous selection.

Selecting an item from a combo box

Procedure

1. Press F1 (SELECT) while focused on the combo field.

A combo dialog opens and displays a list of available selections.
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Selecting a Combo BoxFigure B-4:   

2. Use the UP and DOWN keys to move between the selections.

3. Press ENTER to select the desired value or press EXIT to restore the combo box’s
initial value.

Entering a date and time

Procedure

1. Press F1 (SELECT) while focused on the Date and Time field

The Enter the Date and Time dialog displays. By default, the focus is set on the
Month unit.
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Entering a Date and TimeFigure B-5:   

2. Use the UP and DOWN keys to change the value of the unit—that is, to go from
January to February, or from 1 to 2.

3. Use the LEFT and RIGHT arrow keys to change units—that is, to go from months to
years or hours to minutes.

Note
If the focus is on the leftmost section, the LEFT key will be inactive, and similarly if the focus is
on the rightmost section, the RIGHT arrow key will be inactive.

4. Press ENTER to save the change or press EXIT to discard the change and restore the
original value.

Setting the time

Procedure

1. Press F1 (SELECT) while focused on the Time field

The Enter the Time dialog displays. By default, the focus is set on the Hour unit.

2. Use the UP and DOWN keys to change the value of the unit.

3. Use the LEFT and RIGHT arrow keys to change units—to go from hours to minutes,
for example.

Note
If the focus is on the leftmost section, the LEFT key will be inactive, and similarly if the focus is
on the rightmost section, the RIGHT arrow key will be inactive.
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4. Press ENTER to save the change or press EXIT to discard the change and restore the
original value.

B.4 Screen navigation and interaction tutorial
This tutorial, which guides you through the procedure for editing data on a screen, will
incorporate all of the preceding information to demonstrate the typical method of
navigating and interacting with the LOI. You will learn how to perform the following
actions:

• Open and close screens

• Navigate through tables

• Select fields for editing

• Save data

Procedure

1. From the Main Menu, click the RIGHT key enough times to navigate to the
Application menu. The System submenu, as it is the first item in the list, is already
selected.

Note
In this instance, the term click means to tap the glass on the spot directly above the arrow’s
keyhole.

Navigate to the Application MenuFigure B-6:   

Local operator interface (LOI)

Operations Manual 137



Note
Notice the navigation icon in the upper right corner, which indicates that all four arrow keys
are active. This allows you to navigate to all of the menu items and sub menu items.

Note
Notice that the green prompt boxes are empty. This means that the F1 and F2 keys are
inactive from the Main Menu.

2. Click ENTER.

The System screen displays.

System screenFigure B-7:   

Note
Notice the navigation icon in the upper right corner, which indicates that no arrow keys are
active.

Notice that the green prompt boxes now display function keywords. MAIN means that if you
click the F2 key, the LOI will close the current screen and return you to the Main Menu. MOVE
means that if you click the F1 key, the arrow keys are enabled for navigation within the
System screen.

3. Click F1.

The LOI switches to Edit mode. Notice that the navigation icon in the upper right
corner of the screen indicates that the DOWN key is active.

4. Click the DOWN key once.
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Now the navigation icon indicates that both the UP and DOWN keys are active.

5. Click the UP arrow once to return to the previous cell.

The navigation icon again indicates that only the DOWN key is active.

Notice that the green F1 prompt box reads EDIT.

6. Click F1.

You must be logged in to the GC to make a change to any screen. If you try to edit a
field before logging in—as you just did—the LOI displays the Login dialog to prompt
you to log in.

Login Screen (Edit Mode Prompt)Figure B-8:   

Note
Notice that there is also a navigation icon on the Login dialog.

7. Click F1 (SELECT) and navigate up or down the list to highlight your user name.

Note
For the remainder of this tutorial, when referring to the F1 key, the key’s current valid
function will be indicated in parenthesis—for instance, F1 (MOVE) or F1 (SELECT).

8. Click ENTER.

9. Navigate to the Pin field, press F1 (EDIT), and enter your password.

10. Click ENTER twice.

Now that you are logged in, you can edit the fields on the screen.
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11. Click F1 (EDIT). The Enter the data dialog displays.

The Enter the data dialog allows you to edit the selected field.

Enter the Data DialogFigure B-9:   

12. To delete a character, press F1 (BACKSP). To enter new data, use the UP and DOWN
keys to cycle through the available characters, and use the RIGHT key to add a new
character to the field.

13. When you are finished entering data, press ENTER to validate and save the new
information. To discard the information, press EXIT.
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New Data DisplayedFigure B-10:   

Note
If a validation error is found after pressing ENTER, an Invalid Entry message displays.
Press ENTER to close the message and then re-enter your data.

14. Use the DOWN arrow to move to the Allow Multiple Writers checkbox.

Allow Multiple Writers Checkbox SelectedFigure B-11:   

Local operator interface (LOI)

Operations Manual 141



15. Press F1 (SELECT).

This clears the checkbox.

Allow Multiple Writers Checkbox UnselectedFigure B-12:   

16. Click F1 (SELECT) again to reselect the check box.

17. Navigate to the Time Format field.

Time Format FieldFigure B-13:   
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18. Press F1 (SELECT).

The Select an Item combo box displays.

Select an Item Combo BoxFigure B-14:   

19. Use the DOWN key to scroll down to the last item in the combo box. Press ENTER.

20. Press ENTER a second time to save all the changes that were made to the table.

Note
If you neglect to press ENTER at this point, all of your changes will be lost.

21. Press F2 (MAIN) to return to the Main Menu.

Local operator interface (LOI)

Operations Manual 143



B.5 LOI screens
The Main Menu has six top-level submenus: Chromatogram, Hardware, Application,
Control, Logs/Reports, and Tools.

Refer to the MON2020 Gas Chromatograph Software user manual for detailed information
regarding the commands in Table B-1 to Table B-4.

The tables below list the submenus and commands that are available from the Main Menu.

Chromatogram MenuTable B-1:   

Submenu Command Subcommands Reference

Chromatogram Section B.5.1

View Section B.5.1

Select Chromatogram Figure B-16

Live Chromatogram View Screen (Status Mode) Figure B-17

Live Chromatogram Screen (Advanced Mode) Figure B-18

Archived Chromatogram Screen (Advanced Mode) Figure B-19

Live & Archived Chromatogram Viewer Options Menu Figure B-20

CGM Scaling Screen Figure B-21

Select Detector Screen Figure B-22

Chromatogram TEV Table Figure B-23

Chromatogram CDT Table Figure B-24

Chromatogram Raw Data Table Figure B-25

Hardware and Application MenusTable B-2:   

Submenu Command Subcommands Reference

Hardware Section B.5.2

Heaters Figure B-27

Valves Figure B-28

Detectors Figure B-29

Discrete Inputs Figure B-30

Discrete Outputs Figure B-31

Analog Inputs Figure B-32

Analog Outputs Figure B-33

Installed Hard-
ware

Figure B-34

Application Section B.5.3

System Figure B-36

Component Data Figure B-37

Local operator interface (LOI)
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Hardware and Application Menus (continued)Table B-2:   

Submenu Command Subcommands Reference

CDT 1

CDT 2

CDT 3

CDT 4

Timed Events Figure B-38

TEV 1

TEV 2

TEV 3

TEV 4

Streams Figure B-42

Status Figure B-43

Ethernet Ports Figure B-44

Logs/Reports and Control MenusTable B-3:   

Submenu Command Subcommands Reference

Logs/Reports Section B.5.4

Maintenance Log Figure B-46

Event Log Figure B-47

Alarm Log Figure B-48

Unack Alarms Figure B-49

Active Alarms Figure B-50

Report Display Figure B-51

Control Section B.5.5

Auto Sequence Figure B-53

Single Stream Figure B-54

Halt Figure B-55

Calibration Figure B-56

Validation Figure B-57

Stop Now Figure B-58

Local operator interface (LOI)
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Tools MenuTable B-4:   

Submenu Command Subcommands Reference

Tools Section B.5.6

Screen Control Figure B-60

Change PIN Figure B-61

Diagnostics Figure B-62

Log out no screen

B.5.1 Chromatogram menu
The Chromatogram menu enables you to view live and archived chromatograms and their
associated CDT and TEV tables, as well as to edit the display properties if the
chromatogram screens.

Refer to the Using the chromatograph functions section of the MON2020 Gas
Chromatograph Software manual for detailed information regarding the Chromatogram
menu screens.

Chromatogram MenuFigure B-15:   

Local operator interface (LOI)
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Select Chromatogram ScreenFigure B-16:   

Live Chromatogram View (Status Mode) ScreenFigure B-17:   

Note
The blue box displays the current analysis time.

Local operator interface (LOI)
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Live Chromatogram View (Advanced Mode) ScreenFigure B-18:   

Note
The blue box displays the current analysis time.

Archived Chromatogram (Advanced Mode) ScreenFigure B-19:   

Local operator interface (LOI)
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Live and Archived Chromatogram Viewer Options ScreenFigure B-20:   

Note
The blue box displays the cursor’s X- (analysis time) and Y- (amplitude) coordinates.

CGM Scaling ScreenFigure B-21:   

Local operator interface (LOI)
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Select Detector ScreenFigure B-22:   

Chromatogram TEV Table ScreenFigure B-23:   

Local operator interface (LOI)
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Chromatogram CDT Table ScreenFigure B-24:   

Chromatogram Raw Data Table ScreenFigure B-25:   

Local operator interface (LOI)
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B.5.2 Hardware menu
The Hardware menu enables you to view and manage the GC’s hardware components.

Refer to the Using the hardware functions section of the MON2020 Gas Chromatograph
Software manual for detailed information regarding the Hardware menu screens.

Hardware MenuFigure B-26:   

Heaters ScreenFigure B-27:   

Local operator interface (LOI)
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Valves ScreenFigure B-28:   

Note
The mode (Auto, ON, OFF), and state (Green = ON, Black = OFF, Red = ERROR) of each valve is
displayed. See the Configuring the valves section of the MON2020 Gas Chromatograph Software
manual for more information.

Detectors ScreenFigure B-29:   

Local operator interface (LOI)
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Discrete Inputs ScreenFigure B-30:   

Discrete Outputs ScreenFigure B-31:   

Local operator interface (LOI)
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Analog Inputs ScreenFigure B-32:   

Analog Outputs ScreenFigure B-33:   

Local operator interface (LOI)
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Installed Hardware ScreenFigure B-34:   

Local operator interface (LOI)
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B.5.3 Application menu
The Application menu allows you to view the Component Data, Timed Events, and
Streams tables for the GC. The System, Status, and Ethernet Ports screens are also
accessible from this menu.

Refer to the Using the application functions section of the MON2020 Gas Chromatograph
Software manual for detailed information regarding the Application menu screens.

Application MenuFigure B-35:   

Local operator interface (LOI)
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System ScreenFigure B-36:   

CDT ScreenFigure B-37:   

Local operator interface (LOI)
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TEV - Valve Events ScreenFigure B-38:   

TEV - Integration Events ScreenFigure B-39:   

Local operator interface (LOI)
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TEV - Spectrum Gain Events ScreenFigure B-40:   

TEV - Analysis Time ScreenFigure B-41:   

Local operator interface (LOI)
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Streams ScreenFigure B-42:   

Status ScreenFigure B-43:   

Local operator interface (LOI)
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Ethernet Ports ScreenFigure B-44:   

Local operator interface (LOI)
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B.5.4 Logs/Reports menu
The Logs/Reports menu enables you to view the various reports that are available from the
GC.

Refer to the Logs/Reports section of the MON2020 Gas Chromatograph Software manual for
detailed information regarding the Logs/Reports menu screens.

Logs/Reports MenuFigure B-45:   

Maintenance Log ScreenFigure B-46:   

Local operator interface (LOI)
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Event Logs ScreenFigure B-47:   

Alarm Logs ScreenFigure B-48:   

Local operator interface (LOI)
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Unack Alarms ScreenFigure B-49:   

Active Alarms ScreenFigure B-50:   

Local operator interface (LOI)
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Report Display ScreenFigure B-51:   

B.5.5 Control menu
The Control menu enables you to stop, calibrate, or place on automatic control a sample
stream from the analyzer.

Refer to the Control menu section of the MON2020 Gas Chromatograph Software manual for
detailed information regarding the Control menu screens.

Control MenuFigure B-52:   

Local operator interface (LOI)
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Auto Sequence ScreenFigure B-53:   

The Auto Sequence screen provides selections for Analysis 1, Analysis 2 or Both. Select the
radio button and press ENTER to begin auto sequencing. Press EXIT to abort the process.

Single Stream ScreenFigure B-54:   

The Single Stream screen provides selections for Analysis 1 or Analysis 2. Select the radio
button and press ENTER to begin the analysis. Press EXIT to abort the process.

Local operator interface (LOI)
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Halt ScreenFigure B-55:   

The Halt screen provides selections to halt the analysis for Analysis 1, Analysis 2, or Both.
Select the radio button and press ENTER to halt the current analysis. Press EXIT to abort the
process.

Calibration ScreenFigure B-56:   

The Calibration screen provides selections for Analysis 1 or Analysis 2.

1. Select the radio button and press ENTER.

Local operator interface (LOI)
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2. Select the Calibration Type, Normal or Forced.

3. Press ENTER to begin the calibration.

4. Press EXIT to abort the process.

Validation ScreenFigure B-57:   

The Validation screen provides selections for Analysis 1 or Analysis 2. Select the radio button
and press ENTER to begin the validation. Press EXIT to abort the process.

Local operator interface (LOI)
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Stop Now ScreenFigure B-58:   

The Stop Now screen provides selections for Analysis 1, Analysis 2 or Both. Select the radio button and press
ENTER to stop the analysis. Press EXIT to abort the process

B.5.6 Tools menu
The Tools menu enables you to change the screen control, change a user’s password, and
log off of the GC to which you are connected.

Refer to the Tools menu section of the MON2020 Software for Gas Chromatographs User
Manual for detailed information regarding the Tools menu screens.

Local operator interface (LOI)

170 Rosemount™ 1500XA Gas Chromatograph



Tools menuFigure B-59:   

The Screen Control screenFigure B-60:   

Local operator interface (LOI)
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The Change PIN screenFigure B-61:   

The Diagnostic screenFigure B-62:   

Local operator interface (LOI)
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B.6 Troubleshooting a blank LOI display screen
If the LOI is powered up but the LCD display screen is blank, do the following:

Procedure

1. Power down the gas chromatograph and allow to cool before opening the upper
enclosure door.

2. Unscrew and remove the LOI board.

3. Flip the LOI over to expose its motherboard and associated electronics. Make sure
the J12 connector is tightly connected to the motherboard via ribbon cable.

LOI motherboardFigure B-63:   

If the screen is still blank, replace the board.

For assistance, contact your local Emerson Service Representative.

Local operator interface (LOI)
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Appendix C
Carrier gas installation and maintenance

C.1 Carrier gas
This appendix provides a description of the optional carrier manifold (P/N 2-3-5000-050)
that permits the connection of two carrier gas bottles, or cylinders, to a gas
chromatograph (GC) system. The benefits of this manifold are as follows:

Note
The illustration and information in this appendix are adapted from drawing AE-10098.

• When one bottle is nearly empty (i.e., 100 psig remaining), the other bottle
becomes the primary supply.

• Each bottle can be disconnected for refilling without interrupting GC operation.

Manifold for two carrier gas bottles to GC systemFigure C-1:   
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Valve Carrier gas cylinder Valve description

V-1 Carrier Cylinder 1 Bleed valve

V-2 Carrier Cylinder 1 Block valve

V-3 Carrier Cylinder 2 Block valve

V-4 Carrier Cylinder 2 Bleed valve

C.2 Installation and line purging
To install and purge the dual-bottle carrier gas manifold, proceed as follows:

Procedure

1. Install manifold as shown in Figure C-1. Close all valves and tighten all fittings. Run
tubing to the GC, but do not connect.

2. Back off pressure regulator (counter clockwise) fully.

3. Open cylinder valve for Carrier Cylinder 1.

The pressure indicator will read the cylinder pressure.

4. Open the shut-off valve attached to the carrier regulator.

5. Regulate pressure out of the cylinder to 20 psig, then close the cylinder valve.

6. Open V-1 (bleed valve) and let the carrier gas bleed to atmosphere until both
gauges read 0 psig, then close V-1.

7. Repeat Step 4 and Step 5 twice to purge the line to V-2.

8. Purge the line to V-3 by repeating Step 2 through Step 6; but this time, use bleed
valve V-4 and Carrier Cylinder 2.

9. With valves 1-4 closed, open both cylinder valves and regulate both carriers to
approximately 10 psig.

10. Open V-2 and V-3 simultaneously, then turn both cylinder valves off and let the
carrier gasses bleed through the line to the GC until all gauges read 0 psig.

11. Repeat Step 8 and Step 9 twice to purge the line to the GC.

12. Close V-3, leave V-2 open.

13. Open the cylinder valve of Carrier Cylinder 1 and, with carrier gas flowing at 10 psig
or below, connect the carrier line to the GC.

14. Slowly regulate Carrier Cylinder 1 to 110 psig.

15. Open V-3 and slowly regulate Carrier Cylinder 2 to 100 psig.

By doing this, all but 100 pounds of Carrier Cylinder 1 will be used before any of
Carrier Cylinder 2 is used. When Carrier Cylinder 1 gets to 100 pounds, replace the
cylinder.

16. Leak-check all of the fittings carefully.
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17. Let the GC run overnight before calibrating.

C.3 Replacing carrier cylinder
To replace one carrier cylinder without interrupting GC operation, proceed as follows:

Procedure

1. Turn cylinder valve off.

2. Back off on cylinder pressure regulator until handle turns freely.

3. Remove cylinder.

4. Attach new cylinder to regulator and repeat Step 3 through Step 7 of Section C.2,
using appropriate bleed valve to purge line.

5. Leak-check the fitting.

6. Open the appropriate block valve to the analyzer (V-2 or V-3) and regulate outlet
pressure to appropriate level. (see Step 14 and Step 15 of Section C.2.)

Carrier gas installation and maintenance
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Appendix D
Pre-defined Modbus® Map Files

D.1 Definitions of Terms
Register: Modbus register number

Data type: The following data types are supported:

1. INT - 16-bit integer value

2. FLOAT - 32-bit IEEE single precision floating point value

3. Bitmap (INT) - 16 Boolean values packed into a single 16-bit integer. Each bit
represents one Boolean value.

4. Long - 32-bit long integer value

5. Bitmap (long) - 32 Boolean values packed into a 32-bit long integer. Each bit
represents one Boolean value.

6. SCALED_FP_1 ... SCALED_FP_32 - Scaled floating point data type is also referred to
as Ranged Integers. A 32-bit floating point value is converted to a 16-bit integer. For
more details, refer to Edit Scales.

Variable: System variable that is mapped to a Modbus register.

Record #: This field is applicable only for Archive Average System Variables. The record #
tells the GC which historical average value to retrieve. For example, Record #1 refers to the
most recent average, Record #2 refers to the second most recent average and so on.

Access: Can either be Read only or Read-Write. A small fraction of GC system variables can
be updated from a Modbus Master. Writable registers have to be set to RD_WR in the
mapping before they can be written from a Modbus Master.

Format: This field is applicable for system variables that hold date/time. Date/time is
internally stored in a 32-bit Unix time_t format. The format field is used to convert the
date/time to human readable form. The available format modifiers are:

• MM - 2 digit month (1-12)

• DD - 2 digit day of the month (1-31)

• YY - 2 digit year (0-99)

• YYYY - 4 digit year (1970 - 2038)

• hh - 2 digit hour in 24 hour format (0-23)

• mm - 2 digit minutes (0-59)

• SS - 2 digit seconds (0-59)

• MMDDYY - 6 digit date. If the date is January 4, 2010, the register reads 010410. If
the date is November 7, 2012, the register reads 110712.

Pre-defined Modbus
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• DDMMYY - 6 digit date. If the date is January 4, 2010, the register reads 040110. If
the date is November 7, 2012, the register reads 071112.

• YYMMDD - 6 digit date. If the date is April 17, 2007, the register reads 070417. If the
date is January 31, 2014, the register reads 140131.

• hhmmss - 6 digit time in 24 hour format

• hhmm - 4 digit time in 24 hour format

D.2 SIM2251 map file (with GPA results)

Register # Data Type Variable Record # Access Format

3001 INT Last Analy_Component Code(US)[1 - Component 1] RD_ONLY

3002 INT Last Analy_Component Code(US)[2 - Component 2] RD_ONLY

3003 INT Last Analy_Component Code(US)[3 - Component 3] RD_ONLY

3004 INT Last Analy_Component Code(US)[4 - Component 4] RD_ONLY

3005 INT Last Analy_Component Code(US)[5 - Component 5] RD_ONLY

3006 INT Last Analy_Component Code(US)[6 - Component 6] RD_ONLY

3007 INT Last Analy_Component Code(US)[7 - Component 7] RD_ONLY

3008 INT Last Analy_Component Code(US)[8 - Component 8] RD_ONLY

3009 INT Last Analy_Component Code(US)[9 - Component 9] RD_ONLY

3010 INT Last Analy_Component Code(US)[10 - Component 10] RD_ONLY

3011 INT Last Analy_Component Code(US)[11 - Component 11] RD_ONLY

3012 INT Last Analy_Component Code(US)[12 - Component 12] RD_ONLY

3013 INT Last Analy_Component Code(US)[13 - Component 13] RD_ONLY

3014 INT Last Analy_Component Code(US)[14 - Component 14] RD_ONLY

3015 INT Last Analy_Component Code(US)[15 - Component 15] RD_ONLY

3016 INT Last Analy_Component Code(US)[16 - Component 16] RD_ONLY

3017 INT Last Analy_Component Code(US)[1 - Component 1] RD_ONLY

3018 INT Last Analy_Component Code(US)[2 - Component 2] RD_ONLY

3019 INT Last Analy_Component Code(US)[3 - Component 3] RD_ONLY

3020 INT Last Analy_Component Code(US)[4 - Component 4] RD_ONLY

3021 INT Last Analy_Component Code(US)[5 - Component 5] RD_ONLY

3022 INT Last Analy_Component Code(US)[6 - Component 6] RD_ONLY

3023 INT Last Analy_Component Code(US)[7 - Component 7] RD_ONLY

3024 INT Last Analy_Component Code(US)[8 - Component 8] RD_ONLY

3025 INT Last Analy_Component Code(US)[9 - Component 9] RD_ONLY

3026 INT Last Analy_Component Code(US)[10 - Component 10] RD_ONLY

3027 INT Last Analy_Component Code(US)[11 - Component 11] RD_ONLY
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Register # Data Type Variable Record # Access Format

3028 INT Last Analy_Component Code(US)[12 - Component 12] RD_ONLY

3029 INT Last Analy_Component Code(US)[13 - Component 13] RD_ONLY

3030 INT Last Analy_Component Code(US)[14 - Component 14] RD_ONLY

3031 INT Last Analy_Component Code(US)[15 - Component 15] RD_ONLY

3032 INT Last Analy_Component Code(US)[16 - Component 16] RD_ONLY

3033 INT Run Time(1/30th Sec) RD_ONLY

3034 INT Last Analy_Stream Number RD_ONLY

3035 INT Last Analy_CDT Stream Mask RD_ONLY

3036 INT Current Time(time_t) RD_WR MM

3037 INT Current Time(time_t) RD_WR DD

3038 INT Current Time(time_t) RD_WR YY

3039 INT Current Time(time_t) RD_WR hh

3040 INT Current Time(time_t) RD_WR mm

3041 INT Last Analy_Start Time RD_ONLY MM

3042 INT Last Analy_Start Time RD_ONLY DD

3043 INT Last Analy_Start Time RD_ONLY YY

3044 INT Last Analy_Start Time RD_ONLY hh

3045 INT Last Analy_Start Time RD_ONLY mm
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Register # Data Type Variable Record # Access Format

3046 Bit-
map(INT)

0:Unused,

1:Unused,

2:System Alarm_Alarm On - Last Analysis_Analog In-
put 1 Low Signal,

3:System Alarm_Alarm On - Last Analysis_Analog In-
put 1 High Signal,

4:System Alarm_Alarm On - Last Analysis_Analog In-
put 2 Low Signal,

5:System Alarm_Alarm On - Last Analysis_Analog In-
put 2 High Signal,

6:Unused,

7:Unused,

8:System Alarm_Alarm On - Last Analysis_Analog Out-
put 1 Low Signal,

9:System Alarm_Alarm On - Last Analysis_Analog Out-
put 1 High Signal,

10:System Alarm_Alarm On - Last Analysis_Analog
Output 2 Low Signal,

11:System Alarm_Alarm On - Last Analysis_Analog
Output 2 High Signal,

12:System Alarm_Alarm On - Last Analysis_Analog
Output 3 Low Signal,

13:System Alarm_Alarm On - Last Analysis_Analog
Output 3 High Signal,

14:Analyzer Failure,

15:Unused

RD_ONLY

3047 Bit-
map(INT)

0:System Alarm_Alarm On - Current Analysis_Power
Failure,

1:Calibration Failed,

2:Preamp Failure,

3:Unused,

4:Unused,

5:Unused,

6:Unused,

7:Unused,

8:Unused,

9:Unused,

10:Unused,

11:Unused,

12:Unused,

13:Unused,

14:Unused,

15:Unused

RD_ONLY

3048 INT 1 – Stream 1_Active Low Limit Alarms RD_ONLY
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Register # Data Type Variable Record # Access Format

3049 INT 1 - Stream 1_Active High Limit Alarms RD_ONLY

3050 INT 2 - Stream 2_Active Low Limit Alarms RD_ONLY

3051 INT 2 - Stream 2_Active High Limit Alarms RD_ONLY

3052 INT 3 - Stream 3_Active Low Limit Alarms RD_ONLY

3053 INT 3 - Stream 3_Active High Limit Alarms RD_ONLY

3054 INT 4 - Stream 4_Active Low Limit Alarms RD_ONLY

3055 INT 4 - Stream 4_Active High Limit Alarms RD_ONLY

3056 INT 5 - Stream 5_Active Low Limit Alarms RD_ONLY

3057 INT 5 - Stream 5_Active High Limit Alarms RD_ONLY

3058 INT New Data Flag RD_WR

3059 INT Analy/Calib Flag RD_ONLY

5001 LONG Last Analy_Cycle Time (1/30th sec) RD_ONLY

5002 LONG Last Cal_Cycle Time (1/30th sec) RD_ONLY

7001 FLOAT Last Analy_Mole %[1 - Component 1] RD_ONLY

7002 FLOAT Last Analy_Mole %[2 - Component 2] RD_ONLY

7003 FLOAT Last Analy_Mole %[3 - Component 3] RD_ONLY

7004 FLOAT Last Analy_Mole %[4 - Component 4] RD_ONLY

7005 FLOAT Last Analy_Mole %[5 - Component 5] RD_ONLY

7006 FLOAT Last Analy_Mole %[6 - Component 6] RD_ONLY

7007 FLOAT Last Analy_Mole %[7 - Component 7] RD_ONLY

7008 FLOAT Last Analy_Mole %[8 - Component 8] RD_ONLY

7009 FLOAT Last Analy_Mole %[9 - Component 9] RD_ONLY

7010 FLOAT Last Analy_Mole %[10 - Component 10] RD_ONLY

7011 FLOAT Last Analy_Mole %[11 - Component 11] RD_ONLY

7012 FLOAT Last Analy_Mole %[12 - Component 12] RD_ONLY

7013 FLOAT Last Analy_Mole %[13 - Component 13] RD_ONLY

7014 FLOAT Last Analy_Mole %[14 - Component 14] RD_ONLY

7015 FLOAT Last Analy_Mole %[15 - Component 15] RD_ONLY

7016 FLOAT Last Analy_Mole %[16 - Component 16] RD_ONLY

7017 FLOAT Last Analy_Weight %[1 - Component 1] RD_ONLY

7018 FLOAT Last Analy_Weight %[2 - Component 2] RD_ONLY

7019 FLOAT Last Analy_Weight %[3 - Component 3] RD_ONLY

7020 FLOAT Last Analy_Weight %[4 - Component 4] RD_ONLY

7021 FLOAT Last Analy_Weight %[5 - Component 5] RD_ONLY

7022 FLOAT Last Analy_Weight %[6 - Component 6] RD_ONLY

7023 FLOAT Last Analy_Weight %[7 - Component 7] RD_ONLY

7024 FLOAT Last Analy_Weight %[8 - Component 8] RD_ONLY
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Register # Data Type Variable Record # Access Format

7025 FLOAT Last Analy_Weight %[9 - Component 9] RD_ONLY

7026 FLOAT Last Analy_Weight %[10 - Component 10] RD_ONLY

7027 FLOAT Last Analy_Weight %[11 - Component 11] RD_ONLY

7028 FLOAT Last Analy_Weight %[12 - Component 12] RD_ONLY

7029 FLOAT Last Analy_Weight %[13 - Component 13] RD_ONLY

7030 FLOAT Last Analy_Weight %[14 - Component 14] RD_ONLY

7031 FLOAT Last Analy_Weight %[15 - Component 15] RD_ONLY

7032 FLOAT Last Analy_Weight %[16 - Component 16] RD_ONLY

7033 FLOAT Last Analy_HV Gross BTU Dry RD_ONLY

7034 FLOAT Last Analy_HV Gross BTU Sat RD_ONLY

7035 FLOAT Last Analy_GPA Real Rel Den Gas RD_ONLY

7036 FLOAT Last Analy_GPA Z Factor RD_ONLY

7037 FLOAT Last Analy_GPA Wobbe Index RD_ONLY

7038 FLOAT Last Analy_Total Unnormalized Conc RD_ONLY

7039 FLOAT Last Analy_Gal/1000 SCF C2+ RD_ONLY

7040 FLOAT Calc Result[1 - User Cal 01] RD_ONLY

7041 FLOAT Calc Result[2 - User Cal 02] RD_ONLY

7042 FLOAT Calc Result[3 - User Cal 03] RD_ONLY

7043 FLOAT Calc Result[4 - User Cal 04] RD_ONLY

7044 FLOAT Calc Result[5 - User Cal 05] RD_ONLY

7045 FLOAT Unused RD_ONLY

7046 FLOAT Unused RD_ONLY

7047 FLOAT Unused RD_ONLY

7048 FLOAT Unused RD_ONLY

7049 FLOAT Unused RD_ONLY

7050 FLOAT Unused RD_ONLY

7051 FLOAT Unused RD_ONLY

7052 FLOAT Unused RD_ONLY

7053 FLOAT Unused RD_ONLY

7054 FLOAT Last Analy_HV Gross BTU Act RD_ONLY

7055 FLOAT Avg[1 - Average 1] RD_ONLY

7056 FLOAT Avg[2 - Average 2] RD_ONLY

7057 FLOAT Avg[3 - Average 3] RD_ONLY

7058 FLOAT Avg[4 - Average 4] RD_ONLY

7059 FLOAT Avg[5 - Average 5] RD_ONLY

7060 FLOAT Avg[6 - Average 6] RD_ONLY

7061 FLOAT Avg[7 - Average 7] RD_ONLY
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Register # Data Type Variable Record # Access Format

7062 FLOAT Avg[8 - Average 8] RD_ONLY

7063 FLOAT Avg[9 - Average 9] RD_ONLY

7064 FLOAT Avg[10 - Average 10] RD_ONLY

7065 FLOAT Avg[11 - Average 11] RD_ONLY

7066 FLOAT Avg[12 - Average 12] RD_ONLY

7067 FLOAT Avg[13 - Average 13] RD_ONLY

7068 FLOAT Avg[14 - Average 14] RD_ONLY

7069 FLOAT Avg[15 - Average 15] RD_ONLY

7070 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

7071 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

7072 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

7073 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

7074 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

7075 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

7076 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

7077 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

7078 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY

7079 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

7080 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

7081 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY

7082 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

7083 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

7084 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

7085 FLOAT Current Value[1 - Analog Input 1] RD_ONLY

7086 FLOAT Current Value[2 - Analog Input 2] RD_ONLY

7087 FLOAT Last FCalib_HV Gross BTU Act RD_ONLY

7088 FLOAT Last FCalib_HV Gross BTU Dry RD_ONLY

7089 FLOAT Last FCalib_HV Gross BTU Sat RD_ONLY

7090 FLOAT Last FCalib_GPA Wobbe Index RD_ONLY

7091 FLOAT Last FCalib_GPA Real Rel Den Gas RD_ONLY

7092 FLOAT Last FCalib_GPA Z Factor RD_ONLY

7093 FLOAT Last FCalib_Gal/1000 SCF C2+ RD_ONLY

7094 FLOAT Last FCalib_Total Unnormalized Conc RD_ONLY

7095 FLOAT Last Analy_Response Factor[1 - Component 1] RD_ONLY

7096 FLOAT Last Analy_Response Factor[2 - Component 2] RD_ONLY

7097 FLOAT Last Analy_Response Factor[3 - Component 3] RD_ONLY

7098 FLOAT Last Analy_Response Factor[4 - Component 4] RD_ONLY

Pre-defined Modbus
®

 Map Files

Operations Manual 185



Register # Data Type Variable Record # Access Format

7099 FLOAT Last Analy_Response Factor[5 - Component 5] RD_ONLY

7100 FLOAT Last Analy_Response Factor[6 - Component 6] RD_ONLY

7101 FLOAT Last Analy_Response Factor[7 - Component 7] RD_ONLY

7102 FLOAT Last Analy_Response Factor[8 - Component 8] RD_ONLY

7103 FLOAT Last Analy_Response Factor[9 - Component 9] RD_ONLY

7104 FLOAT Last Analy_Response Factor[10 - Component 10] RD_ONLY

7105 FLOAT Last Analy_Response Factor[11 - Component 11] RD_ONLY

7106 FLOAT Last Analy_Response Factor[12 - Component 12] RD_ONLY

7107 FLOAT Last Analy_Response Factor[13 - Component 13] RD_ONLY

7108 FLOAT Last Analy_Response Factor[14 - Component 14] RD_ONLY

7109 FLOAT Last Analy_Response Factor[15 - Component 15] RD_ONLY

7110 FLOAT Last Analy_Response Factor[16 - Component 16] RD_ONLY

7111 FLOAT Last Analy_Response Factor[1 - Component 1] RD_ONLY

7112 FLOAT Last Analy_Response Factor[2 - Component 2] RD_ONLY

7113 FLOAT Last Analy_Response Factor[3 - Component 3] RD_ONLY

7114 FLOAT Last Analy_Response Factor[4 - Component 4] RD_ONLY

7115 FLOAT Last Analy_Response Factor[5 - Component 5] RD_ONLY

7116 FLOAT Last Analy_Response Factor[6 - Component 6] RD_ONLY

7117 FLOAT Last Analy_Response Factor[7 - Component 7] RD_ONLY

7118 FLOAT Last Analy_Response Factor[8 - Component 8] RD_ONLY

7119 FLOAT Last Analy_Response Factor[9 - Component 9] RD_ONLY

7120 FLOAT Last Analy_Response Factor[10 - Component 10] RD_ONLY

7121 FLOAT Last Analy_Response Factor[11 - Component 11] RD_ONLY

7122 FLOAT Last Analy_Response Factor[12 - Component 12] RD_ONLY

7123 FLOAT Last Analy_Response Factor[13 - Component 13] RD_ONLY

7124 FLOAT Last Analy_Response Factor[14 - Component 14] RD_ONLY

7125 FLOAT Last Analy_Response Factor[15 - Component 15] RD_ONLY

7126 FLOAT Last Analy_Response Factor[16 - Component 16] RD_ONLY

7127 FLOAT Avg[1 - Average 1] RD_ONLY

7128 FLOAT Avg[2 - Average 2] RD_ONLY

7129 FLOAT Avg[3 - Average 3] RD_ONLY

7130 FLOAT Avg[4 - Average 4] RD_ONLY

7131 FLOAT Avg[5 - Average 5] RD_ONLY

7132 FLOAT Avg[6 - Average 6] RD_ONLY

7133 FLOAT Avg[7 - Average 7] RD_ONLY

7134 FLOAT Avg[8 - Average 8] RD_ONLY

7135 FLOAT Avg[9 - Average 9] RD_ONLY

Pre-defined Modbus
®

 Map Files

186 Rosemount™ 1500XA Gas Chromatograph



Register # Data Type Variable Record # Access Format

7136 FLOAT Avg[10 - Average 10] RD_ONLY

7137 FLOAT Avg[11 - Average 11] RD_ONLY

7138 FLOAT Avg[12 - Average 12] RD_ONLY

7139 FLOAT Avg[13 - Average 13] RD_ONLY

7140 FLOAT Avg[14 - Average 14] RD_ONLY

7141 FLOAT Avg[15 - Average 15] RD_ONLY

7142 FLOAT Avg[16 - Average 16] RD_ONLY

7143 FLOAT Avg[17 - Average 17] RD_ONLY

7144 FLOAT Avg[18 - Average 18] RD_ONLY

7145 FLOAT Avg[19 - Average 19] RD_ONLY

7146 FLOAT Avg[20 - Average 20] RD_ONLY

7147 FLOAT Avg[21 - Average 21] RD_ONLY

7148 FLOAT Avg[22 - Average 22] RD_ONLY

7149 FLOAT Avg[23 - Average 23] RD_ONLY

7150 FLOAT Avg[24 - Average 24] RD_ONLY

7151 FLOAT Avg[25 - Average 25] RD_ONLY

7152 FLOAT Avg[26 - Average 26] RD_ONLY

7153 FLOAT Avg[27 - Average 27] RD_ONLY

7154 FLOAT Avg[28 - Average 28] RD_ONLY

7155 FLOAT Avg[29 - Average 29] RD_ONLY

7156 FLOAT Avg[30 - Average 30] RD_ONLY

7157 FLOAT Avg[31 - Average 31] RD_ONLY

7158 FLOAT Avg[32 - Average 32] RD_ONLY

7159 FLOAT Avg[33 - Average 33] RD_ONLY

7160 FLOAT Avg[34 - Average 34] RD_ONLY

7161 FLOAT Avg[35 - Average 35] RD_ONLY

7162 FLOAT Avg[36 - Average 36] RD_ONLY

7163 FLOAT Max[1 - Average 1] RD_ONLY

7164 FLOAT Max[2 - Average 2] RD_ONLY

7165 FLOAT Max[3 - Average 3] RD_ONLY

7166 FLOAT Max[4 - Average 4] RD_ONLY

7167 FLOAT Max[5 - Average 5] RD_ONLY

7168 FLOAT Max[6 - Average 6] RD_ONLY

7169 FLOAT Max[7 - Average 7] RD_ONLY

7170 FLOAT Max[8 - Average 8] RD_ONLY

7171 FLOAT Max[9 - Average 9] RD_ONLY

7172 FLOAT Max[10 - Average 10] RD_ONLY
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7173 FLOAT Max[11 - Average 11] RD_ONLY

7174 FLOAT Max[12 - Average 12] RD_ONLY

7175 FLOAT Max[13 - Average 13] RD_ONLY

7176 FLOAT Max[14 - Average 14] RD_ONLY

7177 FLOAT Max[15 - Average 15] RD_ONLY

7178 FLOAT Max[16 - Average 16] RD_ONLY

7179 FLOAT Max[17 - Average 17] RD_ONLY

7180 FLOAT Max[18 - Average 18] RD_ONLY

7181 FLOAT Max[19 - Average 19] RD_ONLY

7182 FLOAT Max[20 - Average 20] RD_ONLY

7183 FLOAT Max[21 - Average 21] RD_ONLY

7184 FLOAT Max[22 - Average 22] RD_ONLY

7185 FLOAT Max[23 - Average 23] RD_ONLY

7186 FLOAT Max[24 - Average 24] RD_ONLY

7187 FLOAT Max[25 - Average 25] RD_ONLY

7188 FLOAT Max[26 - Average 26] RD_ONLY

7189 FLOAT Max[27 - Average 27] RD_ONLY

7190 FLOAT Max[28 - Average 28] RD_ONLY

7191 FLOAT Max[29 - Average 29] RD_ONLY

7192 FLOAT Max[30 - Average 30] RD_ONLY

7193 FLOAT Max[31 - Average 31] RD_ONLY

7194 FLOAT Max[32 - Average 32] RD_ONLY

7195 FLOAT Max[33 - Average 33] RD_ONLY

7196 FLOAT Max[34 - Average 34] RD_ONLY

7197 FLOAT Max[35 - Average 35] RD_ONLY

7198 FLOAT Max[36 - Average 36] RD_ONLY

7199 FLOAT Min[1 - Average 1] RD_ONLY

7200 FLOAT Min[2 - Average 2] RD_ONLY

7201 FLOAT Min[3 - Average 3] RD_ONLY

7202 FLOAT Min[4 - Average 4] RD_ONLY

7203 FLOAT Min[5 - Average 5] RD_ONLY

7204 FLOAT Min[6 - Average 6] RD_ONLY

7205 FLOAT Min[7 - Average 7] RD_ONLY

7206 FLOAT Min[8 - Average 8] RD_ONLY

7207 FLOAT Min[9 - Average 9] RD_ONLY

7208 FLOAT Min[10 - Average 10] RD_ONLY

7209 FLOAT Min[11 - Average 11] RD_ONLY
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7210 FLOAT Min[12 - Average 12] RD_ONLY

7211 FLOAT Min[13 - Average 13] RD_ONLY

7212 FLOAT Min[14 - Average 14] RD_ONLY

7213 FLOAT Min[15 - Average 15] RD_ONLY

7214 FLOAT Min[16 - Average 16] RD_ONLY

7215 FLOAT Min[17 - Average 17] RD_ONLY

7216 FLOAT Min[18 - Average 18] RD_ONLY

7217 FLOAT Min[19 - Average 19] RD_ONLY

7218 FLOAT Min[20 - Average 20] RD_ONLY

7219 FLOAT Min[21 - Average 21] RD_ONLY

7220 FLOAT Min[22 - Average 22] RD_ONLY

7221 FLOAT Min[23 - Average 23] RD_ONLY

7222 FLOAT Min[24 - Average 24] RD_ONLY

7223 FLOAT Min[25 - Average 25] RD_ONLY

7224 FLOAT Min[26 - Average 26] RD_ONLY

7225 FLOAT Min[27 - Average 27] RD_ONLY

7226 FLOAT Min[28 - Average 28] RD_ONLY

7227 FLOAT Min[29 - Average 29] RD_ONLY

7228 FLOAT Min[30 - Average 30] RD_ONLY

7229 FLOAT Min[31 - Average 31] RD_ONLY

7230 FLOAT Min[32 - Average 32] RD_ONLY

7231 FLOAT Min[33 - Average 33] RD_ONLY

7232 FLOAT Min[34 - Average 34] RD_ONLY

7233 FLOAT Min[35 - Average 35] RD_ONLY

7234 FLOAT Min[36 - Average 36] RD_ONLY

7235 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

7236 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

7237 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

7238 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

7239 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

7240 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

7241 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

7242 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

7243 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY

7244 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

7245 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

7246 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY
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7247 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

7248 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

7249 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

7250 FLOAT Archive_Avg[16 - Average 16] 1 RD_ONLY

7251 FLOAT Archive_Avg[17 - Average 17] 1 RD_ONLY

7252 FLOAT Archive_Avg[18 - Average 18] 1 RD_ONLY

7253 FLOAT Archive_Avg[19 - Average 19] 1 RD_ONLY

7254 FLOAT Archive_Avg[20 - Average 20] 1 RD_ONLY

7255 FLOAT Archive_Avg[21 - Average 21] 1 RD_ONLY

7256 FLOAT Archive_Avg[22 - Average 22] 1 RD_ONLY

7257 FLOAT Archive_Avg[23 - Average 23] 1 RD_ONLY

7258 FLOAT Archive_Avg[24 - Average 24] 1 RD_ONLY

7259 FLOAT Archive_Avg[25 - Average 25] 1 RD_ONLY

7260 FLOAT Archive_Avg[26 - Average 26] 1 RD_ONLY

7261 FLOAT Archive_Avg[27 - Average 27] 1 RD_ONLY

7262 FLOAT Archive_Avg[28 - Average 28] 1 RD_ONLY

7263 FLOAT Archive_Avg[29 - Average 29] 1 RD_ONLY

7264 FLOAT Archive_Avg[30 - Average 30] 1 RD_ONLY

7265 FLOAT Archive_Avg[31 - Average 31] 1 RD_ONLY

7266 FLOAT Archive_Avg[32 - Average 32] 1 RD_ONLY

7267 FLOAT Archive_Avg[33 - Average 33] 1 RD_ONLY

7268 FLOAT Archive_Avg[34 - Average 34] 1 RD_ONLY

7269 FLOAT Archive_Avg[35 - Average 35] 1 RD_ONLY

7270 FLOAT Archive_Avg[36 - Average 36] 1 RD_ONLY

7271 FLOAT Archive_Max[1 - Average 1] 1 RD_ONLY

7272 FLOAT Archive_Max[2 - Average 2] 1 RD_ONLY

7273 FLOAT Archive_Max[3 - Average 3] 1 RD_ONLY

7274 FLOAT Archive_Max[4 - Average 4] 1 RD_ONLY

7275 FLOAT Archive_Max[5 - Average 5] 1 RD_ONLY

7276 FLOAT Archive_Max[6 - Average 6] 1 RD_ONLY

7277 FLOAT Archive_Max[7 - Average 7] 1 RD_ONLY

7278 FLOAT Archive_Max[8 - Average 8] 1 RD_ONLY

7279 FLOAT Archive_Max[9 - Average 9] 1 RD_ONLY

7280 FLOAT Archive_Max[10 - Average 10] 1 RD_ONLY

7281 FLOAT Archive_Max[11 - Average 11] 1 RD_ONLY

7282 FLOAT Archive_Max[12 - Average 12] 1 RD_ONLY

7283 FLOAT Archive_Max[13 - Average 13] 1 RD_ONLY
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7284 FLOAT Archive_Max[14 - Average 14] 1 RD_ONLY

7285 FLOAT Archive_Max[15 - Average 15] 1 RD_ONLY

7286 FLOAT Archive_Max[16 - Average 16] 1 RD_ONLY

7287 FLOAT Archive_Max[17 - Average 17] 1 RD_ONLY

7288 FLOAT Archive_Max[18 - Average 18] 1 RD_ONLY

7289 FLOAT Archive_Max[19 - Average 19] 1 RD_ONLY

7290 FLOAT Archive_Max[20 - Average 20] 1 RD_ONLY

7291 FLOAT Archive_Max[21 - Average 21] 1 RD_ONLY

7292 FLOAT Archive_Max[22 - Average 22] 1 RD_ONLY

7293 FLOAT Archive_Max[23 - Average 23] 1 RD_ONLY

7294 FLOAT Archive_Max[24 - Average 24] 1 RD_ONLY

7295 FLOAT Archive_Max[25 - Average 25] 1 RD_ONLY

7296 FLOAT Archive_Max[26 - Average 26] 1 RD_ONLY

7297 FLOAT Archive_Max[27 - Average 27] 1 RD_ONLY

7298 FLOAT Archive_Max[28 - Average 28] 1 RD_ONLY

7299 FLOAT Archive_Max[29 - Average 29] 1 RD_ONLY

7300 FLOAT Archive_Max[30 - Average 30] 1 RD_ONLY

7301 FLOAT Archive_Max[31 - Average 31] 1 RD_ONLY

7302 FLOAT Archive_Max[32 - Average 32] 1 RD_ONLY

7303 FLOAT Archive_Max[33 - Average 33] 1 RD_ONLY

7304 FLOAT Archive_Max[34 - Average 34] 1 RD_ONLY

7305 FLOAT Archive_Max[35 - Average 35] 1 RD_ONLY

7306 FLOAT Archive_Max[36 - Average 36] 1 RD_ONLY

7307 FLOAT Archive_Min[1 - Average 1] 1 RD_ONLY

7308 FLOAT Archive_Min[2 - Average 2] 1 RD_ONLY

7309 FLOAT Archive_Min[3 - Average 3] 1 RD_ONLY

7310 FLOAT Archive_Min[4 - Average 4] 1 RD_ONLY

7311 FLOAT Archive_Min[5 - Average 5] 1 RD_ONLY

7312 FLOAT Archive_Min[6 - Average 6] 1 RD_ONLY

7313 FLOAT Archive_Min[7 - Average 7] 1 RD_ONLY

7314 FLOAT Archive_Min[8 - Average 8] 1 RD_ONLY

7315 FLOAT Archive_Min[9 - Average 9] 1 RD_ONLY

7316 FLOAT Archive_Min[10 - Average 10] 1 RD_ONLY

7317 FLOAT Archive_Min[11 - Average 11] 1 RD_ONLY

7318 FLOAT Archive_Min[12 - Average 12] 1 RD_ONLY

7319 FLOAT Archive_Min[13 - Average 13] 1 RD_ONLY

7320 FLOAT Archive_Min[14 - Average 14] 1 RD_ONLY
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7321 FLOAT Archive_Min[15 - Average 15] 1 RD_ONLY

7322 FLOAT Archive_Min[16 - Average 16] 1 RD_ONLY

7323 FLOAT Archive_Min[17 - Average 17] 1 RD_ONLY

7324 FLOAT Archive_Min[18 - Average 18] 1 RD_ONLY

7325 FLOAT Archive_Min[19 - Average 19] 1 RD_ONLY

7326 FLOAT Archive_Min[20 - Average 20] 1 RD_ONLY

7327 FLOAT Archive_Min[21 - Average 21] 1 RD_ONLY

7328 FLOAT Archive_Min[22 - Average 22] 1 RD_ONLY

7329 FLOAT Archive_Min[23 - Average 23] 1 RD_ONLY

7330 FLOAT Archive_Min[24 - Average 24] 1 RD_ONLY

7331 FLOAT Archive_Min[25 - Average 25] 1 RD_ONLY

7332 FLOAT Archive_Min[26 - Average 26] 1 RD_ONLY

7333 FLOAT Archive_Min[27 - Average 27] 1 RD_ONLY

7334 FLOAT Archive_Min[28 - Average 28] 1 RD_ONLY

7335 FLOAT Archive_Min[29 - Average 29] 1 RD_ONLY

7336 FLOAT Archive_Min[30 - Average 30] 1 RD_ONLY

7337 FLOAT Archive_Min[31 - Average 31] 1 RD_ONLY

7338 FLOAT Archive_Min[32 - Average 32] 1 RD_ONLY

7339 FLOAT Archive_Min[33 - Average 33] 1 RD_ONLY

7340 FLOAT Archive_Min[34 - Average 34] 1 RD_ONLY

7341 FLOAT Archive_Min[35 - Average 35] 1 RD_ONLY

7342 FLOAT Archive_Min[36 - Average 36] 1 RD_ONLY

7343 FLOAT Archive_Avg[1 - Average 1] 2 RD_ONLY

7344 FLOAT Archive_Avg[2 - Average 2] 2 RD_ONLY

7345 FLOAT Archive_Avg[3 - Average 3] 2 RD_ONLY

7346 FLOAT Archive_Avg[4 - Average 4] 2 RD_ONLY

7347 FLOAT Archive_Avg[5 - Average 5] 2 RD_ONLY

7348 FLOAT Archive_Avg[6 - Average 6] 2 RD_ONLY

7349 FLOAT Archive_Avg[7 - Average 7] 2 RD_ONLY

7350 FLOAT Archive_Avg[8 - Average 8] 2 RD_ONLY

7351 FLOAT Archive_Avg[9 - Average 9] 2 RD_ONLY

7352 FLOAT Archive_Avg[10 - Average 10] 2 RD_ONLY

7353 FLOAT Archive_Avg[11 - Average 11] 2 RD_ONLY

7354 FLOAT Archive_Avg[12 - Average 12] 2 RD_ONLY

7355 FLOAT Archive_Avg[13 - Average 13] 2 RD_ONLY

7356 FLOAT Archive_Avg[14 - Average 14] 2 RD_ONLY

7357 FLOAT Archive_Avg[15 - Average 15] 2 RD_ONLY
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7358 FLOAT Archive_Avg[16 - Average 16] 2 RD_ONLY

7359 FLOAT Archive_Avg[17 - Average 17] 2 RD_ONLY

7360 FLOAT Archive_Avg[18 - Average 18] 2 RD_ONLY

7361 FLOAT Archive_Avg[19 - Average 19] 2 RD_ONLY

7362 FLOAT Archive_Avg[20 - Average 20] 2 RD_ONLY

7363 FLOAT Archive_Avg[21 - Average 21] 2 RD_ONLY

7364 FLOAT Archive_Avg[22 - Average 22] 2 RD_ONLY

7365 FLOAT Archive_Avg[23 - Average 23] 2 RD_ONLY

7366 FLOAT Archive_Avg[24 - Average 24] 2 RD_ONLY

7367 FLOAT Archive_Avg[25 - Average 25] 2 RD_ONLY

7368 FLOAT Archive_Avg[26 - Average 26] 2 RD_ONLY

7369 FLOAT Archive_Avg[27 - Average 27] 2 RD_ONLY

7370 FLOAT Archive_Avg[28 - Average 28] 2 RD_ONLY

7371 FLOAT Archive_Avg[29 - Average 29] 2 RD_ONLY

7372 FLOAT Archive_Avg[30 - Average 30] 2 RD_ONLY

7373 FLOAT Archive_Avg[31 - Average 31] 2 RD_ONLY

7374 FLOAT Archive_Avg[32 - Average 32] 2 RD_ONLY

7375 FLOAT Archive_Avg[33 - Average 33] 2 RD_ONLY

7376 FLOAT Archive_Avg[34 - Average 34] 2 RD_ONLY

7377 FLOAT Archive_Avg[35 - Average 35] 2 RD_ONLY

7378 FLOAT Archive_Avg[36 - Average 36] 2 RD_ONLY

7379 FLOAT Archive_Max[1 - Average 1] 2 RD_ONLY

7380 FLOAT Archive_Max[2 - Average 2] 2 RD_ONLY

7381 FLOAT Archive_Max[3 - Average 3] 2 RD_ONLY

7382 FLOAT Archive_Max[4 - Average 4] 2 RD_ONLY

7383 FLOAT Archive_Max[5 - Average 5] 2 RD_ONLY

7384 FLOAT Archive_Max[6 - Average 6] 2 RD_ONLY

7385 FLOAT Archive_Max[7 - Average 7] 2 RD_ONLY

7386 FLOAT Archive_Max[8 - Average 8] 2 RD_ONLY

7387 FLOAT Archive_Max[9 - Average 9] 2 RD_ONLY

7388 FLOAT Archive_Max[10 - Average 10] 2 RD_ONLY

7389 FLOAT Archive_Max[11 - Average 11] 2 RD_ONLY

7390 FLOAT Archive_Max[12 - Average 12] 2 RD_ONLY

7391 FLOAT Archive_Max[13 - Average 13] 2 RD_ONLY

7392 FLOAT Archive_Max[14 - Average 14] 2 RD_ONLY

7393 FLOAT Archive_Max[15 - Average 15] 2 RD_ONLY

7394 FLOAT Archive_Max[16 - Average 16] 2 RD_ONLY

Pre-defined Modbus
®

 Map Files

Operations Manual 193



Register # Data Type Variable Record # Access Format

7395 FLOAT Archive_Max[17 - Average 17] 2 RD_ONLY

7396 FLOAT Archive_Max[18 - Average 18] 2 RD_ONLY

7397 FLOAT Archive_Max[19 - Average 19] 2 RD_ONLY

7398 FLOAT Archive_Max[20 - Average 20] 2 RD_ONLY

7399 FLOAT Archive_Max[21 - Average 21] 2 RD_ONLY

7400 FLOAT Archive_Max[22 - Average 22] 2 RD_ONLY

7401 FLOAT Archive_Max[23 - Average 23] 2 RD_ONLY

7402 FLOAT Archive_Max[24 - Average 24] 2 RD_ONLY

7403 FLOAT Archive_Max[25 - Average 25] 2 RD_ONLY

7404 FLOAT Archive_Max[26 - Average 26] 2 RD_ONLY

7405 FLOAT Archive_Max[27 - Average 27] 2 RD_ONLY

7406 FLOAT Archive_Max[28 - Average 28] 2 RD_ONLY

7407 FLOAT Archive_Max[29 - Average 29] 2 RD_ONLY

7408 FLOAT Archive_Max[30 - Average 30] 2 RD_ONLY

7409 FLOAT Archive_Max[31 - Average 31] 2 RD_ONLY

7410 FLOAT Archive_Max[32 - Average 32] 2 RD_ONLY

7411 FLOAT Archive_Max[33 - Average 33] 2 RD_ONLY

7412 FLOAT Archive_Max[34 - Average 34] 2 RD_ONLY

7413 FLOAT Archive_Max[35 - Average 35] 2 RD_ONLY

7414 FLOAT Archive_Max[36 - Average 36] 2 RD_ONLY

7415 FLOAT Archive_Min[1 - Average 1] 2 RD_ONLY

7416 FLOAT Archive_Min[2 - Average 2] 2 RD_ONLY

7417 FLOAT Archive_Min[3 - Average 3] 2 RD_ONLY

7418 FLOAT Archive_Min[4 - Average 4] 2 RD_ONLY

7419 FLOAT Archive_Min[5 - Average 5] 2 RD_ONLY

7420 FLOAT Archive_Min[6 - Average 6] 2 RD_ONLY

7421 FLOAT Archive_Min[7 - Average 7] 2 RD_ONLY

7422 FLOAT Archive_Min[8 - Average 8] 2 RD_ONLY

7423 FLOAT Archive_Min[9 - Average 9] 2 RD_ONLY

7424 FLOAT Archive_Min[10 - Average 10] 2 RD_ONLY

7425 FLOAT Archive_Min[11 - Average 11] 2 RD_ONLY

7426 FLOAT Archive_Min[12 - Average 12] 2 RD_ONLY

7427 FLOAT Archive_Min[13 - Average 13] 2 RD_ONLY

7428 FLOAT Archive_Min[14 - Average 14] 2 RD_ONLY

7429 FLOAT Archive_Min[15 - Average 15] 2 RD_ONLY

7430 FLOAT Archive_Min[16 - Average 16] 2 RD_ONLY

7431 FLOAT Archive_Min[17 - Average 17] 2 RD_ONLY

Pre-defined Modbus
®

 Map Files

194 Rosemount™ 1500XA Gas Chromatograph



Register # Data Type Variable Record # Access Format

7432 FLOAT Archive_Min[18 - Average 18] 2 RD_ONLY

7433 FLOAT Archive_Min[19 - Average 19] 2 RD_ONLY

7434 FLOAT Archive_Min[20 - Average 20] 2 RD_ONLY

7435 FLOAT Archive_Min[21 - Average 21] 2 RD_ONLY

7436 FLOAT Archive_Min[22 - Average 22] 2 RD_ONLY

7437 FLOAT Archive_Min[23 - Average 23] 2 RD_ONLY

7438 FLOAT Archive_Min[24 - Average 24] 2 RD_ONLY

7439 FLOAT Archive_Min[25 - Average 25] 2 RD_ONLY

7440 FLOAT Archive_Min[26 - Average 26] 2 RD_ONLY

7441 FLOAT Archive_Min[27 - Average 27] 2 RD_ONLY

7442 FLOAT Archive_Min[28 - Average 28] 2 RD_ONLY

7443 FLOAT Archive_Min[29 - Average 29] 2 RD_ONLY

7444 FLOAT Archive_Min[30 - Average 30] 2 RD_ONLY

7445 FLOAT Archive_Min[31 - Average 31] 2 RD_ONLY

7446 FLOAT Archive_Min[32 - Average 32] 2 RD_ONLY

7447 FLOAT Archive_Min[33 - Average 33] 2 RD_ONLY

7448 FLOAT Archive_Min[34 - Average 34] 2 RD_ONLY

7449 FLOAT Archive_Min[35 - Average 35] 2 RD_ONLY

7450 FLOAT Archive_Min[36 - Average 36] 2 RD_ONLY

7451 FLOAT Archive_Avg[1 - Average 1] 3 RD_ONLY

7452 FLOAT Archive_Avg[2 - Average 2] 3 RD_ONLY

7453 FLOAT Archive_Avg[3 - Average 3] 3 RD_ONLY

7454 FLOAT Archive_Avg[4 - Average 4] 3 RD_ONLY

7455 FLOAT Archive_Avg[5 - Average 5] 3 RD_ONLY

7456 FLOAT Archive_Avg[6 - Average 6] 3 RD_ONLY

7457 FLOAT Archive_Avg[7 - Average 7] 3 RD_ONLY

7458 FLOAT Archive_Avg[8 - Average 8] 3 RD_ONLY

7459 FLOAT Archive_Avg[9 - Average 9] 3 RD_ONLY

7460 FLOAT Archive_Avg[10 - Average 10] 3 RD_ONLY

7461 FLOAT Archive_Avg[11 - Average 11] 3 RD_ONLY

7462 FLOAT Archive_Avg[12 - Average 12] 3 RD_ONLY

7463 FLOAT Archive_Avg[13 - Average 13] 3 RD_ONLY

7464 FLOAT Archive_Avg[14 - Average 14] 3 RD_ONLY

7465 FLOAT Archive_Avg[15 - Average 15] 3 RD_ONLY

7466 FLOAT Archive_Avg[16 - Average 16] 3 RD_ONLY

7467 FLOAT Archive_Avg[17 - Average 17] 3 RD_ONLY

7468 FLOAT Archive_Avg[18 - Average 18] 3 RD_ONLY
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7469 FLOAT Archive_Avg[19 - Average 19] 3 RD_ONLY

7470 FLOAT Archive_Avg[20 - Average 20] 3 RD_ONLY

7471 FLOAT Archive_Avg[21 - Average 21] 3 RD_ONLY

7472 FLOAT Archive_Avg[22 - Average 22] 3 RD_ONLY

7473 FLOAT Archive_Avg[23 - Average 23] 3 RD_ONLY

7474 FLOAT Archive_Avg[24 - Average 24] 3 RD_ONLY

7475 FLOAT Archive_Avg[25 - Average 25] 3 RD_ONLY

7476 FLOAT Archive_Avg[26 - Average 26] 3 RD_ONLY

7477 FLOAT Archive_Avg[27 - Average 27] 3 RD_ONLY

7478 FLOAT Archive_Avg[28 - Average 28] 3 RD_ONLY

7479 FLOAT Archive_Avg[29 - Average 29] 3 RD_ONLY

7480 FLOAT Archive_Avg[30 - Average 30] 3 RD_ONLY

7481 FLOAT Archive_Avg[31 - Average 31] 3 RD_ONLY

7482 FLOAT Archive_Avg[32 - Average 32] 3 RD_ONLY

7483 FLOAT Archive_Avg[33 - Average 33] 3 RD_ONLY

7484 FLOAT Archive_Avg[34 - Average 34] 3 RD_ONLY

7485 FLOAT Archive_Avg[35 - Average 35] 3 RD_ONLY

7486 FLOAT Archive_Avg[36 - Average 36] 3 RD_ONLY

7487 FLOAT Archive_Max[1 - Average 1] 3 RD_ONLY

7488 FLOAT Archive_Max[2 - Average 2] 3 RD_ONLY

7489 FLOAT Archive_Max[3 - Average 3] 3 RD_ONLY

7490 FLOAT Archive_Max[4 - Average 4] 3 RD_ONLY

7491 FLOAT Archive_Max[5 - Average 5] 3 RD_ONLY

7492 FLOAT Archive_Max[6 - Average 6] 3 RD_ONLY

7493 FLOAT Archive_Max[7 - Average 7] 3 RD_ONLY

7494 FLOAT Archive_Max[8 - Average 8] 3 RD_ONLY

7495 FLOAT Archive_Max[9 - Average 9] 3 RD_ONLY

7496 FLOAT Archive_Max[10 - Average 10] 3 RD_ONLY

7497 FLOAT Archive_Max[11 - Average 11] 3 RD_ONLY

7498 FLOAT Archive_Max[12 - Average 12] 3 RD_ONLY

7499 FLOAT Archive_Max[13 - Average 13] 3 RD_ONLY

7500 FLOAT Archive_Max[14 - Average 14] 3 RD_ONLY

7501 FLOAT Archive_Max[15 - Average 15] 3 RD_ONLY

7502 FLOAT Archive_Max[16 - Average 16] 3 RD_ONLY

7503 FLOAT Archive_Max[17 - Average 17] 3 RD_ONLY

7504 FLOAT Archive_Max[18 - Average 18] 3 RD_ONLY

7505 FLOAT Archive_Max[19 - Average 19] 3 RD_ONLY
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7506 FLOAT Archive_Max[20 - Average 20] 3 RD_ONLY

7507 FLOAT Archive_Max[21 - Average 21] 3 RD_ONLY

7508 FLOAT Archive_Max[22 - Average 22] 3 RD_ONLY

7509 FLOAT Archive_Max[23 - Average 23] 3 RD_ONLY

7510 FLOAT Archive_Max[24 - Average 24] 3 RD_ONLY

7511 FLOAT Archive_Max[25 - Average 25] 3 RD_ONLY

7512 FLOAT Archive_Max[26 - Average 26] 3 RD_ONLY

7513 FLOAT Archive_Max[27 - Average 27] 3 RD_ONLY

7514 FLOAT Archive_Max[28 - Average 28] 3 RD_ONLY

7515 FLOAT Archive_Max[29 - Average 29] 3 RD_ONLY

7516 FLOAT Archive_Max[30 - Average 30] 3 RD_ONLY

7517 FLOAT Archive_Max[31 - Average 31] 3 RD_ONLY

7518 FLOAT Archive_Max[32 - Average 32] 3 RD_ONLY

7519 FLOAT Archive_Max[33 - Average 33] 3 RD_ONLY

7520 FLOAT Archive_Max[34 - Average 34] 3 RD_ONLY

7521 FLOAT Archive_Max[35 - Average 35] 3 RD_ONLY

7522 FLOAT Archive_Max[36 - Average 36] 3 RD_ONLY

7523 FLOAT Archive_Min[1 - Average 1] 3 RD_ONLY

7524 FLOAT Archive_Min[2 - Average 2] 3 RD_ONLY

7525 FLOAT Archive_Min[3 - Average 3] 3 RD_ONLY

7526 FLOAT Archive_Min[4 - Average 4] 3 RD_ONLY

7527 FLOAT Archive_Min[5 - Average 5] 3 RD_ONLY

7528 FLOAT Archive_Min[6 - Average 6] 3 RD_ONLY

7529 FLOAT Archive_Min[7 - Average 7] 3 RD_ONLY

7530 FLOAT Archive_Min[8 - Average 8] 3 RD_ONLY

7531 FLOAT Archive_Min[9 - Average 9] 3 RD_ONLY

7532 FLOAT Archive_Min[10 - Average 10] 3 RD_ONLY

7533 FLOAT Archive_Min[11 - Average 11] 3 RD_ONLY

7534 FLOAT Archive_Min[12 - Average 12] 3 RD_ONLY

7535 FLOAT Archive_Min[13 - Average 13] 3 RD_ONLY

7536 FLOAT Archive_Min[14 - Average 14] 3 RD_ONLY

7537 FLOAT Archive_Min[15 - Average 15] 3 RD_ONLY

7538 FLOAT Archive_Min[16 - Average 16] 3 RD_ONLY

7539 FLOAT Archive_Min[17 - Average 17] 3 RD_ONLY

7540 FLOAT Archive_Min[18 - Average 18] 3 RD_ONLY

7541 FLOAT Archive_Min[19 - Average 19] 3 RD_ONLY

7542 FLOAT Archive_Min[20 - Average 20] 3 RD_ONLY
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7543 FLOAT Archive_Min[21 - Average 21] 3 RD_ONLY

7544 FLOAT Archive_Min[22 - Average 22] 3 RD_ONLY

7545 FLOAT Archive_Min[23 - Average 23] 3 RD_ONLY

7546 FLOAT Archive_Min[24 - Average 24] 3 RD_ONLY

7547 FLOAT Archive_Min[25 - Average 25] 3 RD_ONLY

7548 FLOAT Archive_Min[26 - Average 26] 3 RD_ONLY

7549 FLOAT Archive_Min[27 - Average 27] 3 RD_ONLY

7550 FLOAT Archive_Min[28 - Average 28] 3 RD_ONLY

7551 FLOAT Archive_Min[29 - Average 29] 3 RD_ONLY

7552 FLOAT Archive_Min[30 - Average 30] 3 RD_ONLY

7553 FLOAT Archive_Min[31 - Average 31] 3 RD_ONLY

7554 FLOAT Archive_Min[32 - Average 32] 3 RD_ONLY

7555 FLOAT Archive_Min[33 - Average 33] 3 RD_ONLY

7556 FLOAT Archive_Min[34 - Average 34] 3 RD_ONLY

7557 FLOAT Archive_Min[35 - Average 35] 3 RD_ONLY

7558 FLOAT Archive_Min[36 - Average 36] 3 RD_ONLY

7560 FLOAT Current Value[1 - Analog Input 1] RD_ONLY

7561 FLOAT Current Value[2 - Analog Input 2] RD_ONLY

7562 FLOAT Current Value[3] RD_ONLY

7563 FLOAT Current Value[4] RD_ONLY

7564 FLOAT Current Value[1 - Analog Input 1] RD_ONLY

7565 FLOAT Current Value[2 - Analog Input 2] RD_ONLY

7566 FLOAT Current Value[3] RD_ONLY

7567 FLOAT Current Value[4] RD_ONLY

7621 FLOAT 1 - Stream 1_Start Time RD_ONLY YYMMDD

7622 FLOAT 1 - Stream 1_Start Time RD_ONLY hhmmss

7623 FLOAT 1 - Stream 1_Mole %[1 - Component 1] RD_ONLY

7624 FLOAT 1 - Stream 1_Mole %[2 - Component 2] RD_ONLY

7625 FLOAT 1 - Stream 1_Mole %[3 - Component 3] RD_ONLY

7626 FLOAT 1 - Stream 1_Mole %[4 - Component 4] RD_ONLY

7627 FLOAT 1 - Stream 1_Mole %[5 - Component 5] RD_ONLY

7628 FLOAT 1 - Stream 1_Mole %[6 - Component 6] RD_ONLY

7629 FLOAT 1 - Stream 1_Mole %[7 - Component 7] RD_ONLY

7630 FLOAT 1 - Stream 1_Mole %[8 - Component 8] RD_ONLY

7631 FLOAT 1 - Stream 1_Mole %[9 - Component 9] RD_ONLY

7632 FLOAT 1 - Stream 1_Mole %[10 - Component 10] RD_ONLY

7633 FLOAT 1 - Stream 1_Mole %[11 - Component 11] RD_ONLY
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7634 FLOAT 1 - Stream 1_Mole %[12 - Component 12] RD_ONLY

7635 FLOAT 1 - Stream 1_Mole %[13 - Component 13] RD_ONLY

7636 FLOAT 1 - Stream 1_Mole %[14 - Component 14] RD_ONLY

7637 FLOAT 1 - Stream 1_Mole %[15 - Component 15] RD_ONLY

7638 FLOAT 1 - Stream 1_Mole %[16 - Component 16] RD_ONLY

7639 FLOAT 1 - Stream 1_Mole %[17 - Component 17] RD_ONLY

7640 FLOAT 1 - Stream 1_Mole %[18 - Component 18] RD_ONLY

7641 FLOAT 1 - Stream 1_Mole %[19 - Component 19] RD_ONLY

7642 FLOAT 1 - Stream 1_Mole %[20 - Component 20] RD_ONLY

7643 FLOAT 1 - Stream 1_HV Gross BTU Dry RD_ONLY

7644 FLOAT 1 - Stream 1_GPA Real Rel Den Gas RD_ONLY

7645 FLOAT 1 - Stream 1_GPA Z Factor RD_ONLY

7646 FLOAT 1 - Stream 1_Total Unnormalized Conc RD_ONLY

7647 FLOAT Unused RD_ONLY

7648 FLOAT Unused RD_ONLY

7649 FLOAT Unused RD_ONLY

7650 FLOAT Unused RD_ONLY

7651 FLOAT 2 - Stream 2_Start Time RD_ONLY YYMMDD

7652 FLOAT 2 - Stream 2_Start Time RD_ONLY hhmmss

7653 FLOAT 2 - Stream 2_Mole %[1 - Component 1] RD_ONLY

7654 FLOAT 2 - Stream 2_Mole %[2 - Component 2] RD_ONLY

7655 FLOAT 2 - Stream 2_Mole %[3 - Component 3] RD_ONLY

7656 FLOAT 2 - Stream 2_Mole %[4 - Component 4] RD_ONLY

7657 FLOAT 2 - Stream 2_Mole %[5 - Component 5] RD_ONLY

7658 FLOAT 2 - Stream 2_Mole %[6 - Component 6] RD_ONLY

7659 FLOAT 2 - Stream 2_Mole %[7 - Component 7] RD_ONLY

7660 FLOAT 2 - Stream 2_Mole %[8 - Component 8] RD_ONLY

7661 FLOAT 2 - Stream 2_Mole %[9 - Component 9] RD_ONLY

7662 FLOAT 2 - Stream 2_Mole %[10 - Component 10] RD_ONLY

7663 FLOAT 2 - Stream 2_Mole %[11 - Component 11] RD_ONLY

7664 FLOAT 2 - Stream 2_Mole %[12 - Component 12] RD_ONLY

7665 FLOAT 2 - Stream 2_Mole %[13 - Component 13] RD_ONLY

7666 FLOAT 2 - Stream 2_Mole %[14 - Component 14] RD_ONLY

7667 FLOAT 2 - Stream 2_Mole %[15 - Component 15] RD_ONLY

7668 FLOAT 2 - Stream 2_Mole %[16 - Component 16] RD_ONLY

7669 FLOAT 2 - Stream 2_Mole %[17 - Component 17] RD_ONLY

7670 FLOAT 2 - Stream 2_Mole %[18 - Component 18] RD_ONLY
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7671 FLOAT 2 - Stream 2_Mole %[19 - Component 19] RD_ONLY

7672 FLOAT 2 - Stream 2_Mole %[20 - Component 20] RD_ONLY

7673 FLOAT 2 - Stream 2_HV Gross BTU Dry RD_ONLY

7674 FLOAT 2 - Stream 2_GPA Real Rel Den Gas RD_ONLY

7675 FLOAT 2 - Stream 2_GPA Z Factor RD_ONLY

7676 FLOAT 2 - Stream 2_Total Unnormalized Conc RD_ONLY

7677 FLOAT Unused RD_ONLY

7678 FLOAT Unused RD_ONLY

7679 FLOAT Unused RD_ONLY

7680 FLOAT Unused RD_ONLY

7681 FLOAT 3 - Stream 3_Start Time RD_ONLY YYMMDD

7682 FLOAT 3 - Stream 3_Start Time RD_ONLY hhmmss

7683 FLOAT 3 - Stream 3_Mole %[1 - Component 1] RD_ONLY

7684 FLOAT 3 - Stream 3_Mole %[2 - Component 2] RD_ONLY

7685 FLOAT 3 - Stream 3_Mole %[3 - Component 3] RD_ONLY

7686 FLOAT 3 - Stream 3_Mole %[4 - Component 4] RD_ONLY

7687 FLOAT 3 - Stream 3_Mole %[5 - Component 5] RD_ONLY

7688 FLOAT 3 - Stream 3_Mole %[6 - Component 6] RD_ONLY

7689 FLOAT 3 - Stream 3_Mole %[7 - Component 7] RD_ONLY

7690 FLOAT 3 - Stream 3_Mole %[8 - Component 8] RD_ONLY

7691 FLOAT 3 - Stream 3_Mole %[9 - Component 9] RD_ONLY

7692 FLOAT 3 - Stream 3_Mole %[10 - Component 10] RD_ONLY

7693 FLOAT 3 - Stream 3_Mole %[11 - Component 11] RD_ONLY

7694 FLOAT 3 - Stream 3_Mole %[12 - Component 12] RD_ONLY

7695 FLOAT 3 - Stream 3_Mole %[13 - Component 13] RD_ONLY

7696 FLOAT 3 - Stream 3_Mole %[14 - Component 14] RD_ONLY

7697 FLOAT 3 - Stream 3_Mole %[15 - Component 15] RD_ONLY

7698 FLOAT 3 - Stream 3_Mole %[16 - Component 16] RD_ONLY

7699 FLOAT 3 - Stream 3_Mole %[17 - Component 17] RD_ONLY

7700 FLOAT 3 - Stream 3_Mole %[18 - Component 18] RD_ONLY

7701 FLOAT 3 - Stream 3_Mole %[19 - Component 19] RD_ONLY

7702 FLOAT 3 - Stream 3_Mole %[20 - Component 20] RD_ONLY

7703 FLOAT 3 - Stream 3_HV Gross BTU Dry RD_ONLY

7704 FLOAT 3 - Stream 3_GPA Real Rel Den Gas RD_ONLY

7705 FLOAT 3 - Stream 3_GPA Z Factor RD_ONLY

7706 FLOAT 3 - Stream 3_Total Unnormalized Conc RD_ONLY

7707 FLOAT Unused RD_ONLY
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7708 FLOAT Unused RD_ONLY

7709 FLOAT Unused RD_ONLY

7710 FLOAT Unused RD_ONLY

7711 FLOAT 4 - Stream 4_Start Time RD_ONLY YYMMDD

7712 FLOAT 4 - Stream 4_Start Time RD_ONLY hhmmss

7713 FLOAT 4 - Stream 4_Mole %[1 - Component 1] RD_ONLY

7714 FLOAT 4 - Stream 4_Mole %[2 - Component 2] RD_ONLY

7715 FLOAT 4 - Stream 4_Mole %[3 - Component 3] RD_ONLY

7716 FLOAT 4 - Stream 4_Mole %[4 - Component 4] RD_ONLY

7717 FLOAT 4 - Stream 4_Mole %[5 - Component 5] RD_ONLY

7718 FLOAT 4 - Stream 4_Mole %[6 - Component 6] RD_ONLY

7719 FLOAT 4 - Stream 4_Mole %[7 - Component 7] RD_ONLY

7720 FLOAT 4 - Stream 4_Mole %[8 - Component 8] RD_ONLY

7721 FLOAT 4 - Stream 4_Mole %[9 - Component 9] RD_ONLY

7722 FLOAT 4 - Stream 4_Mole %[10 - Component 10] RD_ONLY

7723 FLOAT 4 - Stream 4_Mole %[11 - Component 11] RD_ONLY

7724 FLOAT 4 - Stream 4_Mole %[12 - Component 12] RD_ONLY

7725 FLOAT 4 - Stream 4_Mole %[13 - Component 13] RD_ONLY

7726 FLOAT 4 - Stream 4_Mole %[14 - Component 14] RD_ONLY

7727 FLOAT 4 - Stream 4_Mole %[15 - Component 15] RD_ONLY

7728 FLOAT 4 - Stream 4_Mole %[16 - Component 16] RD_ONLY

7729 FLOAT 4 - Stream 4_Mole %[17 - Component 17] RD_ONLY

7730 FLOAT 4 - Stream 4_Mole %[18 - Component 18] RD_ONLY

7731 FLOAT 4 - Stream 4_Mole %[19 - Component 19] RD_ONLY

7732 FLOAT 4 - Stream 4_Mole %[20 - Component 20] RD_ONLY

7733 FLOAT 4 - Stream 4_HV Gross BTU Dry RD_ONLY

7734 FLOAT 4 - Stream 4_GPA Real Rel Den Gas RD_ONLY

7735 FLOAT 4 - Stream 4_GPA Z Factor RD_ONLY

7736 FLOAT 4 - Stream 4_Total Unnormalized Conc RD_ONLY

7737 FLOAT Unused RD_ONLY

7738 FLOAT Unused RD_ONLY

7739 FLOAT Unused RD_ONLY

7740 FLOAT Unused RD_ONLY

7741 FLOAT 5 - Stream 5_Start Time RD_ONLY YYMMDD

7742 FLOAT 5 - Stream 5_Start Time RD_ONLY hhmmss

7743 FLOAT 5 - Stream 5_Mole %[1 - Component 1] RD_ONLY

7744 FLOAT 5 - Stream 5_Mole %[2 - Component 2] RD_ONLY
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7745 FLOAT 5 - Stream 5_Mole %[3 - Component 3] RD_ONLY

7746 FLOAT 5 - Stream 5_Mole %[4 - Component 4] RD_ONLY

7747 FLOAT 5 - Stream 5_Mole %[5 - Component 5] RD_ONLY

7748 FLOAT 5 - Stream 5_Mole %[6 - Component 6] RD_ONLY

7749 FLOAT 5 - Stream 5_Mole %[7 - Component 7] RD_ONLY

7750 FLOAT 5 - Stream 5_Mole %[8 - Component 8] RD_ONLY

7751 FLOAT 5 - Stream 5_Mole %[9 - Component 9] RD_ONLY

7752 FLOAT 5 - Stream 5_Mole %[10 - Component 10] RD_ONLY

7753 FLOAT 5 - Stream 5_Mole %[11 - Component 11] RD_ONLY

7754 FLOAT 5 - Stream 5_Mole %[12 - Component 12] RD_ONLY

7755 FLOAT 5 - Stream 5_Mole %[13 - Component 13] RD_ONLY

7756 FLOAT 5 - Stream 5_Mole %[14 - Component 14] RD_ONLY

7757 FLOAT 5 - Stream 5_Mole %[15 - Component 15] RD_ONLY

7758 FLOAT 5 - Stream 5_Mole %[16 - Component 16] RD_ONLY

7759 FLOAT 5 - Stream 5_Mole %[17 - Component 17] RD_ONLY

7760 FLOAT 5 - Stream 5_Mole %[18 - Component 18] RD_ONLY

7761 FLOAT 5 - Stream 5_Mole %[19 - Component 19] RD_ONLY

7762 FLOAT 5 - Stream 5_Mole %[20 - Component 20] RD_ONLY

7763 FLOAT 5 - Stream 5_HV Gross BTU Dry RD_ONLY

7764 FLOAT 5 - Stream 5_GPA Real Rel Den Gas RD_ONLY

7765 FLOAT 5 - Stream 5_GPA Z Factor RD_ONLY

7766 FLOAT 5 - Stream 5_Total Unnormalized Conc RD_ONLY

7767 FLOAT Unused RD_ONLY

7768 FLOAT Unused RD_ONLY

7769 FLOAT Unused RD_ONLY

7770 FLOAT Unused RD_ONLY

7771 FLOAT 6 - Stream 6_Start Time RD_ONLY YYMMDD

7772 FLOAT 6 - Stream 6_Start Time RD_ONLY hhmmss

7773 FLOAT 6 - Stream 6_Mole %[1 - Component 1] RD_ONLY

7774 FLOAT 6 - Stream 6_Mole %[2 - Component 2] RD_ONLY

7775 FLOAT 6 - Stream 6_Mole %[3 - Component 3] RD_ONLY

7776 FLOAT 6 - Stream 6_Mole %[4 - Component 4] RD_ONLY

7777 FLOAT 6 - Stream 6_Mole %[5 - Component 5] RD_ONLY

7778 FLOAT 6 - Stream 6_Mole %[6 - Component 6] RD_ONLY

7779 FLOAT 6 - Stream 6_Mole %[7 - Component 7] RD_ONLY

7780 FLOAT 6 - Stream 6_Mole %[8 - Component 8] RD_ONLY

7781 FLOAT 6 - Stream 6_Mole %[9 - Component 9] RD_ONLY
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7782 FLOAT 6 - Stream 6_Mole %[10 - Component 10] RD_ONLY

7783 FLOAT 6 - Stream 6_Mole %[11 - Component 11] RD_ONLY

7784 FLOAT 6 - Stream 6_Mole %[12 - Component 12] RD_ONLY

7785 FLOAT 6 - Stream 6_Mole %[13 - Component 13] RD_ONLY

7786 FLOAT 6 - Stream 6_Mole %[14 - Component 14] RD_ONLY

7787 FLOAT 6 - Stream 6_Mole %[15 - Component 15] RD_ONLY

7788 FLOAT 6 - Stream 6_Mole %[16 - Component 16] RD_ONLY

7789 FLOAT 6 - Stream 6_Mole %[17 - Component 17] RD_ONLY

7790 FLOAT 6 - Stream 6_Mole %[18 - Component 18] RD_ONLY

7791 FLOAT 6 - Stream 6_Mole %[19 - Component 19] RD_ONLY

7792 FLOAT 6 - Stream 6_Mole %[20 - Component 20] RD_ONLY

7793 FLOAT 6 - Stream 6_HV Gross BTU Dry RD_ONLY

7794 FLOAT 6 - Stream 6_GPA Real Rel Den Gas RD_ONLY

7795 FLOAT 6 - Stream 6_GPA Z Factor RD_ONLY

7796 FLOAT 6 - Stream 6_Total Unnormalized Conc RD_ONLY

7797 FLOAT Unused RD_ONLY

7798 FLOAT Unused RD_ONLY

7799 FLOAT Unused RD_ONLY

7800 FLOAT Unused RD_ONLY

7801 FLOAT 7 - Stream 7_Start Time RD_ONLY YYMMDD

7802 FLOAT 7 - Stream 7_Start Time RD_ONLY hhmmss

7803 FLOAT 7 - Stream 7_Mole %[1 - Component 1] RD_ONLY

7804 FLOAT 7 - Stream 7_Mole %[2 - Component 2] RD_ONLY

7805 FLOAT 7 - Stream 7_Mole %[3 - Component 3] RD_ONLY

7806 FLOAT 7 - Stream 7_Mole %[4 - Component 4] RD_ONLY

7807 FLOAT 7 - Stream 7_Mole %[5 - Component 5] RD_ONLY

7808 FLOAT 7 - Stream 7_Mole %[6 - Component 6] RD_ONLY

7809 FLOAT 7 - Stream 7_Mole %[7 - Component 7] RD_ONLY

7810 FLOAT 7 - Stream 7_Mole %[8 - Component 8] RD_ONLY

7811 FLOAT 7 - Stream 7_Mole %[9 - Component 9] RD_ONLY

7812 FLOAT 7 - Stream 7_Mole %[10 - Component 10] RD_ONLY

7813 FLOAT 7 - Stream 7_Mole %[11 - Component 11] RD_ONLY

7814 FLOAT 7 - Stream 7_Mole %[12 - Component 12] RD_ONLY

7815 FLOAT 7 - Stream 7_Mole %[13 - Component 13] RD_ONLY

7816 FLOAT 7 - Stream 7_Mole %[14 - Component 14] RD_ONLY

7817 FLOAT 7 - Stream 7_Mole %[15 - Component 15] RD_ONLY

7818 FLOAT 7 - Stream 7_Mole %[16 - Component 16] RD_ONLY
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7819 FLOAT 7 - Stream 7_Mole %[17 - Component 17] RD_ONLY

7820 FLOAT 7 - Stream 7_Mole %[18 - Component 18] RD_ONLY

7821 FLOAT 7 - Stream 7_Mole %[19 - Component 19] RD_ONLY

7822 FLOAT 7 - Stream 7_Mole %[20 - Component 20] RD_ONLY

7823 FLOAT 7 - Stream 7_HV Gross BTU Dry RD_ONLY

7824 FLOAT 7 - Stream 7_GPA Real Rel Den Gas RD_ONLY

7825 FLOAT 7 - Stream 7_GPA Z Factor RD_ONLY

7826 FLOAT 7 - Stream 7_Total Unnormalized Conc RD_ONLY

7827 FLOAT Unused RD_ONLY

7828 FLOAT Unused RD_ONLY

7829 FLOAT Unused RD_ONLY

7830 FLOAT Unused RD_ONLY

7831 FLOAT 8 - Stream 8_Start Time RD_ONLY YYMMDD

7832 FLOAT 8 - Stream 8_Start Time RD_ONLY hhmmss

7833 FLOAT 8 - Stream 8_Mole %[1 - Component 1] RD_ONLY

7834 FLOAT 8 - Stream 8_Mole %[2 - Component 2] RD_ONLY

7835 FLOAT 8 - Stream 8_Mole %[3 - Component 3] RD_ONLY

7836 FLOAT 8 - Stream 8_Mole %[4 - Component 4] RD_ONLY

7837 FLOAT 8 - Stream 8_Mole %[5 - Component 5] RD_ONLY

7838 FLOAT 8 - Stream 8_Mole %[6 - Component 6] RD_ONLY

7839 FLOAT 8 - Stream 8_Mole %[7 - Component 7] RD_ONLY

7840 FLOAT 8 - Stream 8_Mole %[8 - Component 8] RD_ONLY

7841 FLOAT 8 - Stream 8_Mole %[9 - Component 9] RD_ONLY

7842 FLOAT 8 - Stream 8_Mole %[10 - Component 10] RD_ONLY

7843 FLOAT 8 - Stream 8_Mole %[11 - Component 11] RD_ONLY

7844 FLOAT 8 - Stream 8_Mole %[12 - Component 12] RD_ONLY

7845 FLOAT 8 - Stream 8_Mole %[13 - Component 13] RD_ONLY

7846 FLOAT 8 - Stream 8_Mole %[14 - Component 14] RD_ONLY

7847 FLOAT 8 - Stream 8_Mole %[15 - Component 15] RD_ONLY

7848 FLOAT 8 - Stream 8_Mole %[16 - Component 16] RD_ONLY

7849 FLOAT 8 - Stream 8_Mole %[17 - Component 17] RD_ONLY

7850 FLOAT 8 - Stream 8_Mole %[18 - Component 18] RD_ONLY

7851 FLOAT 8 - Stream 8_Mole %[19 - Component 19] RD_ONLY

7852 FLOAT 8 - Stream 8_Mole %[20 - Component 20] RD_ONLY

7853 FLOAT 8 - Stream 8_HV Gross BTU Dry RD_ONLY

7854 FLOAT 8 - Stream 8_GPA Real Rel Den Gas RD_ONLY

7855 FLOAT 8 - Stream 8_GPA Z Factor RD_ONLY
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7856 FLOAT 8 - Stream 8_Total Unnormalized Conc RD_ONLY

7857 FLOAT Unused RD_ONLY

7858 FLOAT Unused RD_ONLY

7859 FLOAT Unused RD_ONLY

7860 FLOAT Unused RD_ONLY

7861 FLOAT 9 - Stream 9_Start Time RD_ONLY YYMMDD

7862 FLOAT 9 - Stream 9_Start Time RD_ONLY hhmmss

7863 FLOAT 9 - Stream 9_Mole %[1 - Component 1] RD_ONLY

7864 FLOAT 9 - Stream 9_Mole %[2 - Component 2] RD_ONLY

7865 FLOAT 9 - Stream 9_Mole %[3 - Component 3] RD_ONLY

7866 FLOAT 9 - Stream 9_Mole %[4 - Component 4] RD_ONLY

7867 FLOAT 9 - Stream 9_Mole %[5 - Component 5] RD_ONLY

7868 FLOAT 9 - Stream 9_Mole %[6 - Component 6] RD_ONLY

7869 FLOAT 9 - Stream 9_Mole %[7 - Component 7] RD_ONLY

7870 FLOAT 9 - Stream 9_Mole %[8 - Component 8] RD_ONLY

7871 FLOAT 9 - Stream 9_Mole %[9 - Component 9] RD_ONLY

7872 FLOAT 9 - Stream 9_Mole %[10 - Component 10] RD_ONLY

7873 FLOAT 9 - Stream 9_Mole %[11 - Component 11] RD_ONLY

7874 FLOAT 9 - Stream 9_Mole %[12 - Component 12] RD_ONLY

7875 FLOAT 9 - Stream 9_Mole %[13 - Component 13] RD_ONLY

7876 FLOAT 9 - Stream 9_Mole %[14 - Component 14] RD_ONLY

7877 FLOAT 9 - Stream 9_Mole %[15 - Component 15] RD_ONLY

7878 FLOAT 9 - Stream 9_Mole %[16 - Component 16] RD_ONLY

7879 FLOAT 9 - Stream 9_Mole %[17 - Component 17] RD_ONLY

7880 FLOAT 9 - Stream 9_Mole %[18 - Component 18] RD_ONLY

7881 FLOAT 9 - Stream 9_Mole %[19 - Component 19] RD_ONLY

7882 FLOAT 9 - Stream 9_Mole %[20 - Component 20] RD_ONLY

7883 FLOAT 9 - Stream 9_HV Gross BTU Dry RD_ONLY

7884 FLOAT 9 - Stream 9_GPA Real Rel Den Gas RD_ONLY

7885 FLOAT 9 - Stream 9_GPA Z Factor RD_ONLY

7886 FLOAT 9 - Stream 9_Total Unnormalized Conc RD_ONLY

7887 FLOAT Unused RD_ONLY

7888 FLOAT Unused RD_ONLY

7889 FLOAT Unused RD_ONLY

7890 FLOAT Unused RD_ONLY

7891 FLOAT 10 - Stream 10_Start Time RD_ONLY YYMMDD

7892 FLOAT 10 - Stream 10_Start Time RD_ONLY hhmmss
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7893 FLOAT 10 - Stream 10_Mole %[1 - Component 1] RD_ONLY

7894 FLOAT 10 - Stream 10_Mole %[2 - Component 2] RD_ONLY

7895 FLOAT 10 - Stream 10_Mole %[3 - Component 3] RD_ONLY

7896 FLOAT 10 - Stream 10_Mole %[4 - Component 4] RD_ONLY

7897 FLOAT 10 - Stream 10_Mole %[5 - Component 5] RD_ONLY

7898 FLOAT 10 - Stream 10_Mole %[6 - Component 6] RD_ONLY

7899 FLOAT 10 - Stream 10_Mole %[7 - Component 7] RD_ONLY

7900 FLOAT 10 - Stream 10_Mole %[8 - Component 8] RD_ONLY

7901 FLOAT 10 - Stream 10_Mole %[9 - Component 9] RD_ONLY

7902 FLOAT 10 - Stream 10_Mole %[10 - Component 10] RD_ONLY

7903 FLOAT 10 - Stream 10_Mole %[11 - Component 11] RD_ONLY

7904 FLOAT 10 - Stream 10_Mole %[12 - Component 12] RD_ONLY

7905 FLOAT 10 - Stream 10_Mole %[13 - Component 13] RD_ONLY

7906 FLOAT 10 - Stream 10_Mole %[14 - Component 14] RD_ONLY

7907 FLOAT 10 - Stream 10_Mole %[15 - Component 15] RD_ONLY

7908 FLOAT 10 - Stream 10_Mole %[16 - Component 16] RD_ONLY

7909 FLOAT 10 - Stream 10_Mole %[17 - Component 17] RD_ONLY

7910 FLOAT 10 - Stream 10_Mole %[18 - Component 18] RD_ONLY

7911 FLOAT 10 - Stream 10_Mole %[19 - Component 19] RD_ONLY

7912 FLOAT 10 - Stream 10_Mole %[20 - Component 20] RD_ONLY

7913 FLOAT 10 - Stream 10_HV Gross BTU Dry RD_ONLY

7914 FLOAT 10 - Stream 10_GPA Real Rel Den Gas RD_ONLY

7915 FLOAT 10 - Stream 10_GPA Z Factor RD_ONLY

7916 FLOAT 10 - Stream 10_Total Unnormalized Conc RD_ONLY

7917 FLOAT Unused RD_ONLY

7918 FLOAT Unused RD_ONLY

7919 FLOAT Unused RD_ONLY

7920 FLOAT Unused RD_ONLY

7921 FLOAT 11 - Stream 11_Start Time RD_ONLY YYMMDD

7922 FLOAT 11 - Stream 11_Start Time RD_ONLY hhmmss

7923 FLOAT 11 - Stream 11_Mole %[1 - Component 1] RD_ONLY

7924 FLOAT 11 - Stream 11_Mole %[2 - Component 2] RD_ONLY

7925 FLOAT 11 - Stream 11_Mole %[3 - Component 3] RD_ONLY

7926 FLOAT 11 - Stream 11_Mole %[4 - Component 4] RD_ONLY

7927 FLOAT 11 - Stream 11_Mole %[5 - Component 5] RD_ONLY

7928 FLOAT 11 - Stream 11_Mole %[6 - Component 6] RD_ONLY

7929 FLOAT 11 - Stream 11_Mole %[7 - Component 7] RD_ONLY
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7930 FLOAT 11 - Stream 11_Mole %[8 - Component 8] RD_ONLY

7931 FLOAT 11 - Stream 11_Mole %[9 - Component 9] RD_ONLY

7932 FLOAT 11 - Stream 11_Mole %[10 - Component 10] RD_ONLY

7933 FLOAT 11 - Stream 11_Mole %[11 - Component 11] RD_ONLY

7934 FLOAT 11 - Stream 11_Mole %[12 - Component 12] RD_ONLY

7935 FLOAT 11 - Stream 11_Mole %[13 - Component 13] RD_ONLY

7936 FLOAT 11 - Stream 11_Mole %[14 - Component 14] RD_ONLY

7937 FLOAT 11 - Stream 11_Mole %[15 - Component 15] RD_ONLY

7938 FLOAT 11 - Stream 11_Mole %[16 - Component 16] RD_ONLY

7939 FLOAT 11 - Stream 11_Mole %[17 - Component 17] RD_ONLY

7940 FLOAT 11 - Stream 11_Mole %[18 - Component 18] RD_ONLY

7941 FLOAT 11 - Stream 11_Mole %[19 - Component 19] RD_ONLY

7942 FLOAT 11 - Stream 11_Mole %[20 - Component 20] RD_ONLY

7943 FLOAT 11 - Stream 11_HV Gross BTU Dry RD_ONLY

7944 FLOAT 11 - Stream 11_GPA Real Rel Den Gas RD_ONLY

7945 FLOAT 11 - Stream 11_GPA Z Factor RD_ONLY

7946 FLOAT 11 - Stream 11_Total Unnormalized Conc RD_ONLY

7947 FLOAT Unused RD_ONLY

7948 FLOAT Unused RD_ONLY

7949 FLOAT Unused RD_ONLY

7950 FLOAT Unused RD_ONLY

7951 FLOAT 12 - Stream 12_Start Time RD_ONLY YYMMDD

7952 FLOAT 12 - Stream 12_Start Time RD_ONLY hhmmss

7953 FLOAT 12 - Stream 12_Mole %[1 - Component 1] RD_ONLY

7954 FLOAT 12 - Stream 12_Mole %[2 - Component 2] RD_ONLY

7955 FLOAT 12 - Stream 12_Mole %[3 - Component 3] RD_ONLY

7956 FLOAT 12 - Stream 12_Mole %[4 - Component 4] RD_ONLY

7957 FLOAT 12 - Stream 12_Mole %[5 - Component 5] RD_ONLY

7958 FLOAT 12 - Stream 12_Mole %[6 - Component 6] RD_ONLY

7959 FLOAT 12 - Stream 12_Mole %[7 - Component 7] RD_ONLY

7960 FLOAT 12 - Stream 12_Mole %[8 - Component 8] RD_ONLY

7961 FLOAT 12 - Stream 12_Mole %[9 - Component 9] RD_ONLY

7962 FLOAT 12 - Stream 12_Mole %[10 - Component 10] RD_ONLY

7963 FLOAT 12 - Stream 12_Mole %[11 - Component 11] RD_ONLY

7964 FLOAT 12 - Stream 12_Mole %[12 - Component 12] RD_ONLY

7965 FLOAT 12 - Stream 12_Mole %[13 - Component 13] RD_ONLY

7966 FLOAT 12 - Stream 12_Mole %[14 - Component 14] RD_ONLY
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7967 FLOAT 12 - Stream 12_Mole %[15 - Component 15] RD_ONLY

7968 FLOAT 12 - Stream 12_Mole %[16 - Component 16] RD_ONLY

7969 FLOAT 12 - Stream 12_Mole %[17 - Component 17] RD_ONLY

7970 FLOAT 12 - Stream 12_Mole %[18 - Component 18] RD_ONLY

7971 FLOAT 12 - Stream 12_Mole %[19 - Component 19] RD_ONLY

7972 FLOAT 12 - Stream 12_Mole %[20 - Component 20] RD_ONLY

7973 FLOAT 12 - Stream 12_HV Gross BTU Dry RD_ONLY

7974 FLOAT 12 - Stream 12_GPA Real Rel Den Gas RD_ONLY

7975 FLOAT 12 - Stream 12_GPA Z Factor RD_ONLY

7976 FLOAT 12 - Stream 12_Total Unnormalized Conc RD_ONLY

7977 FLOAT Unused RD_ONLY

7978 FLOAT Unused RD_ONLY

7979 FLOAT Unused RD_ONLY

7980 FLOAT Unused RD_ONLY

7981 FLOAT Unused RD_ONLY

7982 FLOAT Unused RD_ONLY

7983 FLOAT Unused RD_ONLY

7984 FLOAT Unused RD_ONLY

7985 FLOAT Unused RD_ONLY

7986 FLOAT Unused RD_ONLY

7987 FLOAT Unused RD_ONLY

7988 FLOAT Unused RD_ONLY

7989 FLOAT Unused RD_ONLY

7990 FLOAT Unused RD_ONLY

7991 FLOAT Unused RD_ONLY

7992 FLOAT Unused RD_ONLY

7993 FLOAT Unused RD_ONLY

7994 FLOAT Unused RD_ONLY

7995 FLOAT Unused RD_ONLY

7996 FLOAT GC Control_Auto Sequence RD_WR

7997 FLOAT GC Control_Halt RD_WR

7998 FLOAT GC Control_Calibration RD_WR

7999 FLOAT GC Control_Single Stream RD_WR

8000 FLOAT Current Stream RD_ONLY

8001 FLOAT GC Calibrating RD_ONLY

8002 FLOAT GC Running RD_ONLY

8003 FLOAT Unused RD_ONLY

Pre-defined Modbus
®

 Map Files

208 Rosemount™ 1500XA Gas Chromatograph



Register # Data Type Variable Record # Access Format

8004 FLOAT Run Time RD_ONLY

8005 FLOAT Current Analysis Mode RD_ONLY

8006 FLOAT GC Control_Validation RD_WR

8007 FLOAT Unused RD_ONLY

8008 FLOAT Unused RD_ONLY

8009 FLOAT Unused RD_ONLY

8010 FLOAT Unused RD_ONLY

8011 FLOAT Unused RD_ONLY

8012 FLOAT Unused RD_ONLY

8013 FLOAT Unused RD_ONLY

8014 FLOAT Unused RD_ONLY

8015 FLOAT Unused RD_ONLY

8016 FLOAT Unused RD_ONLY

8017 FLOAT Unused RD_ONLY

8018 FLOAT Unused RD_ONLY

8019 FLOAT Unused RD_ONLY

8020 FLOAT Unused RD_ONLY

8021 FLOAT Unused RD_ONLY

8022 FLOAT Unused RD_ONLY

8023 FLOAT Unused RD_ONLY

8024 FLOAT Unused RD_ONLY

8025 FLOAT Unused RD_ONLY

8026 FLOAT Unused RD_ONLY

8027 FLOAT Unused RD_ONLY

8028 FLOAT Unused RD_ONLY

8029 FLOAT Unused RD_ONLY

8030 FLOAT Unused RD_ONLY

8031 FLOAT Unused RD_ONLY

8032 FLOAT Unused RD_ONLY

8033 FLOAT Unused RD_ONLY

8034 FLOAT Unused RD_ONLY

8035 FLOAT Unused RD_ONLY

8036 FLOAT Unused RD_ONLY

8037 FLOAT Unused RD_ONLY

8038 FLOAT Unused RD_ONLY

8039 FLOAT Unused RD_ONLY

8040 FLOAT Unused RD_ONLY
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8041 FLOAT Unused RD_ONLY

8042 FLOAT Unused RD_ONLY

8043 FLOAT Unused RD_ONLY

8044 FLOAT Unused RD_ONLY

8045 FLOAT Unused RD_ONLY

8046 FLOAT Unused RD_ONLY

8047 FLOAT Unused RD_ONLY

8048 FLOAT Unused RD_ONLY

8049 FLOAT Unused RD_ONLY

8050 FLOAT Unused RD_ONLY

8051 FLOAT Unused RD_ONLY

8052 FLOAT Unused RD_ONLY

8053 FLOAT Unused RD_ONLY

8054 FLOAT Unused RD_ONLY

8055 FLOAT Unused RD_ONLY

8056 FLOAT Unused RD_ONLY

8057 FLOAT Unused RD_ONLY

8058 FLOAT Unused RD_ONLY

8059 FLOAT Unused RD_ONLY

8060 FLOAT Unused RD_ONLY

8061 FLOAT Unused RD_ONLY

8062 FLOAT Unused RD_ONLY

8063 FLOAT Unused RD_ONLY

8064 FLOAT Unused RD_ONLY

8065 FLOAT Unused RD_ONLY

8066 FLOAT Unused RD_ONLY

8067 FLOAT Unused RD_ONLY

8068 FLOAT Unused RD_ONLY

8069 FLOAT Unused RD_ONLY

8070 FLOAT Unused RD_ONLY

8071 FLOAT Unused RD_ONLY

8072 FLOAT Unused RD_ONLY

8073 FLOAT Unused RD_ONLY

8074 FLOAT Unused RD_ONLY

8075 FLOAT Unused RD_ONLY

8076 FLOAT Unused RD_ONLY

8077 FLOAT Unused RD_ONLY
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8078 FLOAT Unused RD_ONLY

8079 FLOAT Unused RD_ONLY

8080 FLOAT Unused RD_ONLY

8081 FLOAT Unused RD_ONLY

8082 FLOAT Unused RD_ONLY

8083 FLOAT Unused RD_ONLY

8084 FLOAT Unused RD_ONLY

8085 FLOAT Unused RD_ONLY

8086 FLOAT Unused RD_ONLY

8087 FLOAT Unused RD_ONLY

8088 FLOAT Unused RD_ONLY

8089 FLOAT Unused RD_ONLY

8090 FLOAT Unused RD_ONLY

8091 FLOAT Unused RD_ONLY

8092 FLOAT Unused RD_ONLY

8093 FLOAT Unused RD_ONLY

8094 FLOAT Unused RD_ONLY

8095 FLOAT Unused RD_ONLY

8096 FLOAT Unused RD_ONLY

8097 FLOAT Unused RD_ONLY

8098 FLOAT Unused RD_ONLY

8099 FLOAT Unused RD_ONLY

8100 FLOAT Unused RD_ONLY

8101 FLOAT Unused RD_ONLY

8102 FLOAT Unused RD_ONLY

8103 FLOAT Unused RD_ONLY

8104 FLOAT Unused RD_ONLY

8105 FLOAT Unused RD_ONLY

8106 FLOAT Unused RD_ONLY

8107 FLOAT Unused RD_ONLY

8108 FLOAT Unused RD_ONLY

8109 FLOAT Unused RD_ONLY

8110 FLOAT Unused RD_ONLY

8111 FLOAT Unused RD_ONLY

8112 FLOAT Unused RD_ONLY

8113 FLOAT Unused RD_ONLY

8114 FLOAT Unused RD_ONLY
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8115 FLOAT Unused RD_ONLY

8116 FLOAT Unused RD_ONLY

8117 FLOAT Unused RD_ONLY

8118 FLOAT Unused RD_ONLY

8119 FLOAT Unused RD_ONLY

8120 FLOAT Unused RD_ONLY

8121 FLOAT Unused RD_ONLY

8122 FLOAT Unused RD_ONLY

8123 FLOAT Unused RD_ONLY

8124 FLOAT Unused RD_ONLY

8125 FLOAT Unused RD_ONLY

8126 FLOAT Unused RD_ONLY

8127 FLOAT Unused RD_ONLY

8128 FLOAT Unused RD_ONLY

8129 FLOAT Unused RD_ONLY

8130 FLOAT Unused RD_ONLY

8131 FLOAT Unused RD_ONLY

8132 FLOAT Unused RD_ONLY

8133 FLOAT Unused RD_ONLY

8134 FLOAT Unused RD_ONLY

8135 FLOAT Unused RD_ONLY

8136 FLOAT Unused RD_ONLY

8137 FLOAT Unused RD_ONLY

8138 FLOAT Unused RD_ONLY

8139 FLOAT Unused RD_ONLY

8140 FLOAT Unused RD_ONLY

8141 FLOAT Unused RD_ONLY

8142 FLOAT Unused RD_ONLY

8143 FLOAT Unused RD_ONLY

8144 FLOAT Unused RD_ONLY

8145 FLOAT Unused RD_ONLY

8146 FLOAT Unused RD_ONLY

8147 FLOAT Unused RD_ONLY

8148 FLOAT Unused RD_ONLY

8149 FLOAT Unused RD_ONLY

8150 FLOAT Unused RD_ONLY

8151 FLOAT Unused RD_ONLY
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8152 FLOAT Unused RD_ONLY

8153 FLOAT Unused RD_ONLY

8154 FLOAT Unused RD_ONLY

8155 FLOAT Unused RD_ONLY

8156 FLOAT Unused RD_ONLY

8157 FLOAT Unused RD_ONLY

8158 FLOAT Unused RD_ONLY

8159 FLOAT Unused RD_ONLY

8160 FLOAT Unused RD_ONLY

8161 FLOAT Unused RD_ONLY

8162 FLOAT Unused RD_ONLY

8163 FLOAT Unused RD_ONLY

8164 FLOAT Unused RD_ONLY

8165 FLOAT Unused RD_ONLY

8166 FLOAT Unused RD_ONLY

8167 FLOAT Unused RD_ONLY

8168 FLOAT Unused RD_ONLY

8169 FLOAT Unused RD_ONLY

8170 FLOAT Unused RD_ONLY

8171 FLOAT Unused RD_ONLY

8172 FLOAT Unused RD_ONLY

8173 FLOAT Unused RD_ONLY

8174 FLOAT Unused RD_ONLY

8175 FLOAT Unused RD_ONLY

8176 FLOAT Unused RD_ONLY

8177 FLOAT Unused RD_ONLY

8178 FLOAT Unused RD_ONLY

8179 FLOAT Unused RD_ONLY

8180 FLOAT Unused RD_ONLY

8181 FLOAT Unused RD_ONLY

8182 FLOAT Unused RD_ONLY

8183 FLOAT Unused RD_ONLY

8184 FLOAT Unused RD_ONLY

8185 FLOAT Unused RD_ONLY

8186 FLOAT Unused RD_ONLY

8187 FLOAT Unused RD_ONLY

8188 FLOAT Unused RD_ONLY
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8189 FLOAT Unused RD_ONLY

8190 FLOAT Unused RD_ONLY

8191 FLOAT Unused RD_ONLY

8192 FLOAT Unused RD_ONLY

8193 FLOAT Unused RD_ONLY

8194 FLOAT Unused RD_ONLY

8195 FLOAT Unused RD_ONLY

8196 FLOAT Unused RD_ONLY

8197 FLOAT Unused RD_ONLY

8198 FLOAT Unused RD_ONLY

8199 FLOAT Unused RD_ONLY

8200 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

8201 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

8202 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

8203 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

8204 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

8205 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

8206 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

8207 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

8208 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY

8209 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

8210 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

8211 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY

8212 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

8213 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

8214 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

8215 FLOAT Archive_Avg[16 - Average 16] 1 RD_ONLY

8216 FLOAT Archive_Avg[17 - Average 17] 1 RD_ONLY

8217 FLOAT Archive_Avg[18 - Average 18] 1 RD_ONLY

8218 FLOAT Archive_Avg[19 - Average 19] 1 RD_ONLY

8219 FLOAT Archive_Avg[20 - Average 20] 1 RD_ONLY

8220 FLOAT Archive_Avg[21 - Average 21] 1 RD_ONLY

8221 FLOAT Archive_Avg[22 - Average 22] 1 RD_ONLY

8222 FLOAT Archive_Avg[23 - Average 23] 1 RD_ONLY

8223 FLOAT Archive_Avg[24 - Average 24] 1 RD_ONLY

8224 FLOAT Archive_Avg[25 - Average 25] 1 RD_ONLY

8225 FLOAT Archive_Avg[26 - Average 26] 1 RD_ONLY
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8226 FLOAT Archive_Avg[27 - Average 27] 1 RD_ONLY

8227 FLOAT Archive_Avg[28 - Average 28] 1 RD_ONLY

8228 FLOAT Archive_Avg[29 - Average 29] 1 RD_ONLY

8229 FLOAT Archive_Avg[30 - Average 30] 1 RD_ONLY

8230 FLOAT Archive_Avg[31 - Average 31] 1 RD_ONLY

8231 FLOAT Archive_Avg[32 - Average 32] 1 RD_ONLY

8232 FLOAT Archive_Avg[33 - Average 33] 1 RD_ONLY

8233 FLOAT Archive_Avg[34 - Average 34] 1 RD_ONLY

8234 FLOAT Archive_Avg[35 - Average 35] 1 RD_ONLY

8235 FLOAT Archive_Avg[36 - Average 36] 1 RD_ONLY

8236 FLOAT Archive_Avg[37 - Average 37] 1 RD_ONLY

8237 FLOAT Archive_Avg[38 - Average 38] 1 RD_ONLY

8238 FLOAT Archive_Avg[39 - Average 39] 1 RD_ONLY

8239 FLOAT Archive_Avg[40 - Average 40] 1 RD_ONLY

8240 FLOAT Archive_Avg[41 - Average 41] 1 RD_ONLY

8241 FLOAT Archive_Avg[42 - Average 42] 1 RD_ONLY

8242 FLOAT Archive_Avg[43 - Average 43] 1 RD_ONLY

8243 FLOAT Archive_Avg[44 - Average 44] 1 RD_ONLY

8244 FLOAT Archive_Avg[45 - Average 45] 1 RD_ONLY

8245 FLOAT Archive_Avg[46 - Average 46] 1 RD_ONLY

8246 FLOAT Archive_Avg[47 - Average 47] 1 RD_ONLY

8247 FLOAT Archive_Avg[48 - Average 48] 1 RD_ONLY

8248 FLOAT Archive_Avg[49 - Average 49] 1 RD_ONLY

8249 FLOAT Archive_Avg[50 - Average 50] 1 RD_ONLY

8250 FLOAT Archive_Avg[51 - Average 51] 1 RD_ONLY

8251 FLOAT Archive_Avg[52 - Average 52] 1 RD_ONLY

8252 FLOAT Archive_Avg[53 - Average 53] 1 RD_ONLY

8253 FLOAT Archive_Avg[54 - Average 54] 1 RD_ONLY

8254 FLOAT Archive_Avg[55 - Average 55] 1 RD_ONLY

8255 FLOAT Archive_Avg[56 - Average 56] 1 RD_ONLY

8256 FLOAT Archive_Avg[57 - Average 57] 1 RD_ONLY

8257 FLOAT Archive_Avg[58 - Average 58] 1 RD_ONLY

8258 FLOAT Archive_Avg[59 - Average 59] 1 RD_ONLY

8259 FLOAT Archive_Avg[60 - Average 60] 1 RD_ONLY

8260 FLOAT Archive_Avg[61 - Average 61] 1 RD_ONLY

8261 FLOAT Archive_Avg[62 - Average 62] 1 RD_ONLY

8262 FLOAT Archive_Avg[63 - Average 63] 1 RD_ONLY
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8263 FLOAT Archive_Avg[64 - Average 64] 1 RD_ONLY

8264 FLOAT Archive_Avg[65 - Average 65] 1 RD_ONLY

8265 FLOAT Archive_Avg[66 - Average 66] 1 RD_ONLY

8266 FLOAT Archive_Avg[67 - Average 67] 1 RD_ONLY

8267 FLOAT Archive_Avg[68 - Average 68] 1 RD_ONLY

8268 FLOAT Archive_Avg[69 - Average 69] 1 RD_ONLY

8269 FLOAT Archive_Avg[70 - Average 70] 1 RD_ONLY

8270 FLOAT Archive_Avg[71 - Average 71] 1 RD_ONLY

8271 FLOAT Archive_Avg[72 - Average 72] 1 RD_ONLY

8272 FLOAT Archive_Avg[73 - Average 73] 1 RD_ONLY

8273 FLOAT Archive_Avg[74 - Average 74] 1 RD_ONLY

8274 FLOAT Archive_Avg[75 - Average 75] 1 RD_ONLY

8275 FLOAT Archive_Avg[76 - Average 76] 1 RD_ONLY

8276 FLOAT Archive_Avg[77 - Average 77] 1 RD_ONLY

8277 FLOAT Archive_Avg[78 - Average 78] 1 RD_ONLY

8278 FLOAT Archive_Avg[79 - Average 79] 1 RD_ONLY

8279 FLOAT Archive_Avg[80 - Average 80] 1 RD_ONLY

8280 FLOAT Archive_Avg[81 - Average 81] 1 RD_ONLY

8281 FLOAT Archive_Avg[82 - Average 82] 1 RD_ONLY

8282 FLOAT Archive_Avg[83 - Average 83] 1 RD_ONLY

8283 FLOAT Archive_Avg[84 - Average 84] 1 RD_ONLY

8284 FLOAT Archive_Avg[85 - Average 85] 1 RD_ONLY

8285 FLOAT Archive_Avg[86 - Average 86] 1 RD_ONLY

8286 FLOAT Archive_Avg[87 - Average 87] 1 RD_ONLY

8287 FLOAT Archive_Avg[88 - Average 88] 1 RD_ONLY

8288 FLOAT Archive_Avg[89 - Average 89] 1 RD_ONLY

8289 FLOAT Archive_Avg[90 - Average 90] 1 RD_ONLY

8290 FLOAT Archive_Avg[91 - Average 91] 1 RD_ONLY

8291 FLOAT Archive_Avg[92 - Average 92] 1 RD_ONLY

8292 FLOAT Archive_Avg[93 - Average 93] 1 RD_ONLY

8293 FLOAT Archive_Avg[94 - Average 94] 1 RD_ONLY

8294 FLOAT Archive_Avg[95 - Average 95] 1 RD_ONLY

8295 FLOAT Archive_Avg[96 - Average 96] 1 RD_ONLY

8296 FLOAT Archive_Avg[97 - Average 97] 1 RD_ONLY

8297 FLOAT Archive_Avg[98 - Average 98] 1 RD_ONLY

8298 FLOAT Archive_Avg[99 - Average 99] 1 RD_ONLY

8299 FLOAT Archive_Avg[100 - Average 100] 1 RD_ONLY
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8300 FLOAT Archive_Avg[101 - Average 101] 1 RD_ONLY

8301 FLOAT Archive_Avg[102 - Average 102] 1 RD_ONLY

8302 FLOAT Archive_Avg[103 - Average 103] 1 RD_ONLY

8303 FLOAT Archive_Avg[104 - Average 104] 1 RD_ONLY

8304 FLOAT Archive_Avg[105 - Average 105] 1 RD_ONLY

8305 FLOAT Archive_Avg[106 - Average 106] 1 RD_ONLY

8306 FLOAT Archive_Avg[107 - Average 107] 1 RD_ONLY

8307 FLOAT Archive_Avg[108 - Average 108] 1 RD_ONLY

8308 FLOAT Archive_Avg[109 - Average 109] 1 RD_ONLY

8309 FLOAT Archive_Avg[110 - Average 110] 1 RD_ONLY

8310 FLOAT Archive_Avg[111 - Average 111] 1 RD_ONLY

8311 FLOAT Archive_Avg[112 - Average 112] 1 RD_ONLY

8312 FLOAT Archive_Avg[113 - Average 113] 1 RD_ONLY

8313 FLOAT Archive_Avg[114 - Average 114] 1 RD_ONLY

8314 FLOAT Archive_Avg[115 - Average 115] 1 RD_ONLY

8315 FLOAT Archive_Avg[116 - Average 116] 1 RD_ONLY

8316 FLOAT Archive_Avg[117 - Average 117] 1 RD_ONLY

8317 FLOAT Archive_Avg[118 - Average 118] 1 RD_ONLY

8318 FLOAT Archive_Avg[119 - Average 119] 1 RD_ONLY

8319 FLOAT Archive_Avg[120 - Average 120] 1 RD_ONLY

8320 FLOAT Archive_Avg[121 - Average 121] 1 RD_ONLY

8321 FLOAT Archive_Avg[122 - Average 122] 1 RD_ONLY

8322 FLOAT Archive_Avg[123 - Average 123] 1 RD_ONLY

8323 FLOAT Archive_Avg[124 - Average 124] 1 RD_ONLY

8324 FLOAT Archive_Avg[125 - Average 125] 1 RD_ONLY

8325 FLOAT Archive_Avg[126 - Average 126] 1 RD_ONLY

8326 FLOAT Archive_Avg[127 - Average 127] 1 RD_ONLY

8327 FLOAT Archive_Avg[128 - Average 128] 1 RD_ONLY

8328 FLOAT Archive_Avg[129 - Average 129] 1 RD_ONLY

8329 FLOAT Archive_Avg[130 - Average 130] 1 RD_ONLY

8330 FLOAT Archive_Avg[131 - Average 131] 1 RD_ONLY

8331 FLOAT Archive_Avg[132 - Average 132] 1 RD_ONLY

8332 FLOAT Archive_Avg[133 - Average 133] 1 RD_ONLY

8333 FLOAT Archive_Avg[134 - Average 134] 1 RD_ONLY

8334 FLOAT Archive_Avg[135 - Average 135] 1 RD_ONLY

8335 FLOAT Archive_Avg[136 - Average 136] 1 RD_ONLY

8336 FLOAT Archive_Avg[137 - Average 137] 1 RD_ONLY
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8337 FLOAT Archive_Avg[138 - Average 138] 1 RD_ONLY

8338 FLOAT Archive_Avg[139 - Average 139] 1 RD_ONLY

8339 FLOAT Archive_Avg[140 - Average 140] 1 RD_ONLY

8340 FLOAT Archive_Avg[141 - Average 141] 1 RD_ONLY

8341 FLOAT Archive_Avg[142 - Average 142] 1 RD_ONLY

8342 FLOAT Archive_Avg[143 - Average 143] 1 RD_ONLY

8343 FLOAT Archive_Avg[144 - Average 144] 1 RD_ONLY

8344 FLOAT Archive_Avg[145 - Average 145] 1 RD_ONLY

8345 FLOAT Archive_Avg[146 - Average 146] 1 RD_ONLY

8346 FLOAT Archive_Avg[147 - Average 147] 1 RD_ONLY

8347 FLOAT Archive_Avg[148 - Average 148] 1 RD_ONLY

8348 FLOAT Archive_Avg[149 - Average 149] 1 RD_ONLY

8349 FLOAT Archive_Avg[150 - Average 150] 1 RD_ONLY

8350 FLOAT Archive_Avg[151 - Average 151] 1 RD_ONLY

8351 FLOAT Archive_Avg[152 - Average 152] 1 RD_ONLY

8352 FLOAT Archive_Avg[153 - Average 153] 1 RD_ONLY

8353 FLOAT Archive_Avg[154 - Average 154] 1 RD_ONLY

8354 FLOAT Archive_Avg[155 - Average 155] 1 RD_ONLY

8355 FLOAT Archive_Avg[156 - Average 156] 1 RD_ONLY

8356 FLOAT Archive_Avg[157 - Average 157] 1 RD_ONLY

8357 FLOAT Archive_Avg[158 - Average 158] 1 RD_ONLY

8358 FLOAT Archive_Avg[159 - Average 159] 1 RD_ONLY

8359 FLOAT Archive_Avg[160 - Average 160] 1 RD_ONLY

8360 FLOAT Archive_Avg[161 - Average 161] 1 RD_ONLY

8361 FLOAT Archive_Avg[162 - Average 162] 1 RD_ONLY

8362 FLOAT Archive_Avg[163 - Average 163] 1 RD_ONLY

8363 FLOAT Archive_Avg[164 - Average 164] 1 RD_ONLY

8364 FLOAT Archive_Avg[165 - Average 165] 1 RD_ONLY

8365 FLOAT Archive_Avg[166 - Average 166] 1 RD_ONLY

8366 FLOAT Archive_Avg[167 - Average 167] 1 RD_ONLY

8367 FLOAT Archive_Avg[168 - Average 168] 1 RD_ONLY

8368 FLOAT Archive_Avg[169 - Average 169] 1 RD_ONLY

8369 FLOAT Archive_Avg[170 - Average 170] 1 RD_ONLY

8370 FLOAT Archive_Avg[171 - Average 171] 1 RD_ONLY

8371 FLOAT Archive_Avg[172 - Average 172] 1 RD_ONLY

8372 FLOAT Archive_Avg[173 - Average 173] 1 RD_ONLY

8373 FLOAT Archive_Avg[174 - Average 174] 1 RD_ONLY
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8374 FLOAT Archive_Avg[175 - Average 175] 1 RD_ONLY

8375 FLOAT Archive_Avg[176 - Average 176] 1 RD_ONLY

8376 FLOAT Archive_Avg[177 - Average 177] 1 RD_ONLY

8377 FLOAT Archive_Avg[178 - Average 178] 1 RD_ONLY

8378 FLOAT Archive_Avg[179 - Average 179] 1 RD_ONLY

8379 FLOAT Archive_Avg[180 - Average 180] 1 RD_ONLY

8380 FLOAT Archive_Avg[181 - Average 181] 1 RD_ONLY

8381 FLOAT Archive_Avg[182 - Average 182] 1 RD_ONLY

8382 FLOAT Archive_Avg[183 - Average 183] 1 RD_ONLY

8383 FLOAT Archive_Avg[184 - Average 184] 1 RD_ONLY

8384 FLOAT Archive_Avg[185 - Average 185] 1 RD_ONLY

8385 FLOAT Archive_Avg[186 - Average 186] 1 RD_ONLY

8386 FLOAT Archive_Avg[187 - Average 187] 1 RD_ONLY

8387 FLOAT Archive_Avg[188 - Average 188] 1 RD_ONLY

8388 FLOAT Archive_Avg[189 - Average 189] 1 RD_ONLY

8389 FLOAT Archive_Avg[190 - Average 190] 1 RD_ONLY

8390 FLOAT Archive_Avg[191 - Average 191] 1 RD_ONLY

8391 FLOAT Archive_Avg[192 - Average 192] 1 RD_ONLY

8392 FLOAT Archive_Avg[193 - Average 193] 1 RD_ONLY

8393 FLOAT Archive_Avg[194 - Average 194] 1 RD_ONLY

8394 FLOAT Archive_Avg[195 - Average 195] 1 RD_ONLY

8395 FLOAT Archive_Avg[196 - Average 196] 1 RD_ONLY

8396 FLOAT Archive_Avg[197 - Average 197] 1 RD_ONLY

8397 FLOAT Archive_Avg[198 - Average 198] 1 RD_ONLY

8398 FLOAT Archive_Avg[199 - Average 199] 1 RD_ONLY

8399 FLOAT Archive_Avg[200 - Average 200] 1 RD_ONLY

8400 FLOAT Archive_Avg[201 - Average 201] 1 RD_ONLY

8401 FLOAT Archive_Avg[202 - Average 202] 1 RD_ONLY

8402 FLOAT Archive_Avg[203 - Average 203] 1 RD_ONLY

8403 FLOAT Archive_Avg[204 - Average 204] 1 RD_ONLY

8404 FLOAT Archive_Avg[205 - Average 205] 1 RD_ONLY

8405 FLOAT Archive_Avg[206 - Average 206] 1 RD_ONLY

8406 FLOAT Archive_Avg[207 - Average 207] 1 RD_ONLY

8407 FLOAT Archive_Avg[208 - Average 208] 1 RD_ONLY

8408 FLOAT Archive_Avg[209 - Average 209] 1 RD_ONLY

8409 FLOAT Archive_Avg[210 - Average 210] 1 RD_ONLY

8410 FLOAT Archive_Avg[211 - Average 211] 1 RD_ONLY
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8411 FLOAT Archive_Avg[212 - Average 212] 1 RD_ONLY

8412 FLOAT Archive_Avg[213 - Average 213] 1 RD_ONLY

8413 FLOAT Archive_Avg[214 - Average 214] 1 RD_ONLY

8414 FLOAT Archive_Avg[215 - Average 215] 1 RD_ONLY

8415 FLOAT Archive_Avg[216 - Average 216] 1 RD_ONLY

8416 FLOAT Archive_Avg[217 - Average 217] 1 RD_ONLY

8417 FLOAT Archive_Avg[218 - Average 218] 1 RD_ONLY

8418 FLOAT Archive_Avg[219 - Average 219] 1 RD_ONLY

8419 FLOAT Archive_Avg[220 - Average 220] 1 RD_ONLY

8420 FLOAT Archive_Avg[221 - Average 221] 1 RD_ONLY

8421 FLOAT Archive_Avg[222 - Average 222] 1 RD_ONLY

8422 FLOAT Archive_Avg[223 - Average 223] 1 RD_ONLY

8423 FLOAT Archive_Avg[224 - Average 224] 1 RD_ONLY

8424 FLOAT Archive_Avg[225 - Average 225] 1 RD_ONLY

8425 FLOAT Archive_Avg[226 - Average 226] 1 RD_ONLY

8426 FLOAT Archive_Avg[227 - Average 227] 1 RD_ONLY

8427 FLOAT Archive_Avg[228 - Average 228] 1 RD_ONLY

8428 FLOAT Archive_Avg[229 - Average 229] 1 RD_ONLY

8429 FLOAT Archive_Avg[230 - Average 230] 1 RD_ONLY

8430 FLOAT Archive_Avg[231 - Average 231] 1 RD_ONLY

8431 FLOAT Archive_Avg[232 - Average 232] 1 RD_ONLY

8432 FLOAT Archive_Avg[233 - Average 233] 1 RD_ONLY

8433 FLOAT Archive_Avg[234 - Average 234] 1 RD_ONLY

8434 FLOAT Archive_Avg[235 - Average 235] 1 RD_ONLY

8435 FLOAT Archive_Avg[236 - Average 236] 1 RD_ONLY

8436 FLOAT Archive_Avg[237 - Average 237] 1 RD_ONLY

8437 FLOAT Archive_Avg[238 - Average 238] 1 RD_ONLY

8438 FLOAT Archive_Avg[239 - Average 239] 1 RD_ONLY

8439 FLOAT Archive_Avg[240 - Average 240] 1 RD_ONLY

8440 FLOAT Archive_Avg[241 - Average 241] 1 RD_ONLY

8441 FLOAT Archive_Avg[242 - Average 242] 1 RD_ONLY

8442 FLOAT Archive_Avg[243 - Average 243] 1 RD_ONLY

8443 FLOAT Archive_Avg[244 - Average 244] 1 RD_ONLY

8444 FLOAT Archive_Avg[245 - Average 245] 1 RD_ONLY

8445 FLOAT Archive_Avg[246 - Average 246] 1 RD_ONLY

8446 FLOAT Archive_Avg[247 - Average 247] 1 RD_ONLY

8447 FLOAT Archive_Avg[248 - Average 248] 1 RD_ONLY
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8448 FLOAT Archive_Avg[249 - Average 249] 1 RD_ONLY

8449 FLOAT Archive_Avg[250 - Average 250] 1 RD_ONLY

8450 FLOAT Unused RD_ONLY

8451 FLOAT Unused RD_ONLY

8452 FLOAT Unused RD_ONLY

8453 FLOAT Unused RD_ONLY

8454 FLOAT Archive_Max[1 - Average 1] 1 RD_ONLY

8455 FLOAT Archive_Max[2 - Average 2] 1 RD_ONLY

8456 FLOAT Archive_Max[3 - Average 3] 1 RD_ONLY

8457 FLOAT Archive_Max[4 - Average 4] 1 RD_ONLY

8458 FLOAT Archive_Max[5 - Average 5] 1 RD_ONLY

8459 FLOAT Archive_Max[6 - Average 6] 1 RD_ONLY

8460 FLOAT Archive_Max[7 - Average 7] 1 RD_ONLY

8461 FLOAT Archive_Max[8 - Average 8] 1 RD_ONLY

8462 FLOAT Archive_Max[9 - Average 9] 1 RD_ONLY

8463 FLOAT Archive_Max[10 - Average 10] 1 RD_ONLY

8464 FLOAT Archive_Max[11 - Average 11] 1 RD_ONLY

8465 FLOAT Archive_Max[12 - Average 12] 1 RD_ONLY

8466 FLOAT Archive_Max[13 - Average 13] 1 RD_ONLY

8467 FLOAT Archive_Max[14 - Average 14] 1 RD_ONLY

8468 FLOAT Archive_Max[15 - Average 15] 1 RD_ONLY

8469 FLOAT Archive_Max[16 - Average 16] 1 RD_ONLY

8470 FLOAT Archive_Max[17 - Average 17] 1 RD_ONLY

8471 FLOAT Archive_Max[18 - Average 18] 1 RD_ONLY

8472 FLOAT Archive_Max[19 - Average 19] 1 RD_ONLY

8473 FLOAT Archive_Max[20 - Average 20] 1 RD_ONLY

8474 FLOAT Archive_Max[21 - Average 21] 1 RD_ONLY

8475 FLOAT Archive_Max[22 - Average 22] 1 RD_ONLY

8476 FLOAT Archive_Max[23 - Average 23] 1 RD_ONLY

8477 FLOAT Archive_Max[24 - Average 24] 1 RD_ONLY

8478 FLOAT Archive_Max[25 - Average 25] 1 RD_ONLY

8479 FLOAT Archive_Max[26 - Average 26] 1 RD_ONLY

8480 FLOAT Archive_Max[27 - Average 27] 1 RD_ONLY

8481 FLOAT Archive_Max[28 - Average 28] 1 RD_ONLY

8482 FLOAT Archive_Max[29 - Average 29] 1 RD_ONLY

8483 FLOAT Archive_Max[30 - Average 30] 1 RD_ONLY

8484 FLOAT Archive_Max[31 - Average 31] 1 RD_ONLY
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8485 FLOAT Archive_Max[32 - Average 32] 1 RD_ONLY

8486 FLOAT Archive_Max[33 - Average 33] 1 RD_ONLY

8487 FLOAT Archive_Max[34 - Average 34] 1 RD_ONLY

8488 FLOAT Archive_Max[35 - Average 35] 1 RD_ONLY

8489 FLOAT Archive_Max[36 - Average 36] 1 RD_ONLY

8490 FLOAT Archive_Max[37 - Average 37] 1 RD_ONLY

8491 FLOAT Archive_Max[38 - Average 38] 1 RD_ONLY

8492 FLOAT Archive_Max[39 - Average 39] 1 RD_ONLY

8493 FLOAT Archive_Max[40 - Average 40] 1 RD_ONLY

8494 FLOAT Archive_Max[41 - Average 41] 1 RD_ONLY

8495 FLOAT Archive_Max[42 - Average 42] 1 RD_ONLY

8496 FLOAT Archive_Max[43 - Average 43] 1 RD_ONLY

8497 FLOAT Archive_Max[44 - Average 44] 1 RD_ONLY

8498 FLOAT Archive_Max[45 - Average 45] 1 RD_ONLY

8499 FLOAT Archive_Max[46 - Average 46] 1 RD_ONLY

8500 FLOAT Archive_Max[47 - Average 47] 1 RD_ONLY

8501 FLOAT Archive_Max[48 - Average 48] 1 RD_ONLY

8502 FLOAT Archive_Max[49 - Average 49] 1 RD_ONLY

8503 FLOAT Archive_Max[50 - Average 50] 1 RD_ONLY

8504 FLOAT Archive_Max[51 - Average 51] 1 RD_ONLY

8505 FLOAT Archive_Max[52 - Average 52] 1 RD_ONLY

8506 FLOAT Archive_Max[53 - Average 53] 1 RD_ONLY

8507 FLOAT Archive_Max[54 - Average 54] 1 RD_ONLY

8508 FLOAT Archive_Max[55 - Average 55] 1 RD_ONLY

8509 FLOAT Archive_Max[56 - Average 56] 1 RD_ONLY

8510 FLOAT Archive_Max[57 - Average 57] 1 RD_ONLY

8511 FLOAT Archive_Max[58 - Average 58] 1 RD_ONLY

8512 FLOAT Archive_Max[59 - Average 59] 1 RD_ONLY

8513 FLOAT Archive_Max[60 - Average 60] 1 RD_ONLY

8514 FLOAT Archive_Max[61 - Average 61] 1 RD_ONLY

8515 FLOAT Archive_Max[62 - Average 62] 1 RD_ONLY

8516 FLOAT Archive_Max[63 - Average 63] 1 RD_ONLY

8517 FLOAT Archive_Max[64 - Average 64] 1 RD_ONLY

8518 FLOAT Archive_Max[65 - Average 65] 1 RD_ONLY

8519 FLOAT Archive_Max[66 - Average 66] 1 RD_ONLY

8520 FLOAT Archive_Max[67 - Average 67] 1 RD_ONLY

8521 FLOAT Archive_Max[68 - Average 68] 1 RD_ONLY
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8522 FLOAT Archive_Max[69 - Average 69] 1 RD_ONLY

8523 FLOAT Archive_Max[70 - Average 70] 1 RD_ONLY

8524 FLOAT Archive_Max[71 - Average 71] 1 RD_ONLY

8525 FLOAT Archive_Max[72 - Average 72] 1 RD_ONLY

8526 FLOAT Archive_Max[73 - Average 73] 1 RD_ONLY

8527 FLOAT Archive_Max[74 - Average 74] 1 RD_ONLY

8528 FLOAT Archive_Max[75 - Average 75] 1 RD_ONLY

8529 FLOAT Archive_Max[76 - Average 76] 1 RD_ONLY

8530 FLOAT Archive_Max[77 - Average 77] 1 RD_ONLY

8531 FLOAT Archive_Max[78 - Average 78] 1 RD_ONLY

8532 FLOAT Archive_Max[79 - Average 79] 1 RD_ONLY

8533 FLOAT Archive_Max[80 - Average 80] 1 RD_ONLY

8534 FLOAT Archive_Max[81 - Average 81] 1 RD_ONLY

8535 FLOAT Archive_Max[82 - Average 82] 1 RD_ONLY

8536 FLOAT Archive_Max[83 - Average 83] 1 RD_ONLY

8537 FLOAT Archive_Max[84 - Average 84] 1 RD_ONLY

8538 FLOAT Archive_Max[85 - Average 85] 1 RD_ONLY

8539 FLOAT Archive_Max[86 - Average 86] 1 RD_ONLY

8540 FLOAT Archive_Max[87 - Average 87] 1 RD_ONLY

8541 FLOAT Archive_Max[88 - Average 88] 1 RD_ONLY

8542 FLOAT Archive_Max[89 - Average 89] 1 RD_ONLY

8543 FLOAT Archive_Max[90 - Average 90] 1 RD_ONLY

8544 FLOAT Archive_Max[91 - Average 91] 1 RD_ONLY

8545 FLOAT Archive_Max[92 - Average 92] 1 RD_ONLY

8546 FLOAT Archive_Max[93 - Average 93] 1 RD_ONLY

8547 FLOAT Archive_Max[94 - Average 94] 1 RD_ONLY

8548 FLOAT Archive_Max[95 - Average 95] 1 RD_ONLY

8549 FLOAT Archive_Max[96 - Average 96] 1 RD_ONLY

8550 FLOAT Archive_Max[97 - Average 97] 1 RD_ONLY

8551 FLOAT Archive_Max[98 - Average 98] 1 RD_ONLY

8552 FLOAT Archive_Max[99 - Average 99] 1 RD_ONLY

8553 FLOAT Archive_Max[100 - Average 100] 1 RD_ONLY

8554 FLOAT Archive_Max[101 - Average 101] 1 RD_ONLY

8555 FLOAT Archive_Max[102 - Average 102] 1 RD_ONLY

8556 FLOAT Archive_Max[103 - Average 103] 1 RD_ONLY

8557 FLOAT Archive_Max[104 - Average 104] 1 RD_ONLY

8558 FLOAT Archive_Max[105 - Average 105] 1 RD_ONLY
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8559 FLOAT Archive_Max[106 - Average 106] 1 RD_ONLY

8560 FLOAT Archive_Max[107 - Average 107] 1 RD_ONLY

8561 FLOAT Archive_Max[108 - Average 108] 1 RD_ONLY

8562 FLOAT Archive_Max[109 - Average 109] 1 RD_ONLY

8563 FLOAT Archive_Max[110 - Average 110] 1 RD_ONLY

8564 FLOAT Archive_Max[111 - Average 111] 1 RD_ONLY

8565 FLOAT Archive_Max[112 - Average 112] 1 RD_ONLY

8566 FLOAT Archive_Max[113 - Average 113] 1 RD_ONLY

8567 FLOAT Archive_Max[114 - Average 114] 1 RD_ONLY

8568 FLOAT Archive_Max[115 - Average 115] 1 RD_ONLY

8569 FLOAT Archive_Max[116 - Average 116] 1 RD_ONLY

8570 FLOAT Archive_Max[117 - Average 117] 1 RD_ONLY

8571 FLOAT Archive_Max[118 - Average 118] 1 RD_ONLY

8572 FLOAT Archive_Max[119 - Average 119] 1 RD_ONLY

8573 FLOAT Archive_Max[120 - Average 120] 1 RD_ONLY

8574 FLOAT Archive_Max[121 - Average 121] 1 RD_ONLY

8575 FLOAT Archive_Max[122 - Average 122] 1 RD_ONLY

8576 FLOAT Archive_Max[123 - Average 123] 1 RD_ONLY

8577 FLOAT Archive_Max[124 - Average 124] 1 RD_ONLY

8578 FLOAT Archive_Max[125 - Average 125] 1 RD_ONLY

8579 FLOAT Archive_Max[126 - Average 126] 1 RD_ONLY

8580 FLOAT Archive_Max[127 - Average 127] 1 RD_ONLY

8581 FLOAT Archive_Max[128 - Average 128] 1 RD_ONLY

8582 FLOAT Archive_Max[129 - Average 129] 1 RD_ONLY

8583 FLOAT Archive_Max[130 - Average 130] 1 RD_ONLY

8584 FLOAT Archive_Max[131 - Average 131] 1 RD_ONLY

8585 FLOAT Archive_Max[132 - Average 132] 1 RD_ONLY

8586 FLOAT Archive_Max[133 - Average 133] 1 RD_ONLY

8587 FLOAT Archive_Max[134 - Average 134] 1 RD_ONLY

8588 FLOAT Archive_Max[135 - Average 135] 1 RD_ONLY

8589 FLOAT Archive_Max[136 - Average 136] 1 RD_ONLY

8590 FLOAT Archive_Max[137 - Average 137] 1 RD_ONLY

8591 FLOAT Archive_Max[138 - Average 138] 1 RD_ONLY

8592 FLOAT Archive_Max[139 - Average 139] 1 RD_ONLY

8593 FLOAT Archive_Max[140 - Average 140] 1 RD_ONLY

8594 FLOAT Archive_Max[141 - Average 141] 1 RD_ONLY

8595 FLOAT Archive_Max[142 - Average 142] 1 RD_ONLY
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8596 FLOAT Archive_Max[143 - Average 143] 1 RD_ONLY

8597 FLOAT Archive_Max[144 - Average 144] 1 RD_ONLY

8598 FLOAT Archive_Max[145 - Average 145] 1 RD_ONLY

8599 FLOAT Archive_Max[146 - Average 146] 1 RD_ONLY

8600 FLOAT Archive_Max[147 - Average 147] 1 RD_ONLY

8601 FLOAT Archive_Max[148 - Average 148] 1 RD_ONLY

8602 FLOAT Archive_Max[149 - Average 149] 1 RD_ONLY

8603 FLOAT Archive_Max[150 - Average 150] 1 RD_ONLY

8604 FLOAT Archive_Max[151 - Average 151] 1 RD_ONLY

8605 FLOAT Archive_Max[152 - Average 152] 1 RD_ONLY

8606 FLOAT Archive_Max[153 - Average 153] 1 RD_ONLY

8607 FLOAT Archive_Max[154 - Average 154] 1 RD_ONLY

8608 FLOAT Archive_Max[155 - Average 155] 1 RD_ONLY

8609 FLOAT Archive_Max[156 - Average 156] 1 RD_ONLY

8610 FLOAT Archive_Max[157 - Average 157] 1 RD_ONLY

8611 FLOAT Archive_Max[158 - Average 158] 1 RD_ONLY

8612 FLOAT Archive_Max[159 - Average 159] 1 RD_ONLY

8613 FLOAT Archive_Max[160 - Average 160] 1 RD_ONLY

8614 FLOAT Archive_Max[161 - Average 161] 1 RD_ONLY

8615 FLOAT Archive_Max[162 - Average 162] 1 RD_ONLY

8616 FLOAT Archive_Max[163 - Average 163] 1 RD_ONLY

8617 FLOAT Archive_Max[164 - Average 164] 1 RD_ONLY

8618 FLOAT Archive_Max[165 - Average 165] 1 RD_ONLY

8619 FLOAT Archive_Max[166 - Average 166] 1 RD_ONLY

8620 FLOAT Archive_Max[167 - Average 167] 1 RD_ONLY

8621 FLOAT Archive_Max[168 - Average 168] 1 RD_ONLY

8622 FLOAT Archive_Max[169 - Average 169] 1 RD_ONLY

8623 FLOAT Archive_Max[170 - Average 170] 1 RD_ONLY

8624 FLOAT Archive_Max[171 - Average 171] 1 RD_ONLY

8625 FLOAT Archive_Max[172 - Average 172] 1 RD_ONLY

8626 FLOAT Archive_Max[173 - Average 173] 1 RD_ONLY

8627 FLOAT Archive_Max[174 - Average 174] 1 RD_ONLY

8628 FLOAT Archive_Max[175 - Average 175] 1 RD_ONLY

8629 FLOAT Archive_Max[176 - Average 176] 1 RD_ONLY

8630 FLOAT Archive_Max[177 - Average 177] 1 RD_ONLY

8631 FLOAT Archive_Max[178 - Average 178] 1 RD_ONLY

8632 FLOAT Archive_Max[179 - Average 179] 1 RD_ONLY
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8633 FLOAT Archive_Max[180 - Average 180] 1 RD_ONLY

8634 FLOAT Archive_Max[181 - Average 181] 1 RD_ONLY

8635 FLOAT Archive_Max[182 - Average 182] 1 RD_ONLY

8636 FLOAT Archive_Max[183 - Average 183] 1 RD_ONLY

8637 FLOAT Archive_Max[184 - Average 184] 1 RD_ONLY

8638 FLOAT Archive_Max[185 - Average 185] 1 RD_ONLY

8639 FLOAT Archive_Max[186 - Average 186] 1 RD_ONLY

8640 FLOAT Archive_Max[187 - Average 187] 1 RD_ONLY

8641 FLOAT Archive_Max[188 - Average 188] 1 RD_ONLY

8642 FLOAT Archive_Max[189 - Average 189] 1 RD_ONLY

8643 FLOAT Archive_Max[190 - Average 190] 1 RD_ONLY

8644 FLOAT Archive_Max[191 - Average 191] 1 RD_ONLY

8645 FLOAT Archive_Max[192 - Average 192] 1 RD_ONLY

8646 FLOAT Archive_Max[193 - Average 193] 1 RD_ONLY

8647 FLOAT Archive_Max[194 - Average 194] 1 RD_ONLY

8648 FLOAT Archive_Max[195 - Average 195] 1 RD_ONLY

8649 FLOAT Archive_Max[196 - Average 196] 1 RD_ONLY

8650 FLOAT Archive_Max[197 - Average 197] 1 RD_ONLY

8651 FLOAT Archive_Max[198 - Average 198] 1 RD_ONLY

8652 FLOAT Archive_Max[199 - Average 199] 1 RD_ONLY

8653 FLOAT Archive_Max[200 - Average 200] 1 RD_ONLY

8654 FLOAT Archive_Max[201 - Average 201] 1 RD_ONLY

8655 FLOAT Archive_Max[202 - Average 202] 1 RD_ONLY

8656 FLOAT Archive_Max[203 - Average 203] 1 RD_ONLY

8657 FLOAT Archive_Max[204 - Average 204] 1 RD_ONLY

8658 FLOAT Archive_Max[205 - Average 205] 1 RD_ONLY

8659 FLOAT Archive_Max[206 - Average 206] 1 RD_ONLY

8660 FLOAT Archive_Max[207 - Average 207] 1 RD_ONLY

8661 FLOAT Archive_Max[208 - Average 208] 1 RD_ONLY

8662 FLOAT Archive_Max[209 - Average 209] 1 RD_ONLY

8663 FLOAT Archive_Max[210 - Average 210] 1 RD_ONLY

8664 FLOAT Archive_Max[211 - Average 211] 1 RD_ONLY

8665 FLOAT Archive_Max[212 - Average 212] 1 RD_ONLY

8666 FLOAT Archive_Max[213 - Average 213] 1 RD_ONLY

8667 FLOAT Archive_Max[214 - Average 214] 1 RD_ONLY

8668 FLOAT Archive_Max[215 - Average 215] 1 RD_ONLY

8669 FLOAT Archive_Max[216 - Average 216] 1 RD_ONLY
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8670 FLOAT Archive_Max[217 - Average 217] 1 RD_ONLY

8671 FLOAT Archive_Max[218 - Average 218] 1 RD_ONLY

8672 FLOAT Archive_Max[219 - Average 219] 1 RD_ONLY

8673 FLOAT Archive_Max[220 - Average 220] 1 RD_ONLY

8674 FLOAT Archive_Max[221 - Average 221] 1 RD_ONLY

8675 FLOAT Archive_Max[222 - Average 222] 1 RD_ONLY

8676 FLOAT Archive_Max[223 - Average 223] 1 RD_ONLY

8677 FLOAT Archive_Max[224 - Average 224] 1 RD_ONLY

8678 FLOAT Archive_Max[225 - Average 225] 1 RD_ONLY

8679 FLOAT Archive_Max[226 - Average 226] 1 RD_ONLY

8680 FLOAT Archive_Max[227 - Average 227] 1 RD_ONLY

8681 FLOAT Archive_Max[228 - Average 228] 1 RD_ONLY

8682 FLOAT Archive_Max[229 - Average 229] 1 RD_ONLY

8683 FLOAT Archive_Max[230 - Average 230] 1 RD_ONLY

8684 FLOAT Archive_Max[231 - Average 231] 1 RD_ONLY

8685 FLOAT Archive_Max[232 - Average 232] 1 RD_ONLY

8686 FLOAT Archive_Max[233 - Average 233] 1 RD_ONLY

8687 FLOAT Archive_Max[234 - Average 234] 1 RD_ONLY

8688 FLOAT Archive_Max[235 - Average 235] 1 RD_ONLY

8689 FLOAT Archive_Max[236 - Average 236] 1 RD_ONLY

8690 FLOAT Archive_Max[237 - Average 237] 1 RD_ONLY

8691 FLOAT Archive_Max[238 - Average 238] 1 RD_ONLY

8692 FLOAT Archive_Max[239 - Average 239] 1 RD_ONLY

8693 FLOAT Archive_Max[240 - Average 240] 1 RD_ONLY

8694 FLOAT Archive_Max[241 - Average 241] 1 RD_ONLY

8695 FLOAT Archive_Max[242 - Average 242] 1 RD_ONLY

8696 FLOAT Archive_Max[243 - Average 243] 1 RD_ONLY

8697 FLOAT Archive_Max[244 - Average 244] 1 RD_ONLY

8698 FLOAT Archive_Max[245 - Average 245] 1 RD_ONLY

8699 FLOAT Archive_Max[246 - Average 246] 1 RD_ONLY

8700 FLOAT Archive_Max[247 - Average 247] 1 RD_ONLY

8701 FLOAT Archive_Max[248 - Average 248] 1 RD_ONLY

8702 FLOAT Archive_Max[249 - Average 249] 1 RD_ONLY

8703 FLOAT Archive_Max[250 - Average 250] 1 RD_ONLY

8704 FLOAT Unused RD_ONLY

8705 FLOAT Unused RD_ONLY

8706 FLOAT Unused RD_ONLY
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8707 FLOAT Unused RD_ONLY

8708 FLOAT Archive_Min[1 - Average 1] 1 RD_ONLY

8709 FLOAT Archive_Min[2 - Average 2] 1 RD_ONLY

8710 FLOAT Archive_Min[3 - Average 3] 1 RD_ONLY

8711 FLOAT Archive_Min[4 - Average 4] 1 RD_ONLY

8712 FLOAT Archive_Min[5 - Average 5] 1 RD_ONLY

8713 FLOAT Archive_Min[6 - Average 6] 1 RD_ONLY

8714 FLOAT Archive_Min[7 - Average 7] 1 RD_ONLY

8715 FLOAT Archive_Min[8 - Average 8] 1 RD_ONLY

8716 FLOAT Archive_Min[9 - Average 9] 1 RD_ONLY

8717 FLOAT Archive_Min[10 - Average 10] 1 RD_ONLY

8718 FLOAT Archive_Min[11 - Average 11] 1 RD_ONLY

8719 FLOAT Archive_Min[12 - Average 12] 1 RD_ONLY

8720 FLOAT Archive_Min[13 - Average 13] 1 RD_ONLY

8721 FLOAT Archive_Min[14 - Average 14] 1 RD_ONLY

8722 FLOAT Archive_Min[15 - Average 15] 1 RD_ONLY

8723 FLOAT Archive_Min[16 - Average 16] 1 RD_ONLY

8724 FLOAT Archive_Min[17 - Average 17] 1 RD_ONLY

8725 FLOAT Archive_Min[18 - Average 18] 1 RD_ONLY

8726 FLOAT Archive_Min[19 - Average 19] 1 RD_ONLY

8727 FLOAT Archive_Min[20 - Average 20] 1 RD_ONLY

8728 FLOAT Archive_Min[21 - Average 21] 1 RD_ONLY

8729 FLOAT Archive_Min[22 - Average 22] 1 RD_ONLY

8730 FLOAT Archive_Min[23 - Average 23] 1 RD_ONLY

8731 FLOAT Archive_Min[24 - Average 24] 1 RD_ONLY

8732 FLOAT Archive_Min[25 - Average 25] 1 RD_ONLY

8733 FLOAT Archive_Min[26 - Average 26] 1 RD_ONLY

8734 FLOAT Archive_Min[27 - Average 27] 1 RD_ONLY

8735 FLOAT Archive_Min[28 - Average 28] 1 RD_ONLY

8736 FLOAT Archive_Min[29 - Average 29] 1 RD_ONLY

8737 FLOAT Archive_Min[30 - Average 30] 1 RD_ONLY

8738 FLOAT Archive_Min[31 - Average 31] 1 RD_ONLY

8739 FLOAT Archive_Min[32 - Average 32] 1 RD_ONLY

8740 FLOAT Archive_Min[33 - Average 33] 1 RD_ONLY

8741 FLOAT Archive_Min[34 - Average 34] 1 RD_ONLY

8742 FLOAT Archive_Min[35 - Average 35] 1 RD_ONLY

8743 FLOAT Archive_Min[36 - Average 36] 1 RD_ONLY
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8744 FLOAT Archive_Min[37 - Average 37] 1 RD_ONLY

8745 FLOAT Archive_Min[38 - Average 38] 1 RD_ONLY

8746 FLOAT Archive_Min[39 - Average 39] 1 RD_ONLY

8747 FLOAT Archive_Min[40 - Average 40] 1 RD_ONLY

8748 FLOAT Archive_Min[41 - Average 41] 1 RD_ONLY

8749 FLOAT Archive_Min[42 - Average 42] 1 RD_ONLY

8750 FLOAT Archive_Min[43 - Average 43] 1 RD_ONLY

8751 FLOAT Archive_Min[44 - Average 44] 1 RD_ONLY

8752 FLOAT Archive_Min[45 - Average 45] 1 RD_ONLY

8753 FLOAT Archive_Min[46 - Average 46] 1 RD_ONLY

8754 FLOAT Archive_Min[47 - Average 47] 1 RD_ONLY

8755 FLOAT Archive_Min[48 - Average 48] 1 RD_ONLY

8756 FLOAT Archive_Min[49 - Average 49] 1 RD_ONLY

8757 FLOAT Archive_Min[50 - Average 50] 1 RD_ONLY

8758 FLOAT Archive_Min[51 - Average 51] 1 RD_ONLY

8759 FLOAT Archive_Min[52 - Average 52] 1 RD_ONLY

8760 FLOAT Archive_Min[53 - Average 53] 1 RD_ONLY

8761 FLOAT Archive_Min[54 - Average 54] 1 RD_ONLY

8762 FLOAT Archive_Min[55 - Average 55] 1 RD_ONLY

8763 FLOAT Archive_Min[56 - Average 56] 1 RD_ONLY

8764 FLOAT Archive_Min[57 - Average 57] 1 RD_ONLY

8765 FLOAT Archive_Min[58 - Average 58] 1 RD_ONLY

8766 FLOAT Archive_Min[59 - Average 59] 1 RD_ONLY

8767 FLOAT Archive_Min[60 - Average 60] 1 RD_ONLY

8768 FLOAT Archive_Min[61 - Average 61] 1 RD_ONLY

8769 FLOAT Archive_Min[62 - Average 62] 1 RD_ONLY

8770 FLOAT Archive_Min[63 - Average 63] 1 RD_ONLY

8771 FLOAT Archive_Min[64 - Average 64] 1 RD_ONLY

8772 FLOAT Archive_Min[65 - Average 65] 1 RD_ONLY

8773 FLOAT Archive_Min[66 - Average 66] 1 RD_ONLY

8774 FLOAT Archive_Min[67 - Average 67] 1 RD_ONLY

8775 FLOAT Archive_Min[68 - Average 68] 1 RD_ONLY

8776 FLOAT Archive_Min[69 - Average 69] 1 RD_ONLY

8777 FLOAT Archive_Min[70 - Average 70] 1 RD_ONLY

8778 FLOAT Archive_Min[71 - Average 71] 1 RD_ONLY

8779 FLOAT Archive_Min[72 - Average 72] 1 RD_ONLY

8780 FLOAT Archive_Min[73 - Average 73] 1 RD_ONLY
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8781 FLOAT Archive_Min[74 - Average 74] 1 RD_ONLY

8782 FLOAT Archive_Min[75 - Average 75] 1 RD_ONLY

8783 FLOAT Archive_Min[76 - Average 76] 1 RD_ONLY

8784 FLOAT Archive_Min[77 - Average 77] 1 RD_ONLY

8785 FLOAT Archive_Min[78 - Average 78] 1 RD_ONLY

8786 FLOAT Archive_Min[79 - Average 79] 1 RD_ONLY

8787 FLOAT Archive_Min[80 - Average 80] 1 RD_ONLY

8788 FLOAT Archive_Min[81 - Average 81] 1 RD_ONLY

8789 FLOAT Archive_Min[82 - Average 82] 1 RD_ONLY

8790 FLOAT Archive_Min[83 - Average 83] 1 RD_ONLY

8791 FLOAT Archive_Min[84 - Average 84] 1 RD_ONLY

8792 FLOAT Archive_Min[85 - Average 85] 1 RD_ONLY

8793 FLOAT Archive_Min[86 - Average 86] 1 RD_ONLY

8794 FLOAT Archive_Min[87 - Average 87] 1 RD_ONLY

8795 FLOAT Archive_Min[88 - Average 88] 1 RD_ONLY

8796 FLOAT Archive_Min[89 - Average 89] 1 RD_ONLY

8797 FLOAT Archive_Min[90 - Average 90] 1 RD_ONLY

8798 FLOAT Archive_Min[91 - Average 91] 1 RD_ONLY

8799 FLOAT Archive_Min[92 - Average 92] 1 RD_ONLY

8800 FLOAT Archive_Min[93 - Average 93] 1 RD_ONLY

8801 FLOAT Archive_Min[94 - Average 94] 1 RD_ONLY

8802 FLOAT Archive_Min[95 - Average 95] 1 RD_ONLY

8803 FLOAT Archive_Min[96 - Average 96] 1 RD_ONLY

8804 FLOAT Archive_Min[97 - Average 97] 1 RD_ONLY

8805 FLOAT Archive_Min[98 - Average 98] 1 RD_ONLY

8806 FLOAT Archive_Min[99 - Average 99] 1 RD_ONLY

8807 FLOAT Archive_Min[100 - Average 100] 1 RD_ONLY

8808 FLOAT Archive_Min[101 - Average 101] 1 RD_ONLY

8809 FLOAT Archive_Min[102 - Average 102] 1 RD_ONLY

8810 FLOAT Archive_Min[103 - Average 103] 1 RD_ONLY

8811 FLOAT Archive_Min[104 - Average 104] 1 RD_ONLY

8812 FLOAT Archive_Min[105 - Average 105] 1 RD_ONLY

8813 FLOAT Archive_Min[106 - Average 106] 1 RD_ONLY

8814 FLOAT Archive_Min[107 - Average 107] 1 RD_ONLY

8815 FLOAT Archive_Min[108 - Average 108] 1 RD_ONLY

8816 FLOAT Archive_Min[109 - Average 109] 1 RD_ONLY

8817 FLOAT Archive_Min[110 - Average 110] 1 RD_ONLY
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8818 FLOAT Archive_Min[111 - Average 111] 1 RD_ONLY

8819 FLOAT Archive_Min[112 - Average 112] 1 RD_ONLY

8820 FLOAT Archive_Min[113 - Average 113] 1 RD_ONLY

8821 FLOAT Archive_Min[114 - Average 114] 1 RD_ONLY

8822 FLOAT Archive_Min[115 - Average 115] 1 RD_ONLY

8823 FLOAT Archive_Min[116 - Average 116] 1 RD_ONLY

8824 FLOAT Archive_Min[117 - Average 117] 1 RD_ONLY

8825 FLOAT Archive_Min[118 - Average 118] 1 RD_ONLY

8826 FLOAT Archive_Min[119 - Average 119] 1 RD_ONLY

8827 FLOAT Archive_Min[120 - Average 120] 1 RD_ONLY

8828 FLOAT Archive_Min[121 - Average 121] 1 RD_ONLY

8829 FLOAT Archive_Min[122 - Average 122] 1 RD_ONLY

8830 FLOAT Archive_Min[123 - Average 123] 1 RD_ONLY

8831 FLOAT Archive_Min[124 - Average 124] 1 RD_ONLY

8832 FLOAT Archive_Min[125 - Average 125] 1 RD_ONLY

8833 FLOAT Archive_Min[126 - Average 126] 1 RD_ONLY

8834 FLOAT Archive_Min[127 - Average 127] 1 RD_ONLY

8835 FLOAT Archive_Min[128 - Average 128] 1 RD_ONLY

8836 FLOAT Archive_Min[129 - Average 129] 1 RD_ONLY

8837 FLOAT Archive_Min[130 - Average 130] 1 RD_ONLY

8838 FLOAT Archive_Min[131 - Average 131] 1 RD_ONLY

8839 FLOAT Archive_Min[132 - Average 132] 1 RD_ONLY

8840 FLOAT Archive_Min[133 - Average 133] 1 RD_ONLY

8841 FLOAT Archive_Min[134 - Average 134] 1 RD_ONLY

8842 FLOAT Archive_Min[135 - Average 135] 1 RD_ONLY

8843 FLOAT Archive_Min[136 - Average 136] 1 RD_ONLY

8844 FLOAT Archive_Min[137 - Average 137] 1 RD_ONLY

8845 FLOAT Archive_Min[138 - Average 138] 1 RD_ONLY

8846 FLOAT Archive_Min[139 - Average 139] 1 RD_ONLY

8847 FLOAT Archive_Min[140 - Average 140] 1 RD_ONLY

8848 FLOAT Archive_Min[141 - Average 141] 1 RD_ONLY

8849 FLOAT Archive_Min[142 - Average 142] 1 RD_ONLY

8850 FLOAT Archive_Min[143 - Average 143] 1 RD_ONLY

8851 FLOAT Archive_Min[144 - Average 144] 1 RD_ONLY

8852 FLOAT Archive_Min[145 - Average 145] 1 RD_ONLY

8853 FLOAT Archive_Min[146 - Average 146] 1 RD_ONLY

8854 FLOAT Archive_Min[147 - Average 147] 1 RD_ONLY
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8855 FLOAT Archive_Min[148 - Average 148] 1 RD_ONLY

8856 FLOAT Archive_Min[149 - Average 149] 1 RD_ONLY

8857 FLOAT Archive_Min[150 - Average 150] 1 RD_ONLY

8858 FLOAT Archive_Min[151 - Average 151] 1 RD_ONLY

8859 FLOAT Archive_Min[152 - Average 152] 1 RD_ONLY

8860 FLOAT Archive_Min[153 - Average 153] 1 RD_ONLY

8861 FLOAT Archive_Min[154 - Average 154] 1 RD_ONLY

8862 FLOAT Archive_Min[155 - Average 155] 1 RD_ONLY

8863 FLOAT Archive_Min[156 - Average 156] 1 RD_ONLY

8864 FLOAT Archive_Min[157 - Average 157] 1 RD_ONLY

8865 FLOAT Archive_Min[158 - Average 158] 1 RD_ONLY

8866 FLOAT Archive_Min[159 - Average 159] 1 RD_ONLY

8867 FLOAT Archive_Min[160 - Average 160] 1 RD_ONLY

8868 FLOAT Archive_Min[161 - Average 161] 1 RD_ONLY

8869 FLOAT Archive_Min[162 - Average 162] 1 RD_ONLY

8870 FLOAT Archive_Min[163 - Average 163] 1 RD_ONLY

8871 FLOAT Archive_Min[164 - Average 164] 1 RD_ONLY

8872 FLOAT Archive_Min[165 - Average 165] 1 RD_ONLY

8873 FLOAT Archive_Min[166 - Average 166] 1 RD_ONLY

8874 FLOAT Archive_Min[167 - Average 167] 1 RD_ONLY

8875 FLOAT Archive_Min[168 - Average 168] 1 RD_ONLY

8876 FLOAT Archive_Min[169 - Average 169] 1 RD_ONLY

8877 FLOAT Archive_Min[170 - Average 170] 1 RD_ONLY

8878 FLOAT Archive_Min[171 - Average 171] 1 RD_ONLY

8879 FLOAT Archive_Min[172 - Average 172] 1 RD_ONLY

8880 FLOAT Archive_Min[173 - Average 173] 1 RD_ONLY

8881 FLOAT Archive_Min[174 - Average 174] 1 RD_ONLY

8882 FLOAT Archive_Min[175 - Average 175] 1 RD_ONLY

8883 FLOAT Archive_Min[176 - Average 176] 1 RD_ONLY

8884 FLOAT Archive_Min[177 - Average 177] 1 RD_ONLY

8885 FLOAT Archive_Min[178 - Average 178] 1 RD_ONLY

8886 FLOAT Archive_Min[179 - Average 179] 1 RD_ONLY

8887 FLOAT Archive_Min[180 - Average 180] 1 RD_ONLY

8888 FLOAT Archive_Min[181 - Average 181] 1 RD_ONLY

8889 FLOAT Archive_Min[182 - Average 182] 1 RD_ONLY

8890 FLOAT Archive_Min[183 - Average 183] 1 RD_ONLY

8891 FLOAT Archive_Min[184 - Average 184] 1 RD_ONLY
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8892 FLOAT Archive_Min[185 - Average 185] 1 RD_ONLY

8893 FLOAT Archive_Min[186 - Average 186] 1 RD_ONLY

8894 FLOAT Archive_Min[187 - Average 187] 1 RD_ONLY

8895 FLOAT Archive_Min[188 - Average 188] 1 RD_ONLY

8896 FLOAT Archive_Min[189 - Average 189] 1 RD_ONLY

8897 FLOAT Archive_Min[190 - Average 190] 1 RD_ONLY

8898 FLOAT Archive_Min[191 - Average 191] 1 RD_ONLY

8899 FLOAT Archive_Min[192 - Average 192] 1 RD_ONLY

8900 FLOAT Archive_Min[193 - Average 193] 1 RD_ONLY

8901 FLOAT Archive_Min[194 - Average 194] 1 RD_ONLY

8902 FLOAT Archive_Min[195 - Average 195] 1 RD_ONLY

8903 FLOAT Archive_Min[196 - Average 196] 1 RD_ONLY

8904 FLOAT Archive_Min[197 - Average 197] 1 RD_ONLY

8905 FLOAT Archive_Min[198 - Average 198] 1 RD_ONLY

8906 FLOAT Archive_Min[199 - Average 199] 1 RD_ONLY

8907 FLOAT Archive_Min[200 - Average 200] 1 RD_ONLY

8908 FLOAT Archive_Min[201 - Average 201] 1 RD_ONLY

8909 FLOAT Archive_Min[202 - Average 202] 1 RD_ONLY

8910 FLOAT Archive_Min[203 - Average 203] 1 RD_ONLY

8911 FLOAT Archive_Min[204 - Average 204] 1 RD_ONLY

8912 FLOAT Archive_Min[205 - Average 205] 1 RD_ONLY

8913 FLOAT Archive_Min[206 - Average 206] 1 RD_ONLY

8914 FLOAT Archive_Min[207 - Average 207] 1 RD_ONLY

8915 FLOAT Archive_Min[208 - Average 208] 1 RD_ONLY

8916 FLOAT Archive_Min[209 - Average 209] 1 RD_ONLY

8917 FLOAT Archive_Min[210 - Average 210] 1 RD_ONLY

8918 FLOAT Archive_Min[211 - Average 211] 1 RD_ONLY

8919 FLOAT Archive_Min[212 - Average 212] 1 RD_ONLY

8920 FLOAT Archive_Min[213 - Average 213] 1 RD_ONLY

8921 FLOAT Archive_Min[214 - Average 214] 1 RD_ONLY

8922 FLOAT Archive_Min[215 - Average 215] 1 RD_ONLY

8923 FLOAT Archive_Min[216 - Average 216] 1 RD_ONLY

8924 FLOAT Archive_Min[217 - Average 217] 1 RD_ONLY

8925 FLOAT Archive_Min[218 - Average 218] 1 RD_ONLY

8926 FLOAT Archive_Min[219 - Average 219] 1 RD_ONLY

8927 FLOAT Archive_Min[220 - Average 220] 1 RD_ONLY

8928 FLOAT Archive_Min[221 - Average 221] 1 RD_ONLY
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8929 FLOAT Archive_Min[222 - Average 222] 1 RD_ONLY

8930 FLOAT Archive_Min[223 - Average 223] 1 RD_ONLY

8931 FLOAT Archive_Min[224 - Average 224] 1 RD_ONLY

8932 FLOAT Archive_Min[225 - Average 225] 1 RD_ONLY

8933 FLOAT Archive_Min[226 - Average 226] 1 RD_ONLY

8934 FLOAT Archive_Min[227 - Average 227] 1 RD_ONLY

8935 FLOAT Archive_Min[228 - Average 228] 1 RD_ONLY

8936 FLOAT Archive_Min[229 - Average 229] 1 RD_ONLY

8937 FLOAT Archive_Min[230 - Average 230] 1 RD_ONLY

8938 FLOAT Archive_Min[231 - Average 231] 1 RD_ONLY

8939 FLOAT Archive_Min[232 - Average 232] 1 RD_ONLY

8940 FLOAT Archive_Min[233 - Average 233] 1 RD_ONLY

8941 FLOAT Archive_Min[234 - Average 234] 1 RD_ONLY

8942 FLOAT Archive_Min[235 - Average 235] 1 RD_ONLY

8943 FLOAT Archive_Min[236 - Average 236] 1 RD_ONLY

8944 FLOAT Archive_Min[237 - Average 237] 1 RD_ONLY

8945 FLOAT Archive_Min[238 - Average 238] 1 RD_ONLY

8946 FLOAT Archive_Min[239 - Average 239] 1 RD_ONLY

8947 FLOAT Archive_Min[240 - Average 240] 1 RD_ONLY

8948 FLOAT Archive_Min[241 - Average 241] 1 RD_ONLY

8949 FLOAT Archive_Min[242 - Average 242] 1 RD_ONLY

8950 FLOAT Archive_Min[243 - Average 243] 1 RD_ONLY

8951 FLOAT Archive_Min[244 - Average 244] 1 RD_ONLY

8952 FLOAT Archive_Min[245 - Average 245] 1 RD_ONLY

8953 FLOAT Archive_Min[246 - Average 246] 1 RD_ONLY

8954 FLOAT Archive_Min[247 - Average 247] 1 RD_ONLY

8955 FLOAT Archive_Min[248 - Average 248] 1 RD_ONLY

8956 FLOAT Archive_Min[249 - Average 249] 1 RD_ONLY

8957 FLOAT Archive_Min[250 - Average 250] 1 RD_ONLY

8958 FLOAT Unused RD_ONLY

8959 FLOAT Unused RD_ONLY

8960 FLOAT Unused RD_ONLY

8961 FLOAT Unused RD_ONLY

8962 FLOAT Unused RD_ONLY

8963 FLOAT Clear All Alarms RD_WR

8964 FLOAT Acknowledge All Alarms RD_WR

9006 INT Current Time(time_t) RD_WR MM
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9007 INT Current Time(time_t) RD_WR DD

9008 INT Current Time(time_t) RD_WR YYYY

9009 INT Current Time(time_t) RD_WR hh

9010 INT Current Time(time_t) RD_WR mm

9011 INT Current Time(time_t) RD_WR ss

9012 INT Unused RD_ONLY

9013 INT Modbus Id[1 - Port 0] RD_ONLY

9014 INT Site Id RD_WR

9022 INT Analysis Time RD_ONLY

9023 INT Unused RD_ONLY

9024 INT Cycle Time RD_ONLY

9025 INT Unused RD_ONLY

9026 INT Run Time RD_ONLY

9027 INT Unused RD_ONLY

9028 INT Current Stream RD_ONLY

9029 INT Unused RD_ONLY

9030 INT GC Control_Analyser Control (Write Reg 9030) RD_WR

9031 INT Unused RD_ONLY

9032 INT GC Calibrating RD_ONLY

9033 INT Unused RD_ONLY

9034 INT Active Alarm Flag RD_ONLY

9035 INT UnAck Alarm Flag RD_ONLY

9036 INT Hourly Average Reset time RD_ONLY YY

9037 INT Hourly Average Reset time RD_ONLY MM

9038 INT Hourly Average Reset time RD_ONLY DD

9039 INT Hourly Average Reset time RD_ONLY hh

9040 INT Hourly Average Reset time RD_ONLY mm

9041 INT Daily Average Reset time RD_ONLY YY

9042 INT Daily Average Reset time RD_ONLY MM

9043 INT Daily Average Reset time RD_ONLY DD

9044 INT Daily Average Reset time RD_ONLY hh

9045 INT Daily Average Reset time RD_ONLY mm

9046 INT Weekly Average Reset time RD_ONLY YY

9047 INT Weekly Average Reset time RD_ONLY MM

9048 INT Weekly Average Reset time RD_ONLY DD

9049 INT Weekly Average Reset time RD_ONLY hh

9050 INT Weekly Average Reset time RD_ONLY mm
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9051 INT Monthly Average Reset time RD_ONLY YY

9052 INT Monthly Average Reset time RD_ONLY MM

9053 INT Monthly Average Reset time RD_ONLY DD

9054 INT Monthly Average Reset time RD_ONLY hh

9055 INT Monthly Average Reset time RD_ONLY mm

9056 INT Variable Average Reset time RD_ONLY YY

9057 INT Variable Average Reset time RD_ONLY MM

9058 INT Variable Average Reset time RD_ONLY DD

9059 INT Variable Average Reset time RD_ONLY hh

9060 INT Variable Average Reset time RD_ONLY mm

3001..3016/3017..3032 (Component Code): Component Codes for components whose
mole % results are available in Registers 7001..7016.

3033 (Run Time in 1/30th Sec): Current GC Run Time. If Run Time = 200 seconds, then this
register reads 6000.

3034 (Last Analy_Stream Number): Stream that was analyzed last.

3035 (Last Analy_CDT Stream Mask):

• Bit 0: Holds 1 if Stream 1 uses CDT1, 0 otherwise

• Bit 1: Holds 1 if Stream 2 uses CDT1, 0 otherwise

• Bit 2: Holds 1 if Stream 3 uses CDT1, 0 otherwise

• ...

• Bit 15: Holds 1 if Stream 16 uses CDT1, 0 otherwise

3036..3040 (Current GC Time): Holds the current GC Time. Can be written to update GC
date/time.

3041..3045 (Last Analy_Start Time): Sample inject time for the stream that was analyzed
last.

3046..3047 (Alarm Bitmaps): Boolean alarm conditions. 1 – Alarm Active, 0 – Alarm
Inactive.

3046 Bit 14 (Analyzer Failure): This bit is set to 1 if any of the Carrier Pressure/Low Pressure
Limit Switch alarms are active.

3048 (Stream 1 Active Low Limit Alarms):

• Bit 0: Holds 1 if, User Limit Alarm 1 is associated with Stream 1 and if a Low Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 1 is not
associated with Stream 1 or no Low Limit alarm condition exists.

• Bit 1: Holds 1 if, User Limit Alarm 2 is associated with Stream 1 and if a Low Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 2 is not
associated with Stream 1 or no Low Limit alarm condition exists.
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• ...

• Bit 15: Holds 1 if, User Limit Alarm 16 is associated with Stream 1 and if a Low Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 16 is not
associated with Stream 1 or no Low Limit alarm condition exists.

3049 (Stream 1 Active High Limit Alarms):

• Bit 0: Holds 1 if, User Limit Alarm 1 is associated with Stream 1 and if a High Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 1 is not
associated with Stream 1 or no High Limit alarm condition exists.

• Bit 1: Holds 1 if, User Limit Alarm 2 is associated with Stream 1 and if a High Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 2 is not
associated with Stream 1 or no High Limit alarm condition exists.

• ...

• Bit 15: Holds 1 if, User Limit Alarm 16 is associated with Stream 1 and if a High Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 16 is not
associated with Stream 1 or no High Limit alarm condition exists.

3050 .. 3057 (Stream 2..5 Active High/Low Limit Alarms): These registers hold limit alarm
status for Streams 2 through 5. The implementation of these registers is similar to the
Stream 1 Active Low/High Alarms (Registers 3048/3049).

3058 (New Data Flag): This flag is set to 1 when new data is available in the Last Analysis
Results registers. This is a read-write register, so a Modbus Master can clear the flag once
the new results are read.

3059 (Anly/Calib Flag): This flag is set to 1 to indicate the last analysis results were from an
Analysis run. This flag is set to 0 to indicate the last analysis results were from a Calibration
run. A Modbus Master can use Registers 3058 and 3059 to determine when new analysis
results are available on the GC.

5001 (Last Analy_Cycle Time (1/30th sec)): Cycle time for last analysis in 1/30th seconds.
For example, if cycle time is 300 seconds, this register reads 9000.

5002 (Last Cal_Cycle Time (1/30th sec)): Cycle time for last calibration run in 1/30th
seconds. For example, if cycle time is 300 seconds, this register reads 9000.

7001..7016 (Last Analy Mole %): These registers hold the mole % Results for the last
analysis run. The order of components in these registers can be determined by reading
Register 3001..3016 which contain the component codes.

7017..7032 (Last Analy Weight %): These registers hold the weight % results for the last
analysis run. The order of components in these registers can be determined by reading
Register 3001..3016 which contain the component codes.

7033..7039, 7054: Last analysis stream results

7040..7044: User calculation results 1..5

7055..7069: Current running average for Averages 1 through 15

7070..7084: Most recent archive average for Averages 1 through 15

7085..7086: Current analog input values for Analog Input 1 and 2
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7087..7094: Last Calibration Stream Results

7095..7110/7111..7126: Response factors used for last analysis run

7127..7162: Current running average for Averages 1 through 36

7163..7198: Maximum sample value during current averaging period for Averages 1
through 36

7199..7234: Minimum sample value during current averaging period for Averages 1
through 36

7235..7270: Most recent archived average for Averages 1 through 36

7271..7306: Maximum sample value in the most recent archived average for Averages 1
through 36.

7307..7342: Minimum sample value in the most recent archived average for Averages 1
through 36.

7343..7378: Second most recent archived average for Averages 1 through 36

7379..7414: Maximum sample value in the second most recent archived average for
Averages 1 through 36.

7415..7450: Minimum sample value in the second most recent archived average for
Averages 1 through 36.

7451..7486: Third most recent archived average for Averages 1 through 36

7487..7522: Maximum sample value in the third most recent archived average for
Averages 1 through 36.

7523..7558: Minimum sample value in the third most recent archived average for
Averages 1 through 36.

7560..7563/7564..7567: Analog Input Current Value for AI 1 through 4.

7621..7646: Stream 1 results

7651..7676: Stream 2 results

7681..7706: Stream 3 results

7711..7736: Stream 4 results

7741..7766: Stream 5 results

7771..7796: Stream 6 results

7801..7826: Stream 7 results

7831..7856: Stream 8 results

7861..7886: Stream 9 results

7891..7916: Stream 10 results
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7921..7946: Stream 11 results

7951..7976: Stream 12 results

7996..8006: Section D.6

8200..8449: Most recent archived average for Averages 1 through 250.

8454..8703: Maximum sample value in the most recent archived average for Averages 1
through 250.

8708..8957: Minimum sample value in the most recent archived average for Averages 1
through 250.

8963 (Clear All Alarms): Write 1 to this register to clear all active alarms.

8964 (Acknowledge All Alarms): Write 1 to this register to acknowledge all alarms.

9006..9011: GC System Date/Time Read/Write Registers.

9013 (Modbus Id[ Port 0]): Modbus ID for Serial Port 0.

9014 (Site ID): GC Site ID read/write register.

9022 (Analysis Time): Analysis time

9024 (Cycle Time): Cycle time

9026 (Run Time): Run rime

9028 (Current Stream): Stream number

9030 (Analyzer Control): Section D.7

9032 (GC Calibrating): Tells you if the GC is calibrating. A value of 1 means GC is
calibrating, 0 otherwise.

9034 (Active Alarm Flag): Tells you if the GC has any active alarms. A value of 1 indicates
that there are active alarms, 0 otherwise.

9035 (UnAck Alarm Flag): Tells you if the GC has any unacknowledged alarms. A value of 1
indicates that there are unacknowledged alarms, 0 otherwise.

9036..9040 (Hourly Average Reset Time): Date/time when hourly average results were
archived.

9041..9045 (Daily Average Reset Time): Date/time when daily average results were
archived.

9046..9047 (Weekly Average Reset Time): Date/time when weekly average results were
archived.

9051..9055 (Monthly Average Reset Time): Date/time when monthly average results were
archived.

9056..9060 (Variable Average Reset Time): Date/time when variable average results were
archived.
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D.3 User Modbus mapping template

Register # Data type Variable Access Format

1 BOOLEAN Unused RD_ONLY

2 BOOLEAN Unused RD_ONLY

3 BOOLEAN Unused RD_ONLY

4 BOOLEAN Unused RD_ONLY

5 BOOLEAN Unused RD_ONLY

6 BOOLEAN Unused RD_ONLY

7 BOOLEAN Unused RD_ONLY

8 BOOLEAN Unused RD_ONLY

9 BOOLEAN Unused RD_ONLY

10 BOOLEAN System Alarm_Alarm On - Current Analysis_Heater 1 Out Of
Range

RD_ONLY

11 BOOLEAN System Alarm_Alarm On - Current Analysis_Heater 2 Out Of
Range

RD_ONLY

12 BOOLEAN System Alarm_Alarm On - Current Analysis_Heater 3 Out Of
Range

RD_ONLY

13 BOOLEAN System Alarm_Alarm On - Current Analysis_Heater 4 Out Of
Range

RD_ONLY

14 BOOLEAN Unused RD_ONLY

15 BOOLEAN Unused RD_ONLY

16 BOOLEAN System Alarm_Alarm On - Current Analysis_Flame Out RD_ONLY

17 BOOLEAN System Alarm_Alarm On - Current Analysis_Warm Start
Failed

RD_ONLY

18 BOOLEAN Unused RD_ONLY

19 BOOLEAN Calibration Failed RD_ONLY

20 BOOLEAN System Alarm_Alarm On - Current Analysis_Low Carrier Pres-
sure 1

RD_ONLY

21 BOOLEAN System Alarm_Alarm On - Current Analysis_Low Carrier Pres-
sure 2

RD_ONLY

22 BOOLEAN System Alarm_Alarm On - Current Analysis_No Sample Flow
1

RD_ONLY

23 BOOLEAN System Alarm_Alarm On - Current Analysis_No Sample Flow
2

RD_ONLY

24 BOOLEAN System Alarm_Alarm On - Current Analysis_Maintenance
Mode

RD_ONLY

25 BOOLEAN Calibration Failed RD_ONLY

26 BOOLEAN Unused RD_ONLY

27 BOOLEAN Unused RD_ONLY
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Register # Data type Variable Access Format

28 BOOLEAN Unused RD_ONLY

29 BOOLEAN Unused RD_ONLY

30 BOOLEAN Unused RD_ONLY

31 BOOLEAN System Alarm_Alarm On - Current Analysis_Detector 1 Scal-
ing Factor Failure

RD_ONLY

32 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 1
High Signal

RD_ONLY

33 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 2
High Signal

RD_ONLY

34 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 3
High Signal

RD_ONLY

35 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 4
High Signal

RD_ONLY

36 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 5
High Signal

RD_ONLY

37 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 6
High Signal

RD_ONLY

38 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 7
High Signal

RD_ONLY

39 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 8
High Signal

RD_ONLY

40 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 9
High Signal

RD_ONLY

41 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
10 High Signal

RD_ONLY

42 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
11 High Signal

RD_ONLY

43 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
12 High Signal

RD_ONLY

44 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
13 High Signal

RD_ONLY

45 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
14 High Signal

RD_ONLY

46 BOOLEAN Unused RD_ONLY

47 BOOLEAN Unused RD_ONLY

48 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 1
Low Signal

RD_ONLY

49 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 2
Low Signal

RD_ONLY

50 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 3
Low Signal

RD_ONLY
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Register # Data type Variable Access Format

51 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 4
Low Signal

RD_ONLY

52 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 5
Low Signal

RD_ONLY

53 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 6
Low Signal

RD_ONLY

54 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 7
Low Signal

RD_ONLY

55 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 8
Low Signal

RD_ONLY

56 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output 9
Low Signal

RD_ONLY

57 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
10 Low Signal

RD_ONLY

58 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
11 Low Signal

RD_ONLY

59 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
12 Low Signal

RD_ONLY

60 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
13 Low Signal

RD_ONLY

61 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
14 Low Signal

RD_ONLY

62 BOOLEAN Unused RD_ONLY

63 BOOLEAN Unused RD_ONLY

64 BOOLEAN Analyzer Failure RD_ONLY

65 BOOLEAN System Alarm_Alarm On - Current Analysis_Power Failure RD_ONLY

66 BOOLEAN Unused RD_ONLY

67 BOOLEAN System Alarm_Alarm On - Current Analysis_Low Battery Volt-
age

RD_ONLY

68 BOOLEAN System Alarm_Alarm On - Current Analysis_GC Idle RD_ONLY

69 BOOLEAN Unused RD_ONLY

70 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 1
High Signal

RD_ONLY

71 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 2
High Signal

RD_ONLY

72 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 3
High Signal

RD_ONLY

73 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 4
High Signal

RD_ONLY

74 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 1
Low Signal

RD_ONLY
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Register # Data type Variable Access Format

75 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 2
Low Signal

RD_ONLY

76 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 3
Low Signal

RD_ONLY

77 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 4
Low Signal

RD_ONLY

78 BOOLEAN Unused RD_ONLY

79 BOOLEAN Unused RD_ONLY

80 BOOLEAN Unused RD_ONLY

81 BOOLEAN Unused RD_ONLY

82 BOOLEAN Unused RD_ONLY

83 BOOLEAN Unused RD_ONLY

84 BOOLEAN Unused RD_ONLY

85 BOOLEAN Alarm On[1 - Alarm 1] RD_ONLY

86 BOOLEAN Alarm On[2 - Alarm 2] RD_ONLY

87 BOOLEAN Alarm On[3 - Alarm 3] RD_ONLY

88 BOOLEAN Alarm On[4 - Alarm 4] RD_ONLY

89 BOOLEAN Alarm On[5 - Alarm 5] RD_ONLY

90 BOOLEAN Alarm On[6 - Alarm 6] RD_ONLY

91 BOOLEAN Alarm On[7 - Alarm 7] RD_ONLY

92 BOOLEAN Alarm On[8 - Alarm 8] RD_ONLY

93 BOOLEAN Alarm On[9 - Alarm 9] RD_ONLY

94 BOOLEAN Alarm On[10 - Alarm 10] RD_ONLY

95 BOOLEAN Alarm On[11 - Alarm 11] RD_ONLY

96 BOOLEAN Alarm On[12 - Alarm 12] RD_ONLY

97 BOOLEAN Alarm On[13 - Alarm 13] RD_ONLY

98 BOOLEAN Alarm On[14 - Alarm 14] RD_ONLY

99 BOOLEAN Alarm On[15 - Alarm 15] RD_ONLY

100 BOOLEAN Alarm On[16 - Alarm 16] RD_ONLY

101 BOOLEAN Alarm On[17 - Alarm 17] RD_ONLY

102 BOOLEAN Alarm On[18 - Alarm 18] RD_ONLY

103 BOOLEAN Alarm On[19 - Alarm 19] RD_ONLY

104 BOOLEAN Alarm On[20 - Alarm 20] RD_ONLY

105 BOOLEAN 1 - Stream 1_Stream Toggle RD_ONLY

106 BOOLEAN 2 - Stream 2_Stream Toggle RD_ONLY

107 BOOLEAN 3 - Stream 3_Stream Toggle RD_ONLY

108 BOOLEAN 4 - Stream 4_Stream Toggle RD_ONLY
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109 BOOLEAN 5 - Stream 5_Stream Toggle RD_ONLY

110 BOOLEAN 6 - Stream 6_Stream Toggle RD_ONLY

111 BOOLEAN 7 - Stream 7_Stream Toggle RD_ONLY

112 BOOLEAN 8 - Stream 8_Stream Toggle RD_ONLY

113 BOOLEAN Current Value[1 - Discrete Output 1] RD_ONLY

114 BOOLEAN Current Value[2 - Discrete Output 2] RD_ONLY

115 BOOLEAN Current Value[3 - Discrete Output 3] RD_ONLY

116 BOOLEAN Current Value[4 - Discrete Output 4] RD_ONLY

117 BOOLEAN Current Value[5 - Discrete Output 5] RD_ONLY

118 BOOLEAN Switch[1 - Discrete Output 1] RD_WR

119 BOOLEAN Switch[2 - Discrete Output 2] RD_WR

120 BOOLEAN Switch[3 - Discrete Output 3] RD_WR

121 BOOLEAN Switch[4 - Discrete Output 4] RD_WR

122 BOOLEAN Switch[5 - Discrete Output 5] RD_WR

123 INT Switch[1 - Discrete Output 1] RD_WR

124 INT Switch[2 - Discrete Output 2] RD_WR

125 INT Switch[3 - Discrete Output 3] RD_WR

126 INT Switch[4 - Discrete Output 4] RD_WR

127 INT Switch[5 - Discrete Output 5] RD_WR

9006 INT Current Time(time_t) RD_WR MM

9007 INT Current Time(time_t) RD_WR DD

9008 INT Current Time(time_t) RD_WR YYYY

9009 INT Current Time(time_t) RD_WR hh

9010 INT Current Time(time_t) RD_WR mm

9011 INT Current Time(time_t) RD_WR ss

9012 INT Unused RD_ONLY

9013 INT Modbus Id[1 - Port 0] RD_ONLY

9014 INT Site Id RD_WR

9022 INT Analysis Time RD_ONLY

9023 INT Unused RD_ONLY

9024 INT Cycle Time RD_ONLY

9025 INT Unused RD_ONLY

9026 INT Run Time RD_ONLY

9027 INT Unused RD_ONLY

9028 INT Current Stream RD_ONLY

9029 INT Unused RD_ONLY

9030 INT GC Control_Analyzer Control (Write Reg 9030) RD_WR

Pre-defined Modbus
®

 Map Files

244 Rosemount™ 1500XA Gas Chromatograph



Register # Data type Variable Access Format

9031 INT Unused RD_ONLY

9032 INT GC Calibrating RD_ONLY

9033 INT Unused RD_ONLY

9034 INT Active Alarm Flag RD_ONLY

9035 INT UnAck Alarm Flag RD_ONLY

9036 INT Hourly Average Reset time RD_ONLY YY

9037 INT Hourly Average Reset time RD_ONLY MM

9038 INT Hourly Average Reset time RD_ONLY DD

9039 INT Hourly Average Reset time RD_ONLY hh

9040 INT Hourly Average Reset time RD_ONLY mm

9041 INT Daily Average Reset time RD_ONLY YY

9042 INT Daily Average Reset time RD_ONLY MM

9043 INT Daily Average Reset time RD_ONLY DD

9044 INT Daily Average Reset time RD_ONLY hh

9045 INT Daily Average Reset time RD_ONLY mm

9046 INT Weekly Average Reset time RD_ONLY YY

9047 INT Weekly Average Reset time RD_ONLY MM

9048 INT Weekly Average Reset time RD_ONLY DD

9049 INT Weekly Average Reset time RD_ONLY hh

9050 INT Weekly Average Reset time RD_ONLY mm

9051 INT Monthly Average Reset time RD_ONLY YY

9052 INT Monthly Average Reset time RD_ONLY MM

9053 INT Monthly Average Reset time RD_ONLY DD

9054 INT Monthly Average Reset time RD_ONLY hh

9055 INT Monthly Average Reset time RD_ONLY mm

9056 INT Variable Average Reset time RD_ONLY YY

9057 INT Variable Average Reset time RD_ONLY MM

9058 INT Variable Average Reset time RD_ONLY DD

9059 INT Variable Average Reset time RD_ONLY hh

9060 INT Variable Average Reset time RD_ONLY mm

10...13 (Heater 1...4 out of range): 1 if heater is out of range, 0 otherwise

16 (FID flame out): 1 if FID flame has gone out, 0 otherwise

17 (Warmstart failed): 1 if GC warmstart was unable to stabilize temperature/pressure in
analytical oven within pre-defined warmstart duration, 0 otherwise

19 (Calibration failed): 1 if last calibration sequence failed, 0 otherwise
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20...21 (Low carrier pressure 1...2): 1 if the carrier pressure is low, 0 otherwise

22...23 (No sample flow 1...2): 1 if there is no sample flow in the sample conditioning
system, 0 otherwise

24 (Maintenance mode): 1 if a technician has put the GC into Maintenance mode to
perform repairs, 0 otherwise

25 (Calibration failed): 1 if last calibration sequence failed, 0 otherwise

31 (Preamp scaling factor): 1 if there is an electronics failure on the preamp board, 0
otherwise

32...45 (Analog output high signal 1...14): 1 if the variable associated with analog output
has a value that is greater than the zero scale value assigned to the analog output, 0
otherwise

48...61 (Analog output low signal 1...14): 1 if the variable associated with analog output
has a value that is lesser than the zero scale value assigned to the analog output, 0
otherwise

64 (Analyzer failure): 1 indicates that the carrier pressure is either too low or the GC cannot
control the carrier pressure to the desired setpoint, 0 otherwise

65 (Power failure): 1 indicates that the GC lost power and is currently executing the
warmstart sequence, 0 otherwise

67 (Low battery voltage): 1 indicates that the battery used to back up configuration and
real-time clock on the main CPU board is low, 0 otherwise

68 (GC idle): 1 indicates that the GC is not performing an analysis, 0 otherwise

Note
If the GC is halted by the operator using MON2020, then the Idle alarm is not raised. It is raised only if
the GC goes into the Idle state due to alarm condition that has the Halt on Alarm flag enabled.

Note
If the GC is halted by the operator using MON2020 and if he disconnects from the GC without
restarting normal operation, then the GC Idle alarm is raised.

70...77 (Analog input low signal 1...8): 1 indicates that the analog input is sensing a current
that is lower than 4 mA, 0 otherwise

85...104 (User limit alarm 1...20): 1 indicates that the user limit alarm is active, 0 otherwise

105...112 (Stream toggle 1...5): Each time new results are available for a particular stream,
this flag is toggled.

113...117 (Discrete output 1...5 current value): Current state of the discrete output, 1
indicates that it is On; 0 indicates it is Off.
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118...122 (Switch discrete output 1...5): Read/write register for changing the state of the
discrete output. Write 1 to this register to set output state to On, 0 to set output state to
Off.

123...127 (Switch discrete output 1...5): Read/write register for changing the state of the
discrete output. Write 1 to this register to set output state to On, 0 to set output state to
Off, and 2 to set the register to Auto mode.

9006...9011: GC system date/time read-write registers

9013 (Modbus ID [Port 0]): Modbus ID for serial port 0

9014 (Site ID): GC site ID read/write register

9022 (Analysis time): Analysis time

9024 (Cycle time): Cycle time

9026 (Run time): Run time

9028 (Current stream): Stream number

9030 (Analyzer control): Section D.3

9032 (GC calibrating): Tells you if the GC is calibrating. A value of 1 means GC is
calibrating, 0 otherwise.

9034 (Active alarm flag): Tells you if the GC has any active alarms. A value of 1 indicates
that there are active alarms, 0 otherwise.

9035 (UnAck alarm flag): Tells you if the GC has any unacknowledged alarms. A value of 1
indicates that there are unacknowledged alarms, 0 otherwise.

9036...9040 (Hourly average reset time): Date/time when hourly average results was
archived

9041...9045 (Daily average reset time): Date/time when daily average results was archived

9046...9047 (Weekly average reset time): Date/time when weekly average result was
archived

9051...9055 (Monthly average reset time): Date/time when monthly average results was
archived

9056...9060 (Variable average reset time): Date/time when variable average results was
archived
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D.4 SIM_2251 C9 + Hydrocarbon Dewpoint map
This map file is an extension of the SIM2251 map file with the following additional
registers.

Register # Data type Variable Access

3101 INT 1 - Stream 1_Dew Status 1 RD_ONLY

3102 INT 1 - Stream 1_Dew Status 2 RD_ONLY

3103 INT 1 - Stream 1_Dew Status 3 RD_ONLY

3104 INT 1 - Stream 1_Dew Status 4 RD_ONLY

3105 INT 1 - Stream 1_Cri Status RD_ONLY

3106 INT 2 - Calibration_Dew Status 1 RD_ONLY

3107 INT 2 - Calibration_Dew Status 2 RD_ONLY

3108 INT 2 - Calibration_Dew Status 3 RD_ONLY

3109 INT 2 - Calibration_Dew Status 4 RD_ONLY

3110 INT 2 - Calibration_Cri Status RD_ONLY

3111 INT 3 - Stream 3_Dew Status 1 RD_ONLY

3112 INT 3 - Stream 3_Dew Status 2 RD_ONLY

3113 INT 3 - Stream 3_Dew Status 3 RD_ONLY

3114 INT 3 - Stream 3_Dew Status 4 RD_ONLY

3115 INT 3 - Stream 3_Cri Status RD_ONLY

3116 INT 4 - Stream 4_Dew Status 1 RD_ONLY

3117 INT 4 - Stream 4_Dew Status 2 RD_ONLY

3118 INT 4 - Stream 4_Dew Status 3 RD_ONLY

3119 INT 4 - Stream 4_Dew Status 4 RD_ONLY

3120 INT 4 - Stream 4_Cri Status RD_ONLY

3121 INT 5 - Stream 5_Dew Status 1 RD_ONLY

3122 INT 5 - Stream 5_Dew Status 2 RD_ONLY

3123 INT 5 - Stream 5_Dew Status 3 RD_ONLY

3124 INT 5 - Stream 5_Dew Status 4 RD_ONLY

3125 INT 5 - Stream 5_Cri Status RD_ONLY

3126 INT 6 - Stream 6_Dew Status 1 RD_ONLY

3127 INT 6 - Stream 6_Dew Status 2 RD_ONLY

3128 INT 6 - Stream 6_Dew Status 3 RD_ONLY

3129 INT 6 - Stream 6_Dew Status 4 RD_ONLY

3130 INT 6 - Stream 6_Cri Status RD_ONLY

3131 INT 7 - Stream 7_Dew Status 1 RD_ONLY

3132 INT 7 - Stream 7_Dew Status 2 RD_ONLY
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Register # Data type Variable Access

3133 INT 7 - Stream 7_Dew Status 3 RD_ONLY

3134 INT 7 - Stream 7_Dew Status 4 RD_ONLY

3135 INT 7 - Stream 7_Cri Status RD_ONLY

3136 INT 8 - Stream 8_Dew Status 1 RD_ONLY

3137 INT 8 - Stream 8_Dew Status 2 RD_ONLY

3138 INT 8 - Stream 8_Dew Status 3 RD_ONLY

3139 INT 8 - Stream 8_Dew Status 4 RD_ONLY

3140 INT 8 - Stream 8_Cri Status RD_ONLY

8100 FLOAT Dewpoint Configuration 1_Pressure 1 RD_WR

8101 FLOAT Dewpoint Configuration 1_Pressure 2 RD_WR

8102 FLOAT Dewpoint Configuration 1_Pressure 3 RD_WR

8103 FLOAT Dewpoint Configuration 1_Pressure 4 RD_WR

8104 FLOAT Dewpoint Configuration 2_Pressure 1 RD_WR

8105 FLOAT Dewpoint Configuration 2_Pressure 2 RD_WR

8106 FLOAT Dewpoint Configuration 3_Pressure 1 RD_WR

8107 FLOAT Dewpoint Configuration 3_Pressure 2 RD_WR

8108 FLOAT Dewpoint Configuration 4_Pressure 1 RD_WR

8109 FLOAT Dewpoint Configuration 4_Pressure 2 RD_WR

8110 FLOAT 1 - Stream 1_Dewpoint Temp 1 RD_ONLY

8111 FLOAT 1 - Stream 1_Dewpoint Temp 2 RD_ONLY

8112 FLOAT 1 - Stream 1_Dewpoint Temp 3 RD_ONLY

8113 FLOAT 1 - Stream 1_Dewpoint Temp 4 RD_ONLY

8114 FLOAT 1 - Stream 1_Dewpoint Pres 1 RD_ONLY

8115 FLOAT 1 - Stream 1_Dewpoint Pres 2 RD_ONLY

8116 FLOAT 1 - Stream 1_Dewpoint Pres 3 RD_ONLY

8117 FLOAT 1 - Stream 1_Dewpoint Pres 4 RD_ONLY

8118 FLOAT 1 - Stream 1_CricondenTherm Temp RD_ONLY

8119 FLOAT 1 - Stream 1_CricondenTherm Pres RD_ONLY

8120 FLOAT 2 - Calibration_Dewpoint Temp 1 RD_ONLY

8121 FLOAT 2 - Calibration_Dewpoint Temp 2 RD_ONLY

8122 FLOAT 2 - Calibration_Dewpoint Temp 3 RD_ONLY

8123 FLOAT 2 - Calibration_Dewpoint Temp 4 RD_ONLY

8124 FLOAT 2 - Calibration_Dewpoint Pres 1 RD_ONLY

8125 FLOAT 2 - Calibration_Dewpoint Pres 2 RD_ONLY

8126 FLOAT 2 - Calibration_Dewpoint Pres 3 RD_ONLY

8127 FLOAT 2 - Calibration_Dewpoint Pres 4 RD_ONLY

8128 FLOAT 2 - Calibration_CricondenTherm Temp RD_ONLY
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8129 FLOAT 2 - Calibration_CricondenTherm Pres RD_ONLY

8130 FLOAT 3 - Stream 3_Dewpoint Temp 1 RD_ONLY

8131 FLOAT 3 - Stream 3_Dewpoint Temp 2 RD_ONLY

8132 FLOAT 3 - Stream 3_Dewpoint Temp 3 RD_ONLY

8133 FLOAT 3 - Stream 3_Dewpoint Temp 4 RD_ONLY

8134 FLOAT 3 - Stream 3_Dewpoint Pres 1 RD_ONLY

8135 FLOAT 3 - Stream 3_Dewpoint Pres 2 RD_ONLY

8136 FLOAT 3 - Stream 3_Dewpoint Pres 3 RD_ONLY

8137 FLOAT 3 - Stream 3_Dewpoint Pres 4 RD_ONLY

8138 FLOAT 3 - Stream 3_CricondenTherm Temp RD_ONLY

8139 FLOAT 3 - Stream 3_CricondenTherm Pres RD_ONLY

8140 FLOAT 4 - Stream 4_Dewpoint Temp 1 RD_ONLY

8141 FLOAT 4 - Stream 4_Dewpoint Temp 2 RD_ONLY

8142 FLOAT 4 - Stream 4_Dewpoint Temp 3 RD_ONLY

8143 FLOAT 4 - Stream 4_Dewpoint Temp 4 RD_ONLY

8144 FLOAT 4 - Stream 4_Dewpoint Pres 1 RD_ONLY

8145 FLOAT 4 - Stream 4_Dewpoint Pres 2 RD_ONLY

8146 FLOAT 4 - Stream 4_Dewpoint Pres 3 RD_ONLY

8147 FLOAT 4 - Stream 4_Dewpoint Pres 4 RD_ONLY

8148 FLOAT 4 - Stream 4_CricondenTherm Temp RD_ONLY

8149 FLOAT 4 - Stream 4_CricondenTherm Pres RD_ONLY

8150 FLOAT 5 - Stream 5_Dewpoint Temp 1 RD_ONLY

8151 FLOAT 5 - Stream 5_Dewpoint Temp 2 RD_ONLY

8152 FLOAT 5 - Stream 5_Dewpoint Temp 3 RD_ONLY

8153 FLOAT 5 - Stream 5_Dewpoint Temp 4 RD_ONLY

8154 FLOAT 5 - Stream 5_Dewpoint Pres 1 RD_ONLY

8155 FLOAT 5 - Stream 5_Dewpoint Pres 2 RD_ONLY

8156 FLOAT 5 - Stream 5_Dewpoint Pres 3 RD_ONLY

8157 FLOAT 5 - Stream 5_Dewpoint Pres 4 RD_ONLY

8158 FLOAT 5 - Stream 5_CricondenTherm Temp RD_ONLY

8159 FLOAT 5 - Stream 5_CricondenTherm Pres RD_ONLY

8160 FLOAT 6 - Stream 6_Dewpoint Temp 1 RD_ONLY

8161 FLOAT 6 - Stream 6_Dewpoint Temp 2 RD_ONLY

8162 FLOAT 6 - Stream 6_Dewpoint Temp 3 RD_ONLY

8163 FLOAT 6 - Stream 6_Dewpoint Temp 4 RD_ONLY

8164 FLOAT 6 - Stream 6_Dewpoint Pres 1 RD_ONLY

8165 FLOAT 6 - Stream 6_Dewpoint Pres 2 RD_ONLY
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Register # Data type Variable Access

8166 FLOAT 6 - Stream 6_Dewpoint Pres 3 RD_ONLY

8167 FLOAT 6 - Stream 6_Dewpoint Pres 4 RD_ONLY

8168 FLOAT 6 - Stream 6_CricondenTherm Temp RD_ONLY

8169 FLOAT 6 - Stream 6_CricondenTherm Pres RD_ONLY

8170 FLOAT 7 - Stream 7_Dewpoint Temp 1 RD_ONLY

8171 FLOAT 7 - Stream 7_Dewpoint Temp 2 RD_ONLY

8172 FLOAT 7 - Stream 7_Dewpoint Temp 3 RD_ONLY

8173 FLOAT 7 - Stream 7_Dewpoint Temp 4 RD_ONLY

8174 FLOAT 7 - Stream 7_Dewpoint Pres 1 RD_ONLY

8175 FLOAT 7 - Stream 7_Dewpoint Pres 2 RD_ONLY

8176 FLOAT 7 - Stream 7_Dewpoint Pres 3 RD_ONLY

8177 FLOAT 7 - Stream 7_Dewpoint Pres 4 RD_ONLY

8178 FLOAT 7 - Stream 7_CricondenTherm Temp RD_ONLY

8179 FLOAT 7 - Stream 7_CricondenTherm Pres RD_ONLY

8180 FLOAT 8 - Stream 8_Dewpoint Temp 1 RD_ONLY

8181 FLOAT 8 - Stream 8_Dewpoint Temp 2 RD_ONLY

8182 FLOAT 8 - Stream 8_Dewpoint Temp 3 RD_ONLY

8183 FLOAT 8 - Stream 8_Dewpoint Temp 4 RD_ONLY

8184 FLOAT 8 - Stream 8_Dewpoint Pres 1 RD_ONLY

8185 FLOAT 8 - Stream 8_Dewpoint Pres 2 RD_ONLY

8186 FLOAT 8 - Stream 8_Dewpoint Pres 3 RD_ONLY

8187 FLOAT 8 - Stream 8_Dewpoint Pres 4 RD_ONLY

8188 FLOAT 8 - Stream 8_CricondenTherm Temp RD_ONLY

8189 FLOAT 8 - Stream 8_CricondenTherm Pres RD_ONLY
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3101...3140 (Dewpoint status): Dewpoint calculation status for Streams 1 to 8 (read only).
Here are the possible values for these registers and their descriptions.

8100...8109 (Dewpoint pressure setpoints): Pressure setpoints at which dewpoint
calculation results are performed (read-write). The setpoint can be changed through a
Modbus Master.

8110...8189 (Dewpoint results): Dewpoint temperature and pressure, cricondentherm
temperature and pressure.

Value Description Remarks

0 OK Calculation is valid

1 Error 1 No valid solution to gas equation found

2 Error 2 Mole% values are all zero – if analysis is OK check Numeric data

3 Error 3 Calculated fugacities too large – probably unrealistic composition

4 Error 4 Single phase – no liquid phase at this pressure

5 Error 5 Pressure value (from operator or Modbus) is negative

6 Error 6 (Cricondentherm only) – no maximum found – next analysis normally OK

7 Error 7 Single phase – no gas phase at this pressure

D.5 SIM_2251 UK (with ISO results)

Register # Data type Variable Record # Access Format

1001 BOOLEAN Current Value[1 - Discrete Output 1] RD_ONLY

1002 BOOLEAN Current Value[2 - Discrete Output 2] RD_ONLY

1003 BOOLEAN Current Value[3 - Discrete Output 3] RD_ONLY

1004 BOOLEAN Current Value[4 - Discrete Output 4] RD_ONLY

1005 BOOLEAN Current Value[5 - Discrete Output 5] RD_ONLY

1006 BOOLEAN Current Value[1 - Discrete Input 1] RD_ONLY

1007 BOOLEAN Current Value[2 - Discrete Input 2] RD_ONLY

1008 BOOLEAN Current Value[3 - Discrete Input 3] RD_ONLY

1009 BOOLEAN Current Value[4 - Discrete Input 4] RD_ONLY

1010 BOOLEAN Current Value[5 - Discrete Input 5] RD_ONLY

3001 INT Last Analy_Component Code(UK)[1 - Component 1] RD_ONLY

3002 INT Last Analy_Component Code(UK)[2 - Component 2] RD_ONLY

3003 INT Last Analy_Component Code(UK)[3 - Component 3] RD_ONLY

3004 INT Last Analy_Component Code(UK)[4 - Component 4] RD_ONLY

3005 INT Last Analy_Component Code(UK)[5 - Component 5] RD_ONLY

3006 INT Last Analy_Component Code(UK)[6 - Component 6] RD_ONLY

3007 INT Last Analy_Component Code(UK)[7 - Component 7] RD_ONLY
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Register # Data type Variable Record # Access Format

3008 INT Last Analy_Component Code(UK)[8 - Component 8] RD_ONLY

3009 INT Last Analy_Component Code(UK)[9 - Component 9] RD_ONLY

3010 INT Last Analy_Component Code(UK)[10 - Component
10]

RD_ONLY

3011 INT Last Analy_Component Code(UK)[11 - Component
11]

RD_ONLY

3012 INT Last Analy_Component Code(UK)[12 - Component
12]

RD_ONLY

3013 INT Last Analy_Component Code(UK)[13 - Component
13]

RD_ONLY

3014 INT Last Analy_Component Code(UK)[14 - Component
14]

RD_ONLY

3015 INT Last Analy_Component Code(UK)[15 - Component
15]

RD_ONLY

3016 INT Last Analy_Component Code(UK)[16 - Component
16]

RD_ONLY

3017 INT Last Analy_Component Code(UK)[1 - Component 1] RD_ONLY

3018 INT Last Analy_Component Code(UK)[2 - Component 2] RD_ONLY

3019 INT Last Analy_Component Code(UK)[3 - Component 3] RD_ONLY

3020 INT Last Analy_Component Code(UK)[4 - Component 4] RD_ONLY

3021 INT Last Analy_Component Code(UK)[5 - Component 5] RD_ONLY

3022 INT Last Analy_Component Code(UK)[6 - Component 6] RD_ONLY

3023 INT Last Analy_Component Code(UK)[7 - Component 7] RD_ONLY

3024 INT Last Analy_Component Code(UK)[8 - Component 8] RD_ONLY

3025 INT Last Analy_Component Code(UK)[9 - Component 9] RD_ONLY

3026 INT Last Analy_Component Code(UK)[10 - Component
10]

RD_ONLY

3027 INT Last Analy_Component Code(UK)[11 - Component
11]

RD_ONLY

3028 INT Last Analy_Component Code(UK)[12 - Component
12]

RD_ONLY

3029 INT Last Analy_Component Code(UK)[13 - Component
13]

RD_ONLY

3030 INT Last Analy_Component Code(UK)[14 - Component
14]

RD_ONLY

3031 INT Last Analy_Component Code(UK)[15 - Component
15]

RD_ONLY

3032 INT Last Analy_Component Code(UK)[16 - Component
16]

RD_ONLY

3033 INT Run Time(1/30th Sec) RD_ONLY
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3034 INT Last Analy_Stream Number RD_ONLY

3035 INT Last Analy_CDT Stream Mask RD_ONLY

3036 INT Current Time(time_t) RD_WR MM

3037 INT Current Time(time_t) RD_WR DD

3038 INT Current Time(time_t) RD_WR YY

3039 INT Current Time(time_t) RD_WR hh

3040 INT Current Time(time_t) RD_WR mm

3041 INT Last Analy_Start Time RD_ONLY MM

3042 INT Last Analy_Start Time RD_ONLY DD

3043 INT Last Analy_Start Time RD_ONLY YY

3044 INT Last Analy_Start Time RD_ONLY hh

3045 INT Last Analy_Start Time RD_ONLY mm

3046 Bit-
map(INT)

0:Unused, 1:Unused, 2:System Alarm_Alarm On - Last
Analysis_Analog Input 1 Low Signal, 3:System Alarm_
Alarm On - Last Analysis_Analog Input 1 High Signal,
4:System Alarm_Alarm On - Last Analysis_Analog In-
put 2 Low Signal, 5:System Alarm_Alarm On - Last
Analysis_Analog Input 2 High Signal, 6:Unused, 7:Un-
used, 8:System Alarm_Alarm On - Last Analysis_Ana-
log Output 1 Low Signal, 9:System Alarm_Alarm On -
Last Analysis_Analog Output 1 High Signal, 10:System
Alarm_Alarm On - Last Analysis_Analog Output 2 Low
Signal, 11:System Alarm_Alarm On - Last Analysis_An-
alog Output 2 High Signal, 12:System Alarm_Alarm
On - Last Analysis_Analog Output 3 Low Signal,
13:System Alarm_Alarm On - Last Analysis_Analog
Output 3 High Signal, 14:Analyzer Failure, 15:Unused

RD_ONLY

3047 Bit-
map(INT)

0:System Alarm_Alarm On - Current Analysis_Power
Failure, 1:Calibration Failed, 2:Preamp Failure, 3:Un-
used, 4:Unused, 5:Unused, 6:Unused, 7:Unused, 8:Un-
used, 9:Unused, 10:Unused, 11:Unused, 12:Unused,
13:Unused, 14:Unused, 15:Unused

RD_ONLY

3048 INT 1 - Stream 1_Active Low Limit Alarms RD_ONLY

3049 INT 1 - Stream 1_Active High Limit Alarms RD_ONLY

3050 INT 2 - Stream 2_Active Low Limit Alarms RD_ONLY

3051 INT 2 - Stream 2_Active High Limit Alarms RD_ONLY

3052 INT 3 - Stream 3_Active Low Limit Alarms RD_ONLY

3053 INT 3 - Stream 3_Active High Limit Alarms RD_ONLY

3054 INT 4 - Stream 4_Active Low Limit Alarms RD_ONLY

3055 INT 4 - Stream 4_Active High Limit Alarms RD_ONLY

3056 INT 5 - Stream 5_Active Low Limit Alarms RD_ONLY

Pre-defined Modbus
®

 Map Files

254 Rosemount™ 1500XA Gas Chromatograph



Register # Data type Variable Record # Access Format

3057 INT 5 - Stream 5_Active High Limit Alarms RD_ONLY

3058 INT New Data Flag RD_WR

3059 INT Analy/Calib Flag RD_ONLY

3060 INT Daily Avg Updated RD_WR

3061 INT Last Stream RD_ONLY

3062 INT 2 - Stream 2_New Data Available RD_WR

3063 INT 3 - Stream 3_New Data Available RD_WR

3064 INT 4 - Stream 4_New Data Available RD_WR

3065 INT 5 - Stream 5_New Data Available RD_WR

3066 INT Component Data 1_Reference Code[1] RD_ONLY

3067 INT Component Data 1_Reference Code[2] RD_ONLY

3068 INT Component Data 1_Reference Code[3] RD_ONLY

3069 INT Component Data 1_Reference Code[4] RD_ONLY

3070 INT Component Data 1_Reference Code[5] RD_ONLY

3071 INT Component Data 1_Reference Code[6] RD_ONLY

3072 INT Component Data 1_Reference Code[7] RD_ONLY

3073 INT Component Data 1_Reference Code[8] RD_ONLY

3074 INT Component Data 1_Reference Code[9] RD_ONLY

3075 INT Component Data 1_Reference Code[10] RD_ONLY

3076 INT Component Data 1_Reference Code[11] RD_ONLY

3077 INT Component Data 1_Reference Code[12] RD_ONLY

3078 INT Component Data 1_Reference Code[13] RD_ONLY

3079 INT Component Data 1_Reference Code[14] RD_ONLY

3080 INT Component Data 1_Reference Code[15] RD_ONLY

3081 INT Component Data 1_Reference Code[16] RD_ONLY

3082 INT Component Data 2_Reference Code[1] RD_ONLY

3083 INT Component Data 2_Reference Code[2] RD_ONLY

3084 INT Component Data 2_Reference Code[3] RD_ONLY

3085 INT Component Data 2_Reference Code[4] RD_ONLY

3086 INT Component Data 2_Reference Code[5] RD_ONLY

3087 INT Component Data 2_Reference Code[6] RD_ONLY

3088 INT Component Data 2_Reference Code[7] RD_ONLY

3089 INT Component Data 2_Reference Code[8] RD_ONLY

3090 INT Component Data 2_Reference Code[9] RD_ONLY

3091 INT Component Data 2_Reference Code[10] RD_ONLY

3092 INT Component Data 2_Reference Code[11] RD_ONLY

3093 INT Component Data 2_Reference Code[12] RD_ONLY
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3094 INT Component Data 2_Reference Code[13] RD_ONLY

3095 INT Component Data 2_Reference Code[14] RD_ONLY

3096 INT Component Data 2_Reference Code[15] RD_ONLY

3097 INT Component Data 2_Reference Code[16] RD_ONLY

3098 INT Calculations Configuration_Primary CV Units RD_ONLY

3099 INT Last Run Data Valid 1 RD_WR

3100 INT Last Run Data Valid 2 RD_WR

3101 INT Last Run Data Valid 3 RD_WR

3102 INT Last Run Data Valid 4 RD_WR

3103 INT Last FCalib_New RF Update Flag[1 - Component 1] RD_ONLY

3104 INT Last FCalib_New RF Update Flag[2 - Component 2] RD_ONLY

3105 INT Last FCalib_New RF Update Flag[3 - Component 3] RD_ONLY

3106 INT Last FCalib_New RF Update Flag[4 - Component 4] RD_ONLY

3107 INT Last FCalib_New RF Update Flag[5 - Component 5] RD_ONLY

3108 INT Last FCalib_New RF Update Flag[6 - Component 6] RD_ONLY

3109 INT Last FCalib_New RF Update Flag[7 - Component 7] RD_ONLY

3110 INT Last FCalib_New RF Update Flag[8 - Component 8] RD_ONLY

3111 INT Last FCalib_New RF Update Flag[9 - Component 9] RD_ONLY

3112 INT Last FCalib_New RF Update Flag[10 - Component 10] RD_ONLY

3113 INT Last FCalib_New RF Update Flag[11 - Component 11] RD_ONLY

3114 INT Last FCalib_New RF Update Flag[12 - Component 12] RD_ONLY

3115 INT Last FCalib_New RF Update Flag[13 - Component 13] RD_ONLY

3116 INT Last FCalib_New RF Update Flag[14 - Component 14] RD_ONLY

3117 INT Last FCalib_New RF Update Flag[15 - Component 15] RD_ONLY

3118 INT Last FCalib_New RF Update Flag[16 - Component 16] RD_ONLY

3119 INT Last FCalib_New RF Update Flag[17 - Component 17] RD_ONLY

3120 INT Last FCalib_New RF Update Flag[18 - Component 18] RD_ONLY

3121 INT Last FCalib_New RF Update Flag[19 - Component 19] RD_ONLY

3122 INT Last FCalib_New RF Update Flag[20 - Component 20] RD_ONLY

3123 INT Last FCalib_New RF Update Flag[1 - Component 1] RD_ONLY

3124 INT Last FCalib_New RF Update Flag[2 - Component 2] RD_ONLY

3125 INT Last FCalib_New RF Update Flag[3 - Component 3] RD_ONLY

3126 INT Last FCalib_New RF Update Flag[4 - Component 4] RD_ONLY

3127 INT Last FCalib_New RF Update Flag[5 - Component 5] RD_ONLY

3128 INT Last FCalib_New RF Update Flag[6 - Component 6] RD_ONLY

3129 INT Last FCalib_New RF Update Flag[7 - Component 7] RD_ONLY

3130 INT Last FCalib_New RF Update Flag[8 - Component 8] RD_ONLY
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3131 INT Last FCalib_New RF Update Flag[9 - Component 9] RD_ONLY

3132 INT Last FCalib_New RF Update Flag[10 - Component 10] RD_ONLY

3133 INT Last FCalib_New RF Update Flag[11 - Component 11] RD_ONLY

3134 INT Last FCalib_New RF Update Flag[12 - Component 12] RD_ONLY

3135 INT Last FCalib_New RF Update Flag[13 - Component 13] RD_ONLY

3136 INT Last FCalib_New RF Update Flag[14 - Component 14] RD_ONLY

3137 INT Last FCalib_New RF Update Flag[15 - Component 15] RD_ONLY

3138 INT Last FCalib_New RF Update Flag[16 - Component 16] RD_ONLY

3139 INT Last FCalib_New RF Update Flag[17 - Component 17] RD_ONLY

3140 INT Last FCalib_New RF Update Flag[18 - Component 18] RD_ONLY

3141 INT Last FCalib_New RF Update Flag[19 - Component 19] RD_ONLY

3142 INT Last FCalib_New RF Update Flag[20 - Component 20] RD_ONLY

3143 INT Last FCalib_New RF Update Flag[1 - Component 1] RD_ONLY

3144 INT Last FCalib_New RF Update Flag[2 - Component 2] RD_ONLY

3145 INT Last FCalib_New RF Update Flag[3 - Component 3] RD_ONLY

3146 INT Last FCalib_New RF Update Flag[4 - Component 4] RD_ONLY

3147 INT Last FCalib_New RF Update Flag[5 - Component 5] RD_ONLY

3148 INT Last FCalib_New RF Update Flag[6 - Component 6] RD_ONLY

3149 INT Last FCalib_New RF Update Flag[7 - Component 7] RD_ONLY

3150 INT Last FCalib_New RF Update Flag[8 - Component 8] RD_ONLY

3151 INT Last FCalib_New RF Update Flag[9 - Component 9] RD_ONLY

3152 INT Last FCalib_New RF Update Flag[10 - Component 10] RD_ONLY

3153 INT Last FCalib_New RF Update Flag[11 - Component 11] RD_ONLY

3154 INT Last FCalib_New RF Update Flag[12 - Component 12] RD_ONLY

3155 INT Last FCalib_New RF Update Flag[13 - Component 13] RD_ONLY

3156 INT Last FCalib_New RF Update Flag[14 - Component 14] RD_ONLY

3157 INT Last FCalib_New RF Update Flag[15 - Component 15] RD_ONLY

3158 INT Last FCalib_New RF Update Flag[16 - Component 16] RD_ONLY

3159 INT Last FCalib_New RF Update Flag[17 - Component 17] RD_ONLY

3160 INT Last FCalib_New RF Update Flag[18 - Component 18] RD_ONLY

3161 INT Last FCalib_New RF Update Flag[19 - Component 19] RD_ONLY

3162 INT Last FCalib_New RF Update Flag[20 - Component 20] RD_ONLY

3163 INT Last FCalib_New RF Update Flag[1 - Component 1] RD_ONLY

3164 INT Last FCalib_New RF Update Flag[2 - Component 2] RD_ONLY

3165 INT Last FCalib_New RF Update Flag[3 - Component 3] RD_ONLY

3166 INT Last FCalib_New RF Update Flag[4 - Component 4] RD_ONLY

3167 INT Last FCalib_New RF Update Flag[5 - Component 5] RD_ONLY
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3168 INT Last FCalib_New RF Update Flag[6 - Component 6] RD_ONLY

3169 INT Last FCalib_New RF Update Flag[7 - Component 7] RD_ONLY

3170 INT Last FCalib_New RF Update Flag[8 - Component 8] RD_ONLY

3171 INT Last FCalib_New RF Update Flag[9 - Component 9] RD_ONLY

3172 INT Last FCalib_New RF Update Flag[10 - Component 10] RD_ONLY

3173 INT Last FCalib_New RF Update Flag[11 - Component 11] RD_ONLY

3174 INT Last FCalib_New RF Update Flag[12 - Component 12] RD_ONLY

3175 INT Last FCalib_New RF Update Flag[13 - Component 13] RD_ONLY

3176 INT Last FCalib_New RF Update Flag[14 - Component 14] RD_ONLY

3177 INT Last FCalib_New RF Update Flag[15 - Component 15] RD_ONLY

3178 INT Last FCalib_New RF Update Flag[16 - Component 16] RD_ONLY

3179 INT Last FCalib_New RF Update Flag[17 - Component 17] RD_ONLY

3180 INT Last FCalib_New RF Update Flag[18 - Component 18] RD_ONLY

3181 INT Last FCalib_New RF Update Flag[19 - Component 19] RD_ONLY

3182 INT Last FCalib_New RF Update Flag[20 - Component 20] RD_ONLY

5001 LONG Last Analy_Cycle Time (1/30th sec) RD_ONLY

5002 LONG Last Calib_Calib Time(1/30th sec) RD_ONLY

7001 FLOAT Last Analy_Mole %[1 - Component 1] RD_ONLY

7002 FLOAT Last Analy_Mole %[2 - Component 2] RD_ONLY

7003 FLOAT Last Analy_Mole %[3 - Component 3] RD_ONLY

7004 FLOAT Last Analy_Mole %[4 - Component 4] RD_ONLY

7005 FLOAT Last Analy_Mole %[5 - Component 5] RD_ONLY

7006 FLOAT Last Analy_Mole %[6 - Component 6] RD_ONLY

7007 FLOAT Last Analy_Mole %[7 - Component 7] RD_ONLY

7008 FLOAT Last Analy_Mole %[8 - Component 8] RD_ONLY

7009 FLOAT Last Analy_Mole %[9 - Component 9] RD_ONLY

7010 FLOAT Last Analy_Mole %[10 - Component 10] RD_ONLY

7011 FLOAT Last Analy_Mole %[11 - Component 11] RD_ONLY

7012 FLOAT Last Analy_Mole %[12 - Component 12] RD_ONLY

7013 FLOAT Last Analy_Mole %[13 - Component 13] RD_ONLY

7014 FLOAT Last Analy_Mole %[14 - Component 14] RD_ONLY

7015 FLOAT Last Analy_Mole %[15 - Component 15] RD_ONLY

7016 FLOAT Last Analy_Mole %[16 - Component 16] RD_ONLY

7017 FLOAT Last Analy_Weight %[1 - Component 1] RD_ONLY

7018 FLOAT Last Analy_Weight %[2 - Component 2] RD_ONLY

7019 FLOAT Last Analy_Weight %[3 - Component 3] RD_ONLY

7020 FLOAT Last Analy_Weight %[4 - Component 4] RD_ONLY
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7021 FLOAT Last Analy_Weight %[5 - Component 5] RD_ONLY

7022 FLOAT Last Analy_Weight %[6 - Component 6] RD_ONLY

7023 FLOAT Last Analy_Weight %[7 - Component 7] RD_ONLY

7024 FLOAT Last Analy_Weight %[8 - Component 8] RD_ONLY

7025 FLOAT Last Analy_Weight %[9 - Component 9] RD_ONLY

7026 FLOAT Last Analy_Weight %[10 - Component 10] RD_ONLY

7027 FLOAT Last Analy_Weight %[11 - Component 11] RD_ONLY

7028 FLOAT Last Analy_Weight %[12 - Component 12] RD_ONLY

7029 FLOAT Last Analy_Weight %[13 - Component 13] RD_ONLY

7030 FLOAT Last Analy_Weight %[14 - Component 14] RD_ONLY

7031 FLOAT Last Analy_Weight %[15 - Component 15] RD_ONLY

7032 FLOAT Last Analy_Weight %[16 - Component 16] RD_ONLY

7033 FLOAT Last Analy_ISO CV Sup Dry - Pri RD_ONLY

7034 FLOAT Last Analy_ISO CV Sup Sat - Pri RD_ONLY

7035 FLOAT Last Analy_ISO Real Rel Den Gas - Pri RD_ONLY

7036 FLOAT Last Analy_ISO Z Factor - Pri RD_ONLY

7037 FLOAT Last Analy_ISO Wobbe Index Sup - Pri RD_ONLY

7038 FLOAT Last Analy_Total Unnormalized Conc RD_ONLY

7039 FLOAT Last Analy_ISO Avg Molar Mass RD_ONLY

7040 FLOAT Calc Result[1 - User Cal 1] RD_ONLY

7041 FLOAT Calc Result[2 - User Cal 2] RD_ONLY

7042 FLOAT Calc Result[3 - User Cal 3] RD_ONLY

7043 FLOAT Calc Result[4 - User Cal 4] RD_ONLY

7044 FLOAT Calc Result[5 - User Cal 5] RD_ONLY

7045 FLOAT Unused RD_ONLY

7046 FLOAT Last Analy_ISO CV Sup Dry - Sec RD_ONLY

7047 FLOAT Last Analy_ISO CV Sup Sat - Sec RD_ONLY

7048 FLOAT Last Analy_ISO CV Inf Dry - Sec RD_ONLY

7049 FLOAT Last Analy_ISO CV Inf Sat - Sec RD_ONLY

7050 FLOAT Last Analy_ISO Z Factor - Sec RD_ONLY

7051 FLOAT Last Analy_ISO Real Rel Den Gas - Sec RD_ONLY

7052 FLOAT Last Analy_ISO Gas Den kg/m3 - Sec RD_ONLY

7053 FLOAT Last Analy_ISO Wobbe Index Sup - Sec RD_ONLY

7054 FLOAT Last Analy_ISO Wobbe Index Inf - Sec RD_ONLY

7055 FLOAT Avg[1 - Average 1] RD_ONLY

7056 FLOAT Avg[2 - Average 2] RD_ONLY

7057 FLOAT Avg[3 - Average 3] RD_ONLY
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7058 FLOAT Avg[4 - Average 4] RD_ONLY

7059 FLOAT Avg[5 - Average 5] RD_ONLY

7060 FLOAT Avg[6 - Average 6] RD_ONLY

7061 FLOAT Avg[7 - Average 7] RD_ONLY

7062 FLOAT Avg[8 - Average 8] RD_ONLY

7063 FLOAT Avg[9 - Average 9] RD_ONLY

7064 FLOAT Avg[10 - Average 10] RD_ONLY

7065 FLOAT Avg[11 - Average 11] RD_ONLY

7066 FLOAT Avg[12 - Average 12] RD_ONLY

7067 FLOAT Avg[13 - Average 13] RD_ONLY

7068 FLOAT Avg[14 - Average 14] RD_ONLY

7069 FLOAT Avg[15 - Average 15] RD_ONLY

7070 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

7071 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

7072 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

7073 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

7074 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

7075 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

7076 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

7077 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

7078 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY

7079 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

7080 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

7081 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY

7082 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

7083 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

7084 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

7085 FLOAT Current Value[1 - Analog Input 1] RD_ONLY

7086 FLOAT Current Value[2 - Analog Input 2] RD_ONLY

7087 FLOAT Last Analy_ISO CV Inf Dry - Pri RD_ONLY

7088 FLOAT Last Analy_ISO CV Inf Sat - Pri RD_ONLY

7089 FLOAT Last Analy_ISO Wobbe Index Inf - Pri RD_ONLY

7090 FLOAT Last Analy_ISO Gas Den kg/m3 - Pri RD_ONLY

7091 FLOAT Last FCalib_Total Calibration Runs RD_ONLY

7092 FLOAT Last FCalib_Total Average Runs RD_ONLY

7093 FLOAT Auto Calibration Start Time RD_ONLY hhmm

7094 FLOAT GC Control_Stream Sequence Select RD_WR
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7095 FLOAT Last Analy_Response Factor[1 - Component 1] RD_ONLY

7096 FLOAT Last Analy_Response Factor[2 - Component 2] RD_ONLY

7097 FLOAT Last Analy_Response Factor[3 - Component 3] RD_ONLY

7098 FLOAT Last Analy_Response Factor[4 - Component 4] RD_ONLY

7099 FLOAT Last Analy_Response Factor[5 - Component 5] RD_ONLY

7100 FLOAT Last Analy_Response Factor[6 - Component 6] RD_ONLY

7101 FLOAT Last Analy_Response Factor[7 - Component 7] RD_ONLY

7102 FLOAT Last Analy_Response Factor[8 - Component 8] RD_ONLY

7103 FLOAT Last Analy_Response Factor[9 - Component 9] RD_ONLY

7104 FLOAT Last Analy_Response Factor[10 - Component 10] RD_ONLY

7105 FLOAT Last Analy_Response Factor[11 - Component 11] RD_ONLY

7106 FLOAT Last Analy_Response Factor[12 - Component 12] RD_ONLY

7107 FLOAT Last Analy_Response Factor[13 - Component 13] RD_ONLY

7108 FLOAT Last Analy_Response Factor[14 - Component 14] RD_ONLY

7109 FLOAT Last Analy_Response Factor[15 - Component 15] RD_ONLY

7110 FLOAT Last Analy_Response Factor[16 - Component 16] RD_ONLY

7111 FLOAT Last FCalib_ISO CV Sup Dry - Pri RD_ONLY

7112 FLOAT Last FCalib_ISO CV Sup Sat - Pri RD_ONLY

7113 FLOAT Last FCalib_ISO CV Inf Dry - Pri RD_ONLY

7114 FLOAT Last FCalib_ISO CV Inf Sat - Pri RD_ONLY

7115 FLOAT Last FCalib_ISO Z Factor - Pri RD_ONLY

7116 FLOAT Last FCalib_ISO Real Rel Den Gas - Pri RD_ONLY

7117 FLOAT Last FCalib_ISO Gas Den kg/m3 - Pri RD_ONLY

7118 FLOAT Last FCalib_ISO Wobbe Index Sup - Pri RD_ONLY

7119 FLOAT Last FCalib_ISO Wobbe Index Inf - Pri RD_ONLY

7120 FLOAT Last FCalib_ISO Avg Molar Mass RD_ONLY

7121 FLOAT Last FCalib_Total Unnormalized Conc RD_ONLY

7122 FLOAT Last Calib_Stream Number RD_ONLY

7123 FLOAT Last Analy_GS(M)R Incomp Combustion Factor RD_ONLY

7124 FLOAT Last Analy_GS(M)R Soot Index RD_ONLY

7125 FLOAT Last Analy_Ratio of Latent Heat Cap RD_ONLY

7126 FLOAT Avg[1 - Average 1] RD_ONLY

7127 FLOAT Avg[2 - Average 2] RD_ONLY

7128 FLOAT Avg[3 - Average 3] RD_ONLY

7129 FLOAT Avg[4 - Average 4] RD_ONLY

7130 FLOAT Avg[5 - Average 5] RD_ONLY

7131 FLOAT Avg[6 - Average 6] RD_ONLY
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7132 FLOAT Avg[7 - Average 7] RD_ONLY

7133 FLOAT Avg[8 - Average 8] RD_ONLY

7134 FLOAT Avg[9 - Average 9] RD_ONLY

7135 FLOAT Avg[10 - Average 10] RD_ONLY

7136 FLOAT Avg[11 - Average 11] RD_ONLY

7137 FLOAT Avg[12 - Average 12] RD_ONLY

7138 FLOAT Avg[13 - Average 13] RD_ONLY

7139 FLOAT Avg[14 - Average 14] RD_ONLY

7140 FLOAT Avg[15 - Average 15] RD_ONLY

7141 FLOAT Avg[16 - Average 16] RD_ONLY

7142 FLOAT Avg[17 - Average 17] RD_ONLY

7143 FLOAT Avg[18 - Average 18] RD_ONLY

7144 FLOAT Avg[19 - Average 19] RD_ONLY

7145 FLOAT Avg[20 - Average 20] RD_ONLY

7146 FLOAT Avg[21 - Average 21] RD_ONLY

7147 FLOAT Avg[22 - Average 22] RD_ONLY

7148 FLOAT Avg[23 - Average 23] RD_ONLY

7149 FLOAT Avg[24 - Average 24] RD_ONLY

7150 FLOAT Avg[25 - Average 25] RD_ONLY

7151 FLOAT Avg[26 - Average 26] RD_ONLY

7152 FLOAT Avg[27 - Average 27] RD_ONLY

7153 FLOAT Avg[28 - Average 28] RD_ONLY

7154 FLOAT Avg[29 - Average 29] RD_ONLY

7155 FLOAT Avg[30 - Average 30] RD_ONLY

7156 FLOAT Avg[31 - Average 31] RD_ONLY

7157 FLOAT Avg[32 - Average 32] RD_ONLY

7158 FLOAT Avg[33 - Average 33] RD_ONLY

7159 FLOAT Avg[34 - Average 34] RD_ONLY

7160 FLOAT Avg[35 - Average 35] RD_ONLY

7161 FLOAT Avg[36 - Average 36] RD_ONLY

7162 FLOAT Max[1 - Average 1] RD_ONLY

7163 FLOAT Max[2 - Average 2] RD_ONLY

7164 FLOAT Max[3 - Average 3] RD_ONLY

7165 FLOAT Max[4 - Average 4] RD_ONLY

7166 FLOAT Max[5 - Average 5] RD_ONLY

7167 FLOAT Max[6 - Average 6] RD_ONLY

7168 FLOAT Max[7 - Average 7] RD_ONLY
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7169 FLOAT Max[8 - Average 8] RD_ONLY

7170 FLOAT Max[9 - Average 9] RD_ONLY

7171 FLOAT Max[10 - Average 10] RD_ONLY

7172 FLOAT Max[11 - Average 11] RD_ONLY

7173 FLOAT Max[12 - Average 12] RD_ONLY

7174 FLOAT Max[13 - Average 13] RD_ONLY

7175 FLOAT Max[14 - Average 14] RD_ONLY

7176 FLOAT Max[15 - Average 15] RD_ONLY

7177 FLOAT Max[16 - Average 16] RD_ONLY

7178 FLOAT Max[17 - Average 17] RD_ONLY

7179 FLOAT Max[18 - Average 18] RD_ONLY

7180 FLOAT Max[19 - Average 19] RD_ONLY

7181 FLOAT Max[20 - Average 20] RD_ONLY

7182 FLOAT Max[21 - Average 21] RD_ONLY

7183 FLOAT Max[22 - Average 22] RD_ONLY

7184 FLOAT Max[23 - Average 23] RD_ONLY

7185 FLOAT Max[24 - Average 24] RD_ONLY

7186 FLOAT Max[25 - Average 25] RD_ONLY

7187 FLOAT Max[26 - Average 26] RD_ONLY

7188 FLOAT Max[27 - Average 27] RD_ONLY

7189 FLOAT Max[28 - Average 28] RD_ONLY

7190 FLOAT Max[29 - Average 29] RD_ONLY

7191 FLOAT Max[30 - Average 30] RD_ONLY

7192 FLOAT Max[31 - Average 31] RD_ONLY

7193 FLOAT Max[32 - Average 32] RD_ONLY

7194 FLOAT Max[33 - Average 33] RD_ONLY

7195 FLOAT Max[34 - Average 34] RD_ONLY

7196 FLOAT Max[35 - Average 35] RD_ONLY

7197 FLOAT Max[36 - Average 36] RD_ONLY

7198 FLOAT Min[1 - Average 1] RD_ONLY

7199 FLOAT Min[2 - Average 2] RD_ONLY

7200 FLOAT Min[3 - Average 3] RD_ONLY

7201 FLOAT Min[4 - Average 4] RD_ONLY

7202 FLOAT Min[5 - Average 5] RD_ONLY

7203 FLOAT Min[6 - Average 6] RD_ONLY

7204 FLOAT Min[7 - Average 7] RD_ONLY

7205 FLOAT Min[8 - Average 8] RD_ONLY
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7206 FLOAT Min[9 - Average 9] RD_ONLY

7207 FLOAT Min[10 - Average 10] RD_ONLY

7208 FLOAT Min[11 - Average 11] RD_ONLY

7209 FLOAT Min[12 - Average 12] RD_ONLY

7210 FLOAT Min[13 - Average 13] RD_ONLY

7211 FLOAT Min[14 - Average 14] RD_ONLY

7212 FLOAT Min[15 - Average 15] RD_ONLY

7213 FLOAT Min[16 - Average 16] RD_ONLY

7214 FLOAT Min[17 - Average 17] RD_ONLY

7215 FLOAT Min[18 - Average 18] RD_ONLY

7216 FLOAT Min[19 - Average 19] RD_ONLY

7217 FLOAT Min[20 - Average 20] RD_ONLY

7218 FLOAT Min[21 - Average 21] RD_ONLY

7219 FLOAT Min[22 - Average 22] RD_ONLY

7220 FLOAT Min[23 - Average 23] RD_ONLY

7221 FLOAT Min[24 - Average 24] RD_ONLY

7222 FLOAT Min[25 - Average 25] RD_ONLY

7223 FLOAT Min[26 - Average 26] RD_ONLY

7224 FLOAT Min[27 - Average 27] RD_ONLY

7225 FLOAT Min[28 - Average 28] RD_ONLY

7226 FLOAT Min[29 - Average 29] RD_ONLY

7227 FLOAT Min[30 - Average 30] RD_ONLY

7228 FLOAT Min[31 - Average 31] RD_ONLY

7229 FLOAT Min[32 - Average 32] RD_ONLY

7230 FLOAT Min[33 - Average 33] RD_ONLY

7231 FLOAT Min[34 - Average 34] RD_ONLY

7232 FLOAT Min[35 - Average 35] RD_ONLY

7233 FLOAT Min[36 - Average 36] RD_ONLY

7234 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

7235 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

7236 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

7237 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

7238 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

7239 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

7240 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

7241 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

7242 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY
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7243 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

7244 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

7245 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY

7246 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

7247 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

7248 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

7249 FLOAT Archive_Avg[16 - Average 16] 1 RD_ONLY

7250 FLOAT Archive_Avg[17 - Average 17] 1 RD_ONLY

7251 FLOAT Archive_Avg[18 - Average 18] 1 RD_ONLY

7252 FLOAT Archive_Avg[19 - Average 19] 1 RD_ONLY

7253 FLOAT Archive_Avg[20 - Average 20] 1 RD_ONLY

7254 FLOAT Archive_Avg[21 - Average 21] 1 RD_ONLY

7255 FLOAT Archive_Avg[22 - Average 22] 1 RD_ONLY

7256 FLOAT Archive_Avg[23 - Average 23] 1 RD_ONLY

7257 FLOAT Archive_Avg[24 - Average 24] 1 RD_ONLY

7258 FLOAT Archive_Avg[25 - Average 25] 1 RD_ONLY

7259 FLOAT Archive_Avg[26 - Average 26] 1 RD_ONLY

7260 FLOAT Archive_Avg[27 - Average 27] 1 RD_ONLY

7261 FLOAT Archive_Avg[28 - Average 28] 1 RD_ONLY

7262 FLOAT Archive_Avg[29 - Average 29] 1 RD_ONLY

7263 FLOAT Archive_Avg[30 - Average 30] 1 RD_ONLY

7264 FLOAT Archive_Avg[31 - Average 31] 1 RD_ONLY

7265 FLOAT Archive_Avg[32 - Average 32] 1 RD_ONLY

7266 FLOAT Archive_Avg[33 - Average 33] 1 RD_ONLY

7267 FLOAT Archive_Avg[34 - Average 34] 1 RD_ONLY

7268 FLOAT Archive_Avg[35 - Average 35] 1 RD_ONLY

7269 FLOAT Archive_Avg[36 - Average 36] 1 RD_ONLY

7270 FLOAT Archive_Max[1 - Average 1] 1 RD_ONLY

7271 FLOAT Archive_Max[2 - Average 2] 1 RD_ONLY

7272 FLOAT Archive_Max[3 - Average 3] 1 RD_ONLY

7273 FLOAT Archive_Max[4 - Average 4] 1 RD_ONLY

7274 FLOAT Archive_Max[5 - Average 5] 1 RD_ONLY

7275 FLOAT Archive_Max[6 - Average 6] 1 RD_ONLY

7276 FLOAT Archive_Max[7 - Average 7] 1 RD_ONLY

7277 FLOAT Archive_Max[8 - Average 8] 1 RD_ONLY

7278 FLOAT Archive_Max[9 - Average 9] 1 RD_ONLY

7279 FLOAT Archive_Max[10 - Average 10] 1 RD_ONLY
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7280 FLOAT Archive_Max[11 - Average 11] 1 RD_ONLY

7281 FLOAT Archive_Max[12 - Average 12] 1 RD_ONLY

7282 FLOAT Archive_Max[13 - Average 13] 1 RD_ONLY

7283 FLOAT Archive_Max[14 - Average 14] 1 RD_ONLY

7284 FLOAT Archive_Max[15 - Average 15] 1 RD_ONLY

7285 FLOAT Archive_Max[16 - Average 16] 1 RD_ONLY

7286 FLOAT Archive_Max[17 - Average 17] 1 RD_ONLY

7287 FLOAT Archive_Max[18 - Average 18] 1 RD_ONLY

7288 FLOAT Archive_Max[19 - Average 19] 1 RD_ONLY

7289 FLOAT Archive_Max[20 - Average 20] 1 RD_ONLY

7290 FLOAT Archive_Max[21 - Average 21] 1 RD_ONLY

7291 FLOAT Archive_Max[22 - Average 22] 1 RD_ONLY

7292 FLOAT Archive_Max[23 - Average 23] 1 RD_ONLY

7293 FLOAT Archive_Max[24 - Average 24] 1 RD_ONLY

7294 FLOAT Archive_Max[25 - Average 25] 1 RD_ONLY

7295 FLOAT Archive_Max[26 - Average 26] 1 RD_ONLY

7296 FLOAT Archive_Max[27 - Average 27] 1 RD_ONLY

7297 FLOAT Archive_Max[28 - Average 28] 1 RD_ONLY

7298 FLOAT Archive_Max[29 - Average 29] 1 RD_ONLY

7299 FLOAT Archive_Max[30 - Average 30] 1 RD_ONLY

7300 FLOAT Archive_Max[31 - Average 31] 1 RD_ONLY

7301 FLOAT Archive_Max[32 - Average 32] 1 RD_ONLY

7302 FLOAT Archive_Max[33 - Average 33] 1 RD_ONLY

7303 FLOAT Archive_Max[34 - Average 34] 1 RD_ONLY

7304 FLOAT Archive_Max[35 - Average 35] 1 RD_ONLY

7305 FLOAT Archive_Max[36 - Average 36] 1 RD_ONLY

7306 FLOAT Archive_Min[1 - Average 1] 1 RD_ONLY

7307 FLOAT Archive_Min[2 - Average 2] 1 RD_ONLY

7308 FLOAT Archive_Min[3 - Average 3] 1 RD_ONLY

7309 FLOAT Archive_Min[4 - Average 4] 1 RD_ONLY

7310 FLOAT Archive_Min[5 - Average 5] 1 RD_ONLY

7311 FLOAT Archive_Min[6 - Average 6] 1 RD_ONLY

7312 FLOAT Archive_Min[7 - Average 7] 1 RD_ONLY

7313 FLOAT Archive_Min[8 - Average 8] 1 RD_ONLY

7314 FLOAT Archive_Min[9 - Average 9] 1 RD_ONLY

7315 FLOAT Archive_Min[10 - Average 10] 1 RD_ONLY

7316 FLOAT Archive_Min[11 - Average 11] 1 RD_ONLY
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7317 FLOAT Archive_Min[12 - Average 12] 1 RD_ONLY

7318 FLOAT Archive_Min[13 - Average 13] 1 RD_ONLY

7319 FLOAT Archive_Min[14 - Average 14] 1 RD_ONLY

7320 FLOAT Archive_Min[15 - Average 15] 1 RD_ONLY

7321 FLOAT Archive_Min[16 - Average 16] 1 RD_ONLY

7322 FLOAT Archive_Min[17 - Average 17] 1 RD_ONLY

7323 FLOAT Archive_Min[18 - Average 18] 1 RD_ONLY

7324 FLOAT Archive_Min[19 - Average 19] 1 RD_ONLY

7325 FLOAT Archive_Min[20 - Average 20] 1 RD_ONLY

7326 FLOAT Archive_Min[21 - Average 21] 1 RD_ONLY

7327 FLOAT Archive_Min[22 - Average 22] 1 RD_ONLY

7328 FLOAT Archive_Min[23 - Average 23] 1 RD_ONLY

7329 FLOAT Archive_Min[24 - Average 24] 1 RD_ONLY

7330 FLOAT Archive_Min[25 - Average 25] 1 RD_ONLY

7331 FLOAT Archive_Min[26 - Average 26] 1 RD_ONLY

7332 FLOAT Archive_Min[27 - Average 27] 1 RD_ONLY

7333 FLOAT Archive_Min[28 - Average 28] 1 RD_ONLY

7334 FLOAT Archive_Min[29 - Average 29] 1 RD_ONLY

7335 FLOAT Archive_Min[30 - Average 30] 1 RD_ONLY

7336 FLOAT Archive_Min[31 - Average 31] 1 RD_ONLY

7337 FLOAT Archive_Min[32 - Average 32] 1 RD_ONLY

7338 FLOAT Archive_Min[33 - Average 33] 1 RD_ONLY

7339 FLOAT Archive_Min[34 - Average 34] 1 RD_ONLY

7340 FLOAT Archive_Min[35 - Average 35] 1 RD_ONLY

7341 FLOAT Archive_Min[36 - Average 36] 1 RD_ONLY

7342 FLOAT Archive_Avg[1 - Average 1] 2 RD_ONLY

7343 FLOAT Archive_Avg[2 - Average 2] 2 RD_ONLY

7344 FLOAT Archive_Avg[3 - Average 3] 2 RD_ONLY

7345 FLOAT Archive_Avg[4 - Average 4] 2 RD_ONLY

7346 FLOAT Archive_Avg[5 - Average 5] 2 RD_ONLY

7347 FLOAT Archive_Avg[6 - Average 6] 2 RD_ONLY

7348 FLOAT Archive_Avg[7 - Average 7] 2 RD_ONLY

7349 FLOAT Archive_Avg[8 - Average 8] 2 RD_ONLY

7350 FLOAT Archive_Avg[9 - Average 9] 2 RD_ONLY

7351 FLOAT Archive_Avg[10 - Average 10] 2 RD_ONLY

7352 FLOAT Archive_Avg[11 - Average 11] 2 RD_ONLY

7353 FLOAT Archive_Avg[12 - Average 12] 2 RD_ONLY
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7354 FLOAT Archive_Avg[13 - Average 13] 2 RD_ONLY

7355 FLOAT Archive_Avg[14 - Average 14] 2 RD_ONLY

7356 FLOAT Archive_Avg[15 - Average 15] 2 RD_ONLY

7357 FLOAT Archive_Avg[16 - Average 16] 2 RD_ONLY

7358 FLOAT Archive_Avg[17 - Average 17] 2 RD_ONLY

7359 FLOAT Archive_Avg[18 - Average 18] 2 RD_ONLY

7360 FLOAT Archive_Avg[19 - Average 19] 2 RD_ONLY

7361 FLOAT Archive_Avg[20 - Average 20] 2 RD_ONLY

7362 FLOAT Archive_Avg[21 - Average 21] 2 RD_ONLY

7363 FLOAT Archive_Avg[22 - Average 22] 2 RD_ONLY

7364 FLOAT Archive_Avg[23 - Average 23] 2 RD_ONLY

7365 FLOAT Archive_Avg[24 - Average 24] 2 RD_ONLY

7366 FLOAT Archive_Avg[25 - Average 25] 2 RD_ONLY

7367 FLOAT Archive_Avg[26 - Average 26] 2 RD_ONLY

7368 FLOAT Archive_Avg[27 - Average 27] 2 RD_ONLY

7369 FLOAT Archive_Avg[28 - Average 28] 2 RD_ONLY

7370 FLOAT Archive_Avg[29 - Average 29] 2 RD_ONLY

7371 FLOAT Archive_Avg[30 - Average 30] 2 RD_ONLY

7372 FLOAT Archive_Avg[31 - Average 31] 2 RD_ONLY

7373 FLOAT Archive_Avg[32 - Average 32] 2 RD_ONLY

7374 FLOAT Archive_Avg[33 - Average 33] 2 RD_ONLY

7375 FLOAT Archive_Avg[34 - Average 34] 2 RD_ONLY

7376 FLOAT Archive_Avg[35 - Average 35] 2 RD_ONLY

7377 FLOAT Archive_Avg[36 - Average 36] 2 RD_ONLY

7378 FLOAT Archive_Max[1 - Average 1] 2 RD_ONLY

7379 FLOAT Archive_Max[2 - Average 2] 2 RD_ONLY

7380 FLOAT Archive_Max[3 - Average 3] 2 RD_ONLY

7381 FLOAT Archive_Max[4 - Average 4] 2 RD_ONLY

7382 FLOAT Archive_Max[5 - Average 5] 2 RD_ONLY

7383 FLOAT Archive_Max[6 - Average 6] 2 RD_ONLY

7384 FLOAT Archive_Max[7 - Average 7] 2 RD_ONLY

7385 FLOAT Archive_Max[8 - Average 8] 2 RD_ONLY

7386 FLOAT Archive_Max[9 - Average 9] 2 RD_ONLY

7387 FLOAT Archive_Max[10 - Average 10] 2 RD_ONLY

7388 FLOAT Archive_Max[11 - Average 11] 2 RD_ONLY

7389 FLOAT Archive_Max[12 - Average 12] 2 RD_ONLY

7390 FLOAT Archive_Max[13 - Average 13] 2 RD_ONLY
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7391 FLOAT Archive_Max[14 - Average 14] 2 RD_ONLY

7392 FLOAT Archive_Max[15 - Average 15] 2 RD_ONLY

7393 FLOAT Archive_Max[16 - Average 16] 2 RD_ONLY

7394 FLOAT Archive_Max[17 - Average 17] 2 RD_ONLY

7395 FLOAT Archive_Max[18 - Average 18] 2 RD_ONLY

7396 FLOAT Archive_Max[19 - Average 19] 2 RD_ONLY

7397 FLOAT Archive_Max[20 - Average 20] 2 RD_ONLY

7398 FLOAT Archive_Max[21 - Average 21] 2 RD_ONLY

7399 FLOAT Archive_Max[22 - Average 22] 2 RD_ONLY

7400 FLOAT Archive_Max[23 - Average 23] 2 RD_ONLY

7401 FLOAT Archive_Max[24 - Average 24] 2 RD_ONLY

7402 FLOAT Archive_Max[25 - Average 25] 2 RD_ONLY

7403 FLOAT Archive_Max[26 - Average 26] 2 RD_ONLY

7404 FLOAT Archive_Max[27 - Average 27] 2 RD_ONLY

7405 FLOAT Archive_Max[28 - Average 28] 2 RD_ONLY

7406 FLOAT Archive_Max[29 - Average 29] 2 RD_ONLY

7407 FLOAT Archive_Max[30 - Average 30] 2 RD_ONLY

7408 FLOAT Archive_Max[31 - Average 31] 2 RD_ONLY

7409 FLOAT Archive_Max[32 - Average 32] 2 RD_ONLY

7410 FLOAT Archive_Max[33 - Average 33] 2 RD_ONLY

7411 FLOAT Archive_Max[34 - Average 34] 2 RD_ONLY

7412 FLOAT Archive_Max[35 - Average 35] 2 RD_ONLY

7413 FLOAT Archive_Max[36 - Average 36] 2 RD_ONLY

7414 FLOAT Archive_Min[1 - Average 1] 2 RD_ONLY

7415 FLOAT Archive_Min[2 - Average 2] 2 RD_ONLY

7416 FLOAT Archive_Min[3 - Average 3] 2 RD_ONLY

7417 FLOAT Archive_Min[4 - Average 4] 2 RD_ONLY

7418 FLOAT Archive_Min[5 - Average 5] 2 RD_ONLY

7419 FLOAT Archive_Min[6 - Average 6] 2 RD_ONLY

7420 FLOAT Archive_Min[7 - Average 7] 2 RD_ONLY

7421 FLOAT Archive_Min[8 - Average 8] 2 RD_ONLY

7422 FLOAT Archive_Min[9 - Average 9] 2 RD_ONLY

7423 FLOAT Archive_Min[10 - Average 10] 2 RD_ONLY

7424 FLOAT Archive_Min[11 - Average 11] 2 RD_ONLY

7425 FLOAT Archive_Min[12 - Average 12] 2 RD_ONLY

7426 FLOAT Archive_Min[13 - Average 13] 2 RD_ONLY

7427 FLOAT Archive_Min[14 - Average 14] 2 RD_ONLY
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7428 FLOAT Archive_Min[15 - Average 15] 2 RD_ONLY

7429 FLOAT Archive_Min[16 - Average 16] 2 RD_ONLY

7430 FLOAT Archive_Min[17 - Average 17] 2 RD_ONLY

7431 FLOAT Archive_Min[18 - Average 18] 2 RD_ONLY

7432 FLOAT Archive_Min[19 - Average 19] 2 RD_ONLY

7433 FLOAT Archive_Min[20 - Average 20] 2 RD_ONLY

7434 FLOAT Archive_Min[21 - Average 21] 2 RD_ONLY

7435 FLOAT Archive_Min[22 - Average 22] 2 RD_ONLY

7436 FLOAT Archive_Min[23 - Average 23] 2 RD_ONLY

7437 FLOAT Archive_Min[24 - Average 24] 2 RD_ONLY

7438 FLOAT Archive_Min[25 - Average 25] 2 RD_ONLY

7439 FLOAT Archive_Min[26 - Average 26] 2 RD_ONLY

7440 FLOAT Archive_Min[27 - Average 27] 2 RD_ONLY

7441 FLOAT Archive_Min[28 - Average 28] 2 RD_ONLY

7442 FLOAT Archive_Min[29 - Average 29] 2 RD_ONLY

7443 FLOAT Archive_Min[30 - Average 30] 2 RD_ONLY

7444 FLOAT Archive_Min[31 - Average 31] 2 RD_ONLY

7445 FLOAT Archive_Min[32 - Average 32] 2 RD_ONLY

7446 FLOAT Archive_Min[33 - Average 33] 2 RD_ONLY

7447 FLOAT Archive_Min[34 - Average 34] 2 RD_ONLY

7448 FLOAT Archive_Min[35 - Average 35] 2 RD_ONLY

7449 FLOAT Archive_Min[36 - Average 36] 2 RD_ONLY

7450 FLOAT Archive_Avg[1 - Average 1] 3 RD_ONLY

7451 FLOAT Archive_Avg[2 - Average 2] 3 RD_ONLY

7452 FLOAT Archive_Avg[3 - Average 3] 3 RD_ONLY

7453 FLOAT Archive_Avg[4 - Average 4] 3 RD_ONLY

7454 FLOAT Archive_Avg[5 - Average 5] 3 RD_ONLY

7455 FLOAT Archive_Avg[6 - Average 6] 3 RD_ONLY

7456 FLOAT Archive_Avg[7 - Average 7] 3 RD_ONLY

7457 FLOAT Archive_Avg[8 - Average 8] 3 RD_ONLY

7458 FLOAT Archive_Avg[9 - Average 9] 3 RD_ONLY

7459 FLOAT Archive_Avg[10 - Average 10] 3 RD_ONLY

7460 FLOAT Archive_Avg[11 - Average 11] 3 RD_ONLY

7461 FLOAT Archive_Avg[12 - Average 12] 3 RD_ONLY

7462 FLOAT Archive_Avg[13 - Average 13] 3 RD_ONLY

7463 FLOAT Archive_Avg[14 - Average 14] 3 RD_ONLY

7464 FLOAT Archive_Avg[15 - Average 15] 3 RD_ONLY
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7465 FLOAT Archive_Avg[16 - Average 16] 3 RD_ONLY

7466 FLOAT Archive_Avg[17 - Average 17] 3 RD_ONLY

7467 FLOAT Archive_Avg[18 - Average 18] 3 RD_ONLY

7468 FLOAT Archive_Avg[19 - Average 19] 3 RD_ONLY

7469 FLOAT Archive_Avg[20 - Average 20] 3 RD_ONLY

7470 FLOAT Archive_Avg[21 - Average 21] 3 RD_ONLY

7471 FLOAT Archive_Avg[22 - Average 22] 3 RD_ONLY

7472 FLOAT Archive_Avg[23 - Average 23] 3 RD_ONLY

7473 FLOAT Archive_Avg[24 - Average 24] 3 RD_ONLY

7474 FLOAT Archive_Avg[25 - Average 25] 3 RD_ONLY

7475 FLOAT Archive_Avg[26 - Average 26] 3 RD_ONLY

7476 FLOAT Archive_Avg[27 - Average 27] 3 RD_ONLY

7477 FLOAT Archive_Avg[28 - Average 28] 3 RD_ONLY

7478 FLOAT Archive_Avg[29 - Average 29] 3 RD_ONLY

7479 FLOAT Archive_Avg[30 - Average 30] 3 RD_ONLY

7480 FLOAT Archive_Avg[31 - Average 31] 3 RD_ONLY

7481 FLOAT Archive_Avg[32 - Average 32] 3 RD_ONLY

7482 FLOAT Archive_Avg[33 - Average 33] 3 RD_ONLY

7483 FLOAT Archive_Avg[34 - Average 34] 3 RD_ONLY

7484 FLOAT Archive_Avg[35 - Average 35] 3 RD_ONLY

7485 FLOAT Archive_Avg[36 - Average 36] 3 RD_ONLY

7486 FLOAT Archive_Max[1 - Average 1] 3 RD_ONLY

7487 FLOAT Archive_Max[2 - Average 2] 3 RD_ONLY

7488 FLOAT Archive_Max[3 - Average 3] 3 RD_ONLY

7489 FLOAT Archive_Max[4 - Average 4] 3 RD_ONLY

7490 FLOAT Archive_Max[5 - Average 5] 3 RD_ONLY

7491 FLOAT Archive_Max[6 - Average 6] 3 RD_ONLY

7492 FLOAT Archive_Max[7 - Average 7] 3 RD_ONLY

7493 FLOAT Archive_Max[8 - Average 8] 3 RD_ONLY

7494 FLOAT Archive_Max[9 - Average 9] 3 RD_ONLY

7495 FLOAT Archive_Max[10 - Average 10] 3 RD_ONLY

7496 FLOAT Archive_Max[11 - Average 11] 3 RD_ONLY

7497 FLOAT Archive_Max[12 - Average 12] 3 RD_ONLY

7498 FLOAT Archive_Max[13 - Average 13] 3 RD_ONLY

7499 FLOAT Archive_Max[14 - Average 14] 3 RD_ONLY

7500 FLOAT Archive_Max[15 - Average 15] 3 RD_ONLY

7501 FLOAT Archive_Max[16 - Average 16] 3 RD_ONLY
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7502 FLOAT Archive_Max[17 - Average 17] 3 RD_ONLY

7503 FLOAT Archive_Max[18 - Average 18] 3 RD_ONLY

7504 FLOAT Archive_Max[19 - Average 19] 3 RD_ONLY

7505 FLOAT Archive_Max[20 - Average 20] 3 RD_ONLY

7506 FLOAT Archive_Max[21 - Average 21] 3 RD_ONLY

7507 FLOAT Archive_Max[22 - Average 22] 3 RD_ONLY

7508 FLOAT Archive_Max[23 - Average 23] 3 RD_ONLY

7509 FLOAT Archive_Max[24 - Average 24] 3 RD_ONLY

7510 FLOAT Archive_Max[25 - Average 25] 3 RD_ONLY

7511 FLOAT Archive_Max[26 - Average 26] 3 RD_ONLY

7512 FLOAT Archive_Max[27 - Average 27] 3 RD_ONLY

7513 FLOAT Archive_Max[28 - Average 28] 3 RD_ONLY

7514 FLOAT Archive_Max[29 - Average 29] 3 RD_ONLY

7515 FLOAT Archive_Max[30 - Average 30] 3 RD_ONLY

7516 FLOAT Archive_Max[31 - Average 31] 3 RD_ONLY

7517 FLOAT Archive_Max[32 - Average 32] 3 RD_ONLY

7518 FLOAT Archive_Max[33 - Average 33] 3 RD_ONLY

7519 FLOAT Archive_Max[34 - Average 34] 3 RD_ONLY

7520 FLOAT Archive_Max[35 - Average 35] 3 RD_ONLY

7521 FLOAT Archive_Max[36 - Average 36] 3 RD_ONLY

7522 FLOAT Archive_Min[1 - Average 1] 3 RD_ONLY

7523 FLOAT Archive_Min[2 - Average 2] 3 RD_ONLY

7524 FLOAT Archive_Min[3 - Average 3] 3 RD_ONLY

7525 FLOAT Archive_Min[4 - Average 4] 3 RD_ONLY

7526 FLOAT Archive_Min[5 - Average 5] 3 RD_ONLY

7527 FLOAT Archive_Min[6 - Average 6] 3 RD_ONLY

7528 FLOAT Archive_Min[7 - Average 7] 3 RD_ONLY

7529 FLOAT Archive_Min[8 - Average 8] 3 RD_ONLY

7530 FLOAT Archive_Min[9 - Average 9] 3 RD_ONLY

7531 FLOAT Archive_Min[10 - Average 10] 3 RD_ONLY

7532 FLOAT Archive_Min[11 - Average 11] 3 RD_ONLY

7533 FLOAT Archive_Min[12 - Average 12] 3 RD_ONLY

7534 FLOAT Archive_Min[13 - Average 13] 3 RD_ONLY

7535 FLOAT Archive_Min[14 - Average 14] 3 RD_ONLY

7536 FLOAT Archive_Min[15 - Average 15] 3 RD_ONLY

7537 FLOAT Archive_Min[16 - Average 16] 3 RD_ONLY

7538 FLOAT Archive_Min[17 - Average 17] 3 RD_ONLY
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7539 FLOAT Archive_Min[18 - Average 18] 3 RD_ONLY

7540 FLOAT Archive_Min[19 - Average 19] 3 RD_ONLY

7541 FLOAT Archive_Min[20 - Average 20] 3 RD_ONLY

7542 FLOAT Archive_Min[21 - Average 21] 3 RD_ONLY

7543 FLOAT Archive_Min[22 - Average 22] 3 RD_ONLY

7544 FLOAT Archive_Min[23 - Average 23] 3 RD_ONLY

7545 FLOAT Archive_Min[24 - Average 24] 3 RD_ONLY

7546 FLOAT Archive_Min[25 - Average 25] 3 RD_ONLY

7547 FLOAT Archive_Min[26 - Average 26] 3 RD_ONLY

7548 FLOAT Archive_Min[27 - Average 27] 3 RD_ONLY

7549 FLOAT Archive_Min[28 - Average 28] 3 RD_ONLY

7550 FLOAT Archive_Min[29 - Average 29] 3 RD_ONLY

7551 FLOAT Archive_Min[30 - Average 30] 3 RD_ONLY

7552 FLOAT Archive_Min[31 - Average 31] 3 RD_ONLY

7553 FLOAT Archive_Min[32 - Average 32] 3 RD_ONLY

7554 FLOAT Archive_Min[33 - Average 33] 3 RD_ONLY

7555 FLOAT Archive_Min[34 - Average 34] 3 RD_ONLY

7556 FLOAT Archive_Min[35 - Average 35] 3 RD_ONLY

7557 FLOAT Archive_Min[36 - Average 36] 3 RD_ONLY

7558 FLOAT Component Data 1_Multi-level Calib 'a'[1] RD_ONLY

7559 FLOAT Component Data 1_Multi-level Calib 'a'[2] RD_ONLY

7560 FLOAT Component Data 1_Multi-level Calib 'a'[3] RD_ONLY

7561 FLOAT Component Data 1_Multi-level Calib 'a'[4] RD_ONLY

7562 FLOAT Component Data 1_Multi-level Calib 'a'[5] RD_ONLY

7563 FLOAT Component Data 1_Multi-level Calib 'a'[6] RD_ONLY

7564 FLOAT Component Data 1_Multi-level Calib 'a'[7] RD_ONLY

7565 FLOAT Component Data 1_Multi-level Calib 'a'[8] RD_ONLY

7566 FLOAT Component Data 1_Multi-level Calib 'a'[9] RD_ONLY

7567 FLOAT Component Data 1_Multi-level Calib 'a'[10] RD_ONLY

7568 FLOAT Component Data 1_Multi-level Calib 'a'[11] RD_ONLY

7569 FLOAT Component Data 1_Multi-level Calib 'a'[12] RD_ONLY

7570 FLOAT Component Data 1_Multi-level Calib 'a'[13] RD_ONLY

7571 FLOAT Component Data 1_Multi-level Calib 'a'[14] RD_ONLY

7572 FLOAT Component Data 1_Multi-level Calib 'a'[15] RD_ONLY

7573 FLOAT Component Data 1_Multi-level Calib 'a'[16] RD_ONLY

7574 FLOAT Component Data 1_Multi-level Calib 'b'[1] RD_ONLY

7575 FLOAT Component Data 1_Multi-level Calib 'b'[2] RD_ONLY
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7576 FLOAT Component Data 1_Multi-level Calib 'b'[3] RD_ONLY

7577 FLOAT Component Data 1_Multi-level Calib 'b'[4] RD_ONLY

7578 FLOAT Component Data 1_Multi-level Calib 'b'[5] RD_ONLY

7579 FLOAT Component Data 1_Multi-level Calib 'b'[6] RD_ONLY

7580 FLOAT Component Data 1_Multi-level Calib 'b'[7] RD_ONLY

7581 FLOAT Component Data 1_Multi-level Calib 'b'[8] RD_ONLY

7582 FLOAT Component Data 1_Multi-level Calib 'b'[9] RD_ONLY

7583 FLOAT Component Data 1_Multi-level Calib 'b'[10] RD_ONLY

7584 FLOAT Component Data 1_Multi-level Calib 'b'[11] RD_ONLY

7585 FLOAT Component Data 1_Multi-level Calib 'b'[12] RD_ONLY

7586 FLOAT Component Data 1_Multi-level Calib 'b'[13] RD_ONLY

7587 FLOAT Component Data 1_Multi-level Calib 'b'[14] RD_ONLY

7588 FLOAT Component Data 1_Multi-level Calib 'b'[15] RD_ONLY

7589 FLOAT Component Data 1_Multi-level Calib 'b'[16] RD_ONLY

7590 FLOAT Component Data 1_Multi-level Calib 'c'[1] RD_ONLY

7591 FLOAT Component Data 1_Multi-level Calib 'c'[2] RD_ONLY

7592 FLOAT Component Data 1_Multi-level Calib 'c'[3] RD_ONLY

7593 FLOAT Component Data 1_Multi-level Calib 'c'[4] RD_ONLY

7594 FLOAT Component Data 1_Multi-level Calib 'c'[5] RD_ONLY

7595 FLOAT Component Data 1_Multi-level Calib 'c'[6] RD_ONLY

7596 FLOAT Component Data 1_Multi-level Calib 'c'[7] RD_ONLY

7597 FLOAT Component Data 1_Multi-level Calib 'c'[8] RD_ONLY

7598 FLOAT Component Data 1_Multi-level Calib 'c'[9] RD_ONLY

7599 FLOAT Component Data 1_Multi-level Calib 'c'[10] RD_ONLY

7600 FLOAT Component Data 1_Multi-level Calib 'c'[11] RD_ONLY

7601 FLOAT Component Data 1_Multi-level Calib 'c'[12] RD_ONLY

7602 FLOAT Component Data 1_Multi-level Calib 'c'[13] RD_ONLY

7603 FLOAT Component Data 1_Multi-level Calib 'c'[14] RD_ONLY

7604 FLOAT Component Data 1_Multi-level Calib 'c'[15] RD_ONLY

7605 FLOAT Component Data 1_Multi-level Calib 'c'[16] RD_ONLY

7606 FLOAT Component Data 1_Multi-level Calib 'd'[1] RD_ONLY

7607 FLOAT Component Data 1_Multi-level Calib 'd'[2] RD_ONLY

7608 FLOAT Component Data 1_Multi-level Calib 'd'[3] RD_ONLY

7609 FLOAT Component Data 1_Multi-level Calib 'd'[4] RD_ONLY

7610 FLOAT Component Data 1_Multi-level Calib 'd'[5] RD_ONLY

7611 FLOAT Component Data 1_Multi-level Calib 'd'[6] RD_ONLY

7612 FLOAT Component Data 1_Multi-level Calib 'd'[7] RD_ONLY
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7613 FLOAT Component Data 1_Multi-level Calib 'd'[8] RD_ONLY

7614 FLOAT Component Data 1_Multi-level Calib 'd'[9] RD_ONLY

7615 FLOAT Component Data 1_Multi-level Calib 'd'[10] RD_ONLY

7616 FLOAT Component Data 1_Multi-level Calib 'd'[11] RD_ONLY

7617 FLOAT Component Data 1_Multi-level Calib 'd'[12] RD_ONLY

7618 FLOAT Component Data 1_Multi-level Calib 'd'[13] RD_ONLY

7619 FLOAT Component Data 1_Multi-level Calib 'd'[14] RD_ONLY

7620 FLOAT Component Data 1_Multi-level Calib 'd'[15] RD_ONLY

7621 FLOAT Component Data 1_Multi-level Calib 'd'[16] RD_ONLY

7622 FLOAT Component Data 1_Rel Resp Factor[1] RD_ONLY

7623 FLOAT Component Data 1_Rel Resp Factor[2] RD_ONLY

7624 FLOAT Component Data 1_Rel Resp Factor[3] RD_ONLY

7625 FLOAT Component Data 1_Rel Resp Factor[4] RD_ONLY

7626 FLOAT Component Data 1_Rel Resp Factor[5] RD_ONLY

7627 FLOAT Component Data 1_Rel Resp Factor[6] RD_ONLY

7628 FLOAT Component Data 1_Rel Resp Factor[7] RD_ONLY

7629 FLOAT Component Data 1_Rel Resp Factor[8] RD_ONLY

7630 FLOAT Component Data 1_Rel Resp Factor[9] RD_ONLY

7631 FLOAT Component Data 1_Rel Resp Factor[10] RD_ONLY

7632 FLOAT Component Data 1_Rel Resp Factor[11] RD_ONLY

7633 FLOAT Component Data 1_Rel Resp Factor[12] RD_ONLY

7634 FLOAT Component Data 1_Rel Resp Factor[13] RD_ONLY

7635 FLOAT Component Data 1_Rel Resp Factor[14] RD_ONLY

7636 FLOAT Component Data 1_Rel Resp Factor[15] RD_ONLY

7637 FLOAT Component Data 1_Rel Resp Factor[16] RD_ONLY

7638 FLOAT Component Data 2_Multi-level Calib 'a'[1] RD_ONLY

7639 FLOAT Component Data 2_Multi-level Calib 'a'[2] RD_ONLY

7640 FLOAT Component Data 2_Multi-level Calib 'a'[3] RD_ONLY

7641 FLOAT Component Data 2_Multi-level Calib 'a'[4] RD_ONLY

7642 FLOAT Component Data 2_Multi-level Calib 'a'[5] RD_ONLY

7643 FLOAT Component Data 2_Multi-level Calib 'a'[6] RD_ONLY

7644 FLOAT Component Data 2_Multi-level Calib 'a'[7] RD_ONLY

7645 FLOAT Component Data 2_Multi-level Calib 'a'[8] RD_ONLY

7646 FLOAT Component Data 2_Multi-level Calib 'a'[9] RD_ONLY

7647 FLOAT Component Data 2_Multi-level Calib 'a'[10] RD_ONLY

7648 FLOAT Component Data 2_Multi-level Calib 'a'[11] RD_ONLY

7649 FLOAT Component Data 2_Multi-level Calib 'a'[12] RD_ONLY
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7650 FLOAT Component Data 2_Multi-level Calib 'a'[13] RD_ONLY

7651 FLOAT Component Data 2_Multi-level Calib 'a'[14] RD_ONLY

7652 FLOAT Component Data 2_Multi-level Calib 'a'[15] RD_ONLY

7653 FLOAT Component Data 2_Multi-level Calib 'a'[16] RD_ONLY

7654 FLOAT Component Data 2_Multi-level Calib 'b'[1] RD_ONLY

7655 FLOAT Component Data 2_Multi-level Calib 'b'[2] RD_ONLY

7656 FLOAT Component Data 2_Multi-level Calib 'b'[3] RD_ONLY

7657 FLOAT Component Data 2_Multi-level Calib 'b'[4] RD_ONLY

7658 FLOAT Component Data 2_Multi-level Calib 'b'[5] RD_ONLY

7659 FLOAT Component Data 2_Multi-level Calib 'b'[6] RD_ONLY

7660 FLOAT Component Data 2_Multi-level Calib 'b'[7] RD_ONLY

7661 FLOAT Component Data 2_Multi-level Calib 'b'[8] RD_ONLY

7662 FLOAT Component Data 2_Multi-level Calib 'b'[9] RD_ONLY

7663 FLOAT Component Data 2_Multi-level Calib 'b'[10] RD_ONLY

7664 FLOAT Component Data 2_Multi-level Calib 'b'[11] RD_ONLY

7665 FLOAT Component Data 2_Multi-level Calib 'b'[12] RD_ONLY

7666 FLOAT Component Data 2_Multi-level Calib 'b'[13] RD_ONLY

7667 FLOAT Component Data 2_Multi-level Calib 'b'[14] RD_ONLY

7668 FLOAT Component Data 2_Multi-level Calib 'b'[15] RD_ONLY

7669 FLOAT Component Data 2_Multi-level Calib 'b'[16] RD_ONLY

7670 FLOAT Component Data 2_Multi-level Calib 'c'[1] RD_ONLY

7671 FLOAT Component Data 2_Multi-level Calib 'c'[2] RD_ONLY

7672 FLOAT Component Data 2_Multi-level Calib 'c'[3] RD_ONLY

7673 FLOAT Component Data 2_Multi-level Calib 'c'[4] RD_ONLY

7674 FLOAT Component Data 2_Multi-level Calib 'c'[5] RD_ONLY

7675 FLOAT Component Data 2_Multi-level Calib 'c'[6] RD_ONLY

7676 FLOAT Component Data 2_Multi-level Calib 'c'[7] RD_ONLY

7677 FLOAT Component Data 2_Multi-level Calib 'c'[8] RD_ONLY

7678 FLOAT Component Data 2_Multi-level Calib 'c'[9] RD_ONLY

7679 FLOAT Component Data 2_Multi-level Calib 'c'[10] RD_ONLY

7680 FLOAT Component Data 2_Multi-level Calib 'c'[11] RD_ONLY

7681 FLOAT Component Data 2_Multi-level Calib 'c'[12] RD_ONLY

7682 FLOAT Component Data 2_Multi-level Calib 'c'[13] RD_ONLY

7683 FLOAT Component Data 2_Multi-level Calib 'c'[14] RD_ONLY

7684 FLOAT Component Data 2_Multi-level Calib 'c'[15] RD_ONLY

7685 FLOAT Component Data 2_Multi-level Calib 'c'[16] RD_ONLY

7686 FLOAT Component Data 2_Multi-level Calib 'd'[1] RD_ONLY
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7687 FLOAT Component Data 2_Multi-level Calib 'd'[2] RD_ONLY

7688 FLOAT Component Data 2_Multi-level Calib 'd'[3] RD_ONLY

7689 FLOAT Component Data 2_Multi-level Calib 'd'[4] RD_ONLY

7690 FLOAT Component Data 2_Multi-level Calib 'd'[5] RD_ONLY

7691 FLOAT Component Data 2_Multi-level Calib 'd'[6] RD_ONLY

7692 FLOAT Component Data 2_Multi-level Calib 'd'[7] RD_ONLY

7693 FLOAT Component Data 2_Multi-level Calib 'd'[8] RD_ONLY

7694 FLOAT Component Data 2_Multi-level Calib 'd'[9] RD_ONLY

7695 FLOAT Component Data 2_Multi-level Calib 'd'[10] RD_ONLY

7696 FLOAT Component Data 2_Multi-level Calib 'd'[11] RD_ONLY

7697 FLOAT Component Data 2_Multi-level Calib 'd'[12] RD_ONLY

7698 FLOAT Component Data 2_Multi-level Calib 'd'[13] RD_ONLY

7699 FLOAT Component Data 2_Multi-level Calib 'd'[14] RD_ONLY

7700 FLOAT Component Data 2_Multi-level Calib 'd'[15] RD_ONLY

7701 FLOAT Component Data 2_Multi-level Calib 'd'[16] RD_ONLY

7702 FLOAT Component Data 2_Rel Resp Factor[1] RD_ONLY

7703 FLOAT Component Data 2_Rel Resp Factor[2] RD_ONLY

7704 FLOAT Component Data 2_Rel Resp Factor[3] RD_ONLY

7705 FLOAT Component Data 2_Rel Resp Factor[4] RD_ONLY

7706 FLOAT Component Data 2_Rel Resp Factor[5] RD_ONLY

7707 FLOAT Component Data 2_Rel Resp Factor[6] RD_ONLY

7708 FLOAT Component Data 2_Rel Resp Factor[7] RD_ONLY

7709 FLOAT Component Data 2_Rel Resp Factor[8] RD_ONLY

7710 FLOAT Component Data 2_Rel Resp Factor[9] RD_ONLY

7711 FLOAT Component Data 2_Rel Resp Factor[10] RD_ONLY

7712 FLOAT Component Data 2_Rel Resp Factor[11] RD_ONLY

7713 FLOAT Component Data 2_Rel Resp Factor[12] RD_ONLY

7714 FLOAT Component Data 2_Rel Resp Factor[13] RD_ONLY

7715 FLOAT Component Data 2_Rel Resp Factor[14] RD_ONLY

7716 FLOAT Component Data 2_Rel Resp Factor[15] RD_ONLY

7717 FLOAT Component Data 2_Rel Resp Factor[16] RD_ONLY

7718 FLOAT Avg[1 - Average 1] RD_ONLY

7719 FLOAT Avg[2 - Average 2] RD_ONLY

7720 FLOAT Avg[3 - Average 3] RD_ONLY

7721 FLOAT Avg[4 - Average 4] RD_ONLY

7722 FLOAT Avg[5 - Average 5] RD_ONLY

7723 FLOAT Avg[6 - Average 6] RD_ONLY
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7724 FLOAT Avg[7 - Average 7] RD_ONLY

7725 FLOAT Avg[8 - Average 8] RD_ONLY

7726 FLOAT Avg[9 - Average 9] RD_ONLY

7727 FLOAT Avg[10 - Average 10] RD_ONLY

7728 FLOAT Avg[11 - Average 11] RD_ONLY

7729 FLOAT Avg[12 - Average 12] RD_ONLY

7730 FLOAT Avg[13 - Average 13] RD_ONLY

7731 FLOAT Avg[14 - Average 14] RD_ONLY

7732 FLOAT Avg[15 - Average 15] RD_ONLY

7733 FLOAT Avg[16 - Average 16] RD_ONLY

7734 FLOAT Avg[17 - Average 17] RD_ONLY

7735 FLOAT Avg[18 - Average 18] RD_ONLY

7736 FLOAT Avg[19 - Average 19] RD_ONLY

7737 FLOAT Avg[20 - Average 20] RD_ONLY

7738 FLOAT Avg[21 - Average 21] RD_ONLY

7739 FLOAT Avg[22 - Average 22] RD_ONLY

7740 FLOAT Avg[23 - Average 23] RD_ONLY

7741 FLOAT Avg[24 - Average 24] RD_ONLY

7742 FLOAT Avg[25 - Average 25] RD_ONLY

7743 FLOAT Avg[26 - Average 26] RD_ONLY

7744 FLOAT Avg[27 - Average 27] RD_ONLY

7745 FLOAT Avg[28 - Average 28] RD_ONLY

7746 FLOAT Avg[29 - Average 29] RD_ONLY

7747 FLOAT Avg[30 - Average 30] RD_ONLY

7748 FLOAT Avg[31 - Average 31] RD_ONLY

7749 FLOAT Avg[32 - Average 32] RD_ONLY

7750 FLOAT Avg[33 - Average 33] RD_ONLY

7751 FLOAT Avg[34 - Average 34] RD_ONLY

7752 FLOAT Avg[35 - Average 35] RD_ONLY

7753 FLOAT Avg[36 - Average 36] RD_ONLY

7754 FLOAT Avg[37 - Average 37] RD_ONLY

7755 FLOAT Avg[38 - Average 38] RD_ONLY

7756 FLOAT Avg[39 - Average 39] RD_ONLY

7757 FLOAT Avg[40 - Average 40] RD_ONLY

7758 FLOAT Avg[41 - Average 41] RD_ONLY

7759 FLOAT Avg[42 - Average 42] RD_ONLY

7760 FLOAT Avg[43 - Average 43] RD_ONLY
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7761 FLOAT Avg[44 - Average 44] RD_ONLY

7762 FLOAT Avg[45 - Average 45] RD_ONLY

7763 FLOAT Avg[46 - Average 46] RD_ONLY

7764 FLOAT Avg[47 - Average 47] RD_ONLY

7765 FLOAT Avg[48 - Average 48] RD_ONLY

7766 FLOAT Avg[49 - Average 49] RD_ONLY

7767 FLOAT Avg[50 - Average 50] RD_ONLY

7768 FLOAT Avg[51 - Average 51] RD_ONLY

7769 FLOAT Avg[52 - Average 52] RD_ONLY

7770 FLOAT Avg[53 - Average 53] RD_ONLY

7771 FLOAT Avg[54 - Average 54] RD_ONLY

7772 FLOAT Avg[55 - Average 55] RD_ONLY

7773 FLOAT Avg[56 - Average 56] RD_ONLY

7774 FLOAT Avg[57 - Average 57] RD_ONLY

7775 FLOAT Avg[58 - Average 58] RD_ONLY

7776 FLOAT Avg[59 - Average 59] RD_ONLY

7777 FLOAT Avg[60 - Average 60] RD_ONLY

7778 FLOAT Avg[61 - Average 61] RD_ONLY

7779 FLOAT Avg[62 - Average 62] RD_ONLY

7780 FLOAT Avg[63 - Average 63] RD_ONLY

7781 FLOAT Avg[64 - Average 64] RD_ONLY

7782 FLOAT Avg[65 - Average 65] RD_ONLY

7783 FLOAT Avg[66 - Average 66] RD_ONLY

7784 FLOAT Avg[67 - Average 67] RD_ONLY

7785 FLOAT Avg[68 - Average 68] RD_ONLY

7786 FLOAT Avg[69 - Average 69] RD_ONLY

7787 FLOAT Avg[70 - Average 70] RD_ONLY

7788 FLOAT Avg[71 - Average 71] RD_ONLY

7789 FLOAT Avg[72 - Average 72] RD_ONLY

7790 FLOAT Avg[73 - Average 73] RD_ONLY

7791 FLOAT Avg[74 - Average 74] RD_ONLY

7792 FLOAT Avg[75 - Average 75] RD_ONLY

7793 FLOAT Avg[76 - Average 76] RD_ONLY

7794 FLOAT Avg[77 - Average 77] RD_ONLY

7795 FLOAT Avg[78 - Average 78] RD_ONLY

7796 FLOAT Avg[79 - Average 79] RD_ONLY

7797 FLOAT Avg[80 - Average 80] RD_ONLY
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7798 FLOAT Avg[81 - Average 81] RD_ONLY

7799 FLOAT Avg[82 - Average 82] RD_ONLY

7800 FLOAT Avg[83 - Average 83] RD_ONLY

7801 FLOAT Avg[84 - Average 84] RD_ONLY

7802 FLOAT Avg[85 - Average 85] RD_ONLY

7803 FLOAT Avg[86 - Average 86] RD_ONLY

7804 FLOAT Avg[87 - Average 87] RD_ONLY

7805 FLOAT Avg[88 - Average 88] RD_ONLY

7806 FLOAT Avg[89 - Average 89] RD_ONLY

7807 FLOAT Avg[90 - Average 90] RD_ONLY

7808 FLOAT Avg[91 - Average 91] RD_ONLY

7809 FLOAT Avg[92 - Average 92] RD_ONLY

7810 FLOAT Avg[93 - Average 93] RD_ONLY

7811 FLOAT Avg[94 - Average 94] RD_ONLY

7812 FLOAT Avg[95 - Average 95] RD_ONLY

7813 FLOAT Avg[96 - Average 96] RD_ONLY

7814 FLOAT Avg[97 - Average 97] RD_ONLY

7815 FLOAT Avg[98 - Average 98] RD_ONLY

7816 FLOAT Avg[99 - Average 99] RD_ONLY

7817 FLOAT Avg[100 - Average 100] RD_ONLY

7818 FLOAT Avg[101 - Average 101] RD_ONLY

7819 FLOAT Avg[102 - Average 102] RD_ONLY

7820 FLOAT Avg[103 - Average 103] RD_ONLY

7821 FLOAT Avg[104 - Average 104] RD_ONLY

7822 FLOAT Avg[105 - Average 105] RD_ONLY

7823 FLOAT Avg[106 - Average 106] RD_ONLY

7824 FLOAT Avg[107 - Average 107] RD_ONLY

7825 FLOAT Avg[108 - Average 108] RD_ONLY

7826 FLOAT Avg[109 - Average 109] RD_ONLY

7827 FLOAT Avg[110 - Average 110] RD_ONLY

7828 FLOAT Avg[111 - Average 111] RD_ONLY

7829 FLOAT Avg[112 - Average 112] RD_ONLY

7830 FLOAT Avg[113 - Average 113] RD_ONLY

7831 FLOAT Avg[114 - Average 114] RD_ONLY

7832 FLOAT Avg[115 - Average 115] RD_ONLY

7833 FLOAT Avg[116 - Average 116] RD_ONLY

7834 FLOAT Avg[117 - Average 117] RD_ONLY
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7835 FLOAT Avg[118 - Average 118] RD_ONLY

7836 FLOAT Avg[119 - Average 119] RD_ONLY

7837 FLOAT Avg[120 - Average 120] RD_ONLY

7838 FLOAT Avg[121 - Average 121] RD_ONLY

7839 FLOAT Avg[122 - Average 122] RD_ONLY

7840 FLOAT Avg[123 - Average 123] RD_ONLY

7841 FLOAT Avg[124 - Average 124] RD_ONLY

7842 FLOAT Avg[125 - Average 125] RD_ONLY

7843 FLOAT Avg[126 - Average 126] RD_ONLY

7844 FLOAT Avg[127 - Average 127] RD_ONLY

7845 FLOAT Avg[128 - Average 128] RD_ONLY

7846 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

7847 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

7848 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

7849 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

7850 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

7851 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

7852 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

7853 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

7854 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY

7855 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

7856 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

7857 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY

7858 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

7859 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

7860 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

7861 FLOAT Archive_Avg[16 - Average 16] 1 RD_ONLY

7862 FLOAT Archive_Avg[17 - Average 17] 1 RD_ONLY

7863 FLOAT Archive_Avg[18 - Average 18] 1 RD_ONLY

7864 FLOAT Archive_Avg[19 - Average 19] 1 RD_ONLY

7865 FLOAT Archive_Avg[20 - Average 20] 1 RD_ONLY

7866 FLOAT Archive_Avg[21 - Average 21] 1 RD_ONLY

7867 FLOAT Archive_Avg[22 - Average 22] 1 RD_ONLY

7868 FLOAT Archive_Avg[23 - Average 23] 1 RD_ONLY

7869 FLOAT Archive_Avg[24 - Average 24] 1 RD_ONLY

7870 FLOAT Archive_Avg[25 - Average 25] 1 RD_ONLY

7871 FLOAT Archive_Avg[26 - Average 26] 1 RD_ONLY
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7872 FLOAT Archive_Avg[27 - Average 27] 1 RD_ONLY

7873 FLOAT Archive_Avg[28 - Average 28] 1 RD_ONLY

7874 FLOAT Archive_Avg[29 - Average 29] 1 RD_ONLY

7875 FLOAT Archive_Avg[30 - Average 30] 1 RD_ONLY

7876 FLOAT Archive_Avg[31 - Average 31] 1 RD_ONLY

7877 FLOAT Archive_Avg[32 - Average 32] 1 RD_ONLY

7878 FLOAT Archive_Avg[33 - Average 33] 1 RD_ONLY

7879 FLOAT Archive_Avg[34 - Average 34] 1 RD_ONLY

7880 FLOAT Archive_Avg[35 - Average 35] 1 RD_ONLY

7881 FLOAT Archive_Avg[36 - Average 36] 1 RD_ONLY

7882 FLOAT Archive_Avg[37 - Average 37] 1 RD_ONLY

7883 FLOAT Archive_Avg[38 - Average 38] 1 RD_ONLY

7884 FLOAT Archive_Avg[39 - Average 39] 1 RD_ONLY

7885 FLOAT Archive_Avg[40 - Average 40] 1 RD_ONLY

7886 FLOAT Archive_Avg[41 - Average 41] 1 RD_ONLY

7887 FLOAT Archive_Avg[42 - Average 42] 1 RD_ONLY

7888 FLOAT Archive_Avg[43 - Average 43] 1 RD_ONLY

7889 FLOAT Archive_Avg[44 - Average 44] 1 RD_ONLY

7890 FLOAT Archive_Avg[45 - Average 45] 1 RD_ONLY

7891 FLOAT Archive_Avg[46 - Average 46] 1 RD_ONLY

7892 FLOAT Archive_Avg[47 - Average 47] 1 RD_ONLY

7893 FLOAT Archive_Avg[48 - Average 48] 1 RD_ONLY

7894 FLOAT Archive_Avg[49 - Average 49] 1 RD_ONLY

7895 FLOAT Archive_Avg[50 - Average 50] 1 RD_ONLY

7896 FLOAT Archive_Avg[51 - Average 51] 1 RD_ONLY

7897 FLOAT Archive_Avg[52 - Average 52] 1 RD_ONLY

7898 FLOAT Archive_Avg[53 - Average 53] 1 RD_ONLY

7899 FLOAT Archive_Avg[54 - Average 54] 1 RD_ONLY

7900 FLOAT Archive_Avg[55 - Average 55] 1 RD_ONLY

7901 FLOAT Archive_Avg[56 - Average 56] 1 RD_ONLY

7902 FLOAT Archive_Avg[57 - Average 57] 1 RD_ONLY

7903 FLOAT Archive_Avg[58 - Average 58] 1 RD_ONLY

7904 FLOAT Archive_Avg[59 - Average 59] 1 RD_ONLY

7905 FLOAT Archive_Avg[60 - Average 60] 1 RD_ONLY

7906 FLOAT Archive_Avg[61 - Average 61] 1 RD_ONLY

7907 FLOAT Archive_Avg[62 - Average 62] 1 RD_ONLY

7908 FLOAT Archive_Avg[63 - Average 63] 1 RD_ONLY
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7909 FLOAT Archive_Avg[64 - Average 64] 1 RD_ONLY

7910 FLOAT Archive_Avg[65 - Average 65] 1 RD_ONLY

7911 FLOAT Archive_Avg[66 - Average 66] 1 RD_ONLY

7912 FLOAT Archive_Avg[67 - Average 67] 1 RD_ONLY

7913 FLOAT Archive_Avg[68 - Average 68] 1 RD_ONLY

7914 FLOAT Archive_Avg[69 - Average 69] 1 RD_ONLY

7915 FLOAT Archive_Avg[70 - Average 70] 1 RD_ONLY

7916 FLOAT Archive_Avg[71 - Average 71] 1 RD_ONLY

7917 FLOAT Archive_Avg[72 - Average 72] 1 RD_ONLY

7918 FLOAT Archive_Avg[73 - Average 73] 1 RD_ONLY

7919 FLOAT Archive_Avg[74 - Average 74] 1 RD_ONLY

7920 FLOAT Archive_Avg[75 - Average 75] 1 RD_ONLY

7921 FLOAT Archive_Avg[76 - Average 76] 1 RD_ONLY

7922 FLOAT Archive_Avg[77 - Average 77] 1 RD_ONLY

7923 FLOAT Archive_Avg[78 - Average 78] 1 RD_ONLY

7924 FLOAT Archive_Avg[79 - Average 79] 1 RD_ONLY

7925 FLOAT Archive_Avg[80 - Average 80] 1 RD_ONLY

7926 FLOAT Archive_Avg[81 - Average 81] 1 RD_ONLY

7927 FLOAT Archive_Avg[82 - Average 82] 1 RD_ONLY

7928 FLOAT Archive_Avg[83 - Average 83] 1 RD_ONLY

7929 FLOAT Archive_Avg[84 - Average 84] 1 RD_ONLY

7930 FLOAT Archive_Avg[85 - Average 85] 1 RD_ONLY

7931 FLOAT Archive_Avg[86 - Average 86] 1 RD_ONLY

7932 FLOAT Archive_Avg[87 - Average 87] 1 RD_ONLY

7933 FLOAT Archive_Avg[88 - Average 88] 1 RD_ONLY

7934 FLOAT Archive_Avg[89 - Average 89] 1 RD_ONLY

7935 FLOAT Archive_Avg[90 - Average 90] 1 RD_ONLY

7936 FLOAT Archive_Avg[91 - Average 91] 1 RD_ONLY

7937 FLOAT Archive_Avg[92 - Average 92] 1 RD_ONLY

7938 FLOAT Archive_Avg[93 - Average 93] 1 RD_ONLY

7939 FLOAT Archive_Avg[94 - Average 94] 1 RD_ONLY

7940 FLOAT Archive_Avg[95 - Average 95] 1 RD_ONLY

7941 FLOAT Archive_Avg[96 - Average 96] 1 RD_ONLY

7942 FLOAT Archive_Avg[97 - Average 97] 1 RD_ONLY

7943 FLOAT Archive_Avg[98 - Average 98] 1 RD_ONLY

7944 FLOAT Archive_Avg[99 - Average 99] 1 RD_ONLY

7945 FLOAT Archive_Avg[100 - Average 100] 1 RD_ONLY
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7946 FLOAT Archive_Avg[101 - Average 101] 1 RD_ONLY

7947 FLOAT Archive_Avg[102 - Average 102] 1 RD_ONLY

7948 FLOAT Archive_Avg[103 - Average 103] 1 RD_ONLY

7949 FLOAT Archive_Avg[104 - Average 104] 1 RD_ONLY

7950 FLOAT Archive_Avg[105 - Average 105] 1 RD_ONLY

7951 FLOAT Archive_Avg[106 - Average 106] 1 RD_ONLY

7952 FLOAT Archive_Avg[107 - Average 107] 1 RD_ONLY

7953 FLOAT Archive_Avg[108 - Average 108] 1 RD_ONLY

7954 FLOAT Archive_Avg[109 - Average 109] 1 RD_ONLY

7955 FLOAT Archive_Avg[110 - Average 110] 1 RD_ONLY

7956 FLOAT Archive_Avg[111 - Average 111] 1 RD_ONLY

7957 FLOAT Archive_Avg[112 - Average 112] 1 RD_ONLY

7958 FLOAT Archive_Avg[113 - Average 113] 1 RD_ONLY

7959 FLOAT Archive_Avg[114 - Average 114] 1 RD_ONLY

7960 FLOAT Archive_Avg[115 - Average 115] 1 RD_ONLY

7961 FLOAT Archive_Avg[116 - Average 116] 1 RD_ONLY

7962 FLOAT Archive_Avg[117 - Average 117] 1 RD_ONLY

7963 FLOAT Archive_Avg[118 - Average 118] 1 RD_ONLY

7964 FLOAT Archive_Avg[119 - Average 119] 1 RD_ONLY

7965 FLOAT Archive_Avg[120 - Average 120] 1 RD_ONLY

7966 FLOAT Archive_Avg[121 - Average 121] 1 RD_ONLY

7967 FLOAT Archive_Avg[122 - Average 122] 1 RD_ONLY

7968 FLOAT Archive_Avg[123 - Average 123] 1 RD_ONLY

7969 FLOAT Archive_Avg[124 - Average 124] 1 RD_ONLY

7970 FLOAT Archive_Avg[125 - Average 125] 1 RD_ONLY

7971 FLOAT Archive_Avg[126 - Average 126] 1 RD_ONLY

7972 FLOAT Archive_Avg[127 - Average 127] 1 RD_ONLY

7973 FLOAT Archive_Avg[128 - Average 128] 1 RD_ONLY

7974 FLOAT Last FCalib_New Resp Factor[1 - Component 1] RD_ONLY

7975 FLOAT Last FCalib_New Resp Factor[2 - Component 2] RD_ONLY

7976 FLOAT Last FCalib_New Resp Factor[3 - Component 3] RD_ONLY

7977 FLOAT Last FCalib_New Resp Factor[4 - Component 4] RD_ONLY

7978 FLOAT Last FCalib_New Resp Factor[5 - Component 5] RD_ONLY

7979 FLOAT Last FCalib_New Resp Factor[6 - Component 6] RD_ONLY

7980 FLOAT Last FCalib_New Resp Factor[7 - Component 7] RD_ONLY

7981 FLOAT Last FCalib_New Resp Factor[8 - Component 8] RD_ONLY

7982 FLOAT Last FCalib_New Resp Factor[9 - Component 9] RD_ONLY

Pre-defined Modbus
®

 Map Files

284 Rosemount™ 1500XA Gas Chromatograph



Register # Data type Variable Record # Access Format

7983 FLOAT Last FCalib_New Resp Factor[10 - Component 10] RD_ONLY

7984 FLOAT Last FCalib_New Resp Factor[11 - Component 11] RD_ONLY

7985 FLOAT Last FCalib_New Resp Factor[12 - Component 12] RD_ONLY

7986 FLOAT Last FCalib_New Resp Factor[13 - Component 13] RD_ONLY

7987 FLOAT Last FCalib_New Resp Factor[14 - Component 14] RD_ONLY

7988 FLOAT Last FCalib_New Resp Factor[15 - Component 15] RD_ONLY

7989 FLOAT Last FCalib_New Resp Factor[16 - Component 16] RD_ONLY

7990 FLOAT Last FCalib_New Resp Factor[17 - Component 17] RD_ONLY

7991 FLOAT Last FCalib_New Resp Factor[18 - Component 18] RD_ONLY

7992 FLOAT Last FCalib_New Resp Factor[19 - Component 19] RD_ONLY

7993 FLOAT Last FCalib_New Resp Factor[20 - Component 20] RD_ONLY

7994 FLOAT Last FCalib_New Resp Factor[1 - Component 1] RD_ONLY

7995 FLOAT Last FCalib_New Resp Factor[2 - Component 2] RD_ONLY

7996 FLOAT Last FCalib_New Resp Factor[3 - Component 3] RD_ONLY

7997 FLOAT Last FCalib_New Resp Factor[4 - Component 4] RD_ONLY

7998 FLOAT Last FCalib_New Resp Factor[5 - Component 5] RD_ONLY

7999 FLOAT Last FCalib_New Resp Factor[6 - Component 6] RD_ONLY

8000 FLOAT Last FCalib_New Resp Factor[7 - Component 7] RD_ONLY

8001 FLOAT Last FCalib_New Resp Factor[8 - Component 8] RD_ONLY

8002 FLOAT Last FCalib_New Resp Factor[9 - Component 9] RD_ONLY

8003 FLOAT Last FCalib_New Resp Factor[10 - Component 10] RD_ONLY

8004 FLOAT Last FCalib_New Resp Factor[11 - Component 11] RD_ONLY

8005 FLOAT Last FCalib_New Resp Factor[12 - Component 12] RD_ONLY

8006 FLOAT Last FCalib_New Resp Factor[13 - Component 13] RD_ONLY

8007 FLOAT Last FCalib_New Resp Factor[14 - Component 14] RD_ONLY

8008 FLOAT Last FCalib_New Resp Factor[15 - Component 15] RD_ONLY

8009 FLOAT Last FCalib_New Resp Factor[16 - Component 16] RD_ONLY

8010 FLOAT Last FCalib_New Resp Factor[17 - Component 17] RD_ONLY

8011 FLOAT Last FCalib_New Resp Factor[18 - Component 18] RD_ONLY

8012 FLOAT Last FCalib_New Resp Factor[19 - Component 19] RD_ONLY

8013 FLOAT Last FCalib_New Resp Factor[20 - Component 20] RD_ONLY

8014 FLOAT Last FCalib_New Resp Factor[1 - Component 1] RD_ONLY

8015 FLOAT Last FCalib_New Resp Factor[2 - Component 2] RD_ONLY

8016 FLOAT Last FCalib_New Resp Factor[3 - Component 3] RD_ONLY

8017 FLOAT Last FCalib_New Resp Factor[4 - Component 4] RD_ONLY

8018 FLOAT Last FCalib_New Resp Factor[5 - Component 5] RD_ONLY

8019 FLOAT Last FCalib_New Resp Factor[6 - Component 6] RD_ONLY
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8020 FLOAT Last FCalib_New Resp Factor[7 - Component 7] RD_ONLY

8021 FLOAT Last FCalib_New Resp Factor[8 - Component 8] RD_ONLY

8022 FLOAT Last FCalib_New Resp Factor[9 - Component 9] RD_ONLY

8023 FLOAT Last FCalib_New Resp Factor[10 - Component 10] RD_ONLY

8024 FLOAT Last FCalib_New Resp Factor[11 - Component 11] RD_ONLY

8025 FLOAT Last FCalib_New Resp Factor[12 - Component 12] RD_ONLY

8026 FLOAT Last FCalib_New Resp Factor[13 - Component 13] RD_ONLY

8027 FLOAT Last FCalib_New Resp Factor[14 - Component 14] RD_ONLY

8028 FLOAT Last FCalib_New Resp Factor[15 - Component 15] RD_ONLY

8029 FLOAT Last FCalib_New Resp Factor[16 - Component 16] RD_ONLY

8030 FLOAT Last FCalib_New Resp Factor[17 - Component 17] RD_ONLY

8031 FLOAT Last FCalib_New Resp Factor[18 - Component 18] RD_ONLY

8032 FLOAT Last FCalib_New Resp Factor[19 - Component 19] RD_ONLY

8033 FLOAT Last FCalib_New Resp Factor[20 - Component 20] RD_ONLY

8034 FLOAT Last FCalib_New Resp Factor[1 - Component 1] RD_ONLY

8035 FLOAT Last FCalib_New Resp Factor[2 - Component 2] RD_ONLY

8036 FLOAT Last FCalib_New Resp Factor[3 - Component 3] RD_ONLY

8037 FLOAT Last FCalib_New Resp Factor[4 - Component 4] RD_ONLY

8038 FLOAT Last FCalib_New Resp Factor[5 - Component 5] RD_ONLY

8039 FLOAT Last FCalib_New Resp Factor[6 - Component 6] RD_ONLY

8040 FLOAT Last FCalib_New Resp Factor[7 - Component 7] RD_ONLY

8041 FLOAT Last FCalib_New Resp Factor[8 - Component 8] RD_ONLY

8042 FLOAT Last FCalib_New Resp Factor[9 - Component 9] RD_ONLY

8043 FLOAT Last FCalib_New Resp Factor[10 - Component 10] RD_ONLY

8044 FLOAT Last FCalib_New Resp Factor[11 - Component 11] RD_ONLY

8045 FLOAT Last FCalib_New Resp Factor[12 - Component 12] RD_ONLY

8046 FLOAT Last FCalib_New Resp Factor[13 - Component 13] RD_ONLY

8047 FLOAT Last FCalib_New Resp Factor[14 - Component 14] RD_ONLY

8048 FLOAT Last FCalib_New Resp Factor[15 - Component 15] RD_ONLY

8049 FLOAT Last FCalib_New Resp Factor[16 - Component 16] RD_ONLY

8050 FLOAT Last FCalib_New Resp Factor[17 - Component 17] RD_ONLY

8051 FLOAT Last FCalib_New Resp Factor[18 - Component 18] RD_ONLY

8052 FLOAT Last FCalib_New Resp Factor[19 - Component 19] RD_ONLY

8053 FLOAT Last FCalib_New Resp Factor[20 - Component 20] RD_ONLY

8054 FLOAT Last FCalib_New Ret Time[1 - Component 1] RD_ONLY

8055 FLOAT Last FCalib_New Ret Time[2 - Component 2] RD_ONLY

8056 FLOAT Last FCalib_New Ret Time[3 - Component 3] RD_ONLY
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8057 FLOAT Last FCalib_New Ret Time[4 - Component 4] RD_ONLY

8058 FLOAT Last FCalib_New Ret Time[5 - Component 5] RD_ONLY

8059 FLOAT Last FCalib_New Ret Time[6 - Component 6] RD_ONLY

8060 FLOAT Last FCalib_New Ret Time[7 - Component 7] RD_ONLY

8061 FLOAT Last FCalib_New Ret Time[8 - Component 8] RD_ONLY

8062 FLOAT Last FCalib_New Ret Time[9 - Component 9] RD_ONLY

8063 FLOAT Last FCalib_New Ret Time[10 - Component 10] RD_ONLY

8064 FLOAT Last FCalib_New Ret Time[11 - Component 11] RD_ONLY

8065 FLOAT Last FCalib_New Ret Time[12 - Component 12] RD_ONLY

8066 FLOAT Last FCalib_New Ret Time[13 - Component 13] RD_ONLY

8067 FLOAT Last FCalib_New Ret Time[14 - Component 14] RD_ONLY

8068 FLOAT Last FCalib_New Ret Time[15 - Component 15] RD_ONLY

8069 FLOAT Last FCalib_New Ret Time[16 - Component 16] RD_ONLY

8070 FLOAT Last FCalib_New Ret Time[17 - Component 17] RD_ONLY

8071 FLOAT Last FCalib_New Ret Time[18 - Component 18] RD_ONLY

8072 FLOAT Last FCalib_New Ret Time[19 - Component 19] RD_ONLY

8073 FLOAT Last FCalib_New Ret Time[20 - Component 20] RD_ONLY

8074 FLOAT Last FCalib_New Ret Time[1 - Component 1] RD_ONLY

8075 FLOAT Last FCalib_New Ret Time[2 - Component 2] RD_ONLY

8076 FLOAT Last FCalib_New Ret Time[3 - Component 3] RD_ONLY

8077 FLOAT Last FCalib_New Ret Time[4 - Component 4] RD_ONLY

8078 FLOAT Last FCalib_New Ret Time[5 - Component 5] RD_ONLY

8079 FLOAT Last FCalib_New Ret Time[6 - Component 6] RD_ONLY

8080 FLOAT Last FCalib_New Ret Time[7 - Component 7] RD_ONLY

8081 FLOAT Last FCalib_New Ret Time[8 - Component 8] RD_ONLY

8082 FLOAT Last FCalib_New Ret Time[9 - Component 9] RD_ONLY

8083 FLOAT Last FCalib_New Ret Time[10 - Component 10] RD_ONLY

8084 FLOAT Last FCalib_New Ret Time[11 - Component 11] RD_ONLY

8085 FLOAT Last FCalib_New Ret Time[12 - Component 12] RD_ONLY

8086 FLOAT Last FCalib_New Ret Time[13 - Component 13] RD_ONLY

8087 FLOAT Last FCalib_New Ret Time[14 - Component 14] RD_ONLY

8088 FLOAT Last FCalib_New Ret Time[15 - Component 15] RD_ONLY

8089 FLOAT Last FCalib_New Ret Time[16 - Component 16] RD_ONLY

8090 FLOAT Last FCalib_New Ret Time[17 - Component 17] RD_ONLY

8091 FLOAT Last FCalib_New Ret Time[18 - Component 18] RD_ONLY

8092 FLOAT Last FCalib_New Ret Time[19 - Component 19] RD_ONLY

8093 FLOAT Last FCalib_New Ret Time[20 - Component 20] RD_ONLY

Pre-defined Modbus
®

 Map Files

Operations Manual 287



Register # Data type Variable Record # Access Format

8094 FLOAT Last FCalib_New Ret Time[1 - Component 1] RD_ONLY

8095 FLOAT Last FCalib_New Ret Time[2 - Component 2] RD_ONLY

8096 FLOAT Last FCalib_New Ret Time[3 - Component 3] RD_ONLY

8097 FLOAT Last FCalib_New Ret Time[4 - Component 4] RD_ONLY

8098 FLOAT Last FCalib_New Ret Time[5 - Component 5] RD_ONLY

8099 FLOAT Last FCalib_New Ret Time[6 - Component 6] RD_ONLY

8100 FLOAT Last FCalib_New Ret Time[7 - Component 7] RD_ONLY

8101 FLOAT Last FCalib_New Ret Time[8 - Component 8] RD_ONLY

8102 FLOAT Last FCalib_New Ret Time[9 - Component 9] RD_ONLY

8103 FLOAT Last FCalib_New Ret Time[10 - Component 10] RD_ONLY

8104 FLOAT Last FCalib_New Ret Time[11 - Component 11] RD_ONLY

8105 FLOAT Last FCalib_New Ret Time[12 - Component 12] RD_ONLY

8106 FLOAT Last FCalib_New Ret Time[13 - Component 13] RD_ONLY

8107 FLOAT Last FCalib_New Ret Time[14 - Component 14] RD_ONLY

8108 FLOAT Last FCalib_New Ret Time[15 - Component 15] RD_ONLY

8109 FLOAT Last FCalib_New Ret Time[16 - Component 16] RD_ONLY

8110 FLOAT Last FCalib_New Ret Time[17 - Component 17] RD_ONLY

8111 FLOAT Last FCalib_New Ret Time[18 - Component 18] RD_ONLY

8112 FLOAT Last FCalib_New Ret Time[19 - Component 19] RD_ONLY

8113 FLOAT Last FCalib_New Ret Time[20 - Component 20] RD_ONLY

8114 FLOAT Last FCalib_New Ret Time[1 - Component 1] RD_ONLY

8115 FLOAT Last FCalib_New Ret Time[2 - Component 2] RD_ONLY

8116 FLOAT Last FCalib_New Ret Time[3 - Component 3] RD_ONLY

8117 FLOAT Last FCalib_New Ret Time[4 - Component 4] RD_ONLY

8118 FLOAT Last FCalib_New Ret Time[5 - Component 5] RD_ONLY

8119 FLOAT Last FCalib_New Ret Time[6 - Component 6] RD_ONLY

8120 FLOAT Last FCalib_New Ret Time[7 - Component 7] RD_ONLY

8121 FLOAT Last FCalib_New Ret Time[8 - Component 8] RD_ONLY

8122 FLOAT Last FCalib_New Ret Time[9 - Component 9] RD_ONLY

8123 FLOAT Last FCalib_New Ret Time[10 - Component 10] RD_ONLY

8124 FLOAT Last FCalib_New Ret Time[11 - Component 11] RD_ONLY

8125 FLOAT Last FCalib_New Ret Time[12 - Component 12] RD_ONLY

8126 FLOAT Last FCalib_New Ret Time[13 - Component 13] RD_ONLY

8127 FLOAT Last FCalib_New Ret Time[14 - Component 14] RD_ONLY

8128 FLOAT Last FCalib_New Ret Time[15 - Component 15] RD_ONLY

8129 FLOAT Last FCalib_New Ret Time[16 - Component 16] RD_ONLY

8130 FLOAT Last FCalib_New Ret Time[17 - Component 17] RD_ONLY
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8131 FLOAT Last FCalib_New Ret Time[18 - Component 18] RD_ONLY

8132 FLOAT Last FCalib_New Ret Time[19 - Component 19] RD_ONLY

8133 FLOAT Last FCalib_New Ret Time[20 - Component 20] RD_ONLY

8134 FLOAT Last FCalib_Old Resp Factor[1 - Component 1] RD_ONLY

8135 FLOAT Last FCalib_Old Resp Factor[2 - Component 2] RD_ONLY

8136 FLOAT Last FCalib_Old Resp Factor[3 - Component 3] RD_ONLY

8137 FLOAT Last FCalib_Old Resp Factor[4 - Component 4] RD_ONLY

8138 FLOAT Last FCalib_Old Resp Factor[5 - Component 5] RD_ONLY

8139 FLOAT Last FCalib_Old Resp Factor[6 - Component 6] RD_ONLY

8140 FLOAT Last FCalib_Old Resp Factor[7 - Component 7] RD_ONLY

8141 FLOAT Last FCalib_Old Resp Factor[8 - Component 8] RD_ONLY

8142 FLOAT Last FCalib_Old Resp Factor[9 - Component 9] RD_ONLY

8143 FLOAT Last FCalib_Old Resp Factor[10 - Component 10] RD_ONLY

8144 FLOAT Last FCalib_Old Resp Factor[11 - Component 11] RD_ONLY

8145 FLOAT Last FCalib_Old Resp Factor[12 - Component 12] RD_ONLY

8146 FLOAT Last FCalib_Old Resp Factor[13 - Component 13] RD_ONLY

8147 FLOAT Last FCalib_Old Resp Factor[14 - Component 14] RD_ONLY

8148 FLOAT Last FCalib_Old Resp Factor[15 - Component 15] RD_ONLY

8149 FLOAT Last FCalib_Old Resp Factor[16 - Component 16] RD_ONLY

8150 FLOAT Last FCalib_Old Resp Factor[17 - Component 17] RD_ONLY

8151 FLOAT Last FCalib_Old Resp Factor[18 - Component 18] RD_ONLY

8152 FLOAT Last FCalib_Old Resp Factor[19 - Component 19] RD_ONLY

8153 FLOAT Last FCalib_Old Resp Factor[20 - Component 20] RD_ONLY

8154 FLOAT Last FCalib_Old Resp Factor[1 - Component 1] RD_ONLY

8155 FLOAT Last FCalib_Old Resp Factor[2 - Component 2] RD_ONLY

8156 FLOAT Last FCalib_Old Resp Factor[3 - Component 3] RD_ONLY

8157 FLOAT Last FCalib_Old Resp Factor[4 - Component 4] RD_ONLY

8158 FLOAT Last FCalib_Old Resp Factor[5 - Component 5] RD_ONLY

8159 FLOAT Last FCalib_Old Resp Factor[6 - Component 6] RD_ONLY

8160 FLOAT Last FCalib_Old Resp Factor[7 - Component 7] RD_ONLY

8161 FLOAT Last FCalib_Old Resp Factor[8 - Component 8] RD_ONLY

8162 FLOAT Last FCalib_Old Resp Factor[9 - Component 9] RD_ONLY

8163 FLOAT Last FCalib_Old Resp Factor[10 - Component 10] RD_ONLY

8164 FLOAT Last FCalib_Old Resp Factor[11 - Component 11] RD_ONLY

8165 FLOAT Last FCalib_Old Resp Factor[12 - Component 12] RD_ONLY

8166 FLOAT Last FCalib_Old Resp Factor[13 - Component 13] RD_ONLY

8167 FLOAT Last FCalib_Old Resp Factor[14 - Component 14] RD_ONLY
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8168 FLOAT Last FCalib_Old Resp Factor[15 - Component 15] RD_ONLY

8169 FLOAT Last FCalib_Old Resp Factor[16 - Component 16] RD_ONLY

8170 FLOAT Last FCalib_Old Resp Factor[17 - Component 17] RD_ONLY

8171 FLOAT Last FCalib_Old Resp Factor[18 - Component 18] RD_ONLY

8172 FLOAT Last FCalib_Old Resp Factor[19 - Component 19] RD_ONLY

8173 FLOAT Last FCalib_Old Resp Factor[20 - Component 20] RD_ONLY

8174 FLOAT Last FCalib_Old Resp Factor[1 - Component 1] RD_ONLY

8175 FLOAT Last FCalib_Old Resp Factor[2 - Component 2] RD_ONLY

8176 FLOAT Last FCalib_Old Resp Factor[3 - Component 3] RD_ONLY

8177 FLOAT Last FCalib_Old Resp Factor[4 - Component 4] RD_ONLY

8178 FLOAT Last FCalib_Old Resp Factor[5 - Component 5] RD_ONLY

8179 FLOAT Last FCalib_Old Resp Factor[6 - Component 6] RD_ONLY

8180 FLOAT Last FCalib_Old Resp Factor[7 - Component 7] RD_ONLY

8181 FLOAT Last FCalib_Old Resp Factor[8 - Component 8] RD_ONLY

8182 FLOAT Last FCalib_Old Resp Factor[9 - Component 9] RD_ONLY

8183 FLOAT Last FCalib_Old Resp Factor[10 - Component 10] RD_ONLY

8184 FLOAT Last FCalib_Old Resp Factor[11 - Component 11] RD_ONLY

8185 FLOAT Last FCalib_Old Resp Factor[12 - Component 12] RD_ONLY

8186 FLOAT Last FCalib_Old Resp Factor[13 - Component 13] RD_ONLY

8187 FLOAT Last FCalib_Old Resp Factor[14 - Component 14] RD_ONLY

8188 FLOAT Last FCalib_Old Resp Factor[15 - Component 15] RD_ONLY

8189 FLOAT Last FCalib_Old Resp Factor[16 - Component 16] RD_ONLY

8190 FLOAT Last FCalib_Old Resp Factor[17 - Component 17] RD_ONLY

8191 FLOAT Last FCalib_Old Resp Factor[18 - Component 18] RD_ONLY

8192 FLOAT Last FCalib_Old Resp Factor[19 - Component 19] RD_ONLY

8193 FLOAT Last FCalib_Old Resp Factor[20 - Component 20] RD_ONLY

8194 FLOAT Last FCalib_Old Resp Factor[1 - Component 1] RD_ONLY

8195 FLOAT Last FCalib_Old Resp Factor[2 - Component 2] RD_ONLY

8196 FLOAT Last FCalib_Old Resp Factor[3 - Component 3] RD_ONLY

8197 FLOAT Last FCalib_Old Resp Factor[4 - Component 4] RD_ONLY

8198 FLOAT Last FCalib_Old Resp Factor[5 - Component 5] RD_ONLY

8199 FLOAT Last FCalib_Old Resp Factor[6 - Component 6] RD_ONLY

8200 FLOAT Last FCalib_Old Resp Factor[7 - Component 7] RD_ONLY

8201 FLOAT Last FCalib_Old Resp Factor[8 - Component 8] RD_ONLY

8202 FLOAT Last FCalib_Old Resp Factor[9 - Component 9] RD_ONLY

8203 FLOAT Last FCalib_Old Resp Factor[10 - Component 10] RD_ONLY

8204 FLOAT Last FCalib_Old Resp Factor[11 - Component 11] RD_ONLY
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8205 FLOAT Last FCalib_Old Resp Factor[12 - Component 12] RD_ONLY

8206 FLOAT Last FCalib_Old Resp Factor[13 - Component 13] RD_ONLY

8207 FLOAT Last FCalib_Old Resp Factor[14 - Component 14] RD_ONLY

8208 FLOAT Last FCalib_Old Resp Factor[15 - Component 15] RD_ONLY

8209 FLOAT Last FCalib_Old Resp Factor[16 - Component 16] RD_ONLY

8210 FLOAT Last FCalib_Old Resp Factor[17 - Component 17] RD_ONLY

8211 FLOAT Last FCalib_Old Resp Factor[18 - Component 18] RD_ONLY

8212 FLOAT Last FCalib_Old Resp Factor[19 - Component 19] RD_ONLY

8213 FLOAT Last FCalib_Old Resp Factor[20 - Component 20] RD_ONLY

8214 FLOAT Last FCalib_Old Ret Time[1 - Component 1] RD_ONLY

8215 FLOAT Last FCalib_Old Ret Time[2 - Component 2] RD_ONLY

8216 FLOAT Last FCalib_Old Ret Time[3 - Component 3] RD_ONLY

8217 FLOAT Last FCalib_Old Ret Time[4 - Component 4] RD_ONLY

8218 FLOAT Last FCalib_Old Ret Time[5 - Component 5] RD_ONLY

8219 FLOAT Last FCalib_Old Ret Time[6 - Component 6] RD_ONLY

8220 FLOAT Last FCalib_Old Ret Time[7 - Component 7] RD_ONLY

8221 FLOAT Last FCalib_Old Ret Time[8 - Component 8] RD_ONLY

8222 FLOAT Last FCalib_Old Ret Time[9 - Component 9] RD_ONLY

8223 FLOAT Last FCalib_Old Ret Time[10 - Component 10] RD_ONLY

8224 FLOAT Last FCalib_Old Ret Time[11 - Component 11] RD_ONLY

8225 FLOAT Last FCalib_Old Ret Time[12 - Component 12] RD_ONLY

8226 FLOAT Last FCalib_Old Ret Time[13 - Component 13] RD_ONLY

8227 FLOAT Last FCalib_Old Ret Time[14 - Component 14] RD_ONLY

8228 FLOAT Last FCalib_Old Ret Time[15 - Component 15] RD_ONLY

8229 FLOAT Last FCalib_Old Ret Time[16 - Component 16] RD_ONLY

8230 FLOAT Last FCalib_Old Ret Time[17 - Component 17] RD_ONLY

8231 FLOAT Last FCalib_Old Ret Time[18 - Component 18] RD_ONLY

8232 FLOAT Last FCalib_Old Ret Time[19 - Component 19] RD_ONLY

8233 FLOAT Last FCalib_Old Ret Time[20 - Component 20] RD_ONLY

8234 FLOAT Last FCalib_Old Ret Time[1 - Component 1] RD_ONLY

8235 FLOAT Last FCalib_Old Ret Time[2 - Component 2] RD_ONLY

8236 FLOAT Last FCalib_Old Ret Time[3 - Component 3] RD_ONLY

8237 FLOAT Last FCalib_Old Ret Time[4 - Component 4] RD_ONLY

8238 FLOAT Last FCalib_Old Ret Time[5 - Component 5] RD_ONLY

8239 FLOAT Last FCalib_Old Ret Time[6 - Component 6] RD_ONLY

8240 FLOAT Last FCalib_Old Ret Time[7 - Component 7] RD_ONLY

8241 FLOAT Last FCalib_Old Ret Time[8 - Component 8] RD_ONLY
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8242 FLOAT Last FCalib_Old Ret Time[9 - Component 9] RD_ONLY

8243 FLOAT Last FCalib_Old Ret Time[10 - Component 10] RD_ONLY

8244 FLOAT Last FCalib_Old Ret Time[11 - Component 11] RD_ONLY

8245 FLOAT Last FCalib_Old Ret Time[12 - Component 12] RD_ONLY

8246 FLOAT Last FCalib_Old Ret Time[13 - Component 13] RD_ONLY

8247 FLOAT Last FCalib_Old Ret Time[14 - Component 14] RD_ONLY

8248 FLOAT Last FCalib_Old Ret Time[15 - Component 15] RD_ONLY

8249 FLOAT Last FCalib_Old Ret Time[16 - Component 16] RD_ONLY

8250 FLOAT Last FCalib_Old Ret Time[17 - Component 17] RD_ONLY

8251 FLOAT Last FCalib_Old Ret Time[18 - Component 18] RD_ONLY

8252 FLOAT Last FCalib_Old Ret Time[19 - Component 19] RD_ONLY

8253 FLOAT Last FCalib_Old Ret Time[20 - Component 20] RD_ONLY

8254 FLOAT Last FCalib_Old Ret Time[1 - Component 1] RD_ONLY

8255 FLOAT Last FCalib_Old Ret Time[2 - Component 2] RD_ONLY

8256 FLOAT Last FCalib_Old Ret Time[3 - Component 3] RD_ONLY

8257 FLOAT Last FCalib_Old Ret Time[4 - Component 4] RD_ONLY

8258 FLOAT Last FCalib_Old Ret Time[5 - Component 5] RD_ONLY

8259 FLOAT Last FCalib_Old Ret Time[6 - Component 6] RD_ONLY

8260 FLOAT Last FCalib_Old Ret Time[7 - Component 7] RD_ONLY

8261 FLOAT Last FCalib_Old Ret Time[8 - Component 8] RD_ONLY

8262 FLOAT Last FCalib_Old Ret Time[9 - Component 9] RD_ONLY

8263 FLOAT Last FCalib_Old Ret Time[10 - Component 10] RD_ONLY

8264 FLOAT Last FCalib_Old Ret Time[11 - Component 11] RD_ONLY

8265 FLOAT Last FCalib_Old Ret Time[12 - Component 12] RD_ONLY

8266 FLOAT Last FCalib_Old Ret Time[13 - Component 13] RD_ONLY

8267 FLOAT Last FCalib_Old Ret Time[14 - Component 14] RD_ONLY

8268 FLOAT Last FCalib_Old Ret Time[15 - Component 15] RD_ONLY

8269 FLOAT Last FCalib_Old Ret Time[16 - Component 16] RD_ONLY

8270 FLOAT Last FCalib_Old Ret Time[17 - Component 17] RD_ONLY

8271 FLOAT Last FCalib_Old Ret Time[18 - Component 18] RD_ONLY

8272 FLOAT Last FCalib_Old Ret Time[19 - Component 19] RD_ONLY

8273 FLOAT Last FCalib_Old Ret Time[20 - Component 20] RD_ONLY

8274 FLOAT Last FCalib_Old Ret Time[1 - Component 1] RD_ONLY

8275 FLOAT Last FCalib_Old Ret Time[2 - Component 2] RD_ONLY

8276 FLOAT Last FCalib_Old Ret Time[3 - Component 3] RD_ONLY

8277 FLOAT Last FCalib_Old Ret Time[4 - Component 4] RD_ONLY

8278 FLOAT Last FCalib_Old Ret Time[5 - Component 5] RD_ONLY
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Register # Data type Variable Record # Access Format

8279 FLOAT Last FCalib_Old Ret Time[6 - Component 6] RD_ONLY

8280 FLOAT Last FCalib_Old Ret Time[7 - Component 7] RD_ONLY

8281 FLOAT Last FCalib_Old Ret Time[8 - Component 8] RD_ONLY

8282 FLOAT Last FCalib_Old Ret Time[9 - Component 9] RD_ONLY

8283 FLOAT Last FCalib_Old Ret Time[10 - Component 10] RD_ONLY

8284 FLOAT Last FCalib_Old Ret Time[11 - Component 11] RD_ONLY

8285 FLOAT Last FCalib_Old Ret Time[12 - Component 12] RD_ONLY

8286 FLOAT Last FCalib_Old Ret Time[13 - Component 13] RD_ONLY

8287 FLOAT Last FCalib_Old Ret Time[14 - Component 14] RD_ONLY

8288 FLOAT Last FCalib_Old Ret Time[15 - Component 15] RD_ONLY

8289 FLOAT Last FCalib_Old Ret Time[16 - Component 16] RD_ONLY

8290 FLOAT Last FCalib_Old Ret Time[17 - Component 17] RD_ONLY

8291 FLOAT Last FCalib_Old Ret Time[18 - Component 18] RD_ONLY

8292 FLOAT Last FCalib_Old Ret Time[19 - Component 19] RD_ONLY

8293 FLOAT Last FCalib_Old Ret Time[20 - Component 20] RD_ONLY

8963 FLOAT Clear All Alarms RD_WR

8964 FLOAT Acknowledge All Alarms RD_WR

9006 INT Current Time(time_t) RD_WR MM

9007 INT Current Time(time_t) RD_WR DD

9008 INT Current Time(time_t) RD_WR YYYY

9009 INT Current Time(time_t) RD_WR hh

9010 INT Current Time(time_t) RD_WR mm

9011 INT Current Time(time_t) RD_WR ss

9012 INT Unused RD_ONLY

9013 INT Modbus Id[1 - Port 0] RD_ONLY

9014 INT Site Id RD_WR

9022 INT Analysis Time RD_ONLY

9023 INT Unused RD_ONLY

9024 INT Cycle Time RD_ONLY

9025 INT Unused RD_ONLY

9026 INT Run Time RD_ONLY

9027 INT Unused RD_ONLY

9028 INT Current Stream RD_ONLY

9029 INT Unused RD_ONLY

9030 INT GC Control_Analyser Control (Write Reg 9030) RD_WR

9031 INT Unused RD_ONLY

9032 INT GC Calibrating RD_ONLY
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Register # Data type Variable Record # Access Format

9033 INT Unused RD_ONLY

9034 INT Active Alarm Flag RD_ONLY

9035 INT UnAck Alarm Flag RD_ONLY

9036 INT Hourly Average Reset time RD_ONLY YY

9037 INT Hourly Average Reset time RD_ONLY MM

9038 INT Hourly Average Reset time RD_ONLY DD

9039 INT Hourly Average Reset time RD_ONLY hh

9040 INT Hourly Average Reset time RD_ONLY mm

9041 INT Daily Average Reset time RD_ONLY YY

9042 INT Daily Average Reset time RD_ONLY MM

9043 INT Daily Average Reset time RD_ONLY DD

9044 INT Daily Average Reset time RD_ONLY hh

9045 INT Daily Average Reset time RD_ONLY mm

9046 INT Weekly Average Reset time RD_ONLY YY

9047 INT Weekly Average Reset time RD_ONLY MM

9048 INT Weekly Average Reset time RD_ONLY DD

9049 INT Weekly Average Reset time RD_ONLY hh

9050 INT Weekly Average Reset time RD_ONLY mm

9051 INT Monthly Average Reset time RD_ONLY YY

9052 INT Monthly Average Reset time RD_ONLY MM

9053 INT Monthly Average Reset time RD_ONLY DD

9054 INT Monthly Average Reset time RD_ONLY hh

9055 INT Monthly Average Reset time RD_ONLY mm

9056 INT Variable Average Reset time RD_ONLY YY

9057 INT Variable Average Reset time RD_ONLY MM

9058 INT Variable Average Reset time RD_ONLY DD

9059 INT Variable Average Reset time RD_ONLY hh

9060 INT Variable Average Reset time RD_ONLY mm

3099...3102 (Valid data flags): This flag is set to 1 when new valid data is put into the
Modbus registers and set to 0 if an alarm is active. The 4 copies of this flag operate in the
same way; they are intended for use by up to 4 independent Modbus master devices
attached to the 4 serial ports. This is a read-write register, so the Modbus Master can clear
the flag once the new results are read.

3103...3182 (Calibration update flags): Set to 1 when response factors are updated during
a calibration.
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5001 (Last Analy_Cycle Time (1/30th sec)): Cycle time for last analysis in 1/30th seconds.
For example, if cycle time is 300 seconds, this register reads 9000.

5002 (Last Cal_Cycle Time (1/30th sec)): Cycle time for last calibration in 1/30th seconds.
For example, if cycle time is 300 seconds, this register reads 9000.

7001...70016 (Last Analy Mole %): These registers hold the mole % results for the last
analysis run. The order of components in these registers can be determined by reading
Register 3001...3016 which contains the component codes.

7017...7032 (Last Analy Weight %): These registers hold the weight % results for the last
analysis run. The order of components in these registers can be determined by reading
Register 3001...3016 which contains the component codes.

7033...7039 : Last analysis stream results.

7040...7044: User calculation results 1...5.

7046...7054: Last analysis stream results.

7070...7084: Most recent archive averages for Averages 1...15.

7085...7086: Current analog input values for Analog Input 1 and 2.

7087...7090: Last analysis stream results.

7091: Number of total calibration runs.

7092: Number of averaged calibration runs.

7093: Auto calibration start time.

7094: (Stream Sequence Select): Read-write register. When read, returns currently
selected stream sequence. To change stream sequence, write sequence number.

Value Stream sequence

1 Default stream sequence

2 Aux stream sequence 1

3 Aux stream sequence 2

7095...7110 (Last Analysis Response Factors): Response factor for Components 1...16 used
on last run.

7111...7121: Results from last calibration.

7122: Calibration stream number.

7123...7125: Last analysis GS(M)R results.

7126...7161: Current running averages for Averages 1...36.

7162...7197: Maximum sample value during current averaging period for Averages 1...36.
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7198...7233: Minimum sample value during current averaging period for averages 1...36.

7234...7269: Most recent archived averages for Averages 1 through 36.

7270...7305: Maximum sample value in the second most recent archived average for
Averages 1...36.

7306...7341: Minimum sample value in the second most recent archived average for
Averages 1...36.

7342...7377: Second most recent archived averages for Averages 1...36.

7378...7413: Maximum sample value in the second most recent archived average for
Averages 1...36.

7414...7449: Minimum sample value in the second most recent archived average for
averages 1...36.

7450...7485: Third most recent archived averages for Averages 1...36.

7586...7621: Maximum sample value in the third most recent archived averages for
Averages 1...36.

7521...7557: Minimum sample value in the third most recent archived averages for
Averages 1...36.

7558...7573: Multi-level calibration coefficient a components 1...16.

7572...7589: Multi-level calibration coefficient b components 1...16.

7590...7605: Multi-level calibration coefficient c components 1...16.

7606...7621: Multi-level calibration coefficient d components 1...16.

7622...7637: Indirect calibration - relative response factors for components 1...16.

7638...7717: Repeat of 7558...7637 above for component table 2.

7718...7845: Current running averages for Averages 1...128.

7486..7973: Most recent archived averages for Averages 1...128.

7974...8053: Current response factors.

8054...8133: Current retention times.

8214...8293: Retention times from previous calibration.

8963 (Clear All Alarms): Write 1 to this register to clear all active alarms.

8964 (Acknowledge All Alarms): Write 1 to this register to acknowledge all alarms.

9006...9011: GC system date/time read-write registers.

9013 (Modbus ID [Port 0]): Modbus ID for Serial Port 0.

9014 (Site ID): GC site ID read-write register.
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9022 (Analysis Time): Analysis time.

9024 (Cycle Time): Cycle time.

9026 (Run Time): Run time.

9028 (Current Stream): Stream number.

9030 (Analyzer Control): Section B.6.

9032 (GC Calibrating): Tells you if the GC is calibrating. A value of 1 means the GC is
calibrating, 0 otherwise.

9034 (Active Alarm Flag): Tells you if the GC has any active alarms. A value of 1 indicates
that there are active alarms, 0 otherwise.

9035 (UnAck Alarm Flag): Tells you if the GC has any unaknowledged alarms. A value of 1
indicates that there are unacknowledged alarms, 0 otherwise.

9036...9040 (Hourly Average Reset Time): Date/time when hourly average results were
archived.

9041...9045 (Daily Average Reset Time): Date/time when daily average results were
archived.

9046...9047 (Weekly Average Reset Time): Date/time when weekly average results were
archived.

9051...9055 (Monthly Average Reset Time): Date/time when monthly averaged results
were archived.

9056...9060 (Variable Average Reset Time): Date/time when variable average results were
archived.

D.6 Remote control registers

Modbus register Description

GC Control_Auto Sequence Start chromatograph auto sequencing. Normally 0.0; write non-zero value to initiate
sequencing.

1.0 - start with purge

2.0 - start without purge

GC Control_Halt Halt chromatograph sequencing - Normally 0.0; write 1.0 to perform halt.

GC Control_Single Stream Start single stream run - Normally 0.0. Continuous Single Stream mode: Write the
stream number (in floating point) to start with a purge and the negative of the
stream number to start without a purge. Single Analysis Non-continuous Single Stream
mode: Write (128.0 + the stream number) (in floating point) to start with a purge,
and the negative of (128.0 + the stream number) to start without a purge.
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Modbus register Description

GC Control_Calibration Start calibration sequence - Normally 0.0. For Normal Calibration: Write the stream
number of the calibration stream in floating point to start calibration sequence with a
purge, or write the negative of the stream number to start calibration sequence with-
out a purge.

For Forced Calibration: Write (128.0 + stream number) of the cal stream in floating
point to start calibration sequence with a purge or writes the negative of (128 +
stream number) of the cal stream to start a calibration sequence without a purge.

GC Control_Validation Start validation sequence - Normally 0.0. For Validation: Write the stream number of
the Validation stream in floating point to start validation sequence with a purge, or
write the negative of the stream number to start validation sequence without a
purge.

GC Control -> Validation Ac-
knowledge

GC copies Start Validation command to this register; PLC can reset after confirming
that command was successfully issued.

GC Control_Stream Sequence
Select

Read-write register. When read, returns currently selected stream sequence. To
change stream sequence, write sequence number.

Value Stream sequence

1 Default stream sequence

2 Aux stream sequence 1

3 Aux stream sequence 2

Stream Sequence - Default
Stream Sequence

Reads the sequence of streams. For example, if current Sequence is 1, 2, then this
register reads a value of 12. To change the sequence of streams: For example, to
change the Sequence to 2,3, write 23 to this register.

GC Status > GC Running GC is running.

0 - GC is idle

1 - GC is running (Auto Analysis, Single Stream, Calibration, Validation)

GC Status > Current Analysis
Mode

Indicates mode of operation:

0 - GC Idle

1 - Auto Sequence

2 - Single Stream

3 - Manual Calibration

4 - Manual Validation
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D.7 Read-write remote control register (9030)
9030 is a read-write register that can be used for controlling GC operation and for reading
current operating mode.

The mode values read from register 9030 are:

0 Idle

1 In automatic sequencing mode

2 Running in single stream mode

3 Calibrating

4 Warm starting, running confidence tests

5 Validating (added in Firmware Version 2.1.0 and higher)

The commands that can be written to register 9030 are:

0 Halt at the end of the current analysis

1 Start automatic sequencing mode

2 Start a normal calibration, on first calibration stream

3 Run single analysis on stream 1, then halt

4 Run continually on stream 1

5 Run a single analysis on stream 2, then halt

6 Run continually on stream 2

7 Run a single analysis on stream 3, then halt

8 Run continuously on stream 3

9 Run a single analysis on stream 4, then halt

10 Run continually on stream 4

11 Run a single analysis on stream 5, then halt

12 Run continually on stream 5

13 Run a single analysis on stream 6, then halt

14 Run continually on stream 6

15 Run a single analysis on stream 7, then halt

16 Run continuously on stream 7

17 Run a single analysis on stream 8, then halt

18 Run continuously on stream 8

19 Run validation on first validation stream (added in Firmware Version 2.1.0 and higher)

...

41 Run normal calibration on stream 1 (added in Firmware Version 2.1.0 and higher)

42 Run normal calibration on stream 2 (added in Firmware Version 2.1.0 and higher)

...
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60 Run normal calibration on stream 20 (added in Firmware Version 2.1.0 and higher)

...

81 Run validation on stream 1 (added in Firmware Version 2.1.0 and higher)

82 Run validation on stream 2 (added in Firmware Version 2.1.0 and higher)

...

100 Run validation on stream 20 (added in Firmware Version 2.1.0 and higher)

Commands 1-19, 41-60, and 81-100 above are with 60 seconds purge. Adding 20 to any
command means no purge if relevant. These writes are done using Modbus functions 6 or
16. Except for commands 0 and 2, the GC must be idle. If a command fails because the GC
was not idle or because the code is invalid or the stream is not used, a Modbus exception
illegal data value will be returned. All these commands are allowed without requiring a
password or the security switch to be unlocked. These commands are available to both
User Modbus ports and SIM_2251 Modbus ports.

D.8 Writable Modbus registers
The following list documents all the Modbus registers in the GC that can be written when
the GC is under legal metrology control with the security switch locked. Please note that
not all the registers in this table are available in the SIM_2251 mapping.

Modbus register Remarks

GC Status -> Current Month Set GC clock. All 5 registers can be written in a single request, or individual reg-
isters can be written. The new date/time is validated before the GC system
clock is changed.

GC Status -> Current Day

GC Status -> Current Year

GC Status -> Current Hour

GC Status -> Current Minute

GC Status -> New Data Flag Flags for synchronizing Master and Slave. The Slave (GC) updates its result reg-
isters and then sets the flag to 1. The Master (PLC/Flow Computer) reads the
data and resets the flag to 0.

GC Status -> Hourly Avg Updated

GC Status -> Weekly Avg Updated

GC Status -> Daily Avg Updated

GC Status -> Monthly Avg Updated

GC Status -> Last Run Data Valid 1

GC Status -> Last Run Data Valid 2

GC Status -> Last Run Data Valid 3

GC Status -> Last Run Data Valid 4

GC Status -> Last Run Data Valid 5
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Modbus register Remarks

GC Status -> Last Run Data Valid 6

GC Status -> Last Run Data Valid 7

GC Status -> Last Run Data Valid 8

GC Status -> Last Run Data Valid 9

GC Status -> Last Run Data Valid 10

Stream 1 -> New Data Available

Stream 2 -> New Data Available

Stream 3 -> New Data Available

Stream 4 -> New Data Available

Stream 5 -> New Data Available

Stream 6 -> New Data Available

Stream 7 -> New Data Available

Stream 8 -> New Data Available

Stream 9 -> New Data Available

Stream 10 -> New Data Available

Stream 11 -> New Data Available

Stream 12 -> New Data Available

Stream 13 -> New Data Available

Stream 14 -> New Data Available

Stream 15 -> New Data Available

Stream 16 -> New Data Available

Stream 17 -> New Data Available

Stream 18 -> New Data Available

Stream 19 -> New Data Available

Stream 20 -> New Data Available

Discrete Output 1 -> Switch Master can write the following values to this register -

0 - Sets the discrete output to Off.

1 - Sets the discrete output to On.

2 - Sets the discrete output to Automatic (DO controller by GC's timed events).

Discrete Output 2 -> Switch

Discrete Output 3 -> Switch

Discrete Output 4 -> Switch

Discrete Output 5 -> Switch

Dewpoint Configuration 1 -> Pressure
1

Pressure at which hydrocarbon dewpoint results are computed. Used only for
dual-detector C9+ hydrocarbon dewpoint GCs. These registers are not used in
C6+ custody transfer applications.

Dewpoint Configuration 1 -> Pressure
2
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Modbus register Remarks

Dewpoint Configuration 1 -> Pressure
3

Dewpoint Configuration 1 -> Pressure
4

Dewpoint Configuration 2 -> Pressure
1

Dewpoint Configuration 2 -> Pressure
2

Dewpoint Configuration 2 -> Pressure
3

Dewpoint Configuration 2 -> Pressure
4

Dewpoint Configuration 3 -> Pressure
1

Dewpoint Configuration 3 -> Pressure
2

Dewpoint Configuration 3 -> Pressure
3

Dewpoint Configuration 3 -> Pressure
4

Dewpoint Configuration 4 -> Pressure
1

Dewpoint Configuration 4 -> Pressure
2

Dewpoint Configuration 4 -> Pressure
3

Dewpoint Configuration 4 -> Pressure
4

GC Control_Auto Sequence Start chromatograph auto sequencing.

Normally 0.0; write non-zero value to initiate sequencing.

1.0 - Start with purge.

2.0 - Start without purge.

GC Control_Halt Halt chromatograph sequencing -

Normally 0.0; write 1.0 to perform halt.

GC Control_Single Stream Start single stream run.

Normally 0.0.

Continuous Single Stream mode:

Write the stream number (in floating point) to start with a purge, and the nega-
tive of the stream number to start without a purge.

Single Analysis Non-continuous Single Stream mode:

Write (128.0 + the stream number) (in floating point) to start with a purge and
the negative of (128.0 + the stream number) to start without a purge.
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Modbus register Remarks

GC Control_Calibration Start calibration sequence.

Normally 0.0.

For normal calibration:

Write the stream number of the calibration stream in floating point to start cali-
bration sequence with a purge or write the negative of the stream number to
start calibration sequence without a purge.

GC Control_Validation Start validation sequence.

Normally 0.0.

For validation:

Write the stream number of the validation stream in floating point to start vali-
dation sequence with a purge or write the negative of the stream number to
start validation sequence without a purge.

GC Control_Stream Sequence Select Read-write register. When read, returns currently selected stream sequence. To
change stream sequence, write the sequence number.

Value stream sequence

Value Stream sequence

1 Default stream sequence

2 Aux stream sequence 1

3 Aux stream sequence 2

GC Control_Analyser Control (Write
Reg 9030)

GC remote control register. Please refer to Section D.7.

for details.

Acknowledge All Alarms Normally 0.0. Write 1 to acknowledge all alarms.

Component Data 1_Calib Conc[Com-
ponent 1..15]

Update calibration concentration from PLC before starting calibration.

Component Data 1_Resp Fact %
[ Component 1..15]

Update response factors from PLC.

Stream Sequence - Default Stream Se-
quence

Reads the sequence of streams. For example, if the current Sequence is 1, 2,
then this register reads a value of 12.

To change the sequence of streams:

For example, to change the Sequence to 2,3, write 23 to this register.

GC Control_Auto Valve Timing Start auto valve timing. Normally 0.0. Write
• Calibration stream number: to start AVT from current settings.
• Calibration stream number + 20 - to start AVT from default settings.
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Appendix E
Recommended spare parts

The following list of recommended spare parts will allow you to maintain a single
Rosemount 1500XA for approximately two years.

For a more detailed list of recommended spare parts, please see the documentation
package that was provided with the Rosemount 1500XA.

Description Part Number Quantity

Preamplifier board 7A00401 1

Base I/O board 7A00403 1

Solenoid/Heater board 9A00402 1

CPU Board 7A00055G02 1

Assembly, Carrier Dryer 2-3-0500-180 1

Pressure switch, carrier, for Rosemount
1500XA

2-4-5000-209 1

Solenoid, 4-Way, MAC 2-4-0710-224 4

Power supply 7C00086-001 1

Assembly, RTD GC Oven 2-3-1700-092 1

LOI 7A00148G01 1

Heater Assembly 2-3-1510-118 (115 Vac)

2-3-1510-107 (230 Vac)

1

Solid State Relay (SSR) 2-5-2710-055 1

Time Delay Relay (TDR) 2-5-2710-040 (115 VAC)

2-5-2710-054 (230 VAC)

1

Backplane Board 9A00051G01 1

Kit, diaphragm, 10-port XA valve 2-4-0710-171 Application Dependent

Kit, diaphragm, 6-port XA valve 2-4-0710-248 Application Dependent

PFTE Thermistor Seals (Set of 10) 2-3-0500-391 1

Porter Regulator 2-4-5002-223 1

Assembly, Methanator Rosemount
700XA/1500XA(1)

2-3-0710-265 1

(1) For GCs with methantor units

Electrical and mechanical assemblies (Analyzer) 

For units with FID

Recommended spare parts
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Description Part Number Quantity

FID Support PCBA(1) 9A00049G01 1

PCA, FID Electrometer(1) 2-3-0710-014 1

(1) For GCs with FID units
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Appendix F
Shipping and long-term storage
recommendations

For applications equipped with special columns, e.g., mole sieve, read and follow the
additional instructions shipped with the analyzer and/or column set first. If you need
another copy, please contact customer service.

The following recommendations should be followed:

• For shipping purposes the gas chromatograph should be secured to a wooden
pallet, maintained in a vertical position and enclosed in a wood framework.

• Auxiliary equipment such as sample probes may be stored in the packaging in which
it was shipped. If this packaging material is no longer available, secure the
equipment to prevent excessive shaking and protect the accessories in a water proof
enclosure.

• The gas chromatograph should be stored in a sheltered environment that is
temperature controlled between -30 °C (-22° F) and 60° C (140 ° F) to keep the gas
chromatograph’s protective coatings from deteriorating from exposure to rain or
caustic or corrosive environments. Humidity in the sheltered environment should be
non-condensing. Be especially cautious of humidity if the conduit has been potted.
Temporary caps and dessicant may be necessary.

• The configuration of the analyzer may be retained through battery back-up on the
CPU for at least two years. If lost for some reason, a custom program for
downloading the appropriate GC application is included on the USB shipped with
the system documentation.

• If the gas chromatograph has been in operation, the system should be purged with
carrier gas before powering the gas chromatograph down, especially when heavy
hydrocarbons or components that tend to polymerize are present. Allowing the gas
chromatograph to perform a few analysis cycles without sample gas is an acceptable
method of purging the system.

Note
To expedite the purge process, you may use 30 psig of a dry inert gas, such as nitrogen or
helium.

Monitor the results and halt the analyzer after component values fall to 0 or after
peaks are significantly reduced in size. Save a copy of the diagnostic data under
Tools → Save Diagnostic Data; once the file has been saved to a local PC, USB, or
hard drive, you may remove power.

Shipping and long-term storage recommendations
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• After removing power from the GC, remove the purge gas and immediately cap all
inlets and vents, including the carrier drier. These vents and inlets should be capped
with the fittings that were in place when the GC shipped from the factory or with
Swagelok® caps (not provided). This will protect the columns and filters and should
result in a trouble-free start up when the unit is returned to service.

• The sample conditioning system vents and inlets should also be capped with the
fittings that were in place when the system shipped from the factory. Additionally,
all vents should be closed.

• Any remaining openings—such as conduit entries—should also have appropriate
plugs installed to prevent foreign material such as dust or water from entering the
system.

Shipping and long-term storage recommendations
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Appendix G
Engineering drawings

G.2

List of engineering drawings
9R00001A - Outline and Dimensional 1500XA GC Cyclop Z-Purge 

9R00002B - Rosemount 1500XA 115 Vac Internal Power Supply Wiring 

9R00003B - Rosemount 1500XA 220 Vac Internal Power Supply Wiring 

9R00004B - Rosemount 1500XA Field Wiring (sheets 1 & 2) Module

CE-22260D - Assembly, 6 Port XA Valve, Rosemount Model 700XA 

CE-22300C - Assembly, 10 Port XA Valve, Rosemount Model 700XA

Note
Although the two drawings above refer to the 700XA, they also apply to the 1500XA because the
two GCs use the same types of valves.

Engineering drawings
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List of CSA North America engineering drawings
7R01500 – 1500XA Outline and Dimensional GC Cyclop Z-Purge

7R01501 – 1500XA Internal Wiring 115VAC POWER 

7R01503 – 1500XA Flow Configuration 

7R01505 – 1500XA Front Label



Engineering drawings
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Appendix H
Glossary

Auto Zero The TCD is auto zeroed at the start of a new analysis. Automatic
zeroing of the TCD preamplifier can also be configured to take place at
any time during the analysis if the component is not eluting or the
baseline is steady. The FID will auto zero at each new analysis run and
can be configured to auto zero anytime during the analysis if the
component is not eluting or the baseline is steady.

Baseline Signal output when there is only carrier gas going across the
detectors. In a chromatogram you should only see Baseline when
running an analysis without injecting a sample.

Carrier gas The gas used to push the sample through the system during an
analysis.

Chromatogram A permanent record of the detector output. A chromatogram is

Component

CTS

DCD

DSR

DTR

FID

GC

obtained from a PC interfaced with the detector output through the 
controller assembly. A typical chromatogram displays all component 
peaks, and gain changes. It may be viewed in color as it is processed 
on a PC display. Tick marks recorded on the chromatogram by the 
controller assembly indicate where timed events take place.

Any one of several different gases that may appear in a sample 
mixture. For example, natural gas usually contains the following 
components: nitrogen, carbon dioxide, methane, ethane, propane, 
isobutane, normal butane, isopentane, normal pentane, and hexanes 
plus.

Clear to send.

Data carrier detect.

Data set ready.

Data terminal ready.

Flame ionization detector. The optional FID may be used in place of a 
TCD for the detection of trace compounds. The FID requires a 
polarization voltage and its output is connected to the input to a high 
impedance amplifier, an electrometer. The sample of gas to be 
measured is injected into the burner with a mixture of hydrogen and 
air to maintain the flame.

Gas Chromatograph. The Rosemount 1500XA Gas Chromatograph is 
a user-configurable analyzer for various process gas applications.

Glossary
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LSIV Liquid sample injection valve. The optional LSIV is used to convert a
liquid sample to a gas sample by vaporizing the liquid in a heated
chamber, so the resulting gas sample can be analyzed.

Methanator The optional methanator, also known as a catalytic converter,
transforms undetectable (by the FID) components, carbon dioxide
and/or carbon monoxide, into methane by adding hydrogen and heat
to the sample.

Note
Carbon dioxide and/or carbon monoxide components are detectable by the
TCD.

Response factor Correction factor for each component as determined by the following
calibration:�� = ��� ��������������� �������������

Retention time Time, in seconds, that elapses between the start of analysis and the
sensing of the maximum concentration of each component by the
detector.

RI Ring indicator.

RLSD Received line signal detect. A digital simulation of a carrier detect.

RTS Request to send.

RxD, RD, or Sin Receive data, or signal in.

TCD Thermal conductivity detector. A detector that uses the thermal
conductivity of the different gas components to produce an
unbalanced signal across the bridge of the preamplifier. The higher
the temperature, the lower the resistance on the detectors.

TxD, TD, or Sout Transmit data, or signal out.
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